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Prefazione

Questo manuale è destinato principalmente agli operatori e amministratori del sistema 
libreria SL3000. Può essere utilizzato dai partner e dai responsabile dell’assistenza 
tecnica di Sun StorageTek. 

Il documento riguarda principalmente l’hardware della libreria, la StorageTek Library 
Console e le operazioni correlate. Per informazioni specifiche sull’unità o per i comandi 
dell’applicazione software client, consultare la documentazione relativa all’unità o al 
software.

Organizzazione del manuale

Capitolo 1 Introduzione alla libreria SL3000 Panoramica sulle funzioni e le funzionalità della 
libreria modulare Sun StorageTek SL3000. 

Capitolo 2 StorageTek Console della libreria. Informazioni e procedure per installare e utilizzare 
l’interfaccia utente grafica della SL Console. 

Capitolo 3 Operazioni automatizzate della libreria SL3000. Informazioni e procedure per 
utilizzare la SL Console per configurare, gestire e monitorare la libreria SL3000 in 
modalità automatica. 

Capitolo 4 Licenza. Informazioni, procedure e riferimenti alle schermate per installare e gestire le 
licenze delle funzionalità di SL3000. 

Capitolo 5 Capacity on Demand. Informazioni, procedure e riferimenti alle schermate per 
installare e gestire le licenze delle funzionalità di SL3000.

Capitolo 6 Partizionamento della libreria. Informazioni, procedure e riferimenti alle schermate 
per installare e gestire le partizioni della libreria SL3000.

Capitolo 7 Diagnostica e utility della SL Console. Informazioni e procedure per utilizzare la 
SL Console per eseguire funzionalità di diagnostica e di utility nella libreria SL3000. 

Capitolo 8 Operazioni manuali. Informazioni e procedure per un utilizzo sicuro della libreria 
SL3000 nella modalità manuale. 

Appendice A Indirizzi delle risorse della libreria. Informazioni di riferimento riguardanti le celle 
di storage, le CAP e l’indirizzamento delle unità utilizzate con la libreria SL3000. 

Appendice B Schemi delle pareti. Schemi dettagliati di celle di storage, CAP e layout delle unità. 
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Messaggi di avviso
I messaggi di avviso richiamano l’attenzione dell’utente su informazioni 
particolarmente importanti o che hanno riferimenti esclusivi alla grafica o al testo 
principale.

Nota – Una nota fornisce informazioni aggiuntive di particolare interesse. Una nota 
può indicare eccezioni a regole o procedure. 

Attenzione – Un messaggio di attenzione informa il lettore delle condizioni che 
possono provocare danni all’hardware, ai dati, ad applicativi software o a persone. 
Un messaggio di attenzione precede sempre l’informazione alla quale si riferisce.

Avvertenza – Rischio di lesioni personali. Un messaggio di avvertenza avvisa 
il lettore su condizioni che potrebbero essere causa di danni o di morte. Un 
messaggio di avvertenza precede sempre l’informazione alla quale si riferisce.

Appendice C Gestione delle cartucce. Informazioni di riferimento sulle etichette e l’utilizzo delle 
cartucce nella libreria SL3000. 

Appendice D Server della SL Console via Web. Informazioni e procedure per installare e 
configurare il server SL Console via Web. 

Indice Elenco in ordine alfabetico degli argomenti trattati in questo manuale.
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Convenzioni
Convenzioni tipografiche mettono in evidenza parole, frasi e azioni particolari.

Elemento Esempio Descrizione della convenzione

Pulsanti MENU Font e lettere maiuscole dopo il 
nome del prodotto

Comandi Mode Select Iniziale maiuscola

Titoli documenti System Assurance Guide Corsivo

Enfasi not non o deve must Corsivo

Nome file fsc.txt Font monospace

Collegamenti Figure 2-1 a pagina 2-5 Blu (risulta in nero nella stampa)

Indicatori Open Font e lettere maiuscole dopo il 
nome del prodotto

Nomi jumper TERMPWR Tutto maiuscole

Tasti tastiera <Y>  
<Enter> o  
<Ctrl+Alt+Delete>

Font e iniziale maiuscola dopo il 
nome del prodotto; chiusi tra frecce

Nomi menu Configuration Menu Iniziali maiuscole dopo il nome del 
prodotto

Parametri e variabili Device = xx Corsivo

Nomi percorsi c:/mydirectory Font monospace

Porte o nomi connettori SER1 Font e lettere maiuscole dopo il 
nome del prodotto; altrimenti tutte 
maiuscole

Posizioni di interruttori di 
circuito, jumper e 
commutatori

ON Font e lettere maiuscole dopo il 
nome del prodotto; altrimenti tutte 
maiuscole

Testo sullo schermo (incluse 
immagini, messaggi su 
schermo e dati utente)

download Font monospace

Nomi commutatori Power Font e lettere maiuscole dopo il 
nome del prodotto

URL http://www.sun.com Blu (risulta in nero nella stampa)
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Documentazione attinente

Pubblicazioni sul sistema modulare SL3000 N. di parte

System Assurance Guide 3161941xx

SNMP Guide for SL3000 Libraries 3161945xx

Documentazione sulle unità nastro N. di parte

Hewlett Packard Ultrium Tape Drive Manual CD incluso con l’unità 

IBM Ultrium Tape Drive Manual CD incluso con l’unità

T10000 Tape Drive Installation Manual 96173

T10000 Tape Drive Service Manual 96175

T10000 Virtual Operator’s Panel User’s Guide (for Service Representatives) 96180

T9840 Tape Drive User’s Reference Manual 95739

T9x40 Tape Drive Installation Manual 95879

T9x40 Tape Drive Service Reference Manual 95740

Pubblicazioni sui software di gestione dei nastri N. di parte

Automated Cartridge System Library Software (ACSLS) 

ACSLS System Administrator’s Guide 3134648xx

ACSLS Messages 3134649xx

ACSLS Quick Reference 3134650xx

Pubblicazioni su Host Software Component (HSC) MVS 

HSC Operator’s Guide 3125311xx

HSC Messages and Codes Guide 3125313xx

Collegamenti pubblicazioni

SunSolve o docs.sun.com
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Ulteriori informazioni
Sun Microsystems, Inc. (Sun) offre diversi metodi per ottenere informazioni aggiuntive. 

Sito Web esterno Sun 
Il sito Web esterno Sun fornisce informazioni sul marketing, i prodotti, gli eventi, 
l’azienda e i servizi. Il sito Web è accessibile da qualsiasi browser Web e connessione a 
Internet.

L’URL è: http://www.sun.com 

L’URL per le informazioni specifiche su Sun StorageTek è: 

http://www.sun.com/storagetek 

SunSolve e collegamenti utili
SunSolve e gli utili collegamenti Sun riportati qui sotto sono siti Web che consentono ai 
membri di cercare documentazione tecnica, download, patch, funzionalità, articoli e 
Sun Systems Handbook.

■ Firmware della libreria e download del codice della SL Console:

http://www.sun.com/download/index.jsp 

■ Driver: http://www.sun.com/download/index.jsp 

■ Documentazione (cliente): http://docs.sun.com/app/docs 

■ Informazioni generali sul prodotto:

http://www.sun.com/storagetek/products.jsp 

■ Sito esterno SunSolve: http://sunsolve.sun.com 

■ Sun System Handbook (cliente):

http://sunsolve.sun.com/handbook_pub/validateUser.do?target=
index 

■ Sun Learning Services — Formazione: http://www.sun.com/training 

Siti dei partner
TheSun StorageTek Questi siti sono destinati ai partner in possesso di un accordo per 
partner StorageTek. Questo sito fornisce informazioni sui prodotto, servizi, supporto ai 
clienti, eventi, programmi di training e strumenti di vendita per supportare i partner 
StorageTek. L’accesso a questo sito è limitato. Nella pagine di login dei Partner, i 
dipendenti e i partner Sun che hanno accesso possono richiedere un ID e una password, 
e gli aspiranti partner possono fare domanda per diventare rivenditori StorageTek. 

http://www.sun.com/partners 

                    



xxxii Manuale dell’utente di SL3000 • Aprile 2008 Revisione: A • 418605201



418605201 • Revisione: A 1

CAPITOLO 1

Introduzione alla libreria SL3000 

La libreria SL3000 è la nuova arrivata nella famiglia di librerie modulari Sun 
StorageTek, di cui fanno parte i sistemi SL500 e SL8500. 

FIGURA 1-1 SL3000 Modular Library System

Questo capitolo contiene una panoramica sulla libreria SL3000, i suoi componenti e le 
configurazioni e tratta i seguenti argomenti:

■ “Funzionalità della libreria SL3000” a pagina 2

■ “Design modulare” a pagina 2

■ “Base Module” a pagina 7

■ “Drive Expansion Module” a pagina 10

■ “Cartridge Expansion Module” a pagina 13

■ “Parking Expansion Module” a pagina 14

■ “Unità nastro” a pagina 16

■ “Porte di accesso alle cartucce” a pagina 17

■ “Unità robotiche” a pagina 18

■ “Opzioni di alimentazione” a pagina 21

■ “Raffreddamento” a pagina 22

■ “Interfacce” a pagina 22

■ “Software di gestione della libreria” a pagina 27

■ “Modalità operative” a pagina 28
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Funzionalità della libreria SL3000 
La libreria SL3000 offre i seguenti vantaggi: 

■ Scalabilità della capacità di storage da 200 a 5821 celle di storage 

■ Utilizzo da 1 a 56 unità nastro 

■ Supporto di un’ampia gamma di unità nastro

■ Utilizzo di diversi tipi di supporto grazie alla tecnologia Any cartridge, Any slot™ 

■ Allegati eterogenei che utilizzano interfacce standard 

■ Programmi e opzioni del software di gestione di varie librerie 

La libreria SL3000 è stata progettata per: 

■ Rivolgersi ai sistemi aperti di medie e grandi dimensioni e ai mercati mainframe 
entry-level. 

■ Occupare un livello di ingombro standard per un data center, con misure di circa: 

■ Altezza: 198 cm (78 in.) 

■ Spessore: 124 cm (48,8 in.) 

■ Lunghezza: varia tra i 91,5 cm (36 in.), con un modulo, a 478 cm (188 in.), con sei 
moduli 

Design modulare 
La libreria SL3000 presenta un design modulare, che consente agli utenti di soddisfare 
le esigenze di un ambiente in rapida crescita e costante trasformazione. 

Moduli 
La libreria SL3000 prevede quattro tipi di moduli. Il Base Module è l’unico necessario. 

■ Base Module: uno solo 

■ Drive Expansion Module (DEM): uno solo, posto sul lato sinistro del Base Module 

■ Cartridge Expansion Module (CEM): fino a un massimo di otto, quattro sul lato 
sinistro del Base Module (e del DEM opzionale) e quattro sul destro

■ Parking Expansion Module (PEM): installati sempre in coppia, uno su ciascuna 
estremità della libreria 

I moduli sono composti da pareti, colonne e righe che ospitano celle di storage per le 
cartucce, unità nastro, porte di accesso alle cartucce (CAP) e unità robotiche (TallBot). 
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Tecnologia CenterLine
Il design modulare di SL3000 utilizza la tecnologia CenterLine per favorire il 
bilanciamento del workload e migliorare le prestazioni della libreria. Il lato sinistro del 
Base Module funge da asse (CenterLine). È possibile aggiungere altri moduli sul lato 
destro o sinistro del Base Module. Le colonne a destra della CenterLine hanno 
numerazione positiva (+), mentre quelle a sinistra negativa (–). 

La FIGURA 1-2 a pagina 4 mostra la CenterLine della libreria e alcune possibili 
configurazioni di moduli, tra cui: 
■ Solo Base Module 

■ Base Module e DEM 

■ Aggiunta di CEM e PEM 
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FIGURA 1-2 Configurazioni della libreria attorno alla CenterLine 

Configurazioni Base Module Configurazioni Base Module e DEM
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Tecnologia Any cartridge, Any slot™
Per alloggiare le cartucce vengono utilizzate celle di storage che consentono l’utilizzo di 
diversisupporti. Ciò permette alla libreria SL3000 di supportare la tecnologia Any 
cartridge, Any slot Sun StorageTek e di accettare diversi tipi di supporti senza essere 
riconfigurata. 

Le cartucce sono posizionate orizzontalmente all’interno delle celle di storage con l’hub 
verso il basso e parallele al pavimento. Per evitare che si sfilino, vengono bloccate da 
ganci interni. 

Capacità fisiche 
La libreria modulare SL3000 è scalabile, con una capacità di storage fisica che va da 200 
a 5821 celle di storage. Inoltre, la funzionalità di capacità su richiesta consente di 
acquistare solo la capacità effettivamente utilizzata e di espanderla con un impatto 
minimo sull’operatività della libreria. 

Per informazioni su come installare e gestire la capacità di storage della libreria, 
consultare il Capitolo 5, “Capacity on Demand” a pagina 135. 

Per informazioni sulle capacità fisiche di ciascun tipo di modulo, consultare la 
TABELLA 1-1 a pagina 6. Per calcolare il numero totale di celle di storage fisiche 
accessibili in una configurazione, bisogna partire dal numero di celle della 
configurazione standard, evidenziato con un contorno più spesso, e modificarlo in base 
alle opzioni e al posizionamento. Di seguito sono riportati alcuni esempi:

■ Base Module con pannello operatore, un modulo installato a destra e tre array 
dell’unità in totale: 

320 + 0 + 13 – 55 – 60 = 218 

■ DEM, un modulo installato a sinistra, array della finestra, una CAP, e quattro array 
dell’unità: 

410 + 88 + 23 – 77 – 66 – 72 – 78 = 228

■ CEM installato a sinistra della CenterLine, un modulo installato a sinistra, e una 
CAP:

516 + 104 – 78 = 542

■ PEM (sempre installati a coppie), uno con una CAP, l’altro senza:

308 + 312 – 78 = 542 

Rilevazione fuoco/fumo opzionale
Le porte di accesso sulla parte superiore dei moduli presentano dispositivi per 
l’estinzione del fuoco o per il rilevamento del fumo opzionali. L’installazione e la 
manutenzione di questi dispositivi deve essere gestita dal cliente.
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TABELLA 1-1 Numero di celle fisiche accessibili per ognimodulo

Standalone o 
indipendente 

dalla 
posizione

Modulo adiacente
Installato a:

Opzioni modulo Destra Sinistra
Numero 
totale

Base Module

Standard (con finestra di 
visualizzazione), standalone

320

+13 +88

Con pannello operatore +0

Con array di storage delle finestre +23

Con un secondo array dell’unità -55 -66

Con un terzo array dell’unità -60 -72

Drive Expansion Module (DEM)

Standard (con finestra di 
visualizzazione e nessuna CAP)

— 410 +88

Con array di storage delle finestre — +23

Con una CAP — -77

Con un secondo array dell’unità — -55 -66

Con un terzo array dell’unità — -60 -72

Con un quarto array dell’unità — -65 -78

Cartridge Expansion Module (CEM)

Standard (nessuna CAP), a sinistra 
della CenterLine 

516 +0 +104

Standard (nessuna CAP), a destra 
della CenterLine 

620 +0 +0

Con una CAP -78

Parking Expansion Module (PEM)

Standard (nessuna CAP), a sinistra 
della CenterLine

— 308

Standard (nessuna CAP), a destra 
della CenterLine

— 312

Con una CAP — -78

Numero totale di celle di storage accessibili 
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Base Module 
Il Base Module fornisce spazio di storage per le cartucce e un minimo di otto unità 
nastro. Questo modulo include le configurazioni di alimentatori, elementi robotizzati, 
moduli elettronici, porte di accesso alle cartucce, celle di storage per cartucce, unità 
nastro e controlli operatore. Centralizza inoltre l’infrastruttura di tutti gli altri moduli 
della libreria. 

Per ciascuna libreria è necessario un solo Base Module.

FIGURA 1-3 Base Module: vista frontale

Configurazioni Capacità 

8 unità 
16 unità 
24 unità 

8 unità, CAP 
16 unità, CAP 
24 unità, CAP 

Consultare la 
TABELLA 1-1 

a pagina 6 

8 unità, CAP e pannello operatore/finestra 
16 unità, CAP e pannello operatore/finestra 
24 unità, CAP e pannello operatore/finestra 

Dimensioni Misure 

Altezza da 197 cm (77,625 in.) 
200 cm (78,63 in.) nella configurazione 
finale 

Larghezza 76,76 cm (30,22 in.) senza coperture1

91,5 cm (36 in.) con le coperture 

Spessore 121,9 cm (48 in.) senza maniglie
124 cm (49 in.) con le maniglie 

Peso 265 kg (584 lb) solo la struttura 

Area di servizio 

Con entrambe le 
porte aperte 

Anteriore: 46 cm (18 in.) 
Posteriore: 81 cm (32 in.) 
262 cm (103 in.) 

Area laterale2 Raffreddamento: 5 cm (2 in.) 
Installazione: 91 cm (36 in.) 

Note: 
1. Quando sono installati moduli aggiuntivi, le coperture 

vengono rimosse dal Base Module e posizionate alle estremità 
dell’ultimo modulo della configurazione. 

2. Necessario per installare o rimuovere le coperture laterali, che 
si sfilano dalle staffe di fissaggio. 
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La parte anteriore del Base Module include i seguenti componenti: 

■ Una porta di accesso alle cartucce (CAP) con doppio caricatore per 26 cartucce 

■ Porta di servizio per accedere alla libreria 

■ Pannello frontale con tre LED: libreria attiva, richiesta servizio e attesa. 

■ Finestra di visualizzazione standard, che può essere sostituita da una delle seguenti 
opzioni:

■ Pannello operatore touch-screen 

■ Celle di storage delle cartucce

Il Base Module può contenere fino a 24 unità nastro in qualsiasi combinazione 
supportata dalla libreria; per un elenco e la descrizione consultare la sezione “Unità 
nastro” a pagina 16. La configurazione minima include un alloggiamento in grado di 
contenere da una a otto unità. È possibile aggiungere due alloggiamenti per contenere 
altre 8 o 16 unità, fino a un massimo di 24 unità. 

Nota – Per aggiungere un nuovo alloggiamento è necessario spostare da 55 a 72 celle di 
storage, a seconda della configurazione della libreria. Per il numero esatto consultare la 
TABELLA 1-1 a pagina 6. 

Per la vista posteriore di un Base Module, andare alla FIGURA 1-4 a pagina 9. La porta 
posteriore consente di accedere a:

■ Il modulo Electronics Control Module (ECM) 

■ Le unità di distribuzione dell’alimentazione (PDU, Power Distribution Unit) 

■ Gli alimentatori CC 

■ Le unità nastro 

■ Due spazi rack da un’unità (1 unità = 44,5 mm [1,75 in.]) per il montaggio in 
verticale di dispositivi supplementari, come switch Ethernet. 

Nota – Il Base Module non contiene spazi rack da 19” generici. 

Per uno schema dettagliato della configurazione a parete vedere la FIGURA B-1, “Pareti 
del Base Module” a pagina 350. 
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FIGURA 1-4 Base Module: vista posteriore 

Descrizione 

Alimentatori CC robotizzati 
■ DCPS 1 e 2 o 3 

Primo alloggiamento dell’unità  
(in alto)
Il primo alloggiamento dell’unità è 
standard.
Gli alloggiamenti dell’unità vengono 
aggiunti partendo dall’alto.  
 
 

Secondo alloggiamento dell’unità 
(centro) 

 
 
 

Terzo alloggiamento dell’unità (in 
basso) 

Electronics Control Module 

Schede HBC e HBT 
Scheda Fibre Channel MPU2 (non 
mostrata)
Due alimentatori cPCI 
Due ventole di raffreddamento 
Due commutatori di alimentazione 
(N+1 e 2N)

Unità di distribuzione 
dell’alimentazione CA (fino a due)

■ PDU 1 e PDU 2 

Alimentatori CC dell’unità (fino a 
otto) 

■ DCPS da 4 a 11 
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Drive Expansion Module 
Il Drive Expansion Module (DEM) opzionale fornisce alla libreria unità nastro e 
capacità di storage per le cartucce aggiuntive. È possibile includere un DEM per 
ciascuna libreria, sempre a sinistra del Base Module. 

FIGURA 1-5 Drive Expansion Module: vista frontale

Configurazioni Capacità 

8 unità 
16 unità 
24 unità 
32 unità 

8 unità, CAP 
16 unità, CAP 
24 unità, CAP 
32 unità, CAP 

Consultare la 
TABELLA 1-1 

a pagina 6 

8 unità, CAP e pannello operatore/finestra 
16 unità, CAP e pannello operatore/finestra 
24 unità, CAP e pannello operatore/finestra 
32 unità, CAP e pannello operatore/finestra 

Dimensioni1 Misure 

Altezza da 197 cm (77,625 in.) a 
200 cm (78,63 in.)

Larghezza 
Solo DEM
Base e DEM 

 
76,76 cm (30,22 in.) 
168,2 cm (66,22 in.) con le coperture2

Spessore 121,9 cm (48 in.) senza maniglie
124 cm (49 in.) con le maniglie 

Peso 265 kg (584 lb) solo la struttura 

Area di servizio 

Con entrambe le 
porte aperte 

Anteriore: 46 cm (18 in.) 
Posteriore: 81 cm (32 in.) 
262 cm (103 in.) 

Area laterale3 Raffreddamento: 5 cm (2 in.) 
Installazione: 91 cm (36 in.) 

Note: 
1. Le dimensioni del DEM sono le stesse del Base Module. 
2. Quando sono installati moduli aggiuntivi, le coperture 

vengono rimosse dal Base Module e posizionate alle estremità 
dell’ultimo modulo della configurazione. 

3. Necessario per installare o rimuovere le coperture laterali, che 
si sfilano dalle staffe di fissaggio. 
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La parte frontale del DEM offre spazio per i seguenti componenti: 

■ Porta di servizio per accesso alla libreria (standard) 

■ Pannello frontale con tre LED: libreria attiva, richiesta servizio e attesa. 

■ Porta di accesso alle cartucce (CAP) opzionale con doppio caricatore per 26 cartucce 

■ Finestra di visualizzazione standard, che può essere sostituita da una delle seguenti 
opzioni:

■ Pannello operatore touch-screen, se non è già presente nel Base Module 

■ Celle di storage delle cartucce

Il DEM viene fornito con slot per supportare fino a otto unità nastro. È possibile 
aumentare il numero di slot dei DEM, a multipli di otto, fino a un massimo di 32. 

Nota – Per aggiungere un nuovo alloggiamento è necessario spostare da 55 a 78 celle di 
storage, a seconda della configurazione della libreria. Per il numero esatto consultare la 
TABELLA 1-1 a pagina 6. 

Il modulo DEM integra un sistema di alimentazione aggiuntivo per supportare le unità 
nastro in più. 

Per la vista posteriore di un DEM andare alla FIGURA 1-6 a pagina 12. La porta 
posteriore consente di accedere a:

■ Le unità nastro 

■ Gli alimentatori CC dell’unità

■ L’unità di distribuzione dell’alimentazione CA (PDU)

Per uno schema dettagliato della configurazione a paretevedere la FIGURA B-2, “Pareti 
del Drive Expansion Module” a pagina 351. 
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FIGURA 1-6 Drive Expansion Module: vista posteriore del modulo 

Descrizione 

 
 
Primo alloggiamento dell’unità 
(in alto) 
Il primo alloggiamento dell’unità 
è standard. 

Gli alloggiamenti dell’unità 
vengono aggiunti partendo 
dall’alto. 

Secondo alloggiamento dell’unità 
 
 
 
 
 

Terzo alloggiamento dell’unità 
 
 
 

Quarto alloggiamento dell’unità 
 
 
 

Unità di distribuzione 
dell’alimentazione CA (fino a 
due) 

■ PDU 3 e PDU 4 

Alimentatori CC dell’unità (fino a 
otto) 

■ DCPS da 15 a 22 
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Cartridge Expansion Module 
Il modulo opzionale Cartridge Expansion Module (CEM) offre capacità di storage e di 
espansione aggiuntive. In questo modulo non sono presenti unità nastro. In una singola 
libreria sono supportati un massimo di otto CEM.

Le seguenti indicazioni aiuteranno a ottimizzare l’efficienza della libreria:

■ Per un risultato ottimale, si consiglia di alternare i moduli CEM su entrambi i 
lati del Base Module e del modulo DEM opzionale, installando il primo CEM 
direttamente a destra del Base Module. In questo modo si riduce il numero di 
spostamenti da parte dei componenti robotici e si ottimizza l’utilizzo delle celle 
di storage delle cartucce. 

■ Se sono installate TallBot ridondanti, i due CEM esterni vengono convertiti in moduli 
PEM. In questo modo si creano delle aree in cui le TallBot possono operare senza 
intralciarsi. 

Ogni CEM consente di aggiungere fino a 620 celle di storage fisiche per cartucce 
dati. La capacità varia a seconda della direzione di espansione (sinistra o destra) e 
della presenza di una CAP. 
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Per un diagramma dettagliato della configurazione a parete vedere la FIGURA B-3, 
“Pareti del Cartridge Expansion Module” a pagina 352. 

Parking Expansion Module 
I moduli opzionali PEM forniscono capacità di storage e di espansione aggiuntive, 
nonché spazio per “parcheggiare” le TallBot difettose da riparare. Lo spazio di 
parcheggio rende inaccessibili le tre colonne di celle di storage più esterne sulla parete 
frontale e su quelle lateriali. Le celle inaccessibili possono essere lasciate fuori dal 
modulo o installate per consentire la successiva conversione del PEM in CEM. I PEM 
non includono unità nastro. 

I PEM vengono utilizzati solo con TallBot ridondanti e sono sempre installati in coppia. 
Devono essere gli ultimi moduli sui lati destro e sinistro della configurazione della 
libreria. 

FIGURA 1-7 Cartridge Expansion Module con Base Module 

         Base Module     |               CEM

Configurazione  
(accanto al Base Module con 24 
unità) Capacità 

CEM (espansione a sinistra) 
CEM con CAP opzionale (sinistra) Consultare la 

TABELLA 1-1 a 
pagina 6 CEM (espansione a destra) 

CEM con CAP opzionale (destra) 

Dimensioni Misure

Altezza da 197 cm (77,625 in.) a 
200 cm (78,63 in.) nella 
configurazione finale 

Larghezza 76,75 cm (30.22 in.) senza 
coperture1

Copertura: 7,62 cm (3 in.) 

Spessore 80 cm (31,5 in.) 

Peso 175 kg (385 lb) solo la struttura

Area laterale2 Raffreddamento: 5 cm (2 in.) 
Installazione: 91 cm (36 in.) 

Area di servizio, 
anteriore e 
posteriore 

Non necessaria 

Note: 
1. Quando sono installati moduli aggiuntivi, le 

coperture vengono rimosse dal Base Module e 
posizionate alle estremità dell’ultimo modulo della 
configurazione. 

2. Necessario per installare o rimuovere le coperture 
laterali, che si sfilano dalle staffe di fissaggio. 
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Per un diagramma dettagliato della configurazione a parete vedere la FIGURA B-4, 
“Pareti del Parking Expansion Module” a pagina 353. 

FIGURA 1-8 Parking Expansion Module 

Configurazione Capacità 

PEM (espansione a sinistra) con 308 celle
PEM (espansione a destra) con 312 celle 
CAP – 78 celle
Sempre installato in coppia per la funzionalità 
di TallBot ridondante. 

620 

Consultare la 
TABELLA 1-1 a 

pagina 6 

Dimensioni 1 Misure

Altezza: da 197 cm (77,625 in.) a 
200 cm (78,63 in.) nella configurazione 
finale 

Larghezza: 76,75 cm (30,22 in.) con le coperture
77,5 cm (30,5 in.) con le coperture

Spessore: 80 cm (31,5 in.) 

Peso: 103,4 kg (277 lb) solo la struttura

Copertura laterale2 
Area laterale3 

Raffreddamento: 5 cm (2 in.) 
Installazione: 91 cm (36 in.) 

Area di servizio, 
anteriore e posteriore 

Non necessaria

Note: 
1. Le dimensioni del PEM sono le stesse del CEM. 
2. Quando sono installati moduli aggiuntivi, le coperture 

vengono rimosse dal Base Module e posizionate alle estremità 
dell’ultimo modulo della configurazione. 

3. Necessario per installare o rimuovere le coperture laterali, che 
si sfilano dalle staffe di fissaggio. 
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Unità nastro 
Per uno schema delle unità nastro, delle interfacce e del tipo di supporti utilizzati 
dalla libreria SL3000 vedere la TABELLA 1-2. 

All’interno di una libreria è possibile installare fino a 56 unità, come segue:

■ Fino a 24 nel Base Module

■ Fino a 32 in un DEM 

Il numero effettivo di unità varia a seconda delle opzioni di alimentazione e del 
tipo di supporto. Per informazioni, consultare la sezione TABELLA 1-3. 

TABELLA 1-2 Unità nastro supportate 

Produttore Tipo di unità Tipo di interfaccia Supporti

Sun 
StorageTek1

T9840C 
T9840D (supporto per 
cifratura) 

Fibre Channel
FICON
ESCON

9840 
Supporto per VolSafe

Sun StorageTek T10000A (supporto per 
cifratura) 

2 GB/4 GB  
Fibre Channel 
FICON

T0000 Standard, Sport e 
VolSafe 

HP LTO 3 
LTO 4 (supporto per 
cifratura) 

Fibre Channel LTO 3
LTO 4 
WORM (LT) 
LTO 2 (sola lettura)4

IBM LTO 3 
LTO 4 

Fibre Channel LTO 3 
LTO 4 
WORM (LT) 
LTO 2 (sola lettura)2

Note:
1. Sun StorageTek Le unità T9840, modelli A e B, e le unità T9940, modelli A e B, non sono 

supportate.
2. I supporti LTO 2 sono utilizzati per assicurare compatibilità con le versioni precedenti dei 

prodotti LTO (migrazione di dati).

TABELLA 1-3 Opzioni di alimentazione e numero di unità

110-127 PDU 220-240 PDU

Base Module DEM Base Module DEM

T9840 12 14 24 32

T10000 13 16 24 32

LTO 3, 4 24 32 24 32

Supporti diversi varia qualsiasi combinazione
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Vassoi dell’unità 
Nella libreria SL3000 un vassoio universale dell’unità colloca tutti i tipi di unità nastro 
e di interfacce. I vassoi dell’unità della libreria SL3000 hanno due livelli, come segue: 

■ L’alimentazione e i collegamenti si trovano in alto. 

■ L’unità nastro è posta sotto l’alimentazione. 

Ogni vassoio dell’unità scorre all’interno di un alloggiamento per otto unità. 

I cavi e le schede di alimentazione interni sono unici e dipendono dal tipo di unità e 
interfaccia all’interno del vassoio dell’unità. I cavi che collegano l’unità escono dal retro 
del vassoio dell’unità e della libreria, passano attreverso il sistema fermacavo. Il cavi 
possono passare sia dal pavimento che dal soffitto. 

Porte di accesso alle cartucce 
La porta di accesso alle cartucce (CAP) è un cilindro rotante montato in posizione 
verticale e dotato di due caricatori removibili da 13 slot (26 celle in totale). Le CAP 
vengono usate per inserire o espellere le cartucce dalla libreria. 

Il Base Module presenta una CAP come standard. È eventualmente possibile installare 
una CAP in ciascun modulo di espansione, fino a un massimo di dieci CAP per l’intera 
libreria. 

Ciascuna CAP presenta un set di controlli, che consistono in un piccolo tastierino e in 
una serie di indicatori. La CAP e i suoi caricatori ruotano come un’unica unità. 

Per informazioni su come utilizzare le CAP, consultare la sezione “Operazioni della 
CAP” a pagina 62. 

FIGURA 1-9 Vassoio dell’unità 

Misure 

Altezza: 16,5 cm (6,5 in.)

Larghezza: 16,5 cm (6,5 in.)

Spessore: 45 cm (18,5 in.)
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Unità robotiche 
L’unità robotica della libreria SL3000 viene chiamata TallBot. Ogni libreria può avere 
una TallBot (standard) o due TallBot (ridondanti). 

FIGURA 1-10 Porta di accesso alle cartucce

1. Porte di accesso alle cartucce 
2. Coperture 

Quando non è installata una CAP, al suo posto viene posizionata una copertura, che può essere modificata in 
futuro per includere una CAP. 

3. Tastierino e interfaccia utente dell’indicatore. 

1 2 1 2

3
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Le TallBot sono responsabili del movimento e della catalogazione, o controllo, delle 
cartucce all’interno della libreria. 

Le misure della TallBot sono:

■ Larghezza: 30 cm (11,84 in.)

■ Spessore: 39 cm (15,36 in.)

■ Peso: 8,6 kg (19 lb)

Le TallBot scorrono lungo due binari nella parete posteriore della libreria: un binario si 
trova in alto, l’altro è fissato al pavimento della libreria. 

All’interno del binario superiore sono inserite due strisce di rame che portano 
l’alimentazione e forniscono i percorsi segnaletici per la TallBot. 

FIGURA 1-11 TallBot 
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■ L’alimentazione viene fornita da alimentatori da 48 VDC, a 1200 Watt, che si 
spartiscono il carico di lavoro. 

■ I segnali vengono ricevuti e trasmessi tra le TallBots e il controller della libreria. 

■ Come circuito di sicurezza per l’alimentazione dei binari è installato un modulo Rail 
Power Enable.

La gestione delle cartucce da parte delle TallBot include: 

■ Il recupero delle cartucce da una CAP

■ L’inserimento delle cartucce in una CAP

■ L’inserimento delle cartucce all’interno delle celle di storage e il loro recupero 

■ L’installazione delle cartucce nelle unità nastro e la disinstallazione 

Le TallBot contengono un lettore di codice a barre laser che: 

■ Legge i blocchi di configurazione in ogni modulo durante l’inizializzazione della 
libreria. Vedere la FIGURA B-5, “Blocco di configurazione” a pagina 354 come 
esempio. 

■ Identifica le celle di storage delle cartucce/le celle della CAP e le unità nastro. Le 
destinazioni hanno una forma simile a una “N”: 

|\|

■ Identifica gli ID del volume (VOLID) delle cartucce durante: 

■ L’inserimento tramite le CAP

■ I controlli

La TallBot legge i VOLID delle cartucce durante i controlli e l’immissione delle 
cartucce nelle CAP. Tutte le posizioni assegnate alle cartucce vengono archiviate nel 
database del controller della libreria, e la TallBot si serve di questa indicazione per 
recuperare le cartucce. 

TallBot ridondanti (doppie) 
Le TallBot ridondanti sono offerte come opzione ad alta disponibilità. Consentono:

■ Un aumento della velocità delle operazioni eseguite dalla libreria

■ Di contare su una TallBot di backup in caso l’altra non funzioni

Questa opzione richiede dei moduli PEM a ciascuna estremità della libreria. Quando 
una TallBot è difettosa entra automaticamente in modalità offline e si sposta, o viene 
inviata, in uno dei moduli PEM, consentendo alla libreria di continuare la propria 
attività con una sola TallBot fino a che non viene programmata la sostituzione della 
TallBot guasta. 

I requisiti per poter installare una TallBot ridondante sono:

■ Configurazione dell’alimentazione: 240 VAC, 2N

■ Moduli PEM su ciascuna estremità della libreria 

■ Licenza per doppia TallBot 
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Opzioni di alimentazione 

Configurazione alimentazione CA 
Sono disponibili le seguenti opzioni di alimentazione CA:

■ Funzionalità limitate: 110 VAC, 50/60 Hz, a 20 Amp (intervallo: 100–127 VAC,  
50–60 Hz, 16 Amp) 

■ Funzionalità complete: 220 VAC, 50/60 Hz, a 30 Amp (intervallo: 200-240 VAC,  
50–60 Hz, 24 Amp) 

Le unità di distribuzione dell’alimentazione (PDU) sono situate sul retro del Base 
Module e del modulo opzionale DEM. 

Ridondanza dell’alimentazione
La libreria SL3000 fornisce una totale ridondanza delle unità nastro, robotiche ed 
elettroniche. Sono disponibili le seguenti opzioni di ridondanza: 

■ N+1 — Una PDU CA, con un alimentatore CC extra per la ridondanza 
dell’alimentazione CC. Si tratta della configurazione di alimentazione standard per 
SL3000. Questa configurazione richiede almeno un interruttore da 20 Amp sul 
pannello di servizio della centralina cliente. 

■ 2N — Due PDU per la ridondanza CA; ogni PDU ha una gamma di alimentatori CC 
(alimentatori N CC). Questa configurazione richiede una seconda fonte di 
alimentazione cliente separata. 

■ 2N+1 — Due PDU per la ridondanza CA; ogni PDU possiede alimentatori CC 
aggiuntivi per la ridondanza N+1 per ciascuna PDU. La seconda PDU non possiede 
N+1 per la TallBot. 

Alimentazione CC 
Per distribuire +48 VDC alla TallBot e all’unità nastro, sono necessari alimentatori CC 
di distribuzione del carico a 1200 Watt. Il numero di alimentatori CC richiesto dipende 
dalla configurazione dell’alimentazione e dal numero totale di unità presenti nella 
libreria. 

È anche installato un modulo Rail Power Enable come circuito di sicurezza per 
l’alimentazione dei binari. Due alimentatori cPCI (200 Watt ciascuno) alimentano il 
modulo Electronics Control Module. Gli alimentatori sono posizionati sotto la scheda 
HBT: due a sinistra per N+1, o uno su ciascun lato per 2N. 
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Raffreddamento 
Il sistema di raffreddamento all’interno della libreria SL3000 è diviso in tre aree: 

■ Unità elettroniche 

■ Unità nastro 

■ Alimentatori CC 

Unità elettroniche 
A destra del modulo ECM sono posizionate due ventole che raffreddano le unità 
elettroniche nella libreria. L’aria viene presa dal pavimento e dai lati della libreria e 
scorre attraverso le ventole nel retro della libreria. 

■ Il funzionamento delle ventole è monitorato dalla scheda HBC. 

■ Una spia gialla di errore sulla ventola indica che si è verificato un errore. 

Benché vi siano due ventole, una basta a fornire un adeguato raffreddamento delle 
unità elettroniche. Tuttavia, poiché le ventole possono essere sostituite senza interferire 
con il funzionamento della libreria, è consigliabile sostituire una ventola guasta appena 
viene individuata. 

Unità nastro
Ogni vassoio per unità nastro contiene una o due ventole di raffreddamento. 

Le ventole vengono alimentate tramite la scheda di conversione dell’alimentazione. 
L’aria viene presa dalla parte frontale dell’unità e scorre attraverso le ventole sul retro 
dell’unità/libreria. 

Alimentatori CC
Ogni alimentatore CC da 1200 Watt integra una ventola che spinge l’aria dalla parte 
anteriore della libreria, attraverso la parte posteriore dell’alimentatore, fino al retro 
della libreria. 

Interfacce 
La libreria SL3000 supporta i seguenti tipi di interfacce: 
■ Library Control Path — Trasferisce i comandi di gestione della libreria, come 

l’installazione e la disinstallazione delle cartucce, tra l’host e i componenti della 
libreria. Su questa interfaccia non sono presenti dati host. 

■ Data Path — Trasferisce i dati tra l’host e le unità nastro. 
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■ Command Line Interface — Consente a un Sun responsabile dell’assistenza tecnica 
di configurare la libreria ed effettuare una diagnosi.

■ SNMP — Consente agli amministratori di sistema di effettuare ricerche all’interno 
della libreria e di ricevere informazioni su potenziali problemi. 

■ SL Console — Consente agli operatori e agli amministratori della libreria di 
configurare e gestire la libreria da un’interfaccia utente grafica. 

Library Control Path 

Nota – Quando una libreria viene integrata in una rete, è consigliato che 
l’amministratore di sistema/rete lavori a stretto contatto con il rappresentante Sun 
StorageTek per definire la configurazione. 

Il control path trasferisce i comandi di gestione della libreria tra l’host e la libreria. 
La libreria SL3000 supporta i seguenti tipi di connessioni host per il control path: 
■ Interfaccia TCP/IP — Protocollo TCP/IP che utilizza cavi Ethernet 10/100 Base-T e 

CAT-5 

■ Interfaccia FC-SCSI — Protocollo e comandi Small Computer System Interface (SCSI) 
su un’interfaccia Fibre Channel fisica 

Una libreria non partizionata può utilizzare un solo tipo di interfaccia, FC-SCSI o 
TCP/IP. Utilizzando la funzionalità di partizionamento opzionale, la libreria può 
collegarsi a diversi host utilizzando una combinazione dei due tipi di interfacce. Per 
informazioni, consultare il Capitolo 6, “Partizionamento della libraria” a pagina 173. 

L’indirizzamento della libreria dipende dal tipo di connessione host: 
■ Gli host TCP/IP utilizzano uno schema di numerazione pannello, riga, colonna. 
■ Gli host FC-SCSI utilizzano uno schema di numerazione sequenziale, in cui 

ciascun tipo di elemento (celle di storage, unità nastro e CAP) ha un proprio 
intervallo sequenziale. 

Per ulteriori informazioni, consultare l’Appendice A, “Indirizzi delle risorse della 
libreria” a pagina 333. 

Interfaccia TCP/IP
L’interfaccia di tipo TCP/IP utilizza il protocollo TCP/IP tramite un’interfaccia 
fisica Ethernet, (cavo CAT-5, Ethernet, 10/100 BaseT). Questa interfaccia consente a 
una delle seguenti piattaforme host di collegarsi alla libreria e di comunicare: 
■ Piattaforme a sistema aperto con ACSLS (per informazioni, consultare la sezione 

“Automated Cartridge System Library Software (ACSLS)” a pagina 28). 

■ Mainframe di livello enterprise con HSC (per informazioni, consultare la sezione 
“Host Software Component” a pagina 27). 

Il controller della libreria coordina le attività di tutti i componenti all’interno della 
libreria e crea una connessione tra l’interfaccia e l’host. 
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Connessioni

Nella scheda del controller della libreria vi sono due diverse connessioni Ethernet 
per le comunicazioni dall’host alla libreria. 
■ La porta 2A fornisce la doppia connessione TCP/IP: si tratta di una funzionalità 

opzionale concessa in licenza in grado di fornire ridondanza integrata. 
■ La porta 2B fornisce la connessione host primaria: è la connessione standard per 

le librerie SL3000.

Entrambe le porte sono conformi allo standard IEEE 802.3 per le reti Ethernet 
dell’Institute of Electrical and Electronics Engineers. Entrambe le porte effettuano 
la negoziazione automatica delle seguenti funzioni: 
■ Metodo di trasmissione 

■ Half-duplex: trasmette i dati in una sola direzione per volta 

■ Full-duplex: trasmette i dati in due direzioni contemporaneamente 

■ Velocità di trasmissione 

■ 10Base-T: 10 megabit al secondo (Mbps)

■ 100Base-T: 100 megabit al secondo (Mbps) 

Rete

Poiché la libreria SL3000 è installata in una rete, è preferibile separare le attività della 
libreria dal normale traffico di rete. A tale scopo, sono presenti le seguenti reti distinte: 

■ Rete pubblica — gestisce tutte le operazioni di rete relative al cliente per le porte del 
controller del sistema pubblico, come:

■ Accesso a Internet 

■ Comandi dalla libreria all’host 

■ Rete Privata — gestisce tutte le operazioni di rete relative alla libreria interna per le 
porte del controller del sistema privato, come:

■ CAP

■ Percorso del controllo dell’unità 

■ Pannello operatore locale 

Nota – Per massimizzare il throughput e ridurre al minimo il conflitto di risorse, si 
consiglia di impiegare una connessione di rete privata tra la libreria e il software di 
gestione dell’host, che utilizza un hub o uno switch Ethernet. 

Qualora fosse richiesta una rete condivisa, le seguenti azioni possono favorire la 
comunicazione tra l’host e la libreria: 

■ Collegare direttamente la libreria a uno switch. 

■ Posizionare la libreria nella sua sottorete. 

■ Utilizzare uno switch gestito:

■ Assegnare le priorità alle porte per dare all’host e alla libreria il livello di priorità 
maggiore.

■ Fornire l’ampiezza di banda tra l’host e la libreria.

■ Creare una VLAN tra l’host e la libreria. 
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■ Utilizzare una rete privata virtuale (VPN, Virtual Private Network ) per isolare il 
traffico dall’host alla libreria. 

Sun L’adattatore 9300 Control Path Adapter di StorageTek fornisce la connessione 
hardware degli host mainframe. Questo adattatore di interfaccia è installato sul 
mainframe e converte i dati nella rete Ethernet in comandi compatibili con la Host 
Library Interface (HLI). 

Interfaccia FC-SCSI
L’interfaccia di tipo FC-SCSI utilizza i comandi SCSI attraverso una connessione 
Fibre Channel fisica. L’implementazione effettuata dalla libreria Sun StorageTek 
della connessione Fibre Channel è conforme ai seguenti standard: 
■ American National Standards Institute (ANSI) 

■ National Committee for Information Technology Standards (NCITS) 

Per gli host FC-SCSI sono necessarie applicazioni che supportano il protocollo SCSI-3. 

La topologia Fibre Channel consigliata per la libreria SL3000 è un’infrastruttura 
commutata. Un’infrastruttura commutata fornisce interconnessioni dinamiche tra i nodi 
e connessioni Fibre Channel multiple e simultanee alla rete.

Se la libreria SL3000 è connessa a uno switch Fibre Channel o a un host fabric-capable, 
si configura automaticamente come topologia switched e può supportare fino a 16 
milioni di porte all’interno dell’infrastruttura. 

Per ulteriori informazioni, consultare il manuale SL3000 Interface Reference Manual 
(PN 3161952xx). Questo manuale contiene informazioni sui comandi SCSI e sulle 
operazioni Fibre Channel, le implementazioni dei comandi, le topologie, i cavi e le 
connessioni. 

Nota – La libreria SL3000 supporta la topologia Arbitrated Loop, ma si sconsiglia di 
utilizzarla.

Nota – La libreria SL3000 non supporta la forzatura della connessione Arbitrated Loop 
tramite l’impostazione di indirizzi fisici ALPA (Arbitrated Loop Physical Addresses). 

Data Path
Il data path, che è separato e distinto dal control path della libreria, supporta il 
trasferimento di dati tra l’host e l’unità nastro. I percorsi dei dati host verso le unità 
nastro può essere di tipo Fibre Channel, FICON o ESCON, a seconda delle 
caratteristiche operative dell’unità nastro. Per informazioni, consultare la sezione 
“Unità nastro” a pagina 16. 
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Command Line Interface 
Lainterfaccia a riga di comando (CLI) di SL3000 è un’interfaccia della libreria 
accessibile solo a un Sun responsabile dell’assistenza tecnicas qualificato. Questa 
interfaccia consente al responsabile dell’assistenza tecnica di configurare e 
diagnosticare i problemi all’interno della libreria. 

Nota – I clienti non hanno accesso all’interfaccia CLI. 

SNMP
Il protocollo Simple Network Management Protocol (SNMP) consente agli 
amministratori di sistema e ai gestori di rete di monitorare lo stato della libreria e 
ricevere informazioni, tra cui: 

■ Lo stato operativo della libreria (livello di mocrocodice, numero di serie, stato 
online/offline)

■ Lo stato delle CAP (aperto, chiuso, numero di celle)

■ Gli elementi della libreria (numero di TallBot, celle di storage, CAP) 

■ Il numero delle celle di storage e i tipi di supporti presenti nella libreria 

■ Il numero e i tipi di unità nastro installati nella libreria

Nota – Come impostazione predefinita, l’agente SNMP è disattivo e deve essere 
attivato dal Sun responsabile dell’assistenza tecnica tramite la interfaccia a riga di 
comando (CLI). 

La libreria SL3000 supporta le seguenti versioni del protocollo SNMP: 

■ SNMPv2c — Per le richieste dello stato della macchina; le informazioni trasmesse 
non sono sicure.

■ SNMPv3 — Per le informazioni riservate Sun: informazioni a solo uso interno, visto 
che supporta la codifica e un’identificazione “forte” dell’utente. SNMPv3 è quindi il 
protocollo di preferenza per i dati proprietari.

Nota – Per informazioni dettagliate riguardanti il protocollo SNMP e le procedure di 
installazione, consultare la guida SL3000 SNMP Guide (PN 3161945xx).

SL Console
StorageTek Library Console (SL Console) è un’applicazione software basata su Java che 
fornisce un’interfaccia utente grafica (GUI) con cui poter monitorare e gestire la libreria 
StorageTek SL3000. Per ulteriori informazioni, consultare il Capitolo 2, “StorageTek 
Library Console” a pagina 31. 
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Software di gestione della libreria
Il software di gestione della libreria controlla le attività eseguite dalla libreria, come 
l’installazione e la disinstallazione, l’immissione e l’espulsione della cartucce. Gestisce 
anche il database delle cartucce, in cui sono contenute le informazioni sulla posizione e 
le caratteristiche del volume. 

Sun offre diversi componenti software a seconda della piattaforma, del tipo di 
connessione e del sistema operativo. Sono inclusi: 

■ ACSLS

■ HSC (MVS) — solo utilizzando un’interfaccia TCP/IP

■ SCSI direct-attach — solo utilizzando un’interfaccia Fibre Channel

■ ExLM 

■ ExHPDM 

■ ExPR

■ VSM 

■ VTL 

Nota – Per le versioni necessarie per supportare SL3000, consultare la documentazione 
del software di gestione della libreria. 

Nota – SL3000 non supporta LibraryStation. 

Nearline Control Solution
La libreria SL3000 supporta i seguenti prodotti software Sun Nearline Control Solutions 
(NCS).

■ Host Software Component

■ Storage Management Component

■ Sun StorageTek Server HTTP

Host Software Component 
Quando una libreria SL3000 è connessa a un host MVS, è necessario che l’host esegua 
una versione di Sun StorageTek Host Software Component (HSC) insieme a Storage 
Management Component (SMC).

Insieme, Sun StorageTek HSC e SMC eseguono le seguenti funzioni:

■ Influenzano le operazioni di allocazione

■ Intercettano i messaggi di installazione e disinstallazione

■ Ricevono le richieste dell’host e le traducono in comandi di controllo della libreria

HSC si trova all’intero dell’host MVS, ma è invisibile al sistema operativo.
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Storage Management Component
Storage Management Component (SMC) è l’interfaccia tra i sistemi operativi IBM 
OS/390 e z/OS e una libreria Sun StorageTek. SMC si occupa dell’elaborazione 
dell’allocazione, della gestione dei messaggi e dell’elaborazione di SMS per le soluzioni 
NCS. Il componente SMC è posizionato all’interno del sistema host MVS dotato di HSC, 
o di un sistema remoto che utilizza il server HTTP Sun StorageTek per comunicare con il 
software HSC. SMC comunica con HSC per stabilire le logiche, le posizioni del volume e 
la proprietà delle unità.

Nota – SMC è un componente NCS necessario.

Sun StorageTek Server HTTP 
Sun Il server HTTP di StorageTek per i sistemi OS/390 e z/OS funge da intermediario 
per consentire la comunicazione tra SMC (client) e un sottosistema remoto HSC 
(server). Il server HTTP si comporta come un sottosistema separato sull’host MVS in 
cui risiede il sottosistema HSC remoto. 

Automated Cartridge System Library Software 
(ACSLS)
Il software ACSLS gestisce i contenuti della libreria e controlla l’hardware della libreria 
durante le operazioni di installazione e disinstallazione delle cartucce. 

ACSLS fornisce servizi di gestione della libreria, il rilevamento delle cartucce, il pool, i 
report e il controllo della libreria. Gestisce un database che tiene traccia dei nomi dei 
volumi di dati e delle loro posizioni attuali all’interno della libreria. 

Modalità operative
Per la libreria SL3000 sono possibili quattro modalità operative:

■ Modalità automatica 

■ Modalità manuale

■ Modalità di manutenzione

■ Modalità provvisoria

Modalità automatica 
Quando si trova in modalità operativa automatica, la libreria installa e disinstalla 
automaticamente le cartucce senza l’intervento fisico di una persona.
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Le operazioni automatiche includono le seguenti attività:

■ Installazione e disinstallazione delle cartucce
■ Inserimento ed espulsione delle cartucce tramite la CAP
■ Log degli eventi della libreria
■ Pulizia dell’unità 

Per ulteriori informazioni, consultare il Capitolo 3, “Operazioni automatizzate della 
libreria SL3000” a pagina 59. 

Modalità manuale
La modalità operativa manuale viene utilizzata quando la libreria non è accessibile dal 
sistema ed è necessario l’intervento umano. Ciò può avvenire per esempio quando nella 
libreria si verifica un errore irreversibile e l’installazione e la disinstallazione 
automatica risultano quindi impossibili.

Un altro esempio è quando un componente della libreria non è in grado di installare 
una cartuccia in una particolare unità. In questo caso, potrebbe essere necessario che 
una persona entri nella libreria, posizioni la cartuccia e la installi manualmente 
nell’unità richiesta. 

Avvertenza – Rischio di lesioni personali. Chiunque entri nella libreria deve 
essere informato sulle procedure di sicurezza. 

Per ulteriori informazioni, consultare il Capitolo 8, “Operazioni manuali” a pagina 323. 

Modalità di manutenzione
In caso si verifichi un errore in un componente della libreria non ridondante (per 
esempio, una sola TallBot in tutta la libreria), la libreria risulta non disponibile. In 
questo caso, è necessario mettere tutta la libreria offline fino a che non viene riparata.

Dopo che il componente difettoso è stato riparato o sostituito, la libreria può essere 
messa in modalità di manutenzione durante l’esecuzione dei test di verifica. 

Modalità provvisoria
Quando la libreria si trova in modalità provvisoria è sempre operativa e online, ma la 
sua efficienza operativa è ridotta a causa di un guasto di un componente. Esempi di 
modalità provvisoria sono: 

■ In una configurazione con TallBot ridondante, si è verificato un errore in una TallBot; 
l’altra TallBot ha preso in carico tutte le operazioni di installazione e disinstallazione 
della libreria.

■ Si è verificato un errore in una singola unità nastro, che deve essere sostituita.
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CAPITOLO 2

StorageTek Library Console 

Introduzione 
La StorageTek Library Console (SL Console) è un’applicazione software basata su Java 
che fornisce un’interfaccia utente grafica (GUI) con cui poter monitorare e gestire la 
libreria di StorageTek SL3000. 

Di seguito sono elencate alcune delle attività che si possono eseguire con la SL Console:

■ Gestire la capacità di storage della libreria disponibile

■ Gestire e configurare le partizioni della libreria (funzionalità opzionale)

■ Visualizzare e modificare lo stato e le proprietà della libreria e dei dispositivi 
correlati (unità, CAP, robot ed elevatori)

■ Eseguire un controllo su una parte o sull’intera libreria

■ Eseguire un test diagnostico sulla libreria o su un dispositivo correlato

■ Eseguire uno spostamento diagnostico (esercitare un robot)

■ Posizionare una cartuccia

■ Spostare una cartuccia da una posizione a un’altra

■ Visualizzare i log degli eventi della libreria

■ Visualizzare le spiegazioni degli errori 

■ Scaricare un nuovo firmware della libreria mentre la libreria è operativa

■ Visualizzare la guida sensibile al contesto 

Modalità della SL Console 
In base alle necessita, è possibile avviare la SL Consolein una delle seguenti modalità. 
Per informazioni, consultare le seguenti procedure: 

■ “Pannello operatore locale” a pagina 36 

■ “Standalone SL Console” a pagina 38

■ “SL Console via Web” a pagina 44 
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SL Console Sicurezza 
Le funzionalità di sicurezza predefinite per la SL Console controllano l’autenticazione 
dell’utente nonché la sua autorizzazione. Le funzionalità di sicurezza comprendono i 
seguenti elementi:

■ ID utente: gli ID utente controllano l’autenticazione dell’utente. Ogni utente deve 
disporre di un ID e di una password validi e attivi per accedere alla SL Console.

■ Autorizzazioni di accesso: le autorizzazioni di accesso controllano l’autorizzazione 
dell’utente. Ogni ID utente viene assegnato a una serie di autorizzazioni di accesso 
con le quali si determinano i tipi di richiesta che l’utente può inoltrare tramite la 
SL Console. Ad esempio, per modificare le proprietà di sistema di un’unità, un 
utente deve accedere utilizzando un ID utente che abbia le autorizzazioni di accesso 
corrette.

Se si accede alla SL Console con un ID utente, password e nome libreria validi, il 
sistema autentica l’identità, quindi autorizza ad accedere alle varie funzioni della 
SL Console. 

ID utente
Per accedere alla SL Console, è necessario un ID utente attivo e valido. A ogni ID utente 
deve essere assegnata una password.

Esiste una serie fissa di ID utente. Gli ID utente sono admin (responsabile servizio 
clienti), service (Sun Customer Services Engineer) e oem (tecnico assistenza su campo 
di terze parti). Se si accede in modo corretto, la SL Console visualizza l’ID utente nella 
barra di stato della schermata.

Solo un operatore per volta può accedere al pannello operatore locale. Qualsiasi 
numero di utente può invece connettersi alla libreria SL3000 tramite la SL Console 
standalone o la SL Console via Web. 

Password di attivazione 
Prima che un utente del sito possa utilizzare la SL Console per la prima volta, è 
necessario che l’amministratore della libreria SL3000 attivi l’ID utente “admin” 
utilizzando una password di attivazione speciale. Il Sun responsabile dell’assistenza 
tecnica fornisce all’amministratore la password di attivazione, valida soltanto per un 
accesso. 

Dopo aver eseguito il login utilizzando la password di accesso, l’amministratore deve 
modificare la password dell’ID utente admin per garantire la sicurezza del sistema. 

Per informazioni su questa procedura, consultare StorageTek SL3000 Installation Guide. 
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▼ Accedere a SL Console
Le procedure di login variano a seconda della modalità della SL Console utilizzata. 
Per istruzioni dettagliate, consultare i seguenti argomenti:

■ “Accedere al pannello dell’operatore locale” a pagina 37

■ “Accedere alla SL Console standalone” a pagina 43

■ “Accedere alla SL Console via Web tramite browser o riga di comando” a pagina 45

■ “Accedere alla SL Console via Web tramite un’icona” a pagina 51

Nota – La SL Console legge tutti i dati di configurazione della libreria dal controller 
della libreria. Per questo motivo, è necessario fare molta attenzione quando si accede 
alla SL Console prima che l’inizializzazione della libreria sia stata completata. 
Potrebbero essere visualizzati dei messaggi di avvertenza a indicare che i dati di 
configurazione non sono ancora disponibili; in tal caso sarà necessario uscire e accedere 
nuovamente alla console in seguito. Inoltre, se il controllo viene effettuato nel corso del 
processo di inizializzazione, fino a che non è completato, tutti i dati di configurazione 
visualizzati potrebbero non essere del tutto aggiornati o accurati. 

▼ Disconnettersi dalla SL Console

Nota – Prima di disconnettersi, assicurasi che tutte le operazioni della sessione 
corrente della SL Console siano state completate (ad esempio caricamenti di codici, 
controlli e spostamenti diagnostici). 

1. Da una schermata qualsiasi della SL Console, selezionare Tools > Log Off.

2. Nel popup Confirm, scegliere una delle seguenti possibilità:

■ Fare clic su Cancel per rimanere connessi alla SL Console.

■ Fare clic su OK per terminare la sessione corrente della SL Console. 

Si apre la schermata Login. 

3. Fare clic su Exit per chiudere la SL Console.

▼ Modificare una password utente
1. Selezionare Tools > User Mgmt.

2. Nell’albero User, espandere la cartella Permanent. 

3. Selezionare l’account utente che si vuole modificare. 

4. Completare i seguenti campi: Current Password, New Password, e Retype Password. 

5. Fare clic su Modify.
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SL Console Visualizzazione schermata 
La figura e la tabella seguenti spiegano i componenti della schermata della SL Console. 

Nome componente Descrizione 

1 Barra dei menu 
(compresi i menu di Tool 
e Help) 

Il menu Tools fornisce l’accesso a System Detail, Reports, 
Monitors, Utilities, partizionamento, User Management 
nonché alle funzioni di log off. 
Il menu Help fornisce l’accesso all’indice del sistema di guida. 
Identifica inoltre la versione della SL Console in uso.

2 Barra del titolo Visualizza il titolo della schermata corrente. 

3 Schede di funzione Identificano le funzioni disponibili nella schermata. 

4 Barra delle opzioni Qui sono posizionati i pulsanti relativi alla schermata, 
ad esempio Apply, Refresh, Print). Comprende sempre il 
pulsante Help della SL Console (?). Consultare “Sincronizzare 
la visualizzazione con il database del controller” a pagina 35 
per informazioni sull’utilizzo dei pulsanti Apply e Refresh. 

1 2 43

5

78 6

9
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Sincronizzare la visualizzazione con il database del 
controller
Quando si accede a una schermata di SL Console per la prima volta, vengono 
visualizzati gli ultimi dati salvati, letti dal database del controller della libreria. Se si 
utilizza la schermata per modificare il contenuto o la configurazione della libreria, 
il database sarà aggiornato con tali modifiche soltanto dopo averle confermate tramite 
il pulsante Apply. Più utenti possono accedere alla libreria nello stesso momento. 
Utilizzando la SL Console, la interfaccia a riga di comando nonché le varie applicazioni 
host, è possibile apportare le modifiche al contenuto e alla configurazione della libreria. 
Se altri utenti apportano modifiche e le applicano al database del controller, tali 
modifiche non saranno visibili finché non si seleziona Apply o Refresh sulla schermata. 
Pertanto, i dati visualizzati nella SL Console possono non corrispondere alla 
configurazione effettivamente salvata in un determinato momento.

Per questi motivi, se si apportano modifiche consistenti alla configurazione della 
libreria (aggiunta di moduli, definizione di partizioni, ecc.), è importante che si 
coordinino tali modifiche con gli altri utenti della libreria. Diversamente si potrebbe 
assistere a conflitti all’interno del database del controller. 

5 Area di lavoro Posizione dei dati della schermata. 

6 Indicatore di integrità 
della libreria

Identifica la libreria a cui è collegata laSL Console e, sotto 
forma di rappresentazione grafica, visualizza l’integrità della 
libreria. 

7 Indicatore ID utente Visualizza l’ID utente attualmente connesso alla SL Console.

8 Indicatore di integrità di 
comunicazione con 
server

Visualizza un monitoraggio heartbeat grafico a indicare lo 
stato dell’integrità della comunicazione con il server.

9 Albero dispositivi Elenca i dispositivi compresi nella libreria.

Nome componente Descrizione (segue)
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Modificare il layout della schermata 

Nota – Questa funzionalità è disponibile dalla versione FRS_3.30 della SL Console. e 
soltanto nelle schermate selezionate. 

Il layout e la visualizzazione delle schermate selezionate della SL Console possono 
essere modificati. 

Pannello operatore locale 
Il pannello operatore locale è una funzionalità opzionale della SL3000 inclusa nel Base 
Module. Consente di eseguire gran parte dell’applicazione SL Console direttamente 
sulla libreria utilizzando uno schermo piatto con interfaccia touch-screen. 

Il pannello operatore locale offre le seguenti funzionalità:

■ Schermo piatto da 12,1 pollici inserito nel Base Module della libreria

■ Interfaccia touch-screen che consente di inserire dati alfanumerici; penna e stilo 
disponibili 

■ Tastiera e mouse non disponibili

I LED posizionati immediatamente sotto alpannello operatore locale segnalano le 
seguenti informazioni sullo stato:

■ LIB ACTIVE: il processore della libreria è in funzione. 

■ WAIT: caricamento del firmware della libreria in corso. 

■ SVC REQ: reboot della libreria in corso. 

TABELLA 2-1 Modifiche di visualizzazione delle schermate

Opzione visualizzazione Instruzioni

Ordinare la visualizzazione 
per colonna

Fare clic sul titolo della colonna da ordinare. All’inizio, 
le colonne vengono classificate in ordine crescente. Fare 
nuovamente clic sul titolo per passare dall’ordine 
crescente all’ordine decrescente.

Disporre le colonne in un 
ordine qualsiasi

Selezionare e trascinare il titolo della colonna 
orizzontalmente in una posizione qualsiasi della riga 
del titolo. 

Ridimensionare le colonne Fare clic sul bordo del titolo della colonna, trascinarlo 
verso sinistra o destra per modificarne la larghezza. 
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▼ Inserire i dati utilizzando il tastierino 
1. Selezionare l’icona tastiera associata al campo desiderato.

Si apre un popup con la rappresentazione grafica di una tastiera e un’area di 
visualizzazione. 

2. Selezionare i tasti grafici necessari per inserire i dati.

3. Fare clic su Enter per salvare gli inserimenti. 

Il popup si chiude e i dati vengono visualizzati nel campo corrispondente.

▼ Modificare i dati utilizzando il tastierino 
1. Utilizzare i tasti di navigazione per posizionare il cursore a fianco dei caratteri da 

modificare.

Il testo esistente rimane visualizzato sullo schermo ma viene modificato in testo 
normale.

2. Selezionare i tasti di navigazione, di modifica e di testo per apportare le dovute 
modifiche.

3. Fare clic su Enter per salvare le modifiche o su Cancel per ripristinare il testo 
originale nel campo. 

▼ Accedere al pannello dell’operatore locale 

Nota – Solo un utente per volta può accedere al pannello operatore locale. 

Nota – Se sul pannello touch-screen non è visualizzato nulla, toccare un punto 
qualsiasi dello schermo per attivare la schermata Login. 

1. Con il tastierino, inserire le informazioni di login (consultare “Inserire i dati 
utilizzando il tastierino” a pagina 37 per istruzioni dettagliate). 

User ID: SLC_login  
Password: password 

dove:

■ SLC_login è l’SL ConsoleID utente.

■ password è la password assegnata a questo ID utente. 

Nota – L’ID utente che si utilizza determina le schermate alle quali si può accedere. 
Consultare “SL Console Sicurezza” a pagina 32. 

2. Fare clic su Log on. 
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Standalone SL Console 
La SL Console standalone è una funzionalità standard della libreria SL3000. Consente 
di eseguire, in modalità remota, l’applicazione SL Console da un PC o una workstation 
che dispone di una connessione di rete con la libreria SL3000. Con la SL Console 
standalone è possibile connettersi a tutte le librerie SL3000 per le quali si dispone di un 
ID utente valido. 

Considerazioni su sicurezza
L'applicazione SL Console si interfaccia con l’interfaccia della libreria primaria (PLI, 
primary library interface) su un livello software di sicurezza (SSL, security software 
layer). L’SSL offre un percorso di comunicazione sicuro tra la libreria e il pannello 
operatore del cliente. Si evita così che un utente di rete non autorizzato possa 
monitorare l’attività della libreria.

Requisiti di installazione
È possibile installare la SL Console standalone su un computer con i seguenti requisiti:  

Il software della SL Console standalone può essere scaricato dai seguenti siti di Sun 
Microsystems, Inc.:

Nota – È necessario disporre di un ID e una password validi per effettuare il login al 
sito di download che si desidera utilizzare. Per assistenza, contattare il Sun 
responsabile dell’assistenza tecnica. 

Piattaforma Solaris 9—SPARC
Solaris 10—SPARC
Windows 2003 Server—32 bit
Windows XP Client—32 bit
Windows Vista—32 bit

Altro Connessione Ethernet con la libreria SL3000

Utente Nome posizione URL

Clienti Sun Sun Download Center http://www.sun.com/download/
index.jsp

Partner e 
OEM Sun

Sun Partner Exchange https://spe.sun.com/spx/control/
Login 
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Installazione della SL Console standalone

Nota – Il StorageTek CSE potrebbe aver già eseguito le seguenti procedure durante 
l’installazione della libreria.

Per installare la SL Console standalone sul PC o sulla workstation, seguire le seguenti 
procedure:

1. “Scaricare e avviare il programma di installazione della SL Console standalone dal 
sito di download di Sun” a pagina 39. 

2. “Installare standalone SL Console” a pagina 39. 

▼ Scaricare e avviare il programma di installazione della 
SL Console standalone dal sito di download di Sun
Utilizzare questa procedura per scaricare il programma di installazione della 
SL Console standalone e avviarlo sul PC o sulla workstation. 

Nota – È necessario disporre di un ID e una password validi per effettuare il login al 
sito di download che si desidera utilizzare. Per assistenza, contattare il Sun 
responsabile dell’assistenza tecnica. 

1. Avviare un browser sul PC o sulla workstation. 

2. Nella barra degli indirizzi, inserire l’URL del relativo sito di download di Sun. 
Consultare “Requisiti di installazione” a pagina 38 per informazioni. 

3. Accedere al sito di download di Sun utilizzando l’ID e la password di login 
assegnati.

4. Navigare al file del programma di installazione della SL Console standalone. 

5. Selezionare il livello codice della SL Console desiderato.

6. Selezionare il file del programma di installazione richiesto per la propria 
piattaforma:

■ Microsoft Windows: SLConsoleWindowsSTK.exe 

■ Sun Solaris: SLConsoleSolarisSTK.bin 

7. Salvare il file sul PC o sulla workstation. 

8. Per avviare l’installazione, fare doppio clic sull’icona del file del programma di 
installazione della SL Console disponibile sul PC o sulla workstation. 

9. Per completare l’installazione, consultare “Installare standalone SL Console” a 
pagina 39. 

▼ Installare standalone SL Console 
Utilizzare questa procedura per installare la SL Console standalone sul PC o sulla 
workstation. 
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1. Avviare il programma di installazione come descritto in “Scaricare e avviare il 
programma di installazione della SL Console standalone dal sito di download di Sun” 
a pagina 39. 

Si apre la schermata License Agreement. 

2. Verificare le informazioni e fare clic su I accept. 

Si apre la schermata Introduction.



Standalone SL Console

418605201 • Revisione: A Capitolo 2 StorageTek Library Console 41

3. Verificare le informazioni e fare clic su Next. 

Si apre la schermata Choose Install Folder. 

4. Selezionare il percorso di installazione del file, quindi fare clic su Next.

Si apre la schermata Choose Shortcut Folder. 

5. Inserire la posizione in cui creare l’icona di scelta rapida, quindi fare clic su Next. 
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Nota – Su Solaris, la posizione predefinita per la scelta rapida è la directory home 
dell’utente. Le scelte rapide non possono essere tuttavia create in /, che corrisponde 
all’home dell’utente root. Pertanto se l’installazione avviene su una piattaforma 
Solaris, come root è necessario selezionare una posizione diversa da quella predefinita. 
In questo caso si consiglia di scegliere /usr/bin o una posizione simile. 

Si apre la schermata Pre-Installation Summary.

6. Verificare le informazioni e fare clic su Install. 

Inizia l’installazione e si apre la schermata Installing SL Console. 
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7. Al termine dell’installazione, si apre la schermata Install Complete. 

8. Verificare le informazioni e fare clic su Done per uscire dal programma di 
installazione. 

▼ Accedere alla SL Console standalone

Nota – Con la SL Console standalone è possibile connettersi a tutte le librerie per le 
quali si dispone di un ID utente valido.

1. Avviare l’applicazione SL Console sul PC o sulla workstation, scegliendo una delle 
seguenti procedure:

■ Fare doppio clic sull’icona SL Console disponibile sul desktop.

■ Selezionare Start > RunSLConsole o Launch > RunSLConsole 

La SL Console si avvia e si apre la schermata Login. 

2. Inserire le informazioni di login.

User ID: SLC_login  
Password: password  
Library: library_ID 

dove:

■ SLC_login è l’SL ConsoleID utente.

■ password è la password assegnata a questo ID utente. 

■ library_ID è la libreria a cui ci si vuole connettere, espressa in uno dei due seguenti 
modi:

■ Indirizzo IP della libreria SL3000 in notazione decimale puntata 
(nnn.nnn.nnn.nnn) 

■ Alias DNS della libreria SL3000 
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Nota – L’ID utente che si utilizza determina le schermate alle quali si può accedere. 
Consultare “SL Console Sicurezza” a pagina 32. 

3. Fare clic su Log on. 

Aggiornamenti della SL Console standalone

Nota – Prima di poter installare una nuova versione della SL Console standalone, 
è necessario disinstallare la versione precedente. Per istruzioni dettagliate, consultare 
la documentazione del PC o della workstation. Se sullo stesso PC o sulla stessa 
workstation sono operative più versioni della SL Console, si potrebbero verificare 
inconsistenze nei dati dei report. 

Dopo aver disinstallato la versione precedente della SL Console, consultare 
“Installazione della SL Console standalone” a pagina 39 per istruzioni dettagliate 
sull’aggiornamento del software. 

SL Console via Web
La SL Console via Web è una funzionalità standard della libreria SL3000 ed è compresa 
nel CD fornito con ogni libreria. Consente di installare la SL Console su un Web server 
centralizzato. I singoli client possono quindi utilizzare un browser supportato per 
scaricare la SL Console via Web. Con la SL Console via Web è possibile connettersi a 
tutte le librerie SL3000 per le quali si dispone di un ID utente valido.

La SL Console via Web è fornita ai client come processo Java Web Start che opera 
esternamente al browser. 

Considerazioni su sicurezza
Il software di SL Console via Web è provvisto di firma digitale con la quale si garantisce 
che è stato prodotto da Sun Microsystems, Inc. e che, dalla creazione, non è stato 
alterato o danneggiato. Essendo un processo Java Web Start, la SL Console via Web 
comprende le funzionalità di sicurezza tipiche della piattaforma Java 2.

Il cliente è responsabile dell’implementazione di tutti i sistemi di sicurezza aggiuntivi 
appropriati, compresi firewall, accesso utente.
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Requisiti dei client
È possibile scaricare la SL Console via Web su client con i seguenti requisiti:  

Aggiornamenti della SL Console via Web 
È necessario installare gli aggiornamenti della SL Console via Web soltanto su un Web 
server centralizzato. Dopodiché vengono scaricati automaticamente su tutti i client 
quando l’applicazione viene avviata sul client. 

Avviare la SL Console via Web su un client
Per avviare e accedere alla SL Console via Web su client, è possibile utilizzare una delle 
seguenti procedure: 

■ Da una riga di comando di (solo per Solaris) o da un browser supportato. Consultare 
“Accedere alla SL Console via Web tramite browser o riga di comando” a pagina 45. 

■ Con doppio clic sull’icona slc.jnlp disponibile sul client. Per utilizzare questo 
metodo da un client, è necessario optare per il metodo browser almeno una volta e 
salvare il file slc.jnlp in locale. Consultare “Accedere alla SL Console via Web 
tramite un’icona” a pagina 51. 

▼ Accedere alla SL Console via Web tramite browser 
o riga di comando 

Nota – Prima di eseguire questa attività, è necessario disporre dell’alias DNS o 
dell’indirizzo IP del server della SL Console. A seconda della modalità di installazione 
del server della SL Console via Web potrebbe essere possibile accedere soltanto tramite 
indirizzo IP. Per assistenza, contattare l’amministratore della libreria SL3000. 

Nota – L’opzione della riga di comando è disponibile solo sulle piattaforme Solaris. 

Piattaforma Solaris 9—SPARC (Firefox 2.x)
Solaris 10—SPARC (Firefox 2.x)
Windows 2000—32 bit (IE 5, IE 5.5, Firefox 2.x)
Windows XP—32 bit (IE 6, IE 7, Firefox 2.x)
Windows Vista—32 bit (IE 7, Firefox 2.x)

Altro ■ Java 1.5 Plug-in (il browser avvierà l’installazione 
automaticamente se non è già disponibile)

■ Connessione Ethernet con la libreria SL3000
■ Connessione Ethernet con il server della SL Console 

via Web
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Su Windows 2000, potrebbe essere necessario installare un plugin Java per il browser, 
prima di eseguire questa procedura. Si può scaricare il plugin dal seguente percorso: 
http://java.sun.com/products/archive/j2se/5.0_04/index.html 

Sulle piattaforme Solaris, l’accesso alla SL Console via Web è più semplice se si utilizza 
la riga di comando. Tuttavia, se si preferisce utilizzare un browser per accedervi, 
scaricare una versione recente di Firefox dal seguente percorso:  
http://releases.mozilla.org/pub/mozilla.org/firefox/releases/2.0.0
.9/contrib/solaris_tarball/firefox-2.0.0.9.en-US.solaris8-sparc-
gtk1.tar.bz2 

1. Scegliere il metodo di login:

■ Riga di comando—disponibile soltanto su Solaris. Passare al Passo 2. 

■ Browser—disponibile su Windows o Solaris. Passare al Passo 3. 

2. Aprire la finestra del terminale e digitare il seguente comando:

javaws http://server_ID/opel 

dove:

■ server_ID si riferisce a uno dei seguenti elementi:

■ Indirizzo IP del server della SL Console (in formato nnn.nnn.nnn.nnn)

■ Alias DNS del server della SL Console 

■ opel è il nome (context root) dell’applicazione SL Console via Web sul server. 

Passare al Passo 4. 

3. Avviare un browser supportato sul PC del client o sulla workstation (consultare 
“Requisiti dei client” a pagina 45 per un elenco dei browser supportati), quindi 
inserire l’URL dell’applicazione Web Start della SL Console nel campo della barra 
degli indirizzi. 

javaws http://server_ID/opel/slc.jnlp 

dove:

■ server_ID si riferisce a uno dei seguenti elementi:

■ Indirizzo IP del server della SL Console (in formato nnn.nnn.nnn.nnn)

■ Alias DNS del server della SL Console 

■ opel è il nome (context root) dell’applicazione SL Console via Web sul server. 

Nota – È possibile creare un segnalibro per questo URL da utilizzare per login 
successivi. 
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4. Si apre la schermata SL ConsoleLaunch. Sselezionare Launch Now.

Il processo Web Start richiama l’applicazione SL Console via Web dal server. Tutti gli 
aggiornamenti vengono scaricati in automatico. 

5. Si apre il popup Opening slc.jnlp. 

Completare il popup come segue:

a. Specificare l’azione da compiere con il file slc.jnlp:

■ Selezionare il pulsante di scelta Open with JavaTM Web Start Launcher per 
avviare la SL Console direttamente. 

■ Selezionare il pulsante di scelta Save to Disk per salvare il file slc.jnlp sul 
client e accedere alla SL Console in un secondo momento. Consultare “Accedere 
alla SL Console via Web tramite un’icona” a pagina 51 per istruzioni sul login. 
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b. Eventualmente, selezionare la casella di controllo Do this automatically for files 
like this from now on. Se la si seleziona, il popup non si aprirà più ai prossimi 
login. 

c. Fare clic su OK. 

6. Se si avvia la SL Console via Web per la prima volta, si apre un popup di avvertenza 
di sicurezza. 

Completare il popup come segue:

a. Verificare che il Publisher sia Sun Microsystems, Inc. 

b. Eventualmente, selezionare la casella di controllo Always trust content from the 
publisher. Se la si seleziona, il popup non si aprirà più ai prossimi login. 

c. Fare clic su Yes.
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7. Se si avvia la SL Console via Web per la prima volta, si apre il popup License 
Agreement. 

Scorrere verso il basso per leggere il contratto di licenza completo. Fare clic su I accept 
the terms of the License Agreement, quindi selezionare OK.



SL Console via Web

50 Manuale dell’utente di SL3000 • Aprile 2008 Revisione: A • 418605201

8. Si apre la schermata di login alla SL Console. 

Inserire le informazioni di login e fare clic su Log on.

User ID: SLC_login  
Password: password  
Library: library_ID 

dove:

■ SLC_login è l’SL ConsoleID utente.

■ password è la password assegnata a questo ID utente. 

■ library_ID è la libreria a cui ci si vuole connettere, espressa in uno dei due seguenti 
modi:

■ Indirizzo IP della libreria SL3000 in notazione decimale puntata 
(nnn.nnn.nnn.nnn) 

■ Alias DNS della libreria SL3000 
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▼ Accedere alla SL Console via Web tramite 
un’icona

Nota – Per eseguire questa attività, è necessario salvare prima di tutto il file SL Console 
via Web slc.jnlp sul client. Consultare “Accedere alla SL Console via Web tramite 
browser o riga di comando” a pagina 45 per informazioni. 

1. Fare doppio clic sull’icona sul desktop slc.jnlp disponibile sul client. 

Il processo Web Start richiama l’applicazione SL Console via Web dal server. Tutti gli 
aggiornamenti vengono scaricati in automatico. 

■ Indirizzo IP della libreria SL3000, in notazione decimale puntata 
(nnn.nnn.nnn.nnn) 

■ Alias DNS della libreria SL3000 
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2. Si apre la schermata SL ConsoleLaunch. Fare clic su Launch Now.

Il processo Web Start richiama l’applicazione SL Console via Web dal server. Tutti gli 
aggiornamenti vengono scaricati in automatico. 

3. Se si avvia la SL Console via Web per la prima volta, si apre un popup di avvertenza 
di sicurezza. 
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Completare il popup come segue:

a. Verificare che il Publisher sia Sun Microsystems, Inc. 

b. Eventualmente, selezionare la casella di controllo Always trust content from the 
publisher. Se la si seleziona, il popup non si aprirà più ai prossimi login. 

c. Fare clic su Yes.

4. Se si avvia la SL Console via Web per la prima volta, si apre il popup License 
Agreement. 

Scorrere verso il basso per leggere il contratto di licenza completo. Fare clic su I accept 
the terms of the License Agreement, quindi selezionare OK.
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5. Si apre la schermata di login alla SL Console. 

Inserire le informazioni di login e fare clic su Log on.

User ID: SLC_login  
Password: password  
Library: library_ID 

dove:

■ SLC_login è l’SL ConsoleID utente.

■ password è la password assegnata a questo ID utente. 

■ library_ID è la libreria a cui ci si vuole connettere, espressa in uno dei due seguenti 
modi:

■ Indirizzo IP della libreria SL3000 in notazione decimale puntata 
(nnn.nnn.nnn.nnn) 

■ Alias DNS della libreria SL3000  

SL Console Report 
I report della SL Console forniscono informazioni sulla libreria e sui dispositivi correlati 
(ad esempio, unità, robot e CAP), sugli eventi e sulle cartucce nastro. Si possono 
utilizzare i report della libreria per monitorarne l’attività e identificare eventuali 
problemi. Oltre a visualizzare i report sullo schermo, è possibile salvarne i dati in un 
file che si può poi stampare o allegare in un messaggio di posta elettronica. 



SL Console Report

418605201 • Revisione: A Capitolo 2 StorageTek Library Console 55

L’output del report è una visualizzazione di informazioni statica inviate dal controller 
della libreria al momento della generazione del report. La SL Console non aggiorna le 
informazioni in modo dinamico a meno che si selezioni il pulsante Update in modo 
esplicito nella barre delle opzioni.

Nota – Se sul PC o sulla workstation sono operative più istanze della SL Console 
standalone o della SL Console via Web, si potrebbero verificare inconsistenze nei dati 
dei report. Si consiglia che un solo utente per volta generi i report della SL Console sul 
PC o sulla workstation a meno che tutte le istanze della SL Console abbiano la stessa 
versione.

Tipi di report
La SL Console fornisce i seguenti tipi di report:

■ Log: log dettagliati su eventi di sistema

■ Status Detail: dettagli sullo stato della libreria e dei dispositivi correlati, quali CAP, 
unità e robot

■ Status Summary: informazioni riepilogative sullo stato della libreria e dei dispostivi 
correlati

■ Version: dettagli sulla versione di hardware e software della libreria

▼ Generare un report 
1. Selezionare Tools > Reports.

2. Nell’albero dei report, espandere la cartella contenente il report da generare (Log, 
Status Detail, Status Summary, o Version). 

3. Selezionare il nome del report da generare.

4. Vengono visualizzati i dati del report corrente. 

Barra delle opzioni dei report
Con la barra delle opzioni di ogni report è possibile eseguire le seguenti funzioni:

■ Cercare il report specificando una stringa di testo

■ Aggiornare il report con i dati correnti

■ Salvare i dati in un file

▼ Cercare il report specificando una stringa di testo
1. Fare clic su Search. 

2. Nella casella Search Text, inserire la stringa di testo con cui eseguire la ricerca. 
L’inserimento è case-sensitive. I caratteri speciali non sono supportati. 

3. Fare clic su Search.

Vengono evidenziate tutte le occorrenze della stringa. 
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▼ Aggiornare il report con i dati correnti
1. Fare clic su Update. 

La schermata viene aggiornata con i dati correnti letti dal database del controller della 
libreria. 

▼ Salvare i dati in un file
1. Fare clic su Save. 

2. Nel menu a tendina Save, selezionare una cartella.

3. Nella casella File Name box, inserire il nome del file in cui salvare i dati.

4. Nel menu a tendina Files of Type, selezionare il formato con cui salvare i dati 
(HTML, testo o XML). 

5. Fare clic su Save.

Nota – Se il file è già esistente, il sistema chiede di confermare la sostituzione.

Una volta salvato, è possibile stampare o allegare il file in un messaggio di posta 
elettronica. Può essere utile per comunicare problematiche agli addetti al servizio clienti 
Sun. 

Guida della SL Console 
Nella guida della SL Console sono disponibili informazioni per operatori della libreria 
SL3000, programmatori, amministratori di sistema e addetti al servizio clienti. 

Nota – Si tratta di informazioni specifiche sulla SL Console. Per informazioni 
sull’hardware della libreria, le unità nastro o il software host, consultare la 
documentazione del prodotto corrispondente.

Di seguito è riportato un esempio di schermata della guida della SL Console. 



Guida della SL Console

418605201 • Revisione: A Capitolo 2 StorageTek Library Console 57

▼ Accedere alla guida della SL Console 
È possibile visualizzare la guida della SL Console da una qualsiasi schermata della 
SL Console. Utilizzare uno dei seguenti metodi: 

■ Per visualizzare la guida sensibile al contesto della schermata corrente della 
SL Console, fare clic sul pulsante ? nella barra delle opzioni. 

■ Per visualizzare informazioni generali della guida, fare clic su Help > Contents nella 
barra dei menu. 

Navigazione della guida
Nel pannello di sinistra della schermata della guida della SL Console sono visualizzate 
le seguenti informazioni:

■ Table of contents (TOC): struttura di argomenti e argomenti secondari

■ Index: elenco dei termini e degli argomenti in ordine alfabetico

Nel pannello di destra viene visualizzato l’argomento della guida. 

In alto alla schermata della guida della SL Console sono disponibili i seguenti pulsanti 
di navigazione. 

Pulsante Azione

 Back Recupera i passi e torna indietro di un argomento per volta. 

 Forward Recupera i passi e va avanti di un argomento per volta. 

 Print Visualizza il popup Print che consente di stampare uno o più 
argomenti:
■ Per stampare l’argomento corrente, fare clic sul pulsante 

Print.
■ Per stampare un altro argomento, selezionare il titolo 

dell’argomento da stampare nell’indice della guida della 
SL Console, quindi fare clic su Print.

■ Per stampare più di un argomento, evidenziare gli argomenti 
nell’indice della guida della SL Console selezionando 
Shift-Click o Ctrl-Click, quindi fare clic sul pulsante Print. 

 Print Setup Visualizza il popup Page Setup in cui è possibile modificare il 
layout della pagina di stampa.

 TOC Visualizza l’indice analitico della guida della SL Console. 

 Index Visualizza l’indice della guida della SL Console. 
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Suggerimenti per l'utilizzo della guida sulla 
SL Console
■ È possibile ridurre, ingrandire o ridimensionare la schermata della guida a seconda 

delle proprie necessità.

■ I pannelli di sinistra e di destra della guida possono essere ridemensionati 
selezionando il bordo che li divide e trascinandolo verso sinistra o verso destra. 

■ Per la maggior parte degli argomenti è disponibile un pulsante Related Topics in 
fondo alla pagina. Fare clic su questo pulsante per visualizzare e navigare tra gli 
argomenti della guida che contengono informazioni correlate. 
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CAPITOLO 3

Operazioni automatizzate della 
libreria SL3000 

Modalità operativa automatica
Quando si trova in modalità operativa automatica, la libreria installa e disinstalla 
automaticamente le cartucce senza l’intervento fisico di una persona.

Le operazioni automatiche includono le seguenti attività:

■ Installazione e disinstallazione delle cartucce

■ Inserimento ed espulsione delle cartucce tramite la CAP

■ Log degli eventi della libreria

■ Pulizia dell’unità

Attività di installazione e disinstallazione delle 
cartucce
La funzione principale della libreria è l’installazione e la disinstallazione automatica 
delle cartucce. I comdandi di installazione e disinstallazione host sono accettati dal 
controller della libreria e tradotti in comandi robotizzati eseguiti dalle TallBot.

Sequenza di installazione 
Una sequenza di installazione semplificata prevede i seguenti passi:

1. L’host invia la richiesta di installazione del numero di serie di un volume specifico 
(VOLID) in un’unità.

2. Il controller della libreria comunica all’host che il VOLID è posizionato all’interno 
della libreria e che è disponibile un’unità in grado di soddisfare la richiesta di 
installazione.

3. La libreria esegue l’installazione.

4. Il comando host viene tradotto dal controller della libreria in comandi di movimento 
inviati alla TallBot.
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5. La cartuccia viene presa dal suo slot e posizionata in un’unità.

6. La libreria comunica all’host che l’operazione di installazione è stata completata.

7. L’unità esegue l’attività di lettura/scrittura diretta dall’host.

Sequenza di installazione
Una sequenza di disinstallazione semplificata prevede i seguenti passi:

1. L’host invia la richiesta di disinstallazione di un VOLID specifico da un’unità.

2. Il controller della libreria comunica all’host che il VOLID è posizionato nell’unità e la 
libreria è in grado di soddisfare la richiesta di disinstallazione.

3. La libreria prende in carico la disinstallazione.

4. Il comando host viene tradotto dal controller della libreria in comandi meccanici 
inviati alla TallBot.

5. La cartuccia viene presa dall’unità e posizionata nel suo slot.

6. La libreria comunica all’host che l’operazione di disinstallazione è stata completata.

Come stabilire quando la libreria non è in modalità 
automatica 
La libreria non si trova in modalità automatica quando non è in grado di accettare le 
richiese dell’host. Le seguenti condizioni indicano che la libreria non si trova in 
modalità automatica:

■ Una delle porte di accesso della libreria è aperta.

■ La TallBot non installa e disinstalla automaticamente le cartucce.

■ L’albero dei dispositivi nella SL Console segnala un problema nella libreria.

Stato dei dispositivi e della libreria
La schermata della SL Console mostra gli indicatori di integrità di ciascuno dei seguenti 
dispositivi:

■ Libreria

■ Unità

■ CAP

■ Alimentatori

■ Robot (TallBot)
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La seguente tabella descrive gli indicatori di integrità.

Indicatore Descrizione 

1 Comm 
Status

Stato corrente del canale di comunicazione tra la SL Console e il controller 
della libreria. Possibili icone:

Comunicazioni normali. Il monitoraggio heartbeat lampeggia 
periodicamente quando la SL Console sta comunicando 
normalmente con il controller della libreria.

Avvertenza. Questa icona compare quando il server impiega 
più di 10 secondi a rispondere.

Errore. Questa icona compare quando il server impiega più di 
30 secondi a rispondere.

2 Userid ID utente attualmente connesso alla SL Console.

21 3

4
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Errori di comunicazione
Se la SL Console perde la comunicazione con il controller della libreria, dopo circa 30–
60 secondi l’heartbeat di monitoraggio diventa prima grigio e poi rosso e compare il 
seguente messaggio di errore:
Heartbeat message not received from the library controller.

Disconnettersi da SL Console e connettersi di nuovo per ripristinare la comunicazione.

Visualizzare le informazioni della libreria
Il menu System Details > Library fornisce varie opzioni per visualizzare e modificare 
le informazioni della libreria, come la configurazione e lo stato della libreria e la 
configurazione della pulizia automatica dell’unità. Per informazioni complete, 
visualizzare i seguenti argomenti:

■ “Task di gestione della libreria” a pagina 71

■ “Task di pulizia dell’unità” a pagina 101

Operazioni della CAP 
Le CAP (porte di accesso alle cartucce) consentono all’operatore della libreria di inserire 
le cartucce nella libreria o di espellerle quando la libreria si trova in modalità 
automatica. Una CAP è sempre presente nel modulo di base. Anche i moduli DEM e 
CEM possono eventualmente avere una CAP. 

Ogni CAP contiene due caricatori removibili da 13 slot, per un totale di 26 cartucce 
importabili o esportabili in una volta sola tramite ciascuna CAP.

Nota – È possibile utilizzare le CAP solo quando la libreria è in modalità automatica.

3 Library La libreria alla quale la SL Console è connessa più una rappresentazione 
dello stato corrente della libreria e dei suoi dispositivi. Possibili icone:

Tutti i dispositivi della libreria stanno funzionando 
normalmente.

Avvertenza. Uno o più dispositivi nella libreria sono offline o 
danneggiati.

Errore. Uno o più dispositivi nella libreria non funzionano 
correttamente.

4 Device 
health

Stato corrente dell’indicatore. Quando l’indicatore della libreria mostra 
un’avvertenza o un errore, utilizzare questo indicatore per determinare 
quali dispositivi funzionano in modo anomalo.

Indicatore Descrizione (segue)



Operazioni della CAP

418605201 • Revisione: A Capitolo 3 Operazioni automatizzate della libreria SL3000 63

Sequenza di apertura della CAP 
Per aprire una CAP è necessario seguire questa procedura:

1. Un host invia un comando per sbloccare la CAP.

2. Lo stato della CAP viene aggiornato in sbloccato (unlocked).

3. L’operatore della libreria preme il pulsante CAP sul tastierino.

4. Lo stato della CAP viene aggiornato in aperto (open).

5. Il motore della CAP viene attivato, la CAP ruota verso l’esterno, lasciando in mostra 
i caricatori.

Sequenza di chiusura della CAP 
Per chiudere una CAP è necessario seguire questa procedura:

1. L’operatore della libreria preme il pulsante CAP sul tastierino.

2. Il motore della CAP viene attivato, la CAP ruota verso l’interno e si chiude.

3. Lo stato della CAP viene aggiornato in chiuso (closed) e bloccato (locked).

4. La TallBot controlla tutti gli slot della CAP.

Modalità di inserimento automatico 
La modalità in inserimento automatico tramite una CAP consente all’operatore della 
libreria di aprire una CAP e di avviare un’operazione di inserimento senza inviare una 
richiesta esplicita. Quando una CAP è in modalità di inserimento automatico è 
sbloccata e il LED è acceso. La CAP è bloccata solo quando viene utilizzata per inserire 
o espellere le cartucce.

Per mettere una CAP in modalità di inserimento automatico, è necessario inserire il 
comando di sistema adatto per sbloccare la CAP.

Per avviare un’operazione di inserimento utilizzando una CAP automatica, basta 
premere il tasto CAP Open sul tastierino. Per avviare un’operazione di espulsione, 
tuttavia, è necessario inserire una richiesta esplicita.

La modalità di inserimento automatico non influisce sulle operazioni di espulsione 
delle cartucce eseguite dalla CAP, quindi per espellere le cartucce tramite una CAP in 
questa modalità è sempre necessario inviare una richiesta di espulsione esplicita.

Modalità manuale della CAP
La modalità manuale è il metodo più sicuro per eseguire le operazioni della CAP.

Quando si trova in modalità manuale, la CAP è bloccata e il LED è spento. Per avviare 
un’operazione di inserimento o espulsione utilizzando una CAP manuale, è necessario 
inviare una richiesta di inserimento o espulsione esplicita prima di premere il pulsante 
CAP Open sul tastierino.
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Utilizzare le CAP in una libreria partizionata

Nota – Questo argomento si applica solo alle librerie partizionate. Per informazioni su 
come definire le partizioni della libreria consultare la sezione “Configurazione delle 
partizioni della libreria” a pagina 34.

Una CAP è una risorsa condivisa della libreria, questo significa che può essere 
utilizzata da tutte le sue partizioni.

Una CAP può essere utilizzata da una sola partizione per volta. Quando una partizione 
sta utilizzando una CAP per le operazioni di inserimento ed espulsione, la CAP è 
riservata solo a quella partizione specifica e non è disponibile per le altre.

Perché una partizione possa prenotare una CAP, è necessario che tutte le condizioni 
indicate di seguito siano soddisfatte:

■ La CAP deve essere disponibile, ovvero non deve essere prenotata da un’altra 
partizione.

■ La CAP deve essere vuota.

■ La CAP deve essere chiusa e bloccata.

Quando una partizione prenota una CAP, la libreria invia i messaggi sull’apertura e la 
chiusura della CAP (“CAP opened” e “CAP closed”) solo all’host che detiene la 
prenotazione.

Quando un host tenta di prenotare una CAP già prenotata da un’altra partizione, la 
libreria invia un messaggio all’host che ha effettuato la richiesta identificando l’ID della 
partizione e l’ID dell’host che detiene la prenotazione.

Gestione delle cartucce
Tutte le cartucce della libreria devono avere un’etichetta esterna leggibile. Per 
informazioni, consultare la sezione Appendice C, “Gestione delle cartucce” a pagina 357.

Le cartucce non etichettate non sono supportate e non possono essere inserite 
attraverso la CAP. Se si inserisce una cartuccia non etichettata in una CAP, la TallBot la 
lascia in quella sede ed è necessario rimuoverla manualmente dalla CAP.

Se si posiziona manualmente una cartuccia non etichettata in una cella di storage, la 
TallBot la lascia in quella sede durante il controllo dell’hardware e non tenta di inserire 
nello slot un’altra cartuccia. Durante il controllo del software,invece, la TallBot rileva la 
cartuccia nella CAP e la espelle dalla libreria.
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Inserire le cartucce
È possibile inserire fino a 26 cartucce in una volta attraverso ciascuna CAP.

Prima di inserire una cartuccia nella libreria, è necessario verificare che sia etichettata 
correttamente. Inserire ogni cartuccia nello slot di una CAP in modo da avere di fronte 
l’etichetta del cliente (se presente), che il dispositivo hub sia rivolto verso il basso e da 
avere di fronte l’etichetta VOLID. Le cartucce possono essere posizionate in qualsiasi 
slot di una CAP e in qualsiasi ordine; la TallBot controlla tutti gli slot della CAP quando 
la porta della CAP si chiude.

Nota – Il design della CAP impedisce l’inserimento di cartucce T9x40 o T10000 
capovolte. Tuttavia non impedisce di posizionare una cartuccia LTO capovolta.

Il lettore di codice a barre della TallBotlegge i VOLID delle cartucce solo durante le 
operazioni di immissione, al fine di aggiungere i nuovi VOLID nel database del 
controller della libreria. Non è necessario che la TallBot legga i VOLID delle cartucce 
durante l’espulsione.

Quando una cartuccia viene inserita all’interno della libreria, viene assegnata a una 
cella dal controller della libreria oppure installata su un’unità, a seconda del motivo per 
cui è stata inserita. La posizione della cartuccia viene registrata nel database del 
controller della libreria, utilizzando il formato dell’indirizzo interno della libreria 
(consultare “Indirizzo interno della libreria” a pagina 334). La posizione viene 
trasmessa anche all’host per essere inclusa nel database delle cartucce dell’host.

Espellere le cartucce
È possibile espellere fino a 26 cartucce in una volta attraverso ciascuna CAP.

Per espellere una cartuccia è necessario specificare il VOLID della cartuccia che si 
desidera rimuovere dalla libreria. La TallBot si sposta nella posizione di storage 
indicata nel database del controller della libreria, rimuove la cartuccia dallo slot e 
posiziona la cartuccia in uno slot della CAP. Dopo che la CAP è stata aperta, la 
cartuccia e la sua posizione vengono cancellate dal database del controller della libreria 
e dal database dell’host.

Nota – La TallBot non legge i VOLID delle cartucce durante le operazioni di 
espulsione.

Posizionare le cartucce
La SL Console consente di visualizzare l’indirizzo di ogni cartuccia all’interno della 
libreria. È possibile posizionare una cartuccia in base a uno dei criteri seguenti:

■ VOLID

■ Indirizzo interno della libreria

■ indirizzo HLI-PRC



Unità

66 Manuale dell’utente di SL3000 • Aprile 2008 Revisione: A • 418605201

Questa utility è particolarmente pratica quando si vuole eseguire l’installazione 
manuale di una cartuccia. Il software di gestione della libreria (per esempio, HSC o 
ACSLS) fornisce il VOLID e l’indirizzo HLI-PRC o FC-SCSI della cartuccia, nonché 
l’indirizzo dell’alloggiamento di un’unità disponibile. Prima di entrate all’interno della 
libreria, segnarsi il VOLID, la posizione della cartuccia e la posizione dello slot 
dell’unità.

Spostamento di recupero
La funzione diagnostica di spostamento di recupero consente di spostare una cartuccia 
da una posizione di partenza (CAP, cella di storage o unità) in una di destinazione 
(CAP o cella di storage). Per esempio:

■ È possibile rimettere una cartuccia nella sua posizione originaria da una cella della 
CAP, un’unità o un’altra cella di storage.

■ È possibile espellere una cartuccia di pulizia o diagnostica scaduta.

■ È possibile inserire una nuova cartuccia di pulizia o diagnostica e spostarla in una 
cella di storage prenotata.

Prima di spostare qualsiasi cartuccia, è utile generare un report di riepilogo delle 
cartucce in cui sono riportati i contenuti delle celle di storage della libreria. Questo 
report aiuta a stabilire quali celle di storage sono disponibili.

Unità
È possibile installare fino a 56 unità all’interno della libreria, come segue:

■ Fino a 24 nel Base Module

■ Fino a 32 in un Drive Expansion Module (DEM)

Per un elenco delle unità nastro supportate, consultare la sezione “Unità nastro” a 
pagina 16.

Identificazione delle unità
La libreria utilizza i seguenti schemi di indirizzamento per ciascuna unità della libreria:

■ Indirizzo interno della libreria: per tutte le unità. Sono assegnati dal controller in 
base alla posizione della libreria, del binario, della colonna, del lato e della riga in cui 
si trova l’unità.

■ Indirizzo HLI-PRC (Host LMU Interface-Panel, Row, Column): solo per le 
connessioni host TCP/IP. Assegnati da applicazioni host.

■ Indirizzo dell’elemento SCSI host: solo per le connessioni host FC-SCSI. Assegnati da 
applicazioni host.

■ Indirizzo dell’alloggiamento dell’unità: per tutte le unità. È assegnato dal controller 
della libreria in base allo slot fisico in cui l’unità è installata.

■ World Wide Name dinamico: solo per le connessioni Fibre Channel. È assegnato dal 
controller della libreria in base allo slot in cui l’unità è installata.
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Per informazioni sugli schemi di identificazione e indirizzamento delle unità, 
consultare la sezione Appendice A, “Indirizzi delle risorse della libreria” a pagina 333.

Stati delle unità
Un’unità può essere in uno dei seguenti stati:

■ Online: l’unità è disponibile per le operazioni di lettura/scrittura.

■ Offline: l’unità non è disponibile per le operazioni di lettura/scrittura.

Pulizia delle unità 
Le unità nastro richiedono una pulizia periodica per prevenire errori di lettura e 
scrittura. La libreria supporta due metodi di pulizia delle unità:

■ Pulizia automatica

■ Pulizia manuale

Cartucce di pulizia

Nota – È necessario utilizzare delle cartucce di pulizia compatibili con le unità della 
libreria.

Le cartucce di pulizia hanno una durata limitata. Per stabilire il conteggio utilizzo 
massimo, o soglia, per ogni tipo di cartuccia di pulizia, consultare la documentazione 
relativa alle unità nastro.

Quando si immette nella libreria una cartuccia di pulizia, il controller della libreria 
considera la cartuccia come nuova e imposta il conteggio utilizzo su zero. Per questa 
ragione è importante inserire nella libreria solo cartucce nuove.

Ogni volta che una cartuccia di pulizia viene utilizzata per pulire un’unità, il conteggio 
utilizzi aumenta. Quando il conteggio utilizzi di una cartuccia di pulizia supera la 
soglia, è necessario sostituirla.

La SL Console può essere utilizzata per visualizzare in qualsiasi momento lo stato di 
una cartuccia di pulizia. Sono possibili i seguenti stati:

■ OK: la cartuccia è ancora entro la soglia.

■ Avvertenza: la cartuccia ha raggiunto la soglia.

■ Scaduta: la cartuccia ha superato la soglia.
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Espellere le cartucce di pulizia scadute
Prestare attenzione quando si espellono le cartucce di pulizia scadute dalla libreria. Se 
si apre una CAP per spostare una cartuccia di pulizia scaduta, la cartuccia deve essere 
rimossa. Se infatti si chiude la CAP senza aver rimosso la cartuccia di pulizia, la TallBot 
reinserisce la cartuccia scaduta nella libreria e il controller della libreria reimposta il 
contatore d’utilizzo su 0. 

Pulizia automatica 

Nota – La libreria SL3000 gestisce la pulizia automatica solo per le unità controllate da 
host FC-SCSI. Gli host HSC e ACSLS gestiscono la pulizia automatica delle unità 
assegnate a loro. Per informazioni sulla gestione della pulizia automatica consultare la 
documentazione sugli host HSC e ACSLS. 

La funzione di pulizia automatica è disponibile per la libreria SL3000. Tuttavia il 
firmware corrente non supporta le seguenti funzionalità:

■ L’importazione automatica delle cartucce di pulizia tramite la CAP e il 
posizionamento dei nastri all’interno delle celle prenotate dedicate alle cartucce di 
pulizia e diagnostiche.

■ L’esportazione automatica delle cartucce di pulizia scadute tramite la CAP.

La SL Console consente di impostare e monitorare le cartucce di pulizia che si trovano 
all’interno della libreria. In alternativa, è possibile monitorare la funzione di pulizia 
tramite il software host. In questo caso la funzione di pulizia automatica viene ignorata.

Quando viene abilitata la funzione di pulizia automatica, il controller della libreria 
avvia automaticamente l’operazione di pulizia ogni volta che l’unità lo richiede. La 
TallBot recupera una cartuccia di pulizia appropriata (in base al tipo di unità) dagli slot 
del sistema, installa la cartuccia nell’unità e riposiziona la cartuccia nel suo slot al 
termine della pulizia.

Pulizia manuale 

Nota – La pulizia manuale dell’unità viene avviata tramite il software di gestione della 
libreria. Per la sintassi del comando consultare la documentazione relativa agli host 
ACSLS o HSC.

Se la pulizia automatica è disabilitata, è necessario avviare le operazioni di pulizia 
manualmente. Per verificare se un’unità necessita di un intervento di pulizia è possibile 
utilizzare la SL Console per visualizzare lo stato di pulizia dell’unità e la data 
dell’ultimo intervento.

Se quando la funzionalità di pulizia automatica è attiva si desidera effettuare la pulizia 
di un’unità prima del previsto, è possibile farlo avviando una pulizia manuale in 
qualsiasi momento.

Per posizionare il tipo di cartuccia di pulizia giusto per una particolare unità, è 
possibile utilizzare la SL Console per generare un riepilogo delle cartucce e un report 
dettagliato delle unità.
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TallBots 
La TallBot sposta le cartucce attraverso gli slot di storage, le unità nastro e le CAP della 
libreria. Esegue inoltre i controlli della libreria.

La TallBot è inclusa nel modulo Base Module ed è possibile accedervi dal pannello 
frontale del rack. I tre principali componenti della TallBot sono:

■ Complesso tavola X: effettua un movimento laterale di 180 gradi.

■ Complesso unità Z: effettua un movimento verticale.

■ Complesso manuale: include i seguenti componenti:

■ Pinze per afferrare le cartucce.

■ Lettore di codice a barre laser per calibrare la posizione e leggere le etichette delle 
cartucce.

■ Sensore di prossimità per rilevare le celle di storage vuote e le cartucce non 
etichettate.

Per informazioni su come visualizzare e gestire lo stato della TallBot e altre 
informazioni, consultare la sezione “Task di monitoraggio dell’alimentazione e del 
robot” a pagina 110.

Alimentatori 
La libreria SL3000 fornisce una totale ridondanza delle unità nastro, robotiche ed 
elettroniche. Sono disponibili le seguenti opzioni di ridondanza:

■ N+1

■ 2N

■ 2N+1

Sono disponibili le seguenti opzioni di alimentazione:

■ 120-127 VAC, monofase

■ 200-240 VAC, monofase

Per ulteriori informazioni, consultare la sezione “Opzioni di alimentazione” a 
pagina 21.
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Interfaccia host
La libreria SL3000 supporta le seguenti opzioni interfaccia control path:

■ HLI (TCP/IP): protocollo TCP/IP che utilizza cavi Ethernet 10/100 Base-T e CAT-5

■ FC-SCSI: gruppo di comandi e protocollo SCSI-3 su un’interfaccia Fibre Channel 
fisica

Per informazioni, consultare la sezione “Library Control Path” a pagina 23.

Librerie non partizionate
In librerie non partizionate, tutti gli hosts devono utilizzare lo stesso tipo di interfaccia 
per connettersi alla libreria. 

È possibile visualizzare il tipo di interfaccia sulla schermata System Detail > Status > 
General.

È possibile modificare il tipo di interfaccia tramite la schermata 
Select Active Cells > Select Active Cells.

Librerie partizionate
Nelle librerie partizionate, è possibile utilizzare tipi di interfacce host sia FC-SCSI che 
HLI; ogni partizione deve utilizzare l’una o l’altra interfaccia. Quando si crea una 
nuova partizione è necessario specificare quale tipo di interfaccia utilizza. Tutti gli host 
all’interno di una partizione utilizzano lo stesso tipo di interfaccia.

Per ulteriori informazioni, consultare la sezione “Connessioni tra partizione e host” a 
pagina 175. 

Operazioni automatizzate
Le operazioni automatizzate della libreria sono suddivise nelle seguenti categorie:

■ “Task di gestione della libreria” a pagina 71

■ “Task di gestione della CAP” a pagina 83

■ “Task di gestione delle cartucce” a pagina 89

■ “Task di gestione delle unità” a pagina 96

■ “Task di pulizia dell’unità” a pagina 101

■ “Task di monitoraggio dell’alimentazione e del robot” a pagina 110
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Task di gestione della libreria 

▼ Visualizzazione dello stato della libreria 
Mostra lo stato operativo corrente della libreria. Questi valori vengono aggiornati ogni 
volta che l’host o l’operatore svolgono delle attività o che vi sono delle operazioni in 
background.

Nota – Queste informazioni sono disponibili anche in Reports > Library Details. Per 
istruzioni dettagliate, consultare la sezione “Visualizzare il report di una libreria” a 
pagina 78.

1. Selezionare Tools > System Detail.

2. Fare clic sulla cartella Library Folder nell’albero dei dispositivi.
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3. Fare clic sulla scheda Status, e poi sulla scheda General.

La schermata mostra lo stato corrente della libreria.

▼ Visualizzare lo stato della porta HLI  
Utilizzare questa procedura per visualizzare lo stato corrente di tutte le porte 
interfaccia LMU host (HLI) della libreria. Le informazioni includono il socket TCP/IP 
locale, l’IP locale, lo stato della connessione, lo stato della porta, la trasmissione inviata 
e ricevuta durante la connessione.

1. Selezionare Tools > System Detail.

2. Fare clic sulla cartella Library Folder nell’albero dei dispositivi.
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3. Fare clic sulla scheda Status, e poi sulla scheda HLI.

La schermata mostra lo stato attuale della libreria e l’attività di tutte le porte HLI nella 
libreria.

▼ Visualizzare le informazioni di configurazione 
della libreria 
Utilizzare questa procedura per visualizzare la configurazione fisica, meccanica e logica 
della libreria. Alcune delle informazioni vengono impostate automaticamente durante 
l’inizializzazione della libreria, mentre altre possono essere definite dall’utente.

Nota – Queste informazioni sono disponibili anche in Reports > Library Information. 
Per istruzioni dettagliate, consultare la sezione “Visualizzare il report di una libreria” a 
pagina 78.

1. Selezionare Tools > System Detail.

2. Fare clic sulla cartella Library Folder nell’albero dei dispositivi.
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3. Fare clic sulla scheda Properties, e poi sulla scheda General.

La schermata mostra informazioni dettagliate sulla libreria.

▼ Visualizzare le proprietà del controller della 
libreria  
Mostra i dettagli riguardanti il controller della libreria, inclusi il numero di serie e le 
versioni del firmware.

Nota – Questa informazione è disponibile anche in Reports > Library Information. Per 
istruzioni dettagliate, consultare la sezione “Visualizzare il report di una libreria” a 
pagina 78.

1. Selezionare Tools > System Detail.

2. Fare clic sulla cartella Library Folder nell’albero dei dispositivi.
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3. Fare clic sulla scheda Properties, e poi sulla scheda Library Controller.

▼ Visualizzare le proprietà del controller dell’unità
Mostra i dettagli riguardanti il controller dell’unità, inclusi il numero di serie e le 
versioni del firmware.

Nota – Questa informazione è disponibile anche in Reports > Library Information. Per 
istruzioni dettagliate, consultare la sezione “Visualizzare il report di una libreria” a 
pagina 78.

1. Selezionare Tools > System Detail.

2. Fare clic sulla cartella Library Folder nell’albero dei dispositivi.
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3. Fare clic sulla scheda Properties, e poi sulla scheda Drive Controller.

▼ Modificare il tipo di interfaccia della libreria 
(librerie non partizionate)
Utilizzare questa procedura per modificare il tipo di interfaccia utilizzato da tutti gli 
host per collegarsi alla libreria.

Nota – Questa procedura si applica solo alle librerie non partizionate. Per modificare i 
tipi di interfaccia in una libreria partizionata, consultare la sezione “Modificare il tipo 
di interfaccia di una connessione tra partizione e host” a pagina 204.

1. Selezionare Tools > Select Active Cells.

Si apre la schermata Module Map.
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2. Fare clic sulla scheda Select Active Cells.

Si apre la schermata Select Active Cells, che mostra il tipo di interfaccia attualmente 
assegnato alla libreria.

3. Nel menu a tendina Interface Type, selezionare il tipo di interfaccia che si desidera 
assegnare. Fare clic su Apply.

Si apre il popup Confirm Apply.

4. Fare clic su Yes per aggiornare il database del controller della libreria.

Si apre il popup Commit Success.
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5. Fare clic su OK per tornare alla schermata Select Active Cells.

Il nuovo tipo di interfaccia è subito attivo; non è necessario riavviare la libreria.

▼ Visualizzare il report di una libreria 
Utilizzare questa procedura per visualizzare i report della libreria disponibili dal menu 
Tools > Reports. Per cercare i dati di un report o per salvarlo in un file, seguire le 
seguenti procedure:

■ “Cercare un report di una libreria” a pagina 79

■ “Salvare i dati del report di una libreria in un file” a pagina 82

Dai seguenti menu sono disponibili altri report:

■ Tools > Partitions

■ Tools > Select Active Cells

1. Selezionare Tools > Reports.

Si apre la schermata dei report Display. Tutte le opzioni dei report della libreria sono 
elencate nella barra di navigazione.

2. Nella barra di navigazione, espandere una categoria di report per vedere le relative 
opzioni.
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3. Fare clic sul report che si desidera visualizzare.

Viene visualizzato il report selezionato.

▼ Cercare un report di una libreria
Utilizzare questa procedura per cercare una stringa di testo specifica nel report di una 
libreria. Questa procedura può essere eseguita su una qualsiasi schermata di report 
della libreria.
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1. Selezionare Tools > Reports.

Si apre la schermata dei report Display. Tutte le opzioni dei report della libreria sono 
elencate nella barra di navigazione.

2. Nella barra di navigazione, espandere una categoria di report per vedere le relative 
opzioni.

3. Fare clic sul report che si desidera visualizzare.

Viene visualizzato il report selezionato. Tutte le schermate di report presentano il 
pulsante Search nella barra delle opzioni.
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4. Fare clic su Search.

Si apre il popup Search Text.

5. Immettere la stringa di testo da cercare e fare clic su Search.

Nota – La ricerca è case-sensitive e non supporta caratteri speciali.

6. Si apre il popup Search Results, che mostra il numero di occorrenze della stringa di 
testo. Tutte le occorrenze della stringa di testo presenti all’interno del report vengono 
evidenziate.

7. Fare clic su OK per chiudere il popup.
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▼ Salvare i dati del report di una libreria in un file
Utilizzare questa procedura per visualizzare il report di una libreria e salvare i dati in 
un file di testo (.txt). Questa procedura può essere eseguita da una qualsiasi 
schermata di report della libreria.

1. Selezionare Tools > Reports.

Si apre la schermata dei report Display. Tutte le opzioni dei report della libreria sono 
elencate nella barra di navigazione.

2. Nella barra di navigazione, espandere una categoria di report per vedere le relative 
opzioni.

3. Fare clic sul report che si desidera visualizzare.

Viene visualizzato il report selezionato. Tutte le schermate di report presentano il 
pulsante Save nella barra delle opzioni.
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4. Fare clic su Save.

Si apre il popup Save.

5. Cercare la directory in cui si desidera salvare il file. Nel campo File Name è possibile 
accettare il nome standard oppure inserirne uno diverso.

6. Fare clic su Save.

I dati vengono salvati nel file specificato.

Task di gestione della CAP 
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▼ Visualizzare le informazioni riepilogative della 
CAP 
Utilizzare questa procedura per visualizzare le informazioni riepilogative per tutte le 
CAP della libreria.

Nota – Questa informazione è disponibile anche in Reports > CAP Summary. Per 
istruzioni dettagliate, consultare la sezione “Visualizzare il report di una libreria” a 
pagina 78.

1. Selezionare Tools > System Detail.

2. Fare clic sulla cartella CAP Folder nell’albero dei dispositivi.

La schermata mostra un elenco delle CAP della libreria e ne indica le posizioni. 
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▼ Visualizzare lo stato attuale della CAP
Utilizzare questa procedura per visualizzare l’attuale stato operativo di una CAP.

Nota – Questa informazione è disponibile anche in Reports > CAP Details. Per 
istruzioni dettagliate, consultare la sezione “Visualizzare il report di una libreria” a 
pagina 78.

1. Selezionare Tools > System Detail.

2. Espandere la cartella CAP Folder e fare clic sulla CAP che si desidera visualizzare.

3. Fare clic su Status.

La schermata mostra lo stato corrente della CAP.
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▼ Visualizzare le proprietà di una CAP
Utilizzare questa procedura per visualizzare le informazioni statistiche della CAP, 
inclusi il numero di serie e il numero di celle.

Nota – Questa informazione è disponibile anche in Reports > CAP Details. Per 
istruzioni dettagliate, consultare la sezione “Visualizzare il report di una libreria” a 
pagina 78.

1. Selezionare Tools > System Detail.

2. Espandere la cartella CAP Folder e fare clic sulla CAP che si desidera visualizzare.

3. Fare clic su Properties.

Si apre la schermata CAP Properties.

▼ Sbloccare e aprire una CAP 
1. Selezionare Tools > Diagnostics.

2. Espandere la cartella CAP Folder e fare clic sulla CAP da modificare.
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3. Fare clic sulla scheda Access.

Si apre la schermata Access.

4. Nel menu a tendina Locked, fare clic su falso (“false”). Fare clic sul pulsante Apply.

Si apre il popup Confirm.

5. Fare clic su OK.

La CAP si sblocca e il pulsante CAP si illumina.

6. Nel pannello di controllo della libreria, premere il pulsante CAP Open sulla CAP.

La CAP ruota verso l’esterno, consentendo l’aggiunta o la rimozione delle cartucce.
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▼ Chiudere e bloccare una CAP
In genere quando una CAP viene chiusa, si blocca automaticamente. Utilizzare questa 
procedura per bloccare la CAP manualmente.

1. Premere il pulsante CAP Open sulla CAP.

Attenzione – Possibile danno dei dispositivi. NON forzare l’apertura o la chiusura della 
CAP.

La CAP ruota verso l’interno. La TallBot controlla le cartucce all’interno delle celle.

2. Selezionare Tools > Diagnostics.

3. Espandere la cartella CAP Folder e fare clic sulla CAP da modificare.

4. Fare clic sulla scheda Access.

Si apre la schermata Access.

5. Nel campo Locked, fare clic su vero (“true”). Fare clic sul pulsante Apply.

La CAP si blocca e la luce sul pulsante CAP si spegne. 
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Task di gestione delle cartucce

▼ Inserire le cartucce attraverso una CAP
Utilizzare questa procedura per inserire le cartucce in una libreria attraverso una CAP.

Nota – Questa procedura si applica solo alle librerie non partizionate. Per informazioni 
sulle librerie partizionate, consultare la sezione “Inserire le cartucce in una partizione” 
a pagina 217.

1. Avviare l’operazione di inserimento nell’host Per le procedure e i comandi, 
consultare la documentazione del software di gestione nastri.

Nota – Se la CAP si trova in modalità di inserimento automatico è possibile saltare 
questo passo e andare direttamente al Passo 2.

2. Premere il pulsante CAP per aprire la CAP.

La porta della CAP si apre.

Attenzione – Possibile danno dei dispositivi. NON forzare l’apertura o la chiusura della 
CAP.

3. Posizionare le cartucce nella CAP.

Inserire le cartucce in modo che l’etichetta del cliente (se presente) sia rivolta verso 
l’alto, che il dispositivo hub sia rivolto verso il basso e da avere di fronte l’etichetta 
VOLID.

Le cartucce possono essere inserite direttamente nei caricatori mentre questi si trovano 
all’interno della CAP; è possibile anche rimuovere i caricatori dalla CAP, inserire le 
cartucce nel caricatore e quindi riposizionare i caricatori contenenti le cartucce 
all’interno della CAP.
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Nota – Le cartucce possono essere posizionate in qualsiasi slot di una CAP e in 
qualsiasi ordine; la TallBot controlla tutti gli slot della CAP quando la porta della CAP 
si chiude.

Attenzione – Possibile danno del supporto. È sconsigliato inserire cartucce prive di 
etichette esterne o in posizione capovolta, benché sia possibile farlo. Potrebbero infatti 
presentarsi problemi durante l’esecuzione di un controllo. Allo stesso modo, si consiglia 
di non inserire cartucce che contengono etichette illeggibili o danneggiate.

4. Premere il pulsante CAP per chiudere la CAP.

La CAP si chiude e si blocca automaticamente, e la luce sul pulsante CAP si spegne.

Attenzione – Possibile danno dei dispositivi. NON forzare l’apertura o la chiusura della 
CAP.

5. La TallBot controlla la CAP e sposta le cartucce dalla CAP agli slot di storage 
all’interno della partizione appropriata.

Quando tutte le cartucce sono state spostate dalla CAP, la libreria rileva che la CAP è 
vuota e la CAP viene riportata allo stato predefinito.

▼ Espellere le cartucce attraverso una CAP
Utilizzare questa procedura per espellere le cartucce da una libreria attraverso una 
CAP.

Nota – Questa procedura si applica solo alle librerie non partizionate. Per informazioni 
sulle librerie partizionate, consultare la sezione “Espellere le cartucce da una 
partizione” a pagina 217.

1. Avviare l’operazione di espulsione dall’host. Per le procedure e i comandi, consultare 
la documentazione del software di gestione nastri.

È necessario specificare i VOLID delle cartucce che si desidera rimuovere dalla libreria.

2. La TallBot posiziona le cartucce e le posiziona in una o più CAP disponibili.

3. Premere il pulsante CAP per aprire la CAP.

La porta della CAP si apre.

Attenzione – Possibile danno dei dispositivi. NON forzare l’apertura o la chiusura della 
CAP.

4. Rimuovere le cartucce dalla CAP.

Le cartucce possono essere rimosse direttamente dai caricatori mentre questi si trovano 
all’interno della CAP; è possibile anche togliere i caricatori dalla CAP, rimuovere le 
cartucce dai caricatori e quindi riposizionare i caricatori vuoti all’interno della CAP.
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5. Premere il pulsante CAP per chiudere la CAP.

La CAP si chiude e si blocca automaticamente, e la luce sul pulsante CAP si spegne.

Attenzione – Possibile danno dei dispositivi. NON forzare l’apertura o la chiusura della 
CAP.

In caso sia necessario esportare più cartucce, la TallBot continua a riempire le CAP 
necessarie. Attendere che la porta della CAP si sblocchi e ripetere dal Passo 3 al Passo 5.

L’operazione di espulsione termina automaticamente quando tutte le cartucce 
specificate sono state espulse.

6. La TallBot controlla la CAP per verificare che sia vuota.

La CAP viene riportata allo stato predefinito.

▼ Elencare le cartucce della libreria 
Utilizzare questa procedura per visualizzare le informazioni sulle cartucce della 
libreria, inclusi i VOLID, le posizioni e i tipi di media.

1. Selezionare Tools > Reports.

Tutte le opzioni dei report della libreria sono elencate nella barra di navigazione.

2. Espandere la cartella Status Summary.

Vengono elencati tutti i report di riepilogo dello stato.
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3. Fare clic su Cartridge Summary.

Viene visualizzato il report di riepilogo delle cartucce.

4. Per cercare i dati di un report o per salvarlo in un file, seguire le seguenti procedure:

■ “Cercare un report di una libreria” a pagina 79

■ “Salvare i dati del report di una libreria in un file” a pagina 82

▼ Posizionare una cartuccia in base al VOLID
Utilizzare questa procedura per posizionare una cartuccia utilizzando l’ID del suo 
volume.

1. Selezionare Tools > Diagnostics.

2. Fare clic sulla cartella Library Folder nell’albero dei dispositivi.

3. Fare clic sulla scheda Search.

Si apre la schermata Library Search.

4. Nel menu a tendina Search Type, fare clic su VOLID.
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5. Inserire il VOLID, il richiedente e il tipo di cartuccia.

Nota – Nel campo VOLID è possibile utilizzare caratteri speciali.

6. Fare clic su Search.

La schermata mostra tutte le cartucce che soddisfano i criteri di ricerca.

▼ Posizionare una cartuccia in base all’indirizzo
Utilizzare questa procedura per posizionare una cartuccia in base alla sua posizione. La 
posizione può essere in uno dei seguenti formati:

■ Indirizzo interno della libreria

■ Indirizzo HLI-PRC (solo host HLI)

■ Indirizzo FC-SCSI (solo host SCSI-FC)

1. Selezionare Tools > Diagnostics.

2. Selezionare la cartella Library Folder nell’albero dei dispositivi.

3. Fare clic sulla scheda Search.

Si apre la schermata Library Search.
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4. Nel menu a tendina Search Type, fare clic su Location.

5. Nel menu a tendina Location, selezionare il metodo che si desidera utilizzare per 
impostare i parametri di posizione.

6. Nel campo Location, inserire i parametri di posizione da utilizzare per la ricerca.

È necessario utilizzare un formato che corrisponde al richiedente Requester, specificato 
in nel prossimo passo. Per esempio:

■ Utilizzare il formato indirizzo interno se il richiedente è “default”.

■ Utilizzare l’indirizzo HLI-PRC se il richiedente è un host HLI.

■ Utilizzare l’indirizzo FC-SCSI se il richiedente è un host FC-SCSI.

Nota – In questo campo non è possibile utilizzare caratteri speciali.

7. Nel menu a tendina Requester, selezionare l’host che sta inviando la richiesta di 
ricerca.

8. Fare clic sul pulsante Search.

La schermata mostra tutte le posizioni che soddisfano i criteri di ricerca.
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9. Per informazioni su una cartuccia o per visualizzare il mapping di una posizione fare 
clic sul pulsante ... nella colonna Details.

Si apre la schermata Location Details.

10.Fare clic su Close per chiudere il popup.

▼ Spostare una cartuccia 
Utilizzare questa procedura per spostare una cartuccia da una posizione a un’altra 
all’interno della libreria.

Nota – Questa procedura aggiorna la posizione delle cartucce nel database del 
controller della libreria, ma non nel database dell’host. Dopo aver eseguito questa 
procedura è quindi necessario inviare una richiesta di controllo dal software host per 
aggiornare il database dell’host. Se tale operazione non viene eseguita, le successive 
richieste di installazione da parte del software host non verranno portate a termine 
correttamente.

Attenzione – Fare attenzione quando si esegue questa procedura in librerie 
partizionate. Si potrebbe spostare inavvertitamente una cartuccia da una partizione in 
un’altra, consentendo alla nuova partizione di sovrascrivere i dati sulla cartuccia.

1. Selezionare Tools > Diagnostics.

2. Selezionare la scheda RcvrMove.

3. Definire i parametri della posizione di partenza selezionando prima la modalità 
(Location o Volume ID).

Per spostare una cartuccia in base all’indirizzo della posizione:

a. Selezionare la posizione come modalità.

b. Selezonare il tipo (CAP, cella o unità) dal menu a tendina.

c. Selezionare l’indirizzo del modulo, della riga e della colonna dai menu a tendina.
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Per spostare la cartuccia in base all’ID del volume:

a. Selezionare il VOLID come modalità.

b. Inserire l’ID del volume della cartuccia da spostare.

4. Selezionare i parametri della posizione di destinazione:

a. Selezionare il tipo (CAP o cella di storage) dal menu a tendina.

b. Selezionare l’indirizzo del modulo, della riga e della colonna dai menu a tendina.

Attenzione – Se la libreria è partizionata, assicurarsi di mantenere la cartuccia nella 
partizione alla quale è attualmente allocata. Se si sposta una cartuccia in una cella 
allocata a una diversa partizione, un host potrebbe considerarla provvisoria e potrebbe 
quindi sovrascrivere i dati. Se la cartuccia viene spostata in una cella non allocata 
potrebbe essere considerata non accessibile da tutti gli host.

5. Fare clic sulla scheda Start nell’angolo in alto a destra della schermata.

Nota – Se la posizione di destinazione è un’unità, è possibile spostare solo una 
cartuccia da una CAP o da uno slot prenotato. È inoltre impossibile eseguire uno 
spostamento correttivo se la posizione di destinazione è piena.

6. Al termine dello spostamento, il sistema mostra la finestra di dialogo che indica la 
riuscita dell’operazione. Fare clic su OK.

7. Per aggiornare la nuova posizione della cartuccia nel database dell’host, avviare un 
controllo della libreria dal software dell’host. Per le procedure e i comandi, 
consultare la documentazione del software di gestione nastri.

Task di gestione delle unità
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▼ Visualizzare le informazioni riepilogative 
sull’unità 
Utilizzare questa procedura per visualizzare le informazioni riepilogative per tutte le 
unita della libreria.

Se si desidera eseguire l’installazione manuale su un’unità, questa procedura mostra il 
mapping di tutti gli indirizzi di ciascuna unità della libreria:

■ Hardware (alloggiamento unità)

■ Firmware (indirizzo interno)

■ Software host (indirizzo HLI-PRC)

Nota – Questa informazione è disponibile anche in Reports > Drive Summary. Per 
istruzioni dettagliate, consultare la sezione “Visualizzare il report di una libreria” a 
pagina 78.

1. Selezionare Tools > System Detail.

2. Fare clic sulla cartella Drive Folder nell’albero dei dispositivi.

La schermata mostra un elenco delle unità della libreria e ne indica le posizioni. 
Vengono indicati l’indirizzo interno, l’alloggiamento dell’unità e l’indirizzo HLI-PRC.
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▼ Visualizzazione dello stato dell’unità
Utilizzare questa procedura per visualizzare l’attuale stato operativo di un’unità.

Nota – Questa informazione è disponibile anche in Reports > Drive Details. Per 
istruzioni dettagliate, consultare la sezione “Visualizzare il report di una libreria” a 
pagina 78.

1. Selezionare Tools > System Detail.

2. Espandere la cartella Drive Folder e fare clic sull’unità che si desidera visualizzare.

3. Fare clic su Status.

La schermata mostra lo stato corrente dell’unità.
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▼ Visualizzazione delle proprietà dell’unità
Mostra le informazioni riguardanti la configurazione dell’unità, incluso il tipo di unità, 
il numero di serie e la configurazione della porta.

Nota – Questa informazione è disponibile anche in Reports > Drive Details. Per 
istruzioni dettagliate, consultare la sezione “Visualizzare il report di una libreria” a 
pagina 78.

1. Selezionare Tools > System Detail.

2. Espandere la cartella Drive Folder e fare clic sull’unità che si desidera visualizzare.

3. Fare clic su Properties.

▼ Visualizzare il VOP dell’unità

Nota – Questa procedura è solo per unità T10000.

Utilizzare questa procedura per visualizzare il pannello operatore virtuale (VOP) delle 
unità T10000.
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1. Selezionare Tools > System Detail.

2. Espandere la cartella Drive Folder e fare clic sull’unità che si desidera visualizzare.

3. Fare clic su Display.

Si apre la schermata VOP dell’unità.

▼ Visualizzare lo stato del vassoio dell’unità
Utilizzare questa procedura per visualizzare l’attuale stato del vassoio di un’unità.

1. Selezionare Tools > System Detail.

2. Espandere la cartella Drive Folder e fare clic sull’unità che si desidera visualizzare.
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3. Fare clic su DriveTray.

Si apre la schermata Status.

Task di pulizia dell’unità

Nota – I task di pulizia dell’unità si applicano solo a unità gestite da host FC-SCSI 
collegati. Non si applicano, invece, a unità gestite da host HSC o ACSLS.
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▼ Configurare la pulizia automatica dell’unità
Utilizzare questa procedura per abilitare o disabilitare la funzione di pulizia automatica 
dell’unità. Se la libreria è partizionata, la pulizia automatica può essere abilitata o 
disabilitata per singole partizioni.

Nota – Questa procedura si applica solo a unità non gestite da host HSC o ACSLS. 
Per ulteriori informazioni sulla gestione della pulizia automatica consultare la 
documentazione sugli host HSC e ACSLS.

1. Selezionare Tools > System Detail, e scegliere la cartella della libreria nell’albero dei 
dispositivi.

2. Fare clic su Auto Clean e poi su Configure.

Si apre la schermata Configure Auto Clean.

3. Completare la sezione Auto Clean Configuration come segue:

■ Librerie non partizionate: selezionare “enable” nel popup Partition 1 (Or None). Gli 
altri popup possono essere lasciati come sono.

■ Librerie partizionate: selezionare “enable” in corrispondenza delle partizioni per le 
quali si desidera effettuare la pulizia automatica. Selezionare “disable” in 
corrispondenza di ciascuna partizione per la quale si desidera effettuare la pulizia 
manuale dell’unità.
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4. Nella sezione Auto Clean Configuration, specificare la soglia di avvertenza per 
ciascun tipo di cartuccia.

5. Fare clic su Apply.

▼ Inserire cartucce di pulizia o diagnostiche
Utilizzare questa procedura per inserire nuove cartucce di pulizia o diagnostiche nella 
libreria tramite una CAP.

Nota – Questa procedura si applica solo alle librerie non partizionate. 

Prima di cominciare questa procedura, verificare che siano soddisfatte tutte le seguenti 
condizioni:

■ Le celle prenotate richieste devono essere vuote.

■ Lo stato Prevent/Allow della CAP deve essere impostato su Allow (consultare il 
manuale SCSI Reference Manual per la sintassi).

■ La CAP non deve contenere cartucce dati.

Nota – Se la CAP si trova in modalità di inserimento automatico è andare direttamente 
al Passo 5.

1. Selezionare Tools > Diagnostics.
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2. Aprire la cartella CAP Folder, fare clic sulla CAP che si desidera utilizzare e fare di 
nuovo clic sulla scheda Access.

Si apre la schermata Access.

3. Nel menu a tendina Locked, fare clic su falso (“false”). Fare clic sul pulsante Apply.

Si apre il popup Confirm.

4. Fare clic su OK.

Il controller della libreria sblocca la porta della CAP e si accende il LED che segnala 
l’apertura della CAP.

5. Premere il pulsante CAP per aprire la CAP.

La porta della CAP si apre.

6. Posizionare le cartucce di pulizia o diagnostiche nella CAP.



Task di pulizia dell’unità

418605201 • Revisione: A Capitolo 3 Operazioni automatizzate della libreria SL3000 105

7. Premere il pulsante CAP per chiudere la CAP.

La CAP si chiude e si blocca automaticamente, e la luce sul pulsante CAP si spegne.

8. Spostare manualmente ogni cartuccia in una cella prenotata. Per istruzioni 
dettagliate, consultare la sezione “Spostare una cartuccia” a pagina 95.

Quando tutte le cartucce sono state spostate dalla CAP, la libreria rileva che la CAP è 
vuota e la CAP viene riportata allo stato predefinito.

Nota – Per un elenco delle cartucce di pulizia e dignostiche negli slot prenotati, 
consultare la sezione “Visualizzare le cartucce di pulizia” a pagina 107.

▼ Espellere le cartucce di pulizia o diagnostiche
Utilizzare questa prodecura per espellere le cartucce di pulizia o diagnostiche scadute 
tramite la CAP.

Nota – Questa procedura si applica solo alle librerie non partizionate. 

Nota – Prima di iniziare, verificare che tutti gli slot all’interno della CAP che si 
desidera utilizzare siano vuoti.

1. Spostare manualmente ogni cartuccia diagnostica o di pulizia che si desidera 
espellere da una cella riservata a una CAP. Per istruzioni dettagliate, consultare la 
sezione “Spostare una cartuccia” a pagina 95.

Nota – Per un elenco delle cartucce di pulizia e diagnostiche negli slot riservati, 
consultare la sezione “Visualizzare le cartucce di pulizia” a pagina 107.

2. Selezionare Tools > Diagnostics.
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3. Aprire la cartella CAP Folder, fare clic sulla CAP che si desidera utilizzare e fare di 
nuovo clic sulla scheda Access.

Si apre la schermata Access.

4. Nel menu a tendina Locked, fare clic su falso (“false”). Fare clic sul pulsante Apply.

Si apre il popup Confirm.

5. Fare clic su OK.

Il controller della libreria sblocca la porta della CAP e si accende il LED che segnala 
l’apertura della CAP.

6. Premere il pulsante CAP per aprire la CAP.

La porta della CAP si apre.

7. Rimuovere tutte le cartucce dalla CAP.
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Prestare attenzione quando si espellono le cartucce di pulizia scadute dalla libreria. Se 
si apre una CAP per spostare una cartuccia di pulizia scaduta, la cartuccia deve essere 
rimossa. Se infatti si chiude la CAP senza aver rimosso la cartuccia di pulizia, la TallBot 
reinserisce la cartuccia scaduta nella libreria e il controller della libreria reimposta il 
contatore d’utilizzo su 0. 

8. Premere il pulsante CAP per chiudere la CAP.

La CAP si chiude e si blocca automaticamente, e la luce sul pulsante CAP si spegne.

9. La TallBot controlla la CAP per verificare che sia vuota.

La CAP viene riportata allo stato predefinito.

▼ Visualizzare le cartucce di pulizia
1. Selezionare Tools > System Detail, e scegliere la cartella della libreria nell’albero dei 

dispositivi.
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2. Fare clic su Auto Clean e poi su Cleaning Cartridges.

L’elenco mostra le seguenti informazioni per ciascuna cartuccia di pulizia:

■ Posizione della cartuccia (slot di sistema)

■ VOLID

■ Conteggio utilizzi

■ Stato (OK, avvertenza, scaduto)

■ Tipo di cartuccia (per esempio, LTO, SDLT)

▼ Visualizzare lo stato di pulizia dell’unità
Utilizzare questa procedura per visualizzare l’attuale stato di pulizia di un’unità.

1. Selezionare Tools > System Detail.

2. Espandere la cartella Drive Folder e selezionare l’unità che si desidera visualizzare.

3. Fare clic su Status.

La schermata mostra le seguenti informazioni sullo stato di pulizia:

■ L’unità necessita un intervento di pulizia (Drive needs cleaning)

■ Ultima operazione di pulizia o di pulizia automatica dell’unità (Drive Last Cleaned 
or Drive Last Autocleaned)
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Nota – È possibile programmare la pulizia manuale di un’unità monitorando lo stato 
“Drive needs cleaning”.

▼ Pulire manualmente un’unità
Utilizzare questa procedura per pulire un’unità. La libreria SL3000 non offre una 
funzione di pulizia manuale dell’unità dedicata. È necessario installare manualmente 
una cartuccia di pulizia nell’unità.

È possibile avviare un’operazione di pulizia manuale in qualsiasi momento, anche se 
l’unità non lo richiede.

1. Visualizzare l’elenco delle cartucce da pulire. Per istruzioni dettagliate, consultare la 
sezione “Visualizzare le cartucce di pulizia” a pagina 107.

Poiché la libreria non può contenere più di un tipo di unità, verificare che le celle 
prenotate contengano le cartucce di pulizia adatte all’unità da pulire.

2. Spostare manualmente una cartuccia di pulizia da una cella riservata all’unità da 
pulire. Per istruzioni dettagliate, consultare la sezione “Spostare una cartuccia” a 
pagina 95.
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3. Visualizzare lo stato dell’operazione di pulizia sulla Drive Clean Status Console. Per 
istruzioni dettagliate, consultare la sezione “Visualizzare lo stato di pulizia dell’unità” 
a pagina 108.

4. Al completamento dell’operazione di pulizia, spostare di nuovo la cartuccia di 
pulizia dall’unità in una cella prenotata. Per istruzioni dettagliate, consultare la 
sezione “Spostare una cartuccia” a pagina 95.

Task di monitoraggio dell’alimentazione e 
del robot

▼ Visualizzare le informazioni riepilogative del 
robot
Utilizzare questa procedura per visualizzare le informazioni riepilogative per tutte le 
TallBotdella libreria.

Nota – Questa informazione è disponibile anche in Reports > Robot Summary. Per 
istruzioni dettagliate, consultare la sezione “Visualizzare il report di una libreria” a 
pagina 78.

1. Selezionare Tools > System Detail.
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Visualizzare le informazioni riepilogative del robot 110

Visualizzare lo stato del robot 111

Visualizzare le proprietà del robot 112

Visualizzare le informazioni riepilogative sull’alimentazione 113

Visualizzare i dettagli sugli alimentatori 114



Task di monitoraggio dell’alimentazione e del robot

418605201 • Revisione: A Capitolo 3 Operazioni automatizzate della libreria SL3000 111

2. Fare clic sulla cartella Robot Folder nell’albero dei dispositivi.

Si apre la schermata Robot Data.

▼ Visualizzare lo stato del robot
Utilizzare questa procedura per visualizzare l’attuale stato operativo di una TallBot.

Nota – Questa informazione è disponibile anche in Reports > Robot Details. Per 
istruzioni dettagliate, consultare la sezione “Visualizzare il report di una libreria” a 
pagina 78.

1. Selezionare Tools > System Detail.

2. Espandere la cartella Robot Folder e fare clic sul robot da visualizzare.
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3. Fare clic su Status.

La schermata mostra lo stato corrente della TallBot.

▼ Visualizzare le proprietà del robot
Mostra informazioni dettagliate sulla configurazione della TallBot, tra cui il numero di 
serie e gli attuali livelli del firmware.

Nota – Questa informazione è disponibile anche in Reports > Robot Details. Per 
istruzioni dettagliate, consultare la sezione “Visualizzare il report di una libreria” a 
pagina 78.

1. Selezionare Tools > System Detail.

2. Espandere la cartella Robot Folder e fare clic sul robot da visualizzare.
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3. Fare clic su Properties.

Si apre la schermata Robot Properties.

▼ Visualizzare le informazioni riepilogative 
sull’alimentazione 
La schermata Power Supply Data mostra le informazioni riepilogative di tutti gli 
alimentatori della libreria. Questa schermata può essere utilizzata per monitorare lo 
stato degli alimentatori.

Come impostazione predefinita, la schermata elenca gli alimentatori in base 
all’indirizzo interno. È tuttavia possibile modificare l’ordine e risistemare e 
ridimensionare le colonne. Consultare la sezione “Modificare il layout della schermata” 
a pagina 36.

1. Selezionare Tools > System Detail.

2. Nell’albero della libreria, fare clic su Power Supply Folder.
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3. Si apre la schermata Power Supply Data.

▼ Visualizzare i dettagli sugli alimentatori 
La schermata Power Supply Status mostra informazioni dettagliate dell’alimentatore 
selezionato. Questa schermata può essere utilizzare per stabilire se l’alimentatore deve 
essere riparato o sostituito.

1. Selezionare Tools > System Detail.

2. Nell’albero della libreria, espandere la cartella Power Supply Folder.

3. Fare clic sull’alimentatore che si desidera visualizzare.
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4. Si apre la schermata Power Supply Status.
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CAPITOLO 4

Licenza

L’utility di licenza consente si installare le funzionalità opzionali selezionate nella 
libreria SL3000. 

File con il codice di licenza
Il file contenente il codice di licenza può essere fornito all’utente nei seguenti modi:

■ Via e-mail da Sun Microsystems, Inc.

■ Installato dal Sun responsabile dell’assistenza tecnica

Il file con il codice di licenza è un file archivio Java (.jar) con firma digitale contenente 
uno o più codici di licenza per le funzionalità acquistate. Per garantire che le 
funzionalità vengano installate nella libreria corretta, il file con il codice di licenza 
include il numero di serie della libreria target e può essere installato solo in quella 
libreria. 

Tutte le funzionalità della libreria SL3000 concesse in licenza acquistate per una libreria 
sono incluse in un unico file di licenza. 

Attenzione – Quando si installa un nuovo file di licenza, tutte le licenze installate in 
precedenza nella libreria vengono sovrascritte. Per questa ragione, è importante 
esaminare i. contenuto di un nuovo file di licenza prima di installarlo, in modo da 
verificare che contenga tutte le funzionalità acquistate durante il ciclo di vita della 
libreria. Nel caso in cui il nuovo file non contenesse tutte le funzionalità acquistate, 
installandolo si potrebbero eliminare le funzionalità precedentemente installate. Se un 
file con il codice di licenza non risulta corretto, è necessario richiederne uno nuovo al 
Sun responsabile dell’assistenza tecnica. 
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Scadenza delle licenze

Nota – La maggior parte delle licenze SL3000 non scade. L’unica licenza che scade è 
quella relativa al servizio. 

Per quanto riguarda le licenze con scadenza, è importante gestire le scadenze in modo 
da evitare perdite accidentali di funzioni e funzionalità.

Per visualizzare le date di scadenza e il tempo rimanente, consultare la schermata 
License Management > Current License. 

Quando una licenza sta per scadere il controller della libreria invia dei messaggi al log 
degli eventi della SL Console. Per visualizzarli, utilizzare l’opzione del menu 
Tools > Reports. Per esempio, se una licenza di servizio scade tra 30 giorni, ogni 12 ore 
viene inviato un messaggio di informazione, mentre se la licenza scade fra meno di 
10 giorni, ogni 12 ore viene inviato un messaggio di avvertenza. 

Task di licenza 
Questa sezione fornisce istruzioni dettagliate su tutti i task coinvolti durante 
l’installazione e la gestione delle licenze della libreria. 

Processo di installazione della licenza
Di seguito è riportato un riepilogo delle operazioni di installazione della licenza. È 
possibile eventualmente far eseguire tali operazioni dal Sun responsabile dell’assistenza 
tecnica. 

1. Acquisto di una o più funzionalità per una libreria Sun StorageTek specifica da Sun 
Microsystems, Inc. 

2. Sun invia un messaggio di posta elettronica- con in allegato un file con il codice di 
licenza. 

3. Download del file con il codice di licenza in un sistema accessibile da SL Console.

4. Utilizzo della SL Console per visualizzare e verificare i contenuti del file con il 
codice di licenza. 

5. Utilizzo della SL Console per installare il file con il codice di licenza sulla libreria 
target. 

6. Per ulteriori informazioni su come implementare specifiche funzionalità concesse in 
licenza, consultare i seguenti argomenti:

■ “Capacity on Demand” a pagina 135

■ “Partizionamento della libraria” a pagina 173
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Riepilogo del task di licenza

▼ Ricezione di un nuovo file con il codice di licenza
Utilizzare la seguente procedura per ricevere un file con il codice di licenza per 
funzionalità destinate a una specifica libreria Sun StorageTek. 

Nota – Questa procedura non è eseguita dalla SL Console. 

1. Acquisto di una o più funzionalità da Sun Microsystems, Inc. 

Per assistenza, contattare il Sun responsabile dell’assistenza tecnica. 

2. Ricezione del file con il codice di licenza da Sun tramite posta elettronica. 

Di seguito sono riportati alcuni esempi dell’intestazione del messaggio- di posta: 
Oggetto: SL3000 License Key CR6636975 
Data: Wed, 05 Dec 2007 19:24:41 -0700 (MST) 
Da: siks-devoffshore@sun.com

3. Download del file con il codice di licenza in un sistema accessibile dalla SL Console.

Salvare gli allegati secondo le modalità standard. 

▼ Visualizzazione e verifica dei contenuti della 
licenza
Utilizzare questa procedura per visualizzare un nuovo file contenente il codice di 
licenza prima di installarlo su una libreria target. 

Prima di eseguire i seguenti passaggi, è necessario scaricare un nuovo file di licenza su 
un sistema accessibile dalla SL Console. Consultare la sezione “Ricezione di un nuovo 
file con il codice di licenza” a pagina 119. 

1. Utilizzare la SL Console per connettersi alla libreria target. 

Per informazioni, consultare la sezione “Accedere a SL Console” a pagina 33. 
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2. Selezionare Tools > License Management, e fare clic sulla scheda Install License. 

Si apre la schermata Install License.

3. Nel campo File Name, inserire il percorso completo del file con il codice di licenza 
da visualizzare, e premere Invio. In alternativa, fare clic su Browse e cercare la 
posizione del file. 

Nella parte inferiore della schermata vengono visualizzati i dettagli del file di licenza. 

Nota – Se il numero di serie della libreria, specificato nel file contenente il codice di 
licenza, non corrisponde a quello utilizzato per accedere alla libreria, compare un 
messaggio di avvertenza e i dettali su tale file non vengono visualizzati. 
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4. Controllare le informazioni presenti nel file e fare clic su Compare. 

Si apre il popup Compare Licenses. 

5. Controllare le informazioni della licenza.

Nota – Le modifiche che verranno implementate installando il nuovo file di licenza, 
come date di scadenza diverse o funzionalità che verranno rimosse, sono evidenziate in 
rosso. 

In caso di problemi con il nuovo file di licenza, contattare il Sun responsabile 
dell’assistenza tecnica per risolverli prima di installare il file nella libreria target. 

Attenzione – Una volta installato un nuovo file di licenza non è possibile ripristinare 
lo stato precedente. 

6. Fare clic su OK per chiudere il popup. 

▼ Installazione di una nuova licenza in una libreria 
target
Utilizzare questa procedura per installare un nuovo file contenente il codice di licenza 
in una libreria target. 
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Prima di eseguire i seguenti passaggi, è necessario scaricare un nuovo file di licenza su 
un sistema accessibile dalla SL Console. Consultare la sezione “Ricezione di un nuovo 
file con il codice di licenza” a pagina 119. 

1. Utilizzare la SL Console per connettersi alla libreria target. 

Per informazioni, consultare la sezione “Accedere a SL Console” a pagina 33. 

2. Selezionare Tools > License Management, e fare clic sulla scheda Install License. 

Si apre la schermata Install License.

3. Nel campo File Name, inserire il percorso completo del file con il codice di licenza 
da installare, e premere Invio. In alternativa, fare clic su Browse e cercare la 
posizione del file.

Nella parte inferiore della schermata vengono visualizzati i dettagli del file di licenza. 
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Nota – Se il numero di serie della libreria, specificato nel file contenente il codice di 
licenza, non corrisponde a quello utilizzato per accedere alla libreria, compare un 
messaggio di avvertenza e i dettali su tale file non vengono visualizzati. 

4. Controllare le informazioni del file di licenza e fare clic su Install nella barra delle 
opzioni. 

Si apre il popup License Installation Warning.

5. Esaminare le funzionalità che verranno installate e verificare che il nuovo file di 
licenza sia corretto. 

Nota – Le modifiche che verranno implementate installando il nuovo file di licenza, 
come date di scadenza diverse o funzionalità che verranno rimosse, sono evidenziate in 
rosso. 

In caso di problemi con il nuovo file, fare clic su No per annullare l’installazione. Per 
risolvere i problemi prima di procedere all’installazione, consultare il Sun responsabile 
dell’assistenza tecnica. 

Attenzione – Una volta installato un nuovo file di licenza non è possibile ripristinare 
lo stato precedente. 

6. Se il nuovo file di licenza è corretto, fare clic su Yesper installarlo nella libreria 
target. 
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7. Il controller della libreria verifica il file di licenza e procede come segue:

■ In assenza di problemi, vengono installate le funzionalità incluse nel file. 

■ Se il nuovo file di licenza è precedente rispetto a quello attualmente installato sulla 
libreria, si apre il seguente popup e la nuova licenza non viene installata. 

8. A seconda delle funzionalità incluse nel file di licenza, può essere necessario 
eseguire ulteriori task per poter utilizzare le nuove funzionalità. 

■ Per informazioni approfondite su come agire quando si installa un file di licenza che 
modifica la funzionalità coperte da licenza della libreria, consultare le sezioni 
“Aumentare la capacità concessa in licenza” a pagina 138 e “Diminuire la capacità 
concessa in licenza” a pagina 139.

■ Per informazioni approfondite su come agire quando si installa un file di licenza con 
la funzionalità di partizionamento, consultare la sezione “Installare la funzionalità di 
partizionamento” a pagina 174. 

▼ Visualizzazione della licenza attuale della libreria 
Utilizzare questa procedura per visualizzare le funzionalità attualmente installate nella 
libreria alla quale si è connessi. 
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1. Selezionare Tools > License Management, e fare clic sulla scheda Current License. 

Si apre la schermata Current License, in cui vengono indicate le funzionalità 
attualmente installate. 

Riferimento alle schermate delle licenze
In questa sezione vengono elencate descrizioni dettagliate per tutte le schermate 
relative alle licenze della SL Console, organizzate per percorso di navigazione. Ad 
esempio, License Management—Install License—Compare indica la schermata a cui si 
accede facendo clic su Tools, quindi License Management dalla barra dei menu, clic 
sulla scheda Install License e infine sul pulsante Compare. 
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Nota – È possibile accedere alle schermate relative alle licenza solo dalla SL Console 
standalone o dalla SL Console via Web. Non sono disponibili dal pannello operatore 
locale. 

License Management > Current License

Schermata di esempio

Schermata Pagina

License Management > Current License 126

License Management > Install License 128

License Management > Install License—Compare 131

License Management > Install License—Install 133
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Descrizione
Visualizza i contenuti del file con il codice della licenza attualmente installato nella 
libreria alla quale si è connessi. 

Il layout e la visualizzazione di questa schermata possono essere modificati. Per 
informazioni, consultare la sezione “Modificare il layout della schermata” a pagina 36. 

Campi della schermata
Feature 

Sola visualizzazione.

Nome della funzionalità installata nella libreria. 

Expiration 

Sola visualizzazione.

Numero di giorni alla scadenza della funzionalità o da quando è scaduta. Se non vi 
è una data di scadenza, il campo visualizza “noExpiration.” 

Value 

Sola visualizzazione.

Dettagli della funzionalità, se presenti. Per esempio, nel caso della funzionalità di 
capacità su richiesta (Capacity on Demand), questo campo mostra la capacità totale 
fornita dalla licenza. A seconda della funzionalità, il campo può essere vuoto. 

Time Remaining

Sola visualizzazione.

Il tempo che manca alla scadenza della funzionalità. Se non vi è una data di 
scadenza, il campo resta vuoto. 

Pulsanti
Refresh

Fare clic per aggiornare la visualizzazione con i dati correnti del database del 
controller della libreria. 

? (Help) 

Fare clic per visualizzare la guida in linea relativa alla schermata. 

Consultare anche
■ License Management > Install License 
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License Management > Install License

Schermata di esempio

Descrizione
Consente di visualizzare i contenuti di un nuovo file contenente il codice di licenza. 

Include anche i pulsanti che consentono di avviare tutte le seguenti attività:

■ Confronta il nuovo file di licenza con quello attualmente installato nella libreria. 

■ Installa il nuovo file di licenza nella libreria. 

Il layout e la visualizzazione di questa schermata possono essere modificati. Per 
informazioni, consultare la sezione “Modificare il layout della schermata” a pagina 36. 
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Campi della schermata
File Name

Necessario.

Immettere il percorso completo del file di licenza che si desidera installare nella 
libreria. In alternativa, fare clic su Browse e cercare la posizione del file. Il file deve 
essere posizionato in un sistema accessibile alla SL Console e il numero di serie 
specificato nel file deve corrispondere a quello della libreria alla quale si è connessi. 

Product

Sola visualizzazione.

Il tipo di libreria al quale è destinato il file di licenza. Per esempio, SL3000, SL8500, 
SL500. 

Serial Number

Sola visualizzazione.

Il numero di serie della libreria alla quale è destinato il file di licenza. Deve 
corrispondere al numero di serie della libreria al quale si è connessi affinché il file di 
licenza sia valido per questa libreria. 

Generated On

Sola visualizzazione.

La data in cui il file di licenza è stato creato. 

Comment Line 1

Sola visualizzazione.

Commento opzionale riguardante il file di licenza, di Sun Microsystems, Inc. 

Comment Line 2

Sola visualizzazione.

Commento opzionale riguardante il file di licenza, di Sun Microsystems, Inc. 

Feature

Sola visualizzazione.

Nome di una funzionalità inclusa nel file di licenza.

Expiration

Sola visualizzazione.

Numero di giorni alla scadenza della funzionalità. Se non vi è una data di scadenza, 
il campo visualizza “noExpiration.” 

Value 

Sola visualizzazione.

Dettagli della funzionalità, se presenti. Per esempio, nel caso della funzionalità 
relativa alla capacità (Capacity), questo campo mostra la capacità totale fornita dalla 
licenza. A seconda della funzionalità, il campo può essere vuoto. 



Riferimento alle schermate delle licenze

130 Manuale dell’utente di SL3000 • Aprile 2008 Revisione: A • 418605201

Pulsanti
Install

Fare clic su questo pulsante per installare il file contenente il codice della licenza 
visualizzato nella libreria alla quale si è connessi. Si apre il popup License 
Management > Install License—Install. 

Browse

Fare clic su questo pulsante per cercare il file di licenza che si desidera visualizzare e 
installare. 

Nota – Se il numero di serie della libreria, specificato nel file contenente il codice di 
licenza, non corrisponde a quello utilizzato per accedere alla libreria, compare un 
messaggio di avvertenza e i dettali su tale file non vengono visualizzati. 

Compare

Fare clic su questo tasto per confrontare il nuovo file di licenza con quello 
attualmente installato nella libreria. Si apre il popup License Management > Install 
License—Compare. 

? (Help) 

Fare clic per visualizzare la guida in linea relativa alla schermata. 

Consultare anche
■ License Management > Current License 

■ License Management > Install License—Compare 

■ License Management > Install License—Install 



Riferimento alle schermate delle licenze

418605201 • Revisione: A Capitolo 4 Licenza 131

License Management > Install License—Compare 

Schermata di esempio

Descrizione
Consente di confrontare le seguenti informazioni relative alla licenza: 

■ Le funzionalità attualmente installate nella libreria alla quale si è connessi. 

■ Le funzionalità incluse nel nuovo file di licenza specificato nella schermata License 
Management > Install License. 

Nota – Le modifiche che verranno implementate installando il nuovo file di licenza, 
come date di scadenza diverse o funzionalità che verranno rimosse, sono evidenziate in 
rosso. 

Questa schermata è un popup che si apre quando si seleziona Compare nella schermata 
License Management > Install License. 
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Campi della schermata
Current Features

Sola visualizzazione.

Elenco di funzionalità, date di scadenza e valori attualmente installati nella libreria 
alla quale si è connessi. 

Features to be Installed

Sola visualizzazione.

Lista di funzionalità, date di scadenza e valori di tutte le funzionalità incluse nel 
nuovo file di licenza specificato. Le modifiche che verranno implementate 
installando il nuovo file di licenza, come date di scadenza diverse o funzionalità che 
verranno rimosse, sono evidenziate in rosso. 

Pulsanti
OK

Fare clic per abbandonare il popup e tornare alla schermata precedente. 

Consultare anche
■ License Management > Install License 

■ License Management > Install License—Install 
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License Management > Install License—Install 

Schermata di esempio

Descrizione
Consente di confrontare le seguenti informazioni relative alla licenza: 

■ Le funzionalità attualmente installate nella libreria alla quale si è connessi. 

■ Le funzionalità incluse nel nuovo file di licenza specificato nella schermata License 
Management > Install License. 

Se l’installazione del nuovo file contenente il codice di licenza comporta la rimozione di 
funzionalità dalla libreria, compaiono dei messaggi di avviso. 

Dopo aver confrontato le informazioni della licenza, è possibile installare il nuovo file 
di licenza nella libreria facendo clic sul pulsante Yes. 

Attenzione – Si raccomanda di verificare la correttezza del nuovo file di licenza prima 
di installarlo, poiché non è possibile ripristinare le funzioni rimosse. 

Questa schermata è un popup che si apre quando si seleziona Install nella schermata 
License Management > Install License. 

A seconda delle funzionalità incluse nel file di licenza, può essere necessario eseguire 
ulteriori task per poter utilizzare le nuove funzionalità.
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■ Per informazioni approfondite su come agire quando si installa un file di licenza che 
modifica la funzionalità coperte da licenza della libreria, consultare le sezioni 
“Aumentare la capacità concessa in licenza” a pagina 138 e “Diminuire la capacità 
concessa in licenza” a pagina 139.

■ Per informazioni approfondite su come agire quando si installa un file di licenza con 
la funzionalità di partizionamento, consultare la sezione “Installare la funzionalità di 
partizionamento” a pagina 174. 

Campi della schermata
Current Features

Sola visualizzazione.

Elenco di funzionalità, date di scadenza e valori attualmente installati nella libreria 
alla quale si è connessi. 

Features to be Installed

Sola visualizzazione.

Lista di funzionalità, date di scadenza e valori di tutte le funzionalità incluse nel 
nuovo file di licenza specificato. Se l’installazione del file contenente il codice di 
licenza comporta la rimozione di funzionalità dalla libreria, compaiono dei messaggi 
di avviso. 

Pulsanti
Yes

Fare clic per installare il file di licenza specificato nella libreria. Il controller della 
libreria verifica la validità del file di licenza e lo installa. 

No 

Fare clic per annullare l’aggiornamento e tornare alla schermata precedente. 

Consultare anche
■ License Management > Install License 

■ License Management > Install License—Compare 
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CAPITOLO 5

Capacity on Demand

La libreria SL3000 include le funzionalità RealTimeGrowth™ e Capacity on Demand. 
RealTimeGrowth consente di installare capacità di storage fisica aggiuntiva oltre a 
quella corrente. Capacity on Demand separa la capacità fisica da quella concessa in 
licenza e consente di pagare solo la capacità necessaria. Con l’aumentare delle esigenze 
di storage è quindi possibile espandere la capacità con un impatto minimo 
sull’operatività della libreria. Per attivare la capacità aggiuntiva basta acquistare e 
installare un file contenente il codice di licenza relativo alla nuova capacità.

Nota – La capacità di storage della libreria deve essere installata tramite l’utility in 
licenza della libreria SL3000. Consultare Capitolo 4, “Licenza” per informazioni. 

Nota – Questa funzionalità controlla solo le celle di storage delle cartucce. Come 
impostazione predefinita, le CAP e le unità nastro installate sono attive. 

Funzionalità e limiti di Capacity on 
Demand 
In questa sezione vengono descritte importanti funzionalità nonché limiti della 
Capacity on Demand che aiuteranno per la sua pianificazione e il suo utilizzo nella 
libreria SL3000. 

■ La capacità minima concessa in licenza è di 200 celle di storage.

■ La capacità massima concessa in licenza è pari alla capacità fisica della libreria, 
ovvero 5821 celle. 

■ È possibile acquistare capacità concessa in licenza aggiuntiva a multipli di 1, 100, 
200, 500 o 1000 celle. 

■ L’installazione di capacità concessa in licenza aggiuntiva ha un impatto minimo 
sull’operatività della libreria. Una volta esaminate dal controller della libreria, le 
celle di storage aggiuntive sono immediatamente disponibili; non è necessario 
riavviare la libreria. La libreria interrompe temporaneamente tutte le connessioni 
agli host, ma saranno poi automaticamente ripristinate. 

■ La capacità di storage corrente concessa in licenza di una libreria è quella riportata 
nel file di licenza installato più di recente. 
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Terminologia
I seguenti termini vengono utilizzati per descrivere la gestione della capacità della 
libreria:

■ Capacità fisica o installata: il numero di celle di storage presenti fisicamente nella 
libreria.

■ Capacità in licenza: il numero di celle di storage concesse in licenza alla libreria. Il 
numero non può superare la capacità installata. 

■ Capacità attiva: il numero di celle di storage attive concesse in licenza. Questo valore 
corrisponde alla capacità concessa in licenza. È possibile eventualmente disattivare le 
celle di storage selezionate, rendendo il valore inferiore alla capacità concessa in 
licenza. 

■ Regione di storage attiva: un’area rettangolare di celle di storage attive. Una regione 
di storage attiva può essere composta da una singola cella di storage o dall’intera 
capacità concessa in licenza alla libreria. 

■ Cella attiva: una cella di storage attiva. Solo le celle attive possono essere utilizzate 
per immagazzinare le cartucce.

■ Cella non attiva: una cella di storage che è stata esplicitamente disattivata e che 
quindi non può essere utilizzata per immagazzinare le cartucce. 

■ Celle selezionate: una cella di storage non attualmente attiva che verrà attivata 
automaticamente dal controller della libreria quando la capacità concessa in licenza 
viene aumentata. 

Configurazione della regione di storage 
attiva 
Le regioni di storage attive possono essere assegnate automaticamente dal controller 
della libreria o manualmente dall’utente. L’assegnazione automatica da parte del 
controller assicura una crescita bilanciata dei moduli della libreria

Una singola cella di storage può essere in uno dei seguenti stati:

■ Active: la cella può essere utilizzata per immagazzinare le cartucce. 

■ Inactive: la cella è stata disattivata e non può essere utilizzata per immagazzinare le 
cartucce. È possibile monitorare la cella nelle schermate e nei report della libreria, ma 
il controller rifiuta le richieste di spostamento delle cartucce in quella cella. 

■ Selected: la cella non è attualmente attiva, ma verrà attivata automaticamente dal 
controller della libreria quando la capacità concessa in licenza viene aumentata. 
Questo stato si applica solo alle librerie non partizionate. 

Solo le celle di storage attive possono essere utilizzate per immagazzinare le cartucce 
nastro. Le celle di storage inattive non possono essere utilizzate per immagazzinare le 
cartucce né essere raggiunte da alcun host. 
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Regole di attivazione della cella
Il controller della libreria utilizza le seguenti regole quando aggiunge delle celle alle 
regioni di storage attive:

■ L’attivazione della cella comincia dalla parte posteriore, superiore sinistra della 
regione di storage attiva e si sposta in direzione della parte anteriore, inferiore 
destra. 

■ Tutte le celle all’interno di una colonna vengono attivate dall’alto verso il basso 
prima di spostarsi nella colonna successiva. 

■ Le colonne all’interno di un pannello vengono attivate da sinistra a destra. 

Librerie non partizionate
All’interno di una libreria non partizionata, il controller della libreria seleziona 
automaticamente tutte le celle fisiche ma ne attiva solo alcune, fino ad arrivare al 
numero totale della capacità della libreria concessa in licenza. Le celle selezionate che 
non possono essere attivate per limiti di capacità rimangono selezionate e saranno 
attivate automaticamente una volta installata ulteriore capacità.

Il controller attiva le celle partendo dal retro della libreria con il modulo all’estrema 
sinistra e procedendo verso destra. Quindi si sposta sulla parte anteriore, cominciando 
dal modulo all’estrema sinistra e procedendo verso destra. 

Per ottimizzare il posizionamento delle cartucce è possibile eventualmente scegliere 
delle regioni di storage all’interno della libreria nelle quali far applicare dal controller le 
regole indicate sopra. 

Librerie partizionate 
Nelle librerie partizionate, il numero totale delle celle di storage allocate a tutte le 
partizioni della libreria non deve superare la capacità della libreria concessa in licenza.

Nelle librerie partizionate, non esiste una regione di storage attiva predefinita. È 
necessario assegnare le celle di storage alle partizioni in modo esplicito, configurando le 
regioni di storage attive per ogni partizione. Consultare “Processo di partizionamento” 
a pagina 185 per informazioni. 

Quando si posizionano le cartucce nelle celle di storage, il controller della libreria 
applica le regole di attivazione della cella predefinita per ogni singola partizione. 
Consultare “Regole di attivazione della cella” a pagina 137 per informazioni. 

Disattivare la capacità di storage 
È possibile ridurre eventualmente le dimensioni di una regione di storage attiva 
disattivando alcune celle di storage. Se le cartucce restano isolate a causa della 
riduzione della capacità viene visualizzato un messaggio di avvertenza.
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Cartucceisolatein librerie non partizionate

Nota – Per informazioni sulle cartucce isolate nelle librerie partizionate, consultare 
“Cartucce isolate in librerie partizionate” a pagina 184. 

Nelle librerie non partizionate, si considera isolata una cartuccia posizionata all’interno 
di celle di storage non attive. Le cartucce isolate non sono accessibili a tutti gli host. 

Sono vari i motivi alla base di una cartuccia isolata. Di seguito sono elencate le possibili 
cause:

■ È stata ridotta la capacità di storage attiva.

■ La cartuccia è stata spostata manualmente in una cella non attiva o non accessibile. 

Se la SL Console individua una cartuccia isolata, viene visualizzato un messaggio di 
avvertenza. Optare quindi per una delle seguenti soluzioni per correggere e posizionare 
la cartuccia isolata:

■ Generare un report sulle cartucce isolate. 

■ Eseguire un controllo della libreria. 

■ Eseguire uno spostamento correttivo su una cartuccia. 

Per istruzioni dettagliate sul controllo e la correzione di cartucce isolate, seguire le 
procedure seguenti:

■ “Visualizzare il report di una regione di storage attiva” a pagina 147

■ “Confermare le modifiche della regione di storage attiva” a pagina 145

Aumentare la capacità concessa in licenza
Dopo aver installato una licenza che fornisce capacità aggiuntiva, sono necessarie le 
seguenti importanti considerazioni. Per informazioni sull’installazione dei file di 
licenza, consultare il Capitolo 4, “Licenza” a pagina 117. 

■ La nuova capacità della libreria è pari alla capacità specificata nel file di licenza 
installato di recente. 

■ Per cominciare a utilizzare la nuova capacità non serve riavviare la libreria, ma è 
necessario configurare tutte le applicazioni host della libreria interessate per 
riconoscere la nuova capacità. Per ulteriori informazioni, consultare la sezione 
“Notifica da parte dell’host delle modifiche della capacità” a pagina 139. 

■ Se la nuova capacità supera la capacità fisica viene visualizzato un messaggio di 
avvertenza. Non sono necessarie azioni correttive. 

■ Se la libreria non è partizionata, il controller attiva automaticamente le celle che non 
sono state esplicitamente disattivate in precedenza dall’utente. In tal caso, per 
rendere disponibile la nuova capacità in licenza non è necessario l’intervento 
dell’utente. Se le celle sono state disattivate, tuttavia, può essere necessario 
selezionare manualmente le celle per poter cominciare a usare la capacità aggiuntiva. 

■ Se la libreria è partizionata, la nuova capacità viene aggiunta sottoforma di celle non 
allocate. Per poter cominciare a utilizzare le celle è necessario allocare manualmente 
nuove celle di storage alle partizioni; per ulteriori informazioni, consultare la sezione 
“Progettare una partizione” a pagina 191. 



Diminuire la capacità concessa in licenza

418605201 • Revisione: A Capitolo 5 Capacity on Demand 139

Diminuire la capacità concessa in licenza
Dopo aver installato una licenza che riduce la capacità, sono necessarie le seguenti 
importanti considerazioni. Per informazioni sull’installazione dei file di licenza, 
consultare il Capitolo 4, “Licenza” a pagina 117.

Nota – L’installazione di capacità ridotta è una situazione eccezionale; assicurarsi di 
voler ottenere proprio questo risultato prima di installare il file di licenza. 

■ Se in seguito alla riduzione della capacità vengono isolate delle cartucce compare un 
messaggio di avvertenza. 

■ Per le librerie non partizionate:

■ La nuova capacità ridotta ha immediatamente effetto. 

■ Il controller della libreria disattiva le celle in ordine inverso rispetto alla loro 
attivazione: le celle attivate più di recente vengono disattivate per prime. 

■ Per le librerie partizionate:

■ Se il numero totale di celle allocate a tutte le partizioni supera la nuova capacità 
concessa in licenza, la libreria viene automaticamente messa offline. È necessario 
disallocare manualmente le celle dalle partizioni in modo che l’allocazione 
complessiva non superi la nuova capacità concessa in licenza.

■ Se il numero totale di celle allocate a tutte le partizioni è ancora inferiore rispetto 
a quello della nuova capacità concessa in licenza, la nuova capacità ridotta ha 
subito effetto, senza bisogno di modificare le allocazioni della partizione. La 
libreria continua la sua attività senza interruzioni. 

Notifica da parte dell’host delle modifiche 
della capacità 
Quando viene aggiunta o rimossa la capacità di storage, il controller della libreria 
informa tutti gli host interessati in base ai requisiti dell’interfaccia: 

■ Gli host FC-SCSI ricevono la notifica tramite una richiesta di ripristino LUN. L’host 
deve effettuare un nuovo controllo della libreria per determinare le modifiche della 
configurazione.

■ Gli host HLI vengono informati tramite un messaggio asincrono. L’host può quindi 
inviare al controller la richiesta della nuova configurazione. 

Per le procedure e i comandi, consultare la documentazione del software di gestione 
nastri.



Task di gestione della capacità

140 Manuale dell’utente di SL3000 • Aprile 2008 Revisione: A • 418605201

Attenzione – Per questi motivi, si consiglia di non mettere la libreria a disposizione di 
altri utenti finché non si confermano le modifiche apportate alla regione di storage 
attiva.   
 
Non esiste una convalida in tempo reale dei limiti della partizione rispetto al database 
del controller della libreria. Quindi, se la libreria viene resa disponibile e altri utenti 
muovono le cartucce o apportano modifiche alla configurazione della libreria, si 
potrebbe assistere a conflitti di configurazione. Per informazioni, consultare la sezione 
“Sincronizzare la visualizzazione con il database del controller” a pagina 35.  
 
In fase di modifiche alle regioni di storage attive, la libreria interrompe 
temporaneamente tutte le connessioni agli host HSC o ACSLS. Le connessioni agli host 
saranno poi automaticamente ripristinate. Verrà tuttavia visualizzata una serie di 
messaggi di errore e potrebbe essere impossibile concludere i task in corso per la 
gestione delle cartucce. 

Task di gestione della capacità 
Questa sezione fornisce istruzioni dettagliate su tutti i task coinvolti durante 
l’implementazione e la gestione della capacità di storage nella libreria. 

Processo di installazione della capacità di storage
Di seguito è riportato un riepilogo del processo utilizzato per installare la nuova 
capacità di storage della libreria. 

1. Acquisto e installazione di una licenza relativa alla capacità. Per ulteriori 
informazioni, consultare la sezione “Processo di installazione della licenza” a 
pagina 118. 

2. La nuova capacità concessa in licenza è immediatamente disponibile. Non è 
necessario riavviare la libreria. 

3. Nelle librerie non partizionate, tutte le celle appena attivate sono immediatamente 
disponibili. Procedere come segue:

■ Se si desidera utilizzare la configurazione della regione di storage predefinita 
assegnata dal controller della libreria, è necessario configurare tutte le 
applicazioni host interessate in modo da renderle in grado di riconoscere le nuove 
regioni di storage. Per ulteriori informazioni, consultare la sezione “Notifica da 
parte dell’host delle modifiche della capacità” a pagina 139. 

■ Per modificare la configurazione della regione di storage predefinita, consultare la 
sezione “Definire le regioni di storage attive” a pagina 142. 

4. Nelle librerie partizionate, tutte le celle appena attivate vengono aggiunte come celle 
non allocate e non sono quindi disponibili. È necessario allocare manualmente le 
nuove celle alle partizioni. Per istruzioni dettagliate, consultare la sezione “Processo 
di partizionamento” a pagina 185. 
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SL Console Area di lavoro della regione di storage 
attiva
La schermata Select Active Cells e tutti i popup correlati forniscono un’area di lavoro 
dinamica per personalizzare la configurazione della capacità concessa in licenza. Tutte 
le informazioni relative alla configurazione della capacità concessa in licenza vengono 
automaticamente salvate nell’area di lavoro della regione di storage attiva della 
SL Console e conservate per la durata della sessione della SL Console. È quindi 
possibile visualizzare le varie regioni di storage attive e abbandonare nonché ritornare 
alle schermate Select Active Cells tutte le volte necessarie senza perdere le modifiche 
alla configurazione.

Le informazioni nell’area di lavoro relativa alla regione di storage attiva della 
SL Console vengono salvate nel database del controller della libreria premendo il 
pulsante Apply nella schermata Select Active Cells > Select Active Cells. Queste 
informazioni andranno perse qualora si verifichi una delle seguenti situazioni prima di 
aver eseguito gli aggiornamenti: 

■ Ci si disconnette attivamente dalla sessione della SL Console.

■ La sessione della SL Console scade o la connessione alla libreria è interrotta. 

■ Si aggiorna attivamente l’area di lavoro della regione di storage attiva dal database 
del controller della libreria corrente. Ciò avviene premendo il tasto Refresh nella 
schermata Select Active Cells. 

Attenzione – Per questi motivi, si consiglia di non mettere la libreria a disposizione di 
altri utenti finché non si confermano le modifiche apportate alla regione di storage 
attiva.   
 
Non esiste una convalida in tempo reale dei limiti della partizione rispetto al database 
del controller della libreria. Quindi, se la libreria viene resa disponibile e altri utenti 
muovono le cartucce o apportano modifiche alla configurazione della libreria, si 
potrebbe assistere a conflitti di configurazione. Per informazioni, consultare la sezione 
“Sincronizzare la visualizzazione con il database del controller” a pagina 35.  
 
In fase di modifiche alle regioni di storage attive, la libreria interrompe 
temporaneamente tutte le connessioni agli host HSC o ACSLS. Le connessioni agli host 
saranno poi automaticamente ripristinate. Verrà tuttavia visualizzata una serie di 
messaggi di errore e potrebbe essere impossibile concludere i task in corso per la 
gestione delle cartucce. 
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Task di gestione della capacità 

Nota – Questi task si applicano solo alle librerie non partizionate. Per istruzioni 
dettagliate sulla configurazione delle regioni di storage nelle librerie partizionate, 
consultare la sezione “Processo di partizionamento” a pagina 185. 

▼ Definire le regioni di storage attive 

Nota – Per informazioni sull’installazione di capacità concessa in licenza, consultare la 
sezione “Processo di installazione della licenza” a pagina 118. 

Quando si installa capacità concessa in licenza aggiuntiva, il controller della libreria 
attiva automaticamente il numero di celle di storage corrispondente alla capacità 
concessa in licenza. Quando sceglie le celle da attivare utilizza un gruppo di regole 
interne. Per ulteriori informazioni, consultare la sezione “Configurazione della regione 
di storage attiva” a pagina 136. 

Utilizzare questa procedura solo se si desidera eseguire una delle seguenti operazioni:

■ Personalizzare le regioni di storage attive in modo che siano diverse dalla 
configurazione predefinita assegnata dal controller della libreria. Per esempio, è 
possibile configurare le celle di storage attive in modo da concentrare le cartucce 
intorno alle unità e da lasciare le estremità della libreria libere per una espansione 
futura. 

■ Disattivare le celle di storage in modo che il numero totale di celle attive sia inferiore 
alla capacità concessa in licenza. 

■ Deselezionare le celle di storage in modo che non vengano automaticamente attivate 
quando la capacità concessa in licenza della libreria viene aumentata. 

Nota – Se si desidera utilizzare la configurazione della regione di storage predefinita 
dal controller della libreria, non è necessario utilizzare questa procedura. 

Task Pagina

Definire le regioni di storage attive 142

Confermare le modifiche della regione di storage attiva 145

Visualizzare il report di una regione di storage attiva 147

Stampare i dati del report di una regione di storage attiva 149

Salvare i dati del report di una regione di storage attiva 150
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1. Selezionare Tools > Select Active Cells. 

Si apre la schermata Module Map.

2. Fare clic sul modulo per il quale si desidera definire le regioni di storage attive. 

3. Fare clic sulla scheda Select Active Cells.

Si apre la schermata Select Active Cells, in cui è visualizzata la configurazione corrente 
del modulo selezionato.
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Nota – La prima volta che compare questa schermata, il numero di celle selezionate è 
uguale alla capacità fisica della libreria e il numero di celle attive è uguale alla capacità 
complessiva concessa in licenza della libreria. 

Nota – Fare clic sui pulsanti Move Left o Move Right per visualizzare un modulo 
direttamente adiacente a quello attualmente visualizzato. 

4. Scegliere il metodo Selected by e fare clic sul pulsante di scelta Add o Remove.

5. Utilizzare la mappa della libreria per selezionare le celle di storage da attivare o 
disattivare. 

Nota – Per ulteriori istruzioni sull’utilizzo della mappa della libreria, consultare 
“Select Active Cells > Select Active Cells” a pagina 154. 

Le modifiche alla configurazione della capacità vengono salvate nell’area di lavoro 
della regione di storage attiva della SL Console per la durata della sessione di login. È 
quindi possibile modificare, abbandonare nonché ritornare alle schermate Select Active 
Cells tutte le volte necessarie senza perdere le modifiche.

6. Dopo aver effettuato le modifiche desiderate, andare alla sezione “Confermare le 
modifiche della regione di storage attiva” a pagina 145 per verificarle e salvarle. 
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▼ Confermare le modifiche della regione di storage 
attiva 
Utilizzare questa procedura per verificare e confermare le modifiche della 
configurazione della regione di storage attiva effettuate tramite la schermata Select 
Active Cells. Questa procedura avvisa nel caso si verifichino i seguenti errori:

■ La libreria contiene cartucce isolate. Per ulteriori informazioni, consultare la sezione 
“Cartucceisolatein librerie non partizionate” a pagina 138.

■ Le celle saranno rese inaccessibili agli host della libreria. 

Attenzione – Per questi motivi, si consiglia di non mettere la libreria a disposizione di 
altri utenti finché non si confermano le modifiche apportate alla regione di storage 
attiva.   
 
Non esiste una convalida in tempo reale dei limiti della partizione rispetto al database 
del controller della libreria. Quindi, se la libreria viene resa disponibile e altri utenti 
muovono le cartucce o apportano modifiche alla configurazione della libreria, si 
potrebbe assistere a conflitti di configurazione. Per informazioni, consultare la sezione 
“Sincronizzare la visualizzazione con il database del controller” a pagina 35.  
 
In fase di modifiche alle regioni di storage attive, la libreria interrompe 
temporaneamente tutte le connessioni agli host HSC o ACSLS. Le connessioni agli host 
saranno poi automaticamente ripristinate. Verrà tuttavia visualizzata una serie di 
messaggi di errore e potrebbe essere impossibile concludere i task in corso per la 
gestione delle cartucce. 

1. Seguire i passaggi indicati nella sezione “Definire le regioni di storage attive” a 
pagina 142. 

Le modifiche apportate vengono visualizzate sullo schermo Select Active Cells.

2. Nella barra delle opzioni, fare clic su Apply. 

Vengono verificati i limiti delle regioni di storage attive, comprese le sedi di tutte le 
cartucce nastro. 
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Nota – La verifica viene eseguita solo sulla configurazione della regione di storage 
attiva definita nelle schermate Select Active Cells. Non vengono invece verificate le 
regioni di storage attive rispetto al database del controller della libreria. Non è pertanto 
possibile individuare conflitti nella configurazione dovuti a eventuali movimenti di 
cartucce per mano di altri utenti o modifiche alla configurazione della libreria (eseguite 
tramite l’interfaccia a riga di comando, altre sessioni di SL Console o altre applicazioni 
host) nel momento in cui sono state apportate le modifiche alle regioni. 

Si apre il popup Confirm Apply a indicare la presenza di eventuali cartucce isolate o di 
altri errori nella configurazione della regione di storage attiva. 

3. Per visualizzare i messaggi di avvertenza dettagliati in cui vengono spiegati i motivi 
per cui le cartucce sono isolate, selezionare Details. 

È possibile utilizzare il pulsante Details per passare da una vista espansa a una chiusa 
dei messaggi di avvertenza. 
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4. Nella vista espansa dei messaggi di avvertenza, è inoltre possibile eseguire le 
seguenti operazioni:

■ Stampare i dati del messaggio dettagliato facendo clic su Print.

■ Salvare i dati del messaggio dettagliato in un file delimitato da virgole facendo clic 
su Save. 

5. Procedere come segue:

■ Fare clic su No per annullare l’aggiornamento. 

Il database del controller della libreria non è aggiornato, ma tutte le modifiche 
apportate vengono riportate nella schermata Select Active Cells. 

■ Fare clic su Yes per effettuare i seguenti aggiornamenti nel database del controller 
della libreria e procedere al Passo 6. 

■ Le celle bianche contrassegnate da un’orecchietta sull’angolo sinistro vengono 
disattivate.

■ Le celle viola senza orecchietta sull’angolo sinistro vengono attivate fino a 
raggiungere la capacità totale della libreria concessa in licenza. Le celle viola che 
non possono essere attivate per limiti di capacità rimangono viola. Saranno 
attivate automaticamente una volta installata un’ulteriore capacità. 

■ Tutte le altre celle rimangono invariate. 

Commit Success. 

6. Fare clic su OK per tornare alla schermata Select Active Cells. 

Tutte le celle appena attivate sono immediatamente disponibili; non è necessario 
riavviare la libreria. 

7. Perché questi aggiornamenti siano riconosciuti, è necessario configurare tutte le 
applicazioni host della libreria interessate. Per le procedure e i comandi, consultare 
la documentazione del software di gestione nastri.

▼ Visualizzare il report di una regione di storage 
attiva 
Utilizzare questa procedura per visualizzare il seguente report della regione di storage 
attiva:

■ Cartridge Cell and Media Summary: visualizza un elenco dettagliato di tutte le 
risorse della libreria e del loro stato (attivo o inattivo).

■ Orphaned Cartridge Report: visualizza un elenco dettagliato di tutte le cartucce 
isolate.
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Nota – Nei report sulla regione di storage attiva vengono elencati i dati salvati nel 
database del controller della libreria. Se sono state apportate modifiche alla 
configurazione della regione storage attiva senza averle confermate nel controller della 
libreria, i dati in questi report non corrisponderanno a quelli visualizzati nella 
schermata Select Active Cells. 

1. Selezionare Tools > Select Active Cells, e fare clic sulla scheda View Reports.

Si apre la schermata View Reports.

2. Nel menu a tendina, selezionare il report da visualizzare. 

Sullo schermo vengono visualizzati i dati correnti letti dal database del controller della 
libreria. 
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3. Se si vuole stampare i dati del report e salvarli in un file, seguire le procedure 
seguenti:

■ “Stampare i dati del report di una regione di storage attiva” a pagina 149

■ “Salvare i dati del report di una regione di storage attiva” a pagina 150 

▼ Stampare i dati del report di una regione di 
storage attiva 
Utilizzare questa procedura per stampare il report di una regione di storage attiva. Tale 
procedura può essere eseguita da una qualsiasi schermata di report di una regione di 
storage attiva. 

1. Selezionare Tools > Select Active Cells e fare clic sulla scheda View Reports.

Si apre la schermata View Reports.

2. Nel menu a tendina, selezionare uno dei report. 

Viene visualizzato il report selezionato. In tutte le schermate dei report, sono 
disponibili i pulsanti Print e Save to File. 
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3. Fare clic su Print. 

Si apre il popup Print. 

4. Completare il popup di stampa e fare clic su Print. 

Il report viene stampato sulla stampante selezionata. 

▼ Salvare i dati del report di una regione di storage 
attiva
Utilizzare questa procedura per salvare i dati di un report di una regione di storage 
attiva su un file delimitato da virgole (formato .csv). Per visualizzare il file si possono 
utilizzare varie applicazioni per fogli di calcolo. Tale procedura può essere eseguita da 
una qualsiasi schermata di report di una regione di storage attiva. 

1. Selezionare Tools > Select Active Cells e fare clic sulla scheda View Reports.

Si apre la schermata View Reports.
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2. Nel menu a tendina, selezionare uno dei report. 

Viene visualizzato il report selezionato. In tutte le schermate dei report, sono 
disponibili i pulsanti Print e Save to File. 

3. Fare clic su Save to File.

Si apre il popup Save. 

4. Sfogliare la directory in cui si desidera salvare il file e immettere il nome del file. 

5. Fare clic su Save. 

I dati vengono salvati nel file specificato. 

Riferimento alle schermate della regione 
di storage attiva 
In questa sezione vengono elencate descrizioni dettagliate per tutte le schermate 
relative alla regione di storage attiva di SL Console, organizzate per percorso di 
navigazione. Per esempio, Select Active Cells—Select Active Cells—Confirm Apply 
indica la schermata a cui si accede facendo clic suTools, quindi Select Active Cells 
dalla barra dei menu, clic sulla scheda Select Active Cells e infine sul pulsante 
Confirm Apply. 
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Nota – Queste schermate sono disponibili solo per le librerie non partizionate. 
Consultare la sezione “Riferimento alle schermate delle partizioni” a pagina 221 per 
esaminare le schermate utilizzate per gestire la capacità nelle librerie partizionate. 

Nota – Soltanto la schermata Select Active Cells—Current Active Cells è disponibile 
nel pannello operatore locale. A tutte le schermate restanti si accede solo da SL Console 
standalone  o da SL Console via Web.

Nota – La schermata Select Active Cells e tutti i popup correlati forniscono un’area di 
lavoro dinamica in cui organizzare le regioni di storage attive. Tutte le informazioni 
sulle celle attive vengono automaticamente salvate nell’area di lavoro della regione di 
storage della SL Console e conservate per la durata della sessione della SL Console. È 
quindi possibile modificare, abbandonare nonché ritornare alle schermate Select Active 
Cells tutte le volte necessarie senza perdere le modifiche. 

Attenzione – Le informazioni nell’area di lavoro relativa alla regione di storage attiva 
della SL Console vengono salvate nel database del controller della libreria premendo il 
pulsante Apply. Se la sessione della SL Console termina oppure i dati dell’area di 
lavoro vengono aggiornati prima di averli confermati con il pulsante Apply, andranno 
perse tutte le modifiche alla regione di storage attiva apportate tramite le schermate 
Select Active Cells e tutti i popup correlati. 

Schermata Pagina

Select Active Cells > Module Map 153

Select Active Cells > Select Active Cells 154

Select Active Cells > Select Active Cells—Confirm Apply 160

Select Active Cells—View Reports—Cartridge Cell and Media 
Summary

165

Select Active Cells—View Reports—Orphaned Cartridge Report 167

Select Active Cells—Current Active Cells 170
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Select Active Cells > Module Map

Schermata di esempio

Descrizione
Consente di selezionare il modulo della libreria nel quale attivare o disattivare le celle 
per l’immagazzinamento delle cartucce. 

Campi della schermata
Select a module from the map below 

Sullo schermo viene visualizzata un'immagine sulla configurazione attuale del 
modulo della libreria. Le informazioni sono lette direttamente dal database del 
controller della libreria. 

Fare clic sul modulo nel quale si desidera selezionare le celle di storage, quindi fare 
clic sulla scheda Select Active Cells. 
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Pulsanti
? (Help) 

Fare clic per visualizzare la guida in linea relativa alla schermata. 

Consultare anche
■ Select Active Cells > Select Active Cells 

Select Active Cells > Select Active Cells

Schermata di esempio

Descrizione

Nota – Se si desidera utilizzare la configurazione della regione di storage attiva 
predefinita dal controller della libreria, non è necessario utilizzare questa schermata. 
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Consente di definire le regioni di storage attive della libreria selezionando le celle di 
storage che si desidera attivare o disattivare. Per esempio, è possibile configurare le 
celle di storage attive in modo da concentrare le cartucce intorno alle unità e da lasciare 
le estremità della libreria libere per una espansione futura.

È possibile attivare un numero qualsiasi di celle fino ad arrivare alla capacità totale 
concessa in licenza per la libreria. Le celle selezionate che non possono essere attivate 
per limiti di capacità rimangono selezionate e saranno attivate automaticamente una 
volta installata ulteriore capacità. 

Per selezionare celle di storage è possibile utilizzare uno dei seguenti metodi (per 
istruzioni dettagliate, consultare “Library Map” a pagina 158): 

■ Selezionare le singole celle o i gruppi di celle 

■ Selezionare un’intera colonna all’interno di un modulo della libreria

■ Selezionare un lato all’interno del modulo della libreria (frontale o posteriore) 

■ Selezionare un intero modulo della libreria 

■ Selezionare tutte le celle all’interno della libreria 

Attenzione – Disattivando le celle di storage le celle potrebbero restare isolate e 
potrebbe essere impossibile accedere ai dati. Per ulteriori informazioni, consultare la 
sezione “Cartucceisolatein librerie non partizionate” a pagina 138. 

Nota – È possibile selezionare solo celle di storage; le CAP e le unità nastro installate 
sono sempre attive. 

Nota – La schermata Select Active Cells e tutti i popup correlati forniscono un’area di 
lavoro dinamica in cui organizzare le regioni di storage attive. Tutte le informazioni 
sulle celle attive vengono automaticamente salvate nell’area di lavoro della regione di 
storage della SL Console e conservate per la durata della sessione della SL Console. È 
quindi possibile modificare, abbandonare nonché ritornare alle schermate Select Active 
Cells tutte le volte necessarie senza perdere le modifiche. 

Attenzione – Le informazioni nell’area di lavoro relativa alla regione di storage attiva 
della SL Console vengono salvate nel database del controller della libreria premendo il 
pulsante Apply. Se la sessione della SL Console termina oppure i dati dell’area di 
lavoro vengono aggiornati prima di averli confermati con il pulsante Apply, andranno 
perse tutte le modifiche alla regione di storage attiva apportate tramite le schermate 
Select Active Cells e tutti i popup correlati. 

Campi della schermata
Select by

Necessario.

Indica il metodo da utilizzare per selezionare le celle di storage da attivare o 
disattivare. Le opzioni sono le seguenti:

■ Cell: vengono selezionati un gruppo singolo o gruppi rettangolari di celle.
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■ Column: vengono selezionate tutte le celle in una colonna 

■ Side: vengono selezionate tutte le celle in un lato di un modulo della libreria. 

■ Module: vengono selezionate tutte le celle all’interno di un modulo della libreria. 

■ Library: vengono selezionare tutte le celle all’interno della libreria. 

Nota – È necessario selezionare Add o Remove. 

Add 

Necessario.

Indica che si vogliono assegnare delle celle alla regione di storage attiva. Si possono 
selezionare soltanto celle non attive nella mappa della libreria. 

Remove

Necessario.

Indica che si vogliono rimuovere delle celle dalla regione di storage attiva. Si 
possono selezionare soltanto celle attive o evidenziate nella mappa della libreria. 

Current Library Totals

Capacity

Sola visualizzazione.

Capacità totale della libreria concessa in licenza. 

Active Cells

Sola visualizzazione.

Numero totale di celle di storage che sono state attivate nel database del controller 
della libreria. Il valore non può essere superiore alla capacità concessa in licenza. 

Selection Totals 

Selected Cells 

Sola visualizzazione.

Il numero totale di celle selezionate e attive. Il valore può essere superiore alla 
capacità concessa in licenza. 

Unselected Cells 

Sola visualizzazione.

Il numero totale di celle deselezionate e inattive. 

Nota – Selected Cells + Unselected Cells = capacità fisica della libreria

% Capacity Used 

Sola visualizzazione.

Percentuale della capacità totale concessa in licenza che è stata selezionata (non può 
essere superiore a 100%). È data da:

Selected Cells / Capacity (concessa in licenza) 
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Interface Type 

Necessario.

 Tipo di interfaccia da utilizzare per la connessione dell’host della libreria. Le opzioni 
sono le seguenti:

■ HLI

■ FC-SCSI 

Sullo schermo viene visualizzato il valore assegnato in precedenza. È possibile 
mantenere questo valore oppure modificarlo. 

Nota – Per ulteriori informazioni su come modificare questo campo, consultare la 
sezione “Modificare il tipo di interfaccia della libreria (librerie non partizionate)” a 
pagina 76. 

Legend 

Legenda per la mappa della libreria. Lo stato di ogni risorsa della libreria (cella di 
storage, unità nastro o cella CAP) è indicato come segue: 

■ Not Accessible (bianco e barrato con una x-). La risorsa non è accessibile ad alcun 
host. Di seguito sono elencate i possibili motivi:

■ Le celle di storage sono state configurate per le cartucce diagnostiche. 

■ L’alloggiamento dell’unità non contiene unità. 

■ La CAP è stata configurata per operazioni di immagazzinamento e non per le 
operazioni CAP. 

■ Inactive (bianco). La cella di storage non è selezionata. 

■ Se la cella ha anche un’orecchietta sull’angolo sinistro significa che è attualmente 
attiva nel database del controller della libreria e che è stata selezionata per essere 
rimossa dalla regione di storage attiva. Facendo clic sul pulsante Apply la cella 
verrà resa inattiva nel database del controller.

■ Se la cella non ha un’orecchietta sull’angolo sinistro significa che è attualmente 
inattiva nel database del controller della libreria. Facendo clic sul pulsante Apply 
lo stato delle celle nel database del controller della libreria non cambierà. 

■ Active (orecchietta sulla sinistra). Indica lo stato della cella di storage nel database 
del controller della libreria:

■ Le celle contrassegnate da un’orecchietta sull’angolo sinistro sono attualmente 
attive. 

■ Le celle contrassegnate da un’orecchietta sull’angolo sinistro sono attualmente 
inattive. 

■ Selected (viola). La cella di storage è selezionata. Le celle possono essere selezionate 
automaticamente dal controller della libreria o manualmente dall’utente. 

■ Se la cella ha anche un’orecchietta sull’angolo sinistro significa che è attualmente 
attiva nel database del controller della libreria. Facendo clic sul pulsante Apply lo 
stato delle celle nel database del controller della libreria non cambierà.
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■ Se la cella non ha un’orecchietta sull’angolo sinistro significa che è attualmente 
inattiva nel database del controller della libreria e che è stata selezionata per 
essere aggiunta alla regione di storage attiva. Facendo clic sul pulsante Apply, la 
cella verrà resa attiva nel database del controller della libreria, fino al totale della 
capacità concessa in licenza della libreria. Le celle viola che non possono essere 
attivate per limiti di capacità rimangono viola. Saranno attivate automaticamente 
una volta installata un’ulteriore capacità. 

■ No Activation Needed (marrone). La risorsa non può essere selezionata su questo 
schermo perché è attiva come impostazione predefinita; si applica a tutte le celle 
CAP e alle unità nastro. 

■ Cartridge (icona di una cartuccia). La risorsa contiene una cartuccia nastro. 

■ Gli slot unità con unità installate sono evidenziate da un bordo spesso. Gli slot unità 
vuoti hanno invece un bordo sottile. 

Library Map 
Rappresentazione grafica della configurazione corrente della libreria. I dati per la 
visualizzazione iniziale della sessione di login della SL Console vengono letti dal 
database del controller della libreria. Dopo di che le modifiche saranno visualizzate. 
Sono visualizzate le seguenti informazioni:

■ Tipo di modulo attualmente visualizzato (Base Module, modulo DEM, modulo 
PEM.) 

■ ID modulo numerico (da 1 a 12)

■ Posizione di tutte le risorse (celle di storage, unità nastro, celle CAP) all’interno 
della libreria 

Nota – Spostare il cursore su una delle risorse per visualizzare un tooltip con le 
informazioni dettagliate sulla cella o sull’unità, se è attiva nel database del controller 
della libreria, se è attualmente selezionata nella schermata, e l’identità di ogni cartuccia 
installata. 

Utilizzare la mappa della libreria per modificare i limiti delle aree di capacità di 
storage attiva. Facendo clic sul pulsanti di scelta Add o Remove è possibile 
selezionare o deselezionare le celle. 

In base al valore selezionato nel campo Select by, è possibile eseguire una delle 
seguenti azioni. 

■ Select by cell: vengono selezionati risorse singole o gruppi di risorse. Non è 
necessario che le celle di storage attive siano adiacenti. 

- Per selezionare una cella di storage singola, fare doppio clic.

- Per selezionare un gruppo rettangolare di celle di storage, fare clic sulla cella in 
un angolo del rettangolo, quindi selezionare la cella o l’unità diagonalmente 
opposta. 

■ Select by column: viene selezionata un’intera colonna del modulo. Non è 
necessario che le colonne di celle attive siano adiacenti. Fare clic su una qualsiasi 
cella di storage all’interno della colonna che si desidera selezionare. 

■ Select by side: vengono selezionate tutte le celle di storage su un intero lato del 
modulo. Non è necessario che i lati attivi siano adiacenti. Fare clic su una 
qualsiasi cella di storage all’interno del lato che si desidera selezionare. 
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■ Select by module: vengono selezionate tutte le celle di storage all’interno di un 
modulo. Non è necessario che i moduli attivi siano adiacenti. Fare clic su una 
qualsiasi cella di storage all’interno del modulo che si desidera selezionare. 

■ Select the library: vengono selezionare tutte le celle di storage all’interno della 
libreria. Fare clic su una qualsiasi cella di storage all’interno della libreria. 

Pulsanti
Move Left 

Fare clic per visualizzare il primo modulo della libreria a sinistra di quello 
attualmente visualizzato. Il pulsante non è attivo se non esistono moduli a sinistra. 

Move Right 

Fare clic per visualizzare il primo modulo della libreria a destra di quello 
attualmente visualizzato. Il pulsante non è attivo se non esistono moduli a destra. 

Apply 

Fare clic per aggiornare il database del controller della libreria con le impostazioni 
della schermata. Si apre il popup Confirm Apply a indicare la presenza di eventuali 
cartucce isolate o di altri errori nella configurazione della regione di storage attiva. 

Nota – Il pulsante è disattivato se non sono state apportate modifiche alla schermata 
Select Active Cells dall’ultimo aggiornamento. 

Lo stato delle celle verrà aggiornato nel database del controller della libreria, come 
segue: 

■ Le celle bianche contrassegnate da un’orecchietta sull’angolo sinistro vengono 
disattivate.

■ Le celle viola senza orecchietta sull’angolo sinistro vengono attivate fino a 
raggiungere la capacità totale della libreria concessa in licenza. Le celle viola che 
non possono essere attivate per limiti di capacità rimangono viola. Saranno 
attivate automaticamente una volta installata un’ulteriore capacità. 

■ Tutte le altre celle rimangono invariate. 

Refresh

Fare clic per aggiornare la schermata con i dati correnti letti dal database del 
controller della libreria. Tutte le modifiche non confermate, apportate alla regione di 
storage attiva durante la sessione di login alla SL Console, saranno eliminate. Si apre 
il popup Cell Selection Refresh in cui si richiede di confermare l’aggiornamento. 

? (Help) 

Fare clic per visualizzare la guida in linea relativa alla schermata. 

Consultare anche
■ Select Active Cells > Module Map 

■ Select Active Cells > Select Active Cells—Confirm Apply 

■ Select Active Cells—Current Active Cells 
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Select Active Cells > Select Active Cells—Confirm 
Apply

Schermata di esempio

Descrizione
Visualizza un elenco degli errori di configurazione nelle regioni di storage attive 
definite. Questa schermata è un popup che si apre quando si seleziona Apply nella 
schermata Select Active Cells > Select Active Cells. 

Dopo aver visualizzato i messaggi di errore, è possibile confermare tutti i dati dalla 
schermata Select Active Cells nel database del controller della libreria facendo clic sul 
pulsante Yes. 

Errori possibili:

■ La libreria contiene cartucce isolate. Per informazioni, consultare la sezione 
“Cartucce isolate in librerie partizionate” a pagina 184.

■ Le celle di storage sono state rimosse dalla libreria. 

In presenza di uno di questi errori, la schermata visualizza subito dei messaggi di 
avvertenza riepilogativi. È possibile visualizzare i messaggi dettagliati facendo clic sul 
pulsante Details. 

Si consiglia di correggere tutti gli errori prima di confermare i dati nel database del 
controller della libreria. 
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Si può eventualmente stampare i dati della schermata oppure salvarli in un file 
delimitato da virgole. 

Campi della schermata
Warnings found

Sola visualizzazione.

Messaggi di errore riepilogativi relativi alla configurazione della regione di storage. 

Library 

Sola visualizzazione.

Numero della libreria in cui è posizionata la cartuccia isolata. È sempre 1. 

Rail 

Sola visualizzazione.

Numero del binario in cui è posizionata la cartuccia isolata. È sempre 1. 

Column

Sola visualizzazione.

Numero della colonna in cui è posizionata la cartuccia isolata. Lo si calcola partendo 
dal lato sinistro del Base Module. +1 è verso destra; -1 è verso sinistra.

Side

Sola visualizzazione.

Lato del modulo in cui è posizionata la cartuccia isolata. 1 è la parete posteriore; 2 è 
la parete frontale.

Row

Sola visualizzazione.

Numero della riga in cui è posizionata la cartuccia isolata. La numerazione delle 
righe è consecutiva, dall’alto al basso. La riga 1 è in alto.

Cause for Orphaned State

Sola visualizzazione.

Il motivo per cui la cartuccia è stata identificata come isolata. Le opzioni sono:

■ Just Activated 

■ Inactive Media 

Vol Ser 

Sola visualizzazione.

Numero di serie del volume (VOLID) della cartuccia isolata. 

Explanation

Sola visualizzazione.

Spiegazione sul motivo per cui la cartuccia è isolata. 

Di seguito alcune delle possibili opzioni:

■ È stato trovato un supporto in una cella non attiva. 

■ È stata appena attivata una cella non attiva con un supporto. 

Pulsanti



Riferimento alle schermate della regione di storage attiva

162 Manuale dell’utente di SL3000 • Aprile 2008 Revisione: A • 418605201

Nota – Per visualizzare i pulsanti Print e Save to File è necessario scorrere in basso alla 
finestra interna. 

Print

Fare clic per stampare il report sulla stampante selezionata.

Save to File

Fare clic per salvare il report come file di testo designato e delimitato da virgole 
(estensione .csv). Sono molti i fogli di calcolo e i programmi database in grado di 
aprire i file delimitati da virgole. 

Yes

Fare clic per confermare l’aggiornamento del database del controller della libreria 
con le impostazioni correnti in Select Active Cells. Lo stato delle celle viene 
aggiornato nel database del controller della libreria, come segue: 

■ Le celle bianche contrassegnate da un’orecchietta sull’angolo sinistro vengono 
disattivate.

■ Le celle viola senza orecchietta sull’angolo sinistro vengono attivate fino a 
raggiungere la capacità totale della libreria concessa in licenza. Le celle viola che 
non possono essere attivate per limiti di capacità rimangono viola. Saranno 
attivate automaticamente una volta installata un’ulteriore capacità. 

■ Tutte le altre celle rimangono invariate. 

No

Fare clic per annullare l’aggiornamento. Il database del controller della libreria non è 
aggiornato, ma tutte le modifiche apportate vengono riportate nella schermata 
Select Active Cells. 

Details 

Fare clic per passare da una vista espansa a una chiusa della visualizzazione dei 
messaggi di avvertenza. 

Consultare anche
■ Select Active Cells > Select Active Cells 
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Select Active Cells—Reports

Schermata di esempio

Descrizione
Consente di selezionare uno dei seguenti report sulla regione di storage attiva:

■ Cartridge Cell and Media Summary

■ Orphaned Cartridge Report

Nota – Nei report sulla regione di storage attiva vengono elencati i dati salvati nel 
database del controller della libreria. Se sono state apportate modifiche alla 
configurazione della regione di storage attiva senza averle confermate con il pulsante 
Apply, i dati in questi report non coincideranno a quelli visualizzati nella schermata 
Select Active Cells. 
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Campi della schermata
Please select a report to display

Necessario.

Fare clic sul report che si desidera visualizzare. Il menu a discesa elenca tutti i report 
sulla regione di storage attiva disponibili. 

Pulsanti
Apply 

Fare clic per aggiornare il database del controller della libreria con le impostazioni 
della schermata. Si apre il popup Confirm Apply a indicare la presenza di eventuali 
cartucce isolate o di altri errori nella configurazione della regione di storage attiva. 

Nota – Il pulsante è disattivato se non sono state apportate modifiche alla schermata 
Select Active Cells dall’ultimo aggiornamento. 

Refresh

Fare clic per aggiornare la schermata con i dati correnti letti dal database del 
controller della libreria. Tutte le modifiche non confermate, apportate alla regione di 
storage attiva durante la sessione di login alla SL Console, saranno eliminate. Si apre 
il popup Cell Selection Refresh in cui si richiede di confermare l’aggiornamento. 

? (Help) 

Fare clic per visualizzare la guida in linea relativa alla schermata. 

Consultare anche
■ Select Active Cells > Select Active Cells 

■ Select Active Cells—View Reports—Cartridge Cell and Media Summary 

■ Select Active Cells—View Reports—Orphaned Cartridge Report 
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Select Active Cells—View Reports—Cartridge Cell 
and Media Summary

Schermata di esempio

Descrizione
Visualizza informazioni dettagliate su tutte le risorse della libreria (celle di storage, 
unità nastro e celle CAP) nonché informazioni su tutte le cartucce di storage.

Nota – Nei report sulla regione di storage attiva vengono elencati i dati salvati nel 
database del controller della libreria. Se sono state apportate modifiche alla 
configurazione della regione storage attiva senza averle confermate nel controller della 
libreria, i dati in questi report non corrisponderanno a quelli visualizzati nella 
schermata Select Active Cells. 

Il layout e la visualizzazione di questa schermata possono essere modificati. Per 
informazioni, consultare la sezione “Modificare il layout della schermata” a pagina 36. 

Si può eventualmente stampare i dati della schermata oppure salvarli in un file 
delimitato da virgole.



Riferimento alle schermate della regione di storage attiva

166 Manuale dell’utente di SL3000 • Aprile 2008 Revisione: A • 418605201

Campi della schermata
Library 

Sola visualizzazione.

Numero della libreria in cui è posizionata la risorsa della libreria. È sempre 1. 

Rail 

Sola visualizzazione.

Numero del binario in cui è posizionata la risorsa della libreria. È sempre 1. 

Column

Sola visualizzazione.

Numero della colonna in cui è posizionata la risorsa della libreria. Lo si calcola 
partendo dal lato sinistro del Base Module. +1 è verso destra; -1 è verso sinistra.

Side

Sola visualizzazione.

Lato del modulo in cui è posizionata la risorsa della libreria. 1 è la parete posteriore; 
2 è la parete frontale.

Row

Sola visualizzazione.

Numero della riga in cui è posizionata la risorsa della libreria. La numerazione delle 
righe è consecutiva, dall’alto al basso. La riga 1 è in alto.

Element Type

Sola visualizzazione.

Tipo di risorsa della libreria. Le opzioni sono le seguenti:

■ CAP
■ CELL
■ DRIVE

Vol Ser 

Sola visualizzazione.

Numero di serie del volume (VOLID) della cartuccia posizionata nella risorsa della 
libreria, se applicabile. 

Cell Status

Sola visualizzazione.

Stato capacità della risorsa della libreria. Si applica soltanto alle celle di storage. Le 
opzioni sono le seguenti:

■ Active: la cella è attiva. Può essere utilizzata per immagazzinare le cartucce. 

■ Inactive: la cella non è attiva. Non può essere utilizzata per immagazzinare le 
cartucce. 

Pulsanti
Print

Fare clic per stampare il report sulla stampante selezionata.
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Save to File

Fare clic per salvare il report come file di testo designato e delimitato da virgole 
(estensione .csv). Sono molti i fogli di calcolo e i programmi database in grado di 
aprire i file delimitati da virgole. 

? (Help) 

Fare clic per visualizzare la guida in linea relativa alla schermata. 

Consultare anche
■ Select Active Cells—Reports

■ Select Active Cells—View Reports—Orphaned Cartridge Report

Select Active Cells—View Reports—Orphaned 
Cartridge Report 

Schermata di esempio
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Descrizione
Visualizza le posizioni e i numeri di serie del volume (VOLID) di tutte le cartucce 
isolate della libreria. Identifica inoltre il motivo per cui la cartuccia è isolata. 

Nota – Nei report sulla regione di storage attiva vengono elencati i dati salvati nel 
database del controller della libreria. Se sono state apportate modifiche alla 
configurazione della regione storage attiva senza averle confermate nel controller della 
libreria, i dati in questi report non corrisponderanno a quelli visualizzati nella 
schermata Select Active Cells. 

Il layout e la visualizzazione di questa schermata possono essere modificati. Per 
informazioni, consultare la sezione “Modificare il layout della schermata” a pagina 36. 

Si può eventualmente stampare i dati della schermata oppure salvarli in un file 
delimitato da virgole.

Campi della schermata
Library 

Sola visualizzazione.

Numero della libreria in cui è posizionata la cartuccia isolata. È sempre 1. 

Rail 

Sola visualizzazione.

Numero del binario in cui è posizionata la cartuccia isolata. È sempre 1. 

Column

Sola visualizzazione.

Numero della colonna in cui è posizionata la cartuccia isolata. Lo si calcola partendo 
dal lato sinistro del Base Module. +1 è verso destra; -1 è verso sinistra.

Side

Sola visualizzazione.

Lato del modulo in cui è posizionata la cartuccia isolata. 1 è la parete posteriore; 2 è 
la parete frontale.

Row

Sola visualizzazione.

Numero della riga in cui è posizionata la cartuccia isolata. La numerazione delle 
righe è consecutiva, dall’alto al basso. La riga 1 è in alto.

Vol Ser 

Sola visualizzazione.

Numero di serie del volume (VOLID) della cartuccia isolata. 

Explanation

Sola visualizzazione.

Spiegazione sul motivo per cui la cartuccia è isolata. 

Di seguito alcune delle possibili opzioni:
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■ È stato trovato un supporto in una cella non attiva. 

■ È stata appena attivata una cella non attiva con un supporto. 

Pulsanti
Print

Fare clic per stampare il report sulla stampante selezionata.

Save

Fare clic per salvare il report come file di testo designato e delimitato da virgole 
(estensione .csv). Sono molti i fogli di calcolo e i programmi database in grado di 
aprire i file delimitati da virgole. 

? (Help) 

Fare clic per visualizzare la guida in linea relativa alla schermata. 

Consultareanche
■ Select Active Cells—Reports 

■ Select Active Cells—View Reports—Orphaned Cartridge Report 
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Select Active Cells—Current Active Cells

Schermata di esempio

Descrizione
Visualizza le regioni di storage della libreria attive. Mostra le celle di storage attive, non 
attive o in attesa di attivazione.

È l’unica schermata Select Active Cells disponibile nel pannello operatore locale.

Nota – La schermata è di sola visualizzazione. 

Campi della schermata
Per descrizioni dettagliate sui campi della schermata, consultare 
“Select Active Cells > Select Active Cells” a pagina 154. 
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Pulsanti
Refresh

Fare clic per aggiornare la visualizzazione con i dati correnti del database del 
controller della libreria. 

? (Help) 

Fare clic per visualizzare la guida in linea relativa alla schermata. 

Consultareanche 
■ Select Active Cells > Select Active Cells 
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CHAPTER 6

Partizionamento della libraria

Nota – Il partizionamento della libreria è una funzionalità concessa in licenza. È 
necessario installarla tramite l’utility in licenza della libreria SL3000. Consultare il 
capitolo Capitolo 4, “Licenza” per informazioni. 

Il partizionamento della libreria consente di riservare sezioni della libreria SL3000 
all’uso esclusivo di specifici host. Ad esempio, è possibile configurare un gruppo di 
celle e unità di storage da utilizzare solo per operazioni Veritas e un altro gruppo solo 
per operazioni Tivoli. Questo consente quindi di configurare una libreria SL3000 per 
applicazioni attive su più sistemi operativi. 

Funzionalità e restrizioni del 
partizionamento
In questa sezione vengono descritte importanti funzionalità nonché restrizioni del 
partizionamento della libreria che aiuteranno nella sua configurazione e nel suo utilizzo 
all’interno della libreria SL3000. 

■ In una libreria SL3000 è possibile configurare fino a otto partizioni. 

■ La dimensione di una partizione può variare da una cella di storage singola, a 
un’unità nastro, a una CAP intera. Le celle e le unità all'interno di una partizione 
non devono essere necessariamente adiacenti. 

■ Le celle di storage e le unità nastro allocate a una partizione possono essere utilizzate 
esclusivamente dagli host assegnati a tale partizione. Gli host assegnati ad altre 
partizioni non hanno accesso ai contenuti di queste celle e unità. Consultare “Celle 
di storage e unità” a pagina 179 per informazioni. 

■ Le celle di storage e le unità non allocate ad alcuna partizione non sono accessibili da 
alcun host. Ad esempio, si può pensare di lasciare un’area di celle senza allocazione, 
riservata per un partizionamento futuro. 

■ Le connessioni tra partizione e host possono essere utilizzate per l’interfaccia 
(TCP/IP) FC-SCSI o HLI 

■ Le CAP intere possono essere allocate per uso esclusivo di una partizione oppure 
possono essere condivise da più partizioni. Consultare “Partizionamento e CAP” a 
pagina 179 per informazioni.
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■ Possono essere condivise soltanto dalle partizioni con lo stesso tipo di interfaccia 
host. Quindi, le partizioni FC-SCSI e HLI non possono condividere la stessa CAP. 

Abilitare e disabilitare il partizionamento
Per utilizzare le partizioni in una libreria, è necessario installare la funzionalità di 
partizionamento tramite l’utility in licenza. Consultare Capitolo 4, “Licenza” a pagina 
117 per informazioni. 

Una libreria con partizionamento abilitato può avere uno dei seguenti stati: 

■ Partizionata: la libreria possiede almeno una partizione definita dall’utente e un ID 
partizione valido.

■ Non partizionata: la libreria non possiede partizioni definite dall’utente. Il 
comportamento di una libreria non partizionata è il medesimo di quello assunto da 
una libreria in cui il partizionamento non è abilitato. Quindi, tutte le celle di storage 
attive, le unità nonché le CAP diventano accessibili a ogni host. 

Per disabilitare il partizionamento da una libreria, è necessario prima di tutto eliminare 
tutte le partizioni. Lo stato della libreria cambierà e diventerà non partizionata. 

Pianificare la partizione
Grazie alla funzionalità di partizionamento, l’utilizzo della libreria diventa molto 
flessibile. Sono richieste pianificazione attenta, elevata conoscenza del mapping di celle 
di storage e di pareti della libreria nonché esperienza nella configurazione e 
nell’amministrazione di applicazioni software host. È necessario provvedere a un 
sistema di comunicazione chiaro tra tutte le parti coinvolte, compresi programmatori e 
amministratori di sistema, operatori della libreria e addetti al servizio clienti Sun. 

Prima di creare delle partizioni, è necessario pianificare l’area di storage destinata ad 
accogliere le cartucce nonché prevedere il numero di celle libere necessarie. È necessario 
riconoscere i limiti di ogni partizione e le relazioni di proprietà degli host. Si deve 
inoltre verificare che tutte le unità nastro e le cartucce siano state trasferite nelle 
posizioni corrette in base alle assegnazioni pianificate. 

Installare la funzionalità di partizionamento
Dopo aver installato la funzionalità di partizionamento su una libreria non ancora 
partizionata, sono necessarie le seguenti importanti considerazioni. 

■ È possibile iniziare a creare le partizioni immediatamente. Non è necessario 
effetturare il reboot della libreria.

■ Finché non si crea almeno una partizione, la libreria mantiene uno stato di non 
partizionata. Pertanto tutte le celle di storage in licenza, le unità e le CAP rimangono 
accessibili a tutti gli host. 
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Capacità di storage allocata
Nelle librerie partizionate, il numero totale delle celle di storage allocate a tutte le 
partizioni della libreria non deve superare la capacità della libreria concessa in licenza. 

Nelle librerie partizionate, non esiste una regione di storage attiva predefinita. È 
necessario assegnare le celle di storage alle partizioni in modo esplicito, configurando le 
regioni di storage attive per ogni partizione. Consultare “Processo di partizionamento” 
a pagina 185 per informazioni. 

Quando le cartucce vengono assegnate alle celle di storage, il controller della libreria 
applica le regole di selezione delle cella predefinite per ogni singola partizione. 
Consultare “Regole di attivazione della cella” a pagina 137 per informazioni. 

Configurazioni delle partizioni
Utilizzare la SL Console standalone o la SL Console via Web per configurare le 
partizioni della libreria. Le schermate per il partizionamento non sono disponibili nel 
pannello operatore locale. 

Per configurare una partizione, è necessario definire le seguenti informazioni: 

■ Informazioni riepilogative sulla partizione

■ Connessioni tra partizione e host

■ Limiti della partizione

Per istruzioni dettagliate sulla definizione delle partizioni della libreria, consultare 
“Processo di partizionamento” a pagina 185. 

Informazioni riepilogative sulla partizione
 Le informazioni riepilogative sulla partizione comprendono l’ID partizione, il nome, il 
tipo di connessione tra partizione e host (HLI o FC-SCSI). L'ID partizione deve essere 
univoco e compreso tra 1 e 8.

Connessioni tra partizione e host
Le connessioni tra partizione e host identificano gli host che possono accedere a una 
partizione. Ogni partizione viene visualizzata nell’host come libreria separata. Un host 
può controllare una o più partizioni. È inoltre possibile che una sola partizione FC-SCSI 
sia controllata da più di un host. Si consiglia tuttavia attenzione durante 
l’implementazione di tale configurazione. Alcune applicazioni host, infatti, non 
possono condividere le risorse. 

Connessioni tra partizione e host HLI

A una partizione HLI (Host Library Interface) possono essere assegnati fino a 16 host. 
Definire la configurazione per la connessione tra partizione e host HLI utilizzando il 
software di gestione della libreria (ACSLS o HSC). Non esistono schermate della 
SL Console per visualizzare o aggiornare queste informazioni. Consultare la 
documentazione del software di gestione nastri appropriata per informazioni. 
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Connessioni tra partizione e host FC-SCSI

Una partizione FC-SCSI può disporre di una o più connessioni tra partizione e host. La 
configurazione della connessione tra partizione e host è definita dall’utente e 
comprende i seguenti dati: 

■ Il WWPN (World Wide Port Name) del controller (HBA) FC-SCSI

■ Il numero della porta della scheda in fibra ottica della libreria

■ Il numero dell’unità logica (LUN) della partizione nell’host

Consultare “Configurare una connessione tra partizione e host” a pagina 190 per 
istruzioni dettagliate sulla definizione di tali dati. 

Limiti della partizione
I limiti della partizione identificano le celle di storage, le unità e le CAP di ogni 
partizione. È possibile aggiungere a una partizione soltanto le celle non allocate ed è 
possibile rimuovere solo le cella allocate. 

I limiti di una partizione possono essere definiti in uno dei seguenti modi:

■ Selezionare le singole celle o i gruppi rettangolari di celle da aggiungere o rimuovere 
da una partizione. Le celle o i gruppi di celle non devono essere consecutivi.

■ Selezionare una colonna del modulo da aggiungere o rimuovere da una partizione. 
Le colonne non devono essere consecutive. 

■ Selezionare il lato del modulo intero (frontale o posteriore) da aggiungere o 
rimuovere da una partizione. I lati non devono essere consecutivi. 

■ Selezionare un modulo intero da aggiungere o rimuovere da una partizione. 
I moduli non devono essere consecutivi. 

Nota – È possibile avere partizioni con risorse non allocate. 

Partizioni e risorse della libreria

Indirizzamenti delle risorse della libreria 
Gli indirizzi della risorsa identificano ogni risorsa in maniera univoca (celle di storage, 
unità e CAP) all’interno della libreria. La libreria SL3000 e gli host collegati utilizzano i 
seguenti schemi di indirizzamento: 

■ Indirizzo interno della libreria

■ Indirizzo dell’elemento FC-SCSI

■ Indirizzo HLI-PRC

Ogni partizione viene visualizzata in un host come libreria separata. Questo si riflette 
nell’indirizzo della partizione. 
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Indirizzo interno della libreria
L’indirizzo interno della libreria viene utilizzato dal controller della libreria SL3000 e 
dall'albero di dispostivi della SL Console per identificare la posizione fisica di ogni 
risorsa. La libreria SL3000 utilizza uno schema di indirizzamento a cinque cifre, con 
valori delimitati da virgole, in cui si specifica la libreria, il binario, la colonna il lato e la 
riga, tenendo di fronte la libreria e gli alloggiamenti delle unità. 

Il formato dell’indirizzo interno della libreria SL3000 è l,r,c,s,w dove:

■ l = numero della libreria o della partizione; questo valore è sempre 1. 

■ l = numero del binario; questo valore è sempre 1.

■ c = numero della colonna. La numerazione della colonna parte dal lato sinistro del 
Base Module (avendo di fronte la parete di fondo interna), come di seguito descritto:

■ La numerazione è statica e consente quindi di aggiungere dei moduli senza dover 
rinumerare le colonne esistenti. 

■ Le colonne interne o a destra del Base Module sono numerate con il segno +, con 
sequenza crescente da sinistra a destra. 

■ Le colonne a sinistra del Base Module sono numerate con il segno -, con sequenza 
decrescente da destra a sinistra. 

■ I pannelli del Base Module sono sempre compresi tra 1 e 6. 

■ Se presenti, i pannelli DEM sono sempre compresi tra -1 e -6.

■ Se non esistono moduli DEM e un modulo CEM si trova a sinistra del Base 
Module, le colonne da -1 a -6 vengono saltate e al modulo CEM vengono 
assegnate le colonne da -7 a -12. 

■ Le colonne CEM a destra del Base Module iniziano con 7. 

■ Le colonne AEM sono numerate come se un DEM e quattro CEM fossero installati 
a sinistra e quattro CEM fossero installati a destra del Base Module

■ s = lato. Parete di fondo = 1, parete frontale = 2.

■ c = numero della riga. La numerazione è consecutiva, dall’alto al basso. I valori 
validi sono da 1 a 52. La riga 1 si trova in alto. 

Indirizzo dell’elemento FC-SCSI
L’indirizzo dell’elemento FC-SCSI viene utilizzato dagli host con una connessione 
FC-SCSI alla libreria SL3000 unicamente per identificare tutte le risorse disponibili 
nell’host. 

Per la numerazione dell’elemento FC-SCSI viene utilizzato un numero intero con cui si 
identifica ogni risorsa della libreria. La numerazione dell’elemento FC -SCSI all’interno 
delle librerie partizionate è continua per ogni partizione anche se le posizioni delle celle 
della partizione non sono adiacenti. Gli indirizzi dell’elemento FC-SCSI di una 
partizione iniziano dal modulo, dalla riga e dalla colonna più bassi all’interno della 
partizione, procedono poi per riga fino alla fine della colonna e poi per colonna fino 
alla fine del modulo. 

Se risorse nuove vengono allocate a una partizione FC-SCSI esistente, le risorse 
originali non vengono rinumerate. In questo modo si evita di compromettere l’host 
FC-SCSI. 
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Esempi di indirizzo per l’elemento FC-SCSI

Se la base di una libreria nonché i moduli di espansione di storage vengono allocati alla 
partizione 1 e il modulo dell’unità viene allocato alla partizione 2, la numerazione 
dell’elemento -SCSI sarà la seguente:

■ La numerazione della partizione 1 inizia con il primo slot disponibile del Base 
Module e prosegue fino all’ultima cella disponibile del modulo. 

■ La numerazione della partizione 2 inizia con il primo slot disponibile dell’indirizzo 
PRC del modulo unità e termina con l’ultima cella disponibile di quel modulo. 

Indirizzo HLI-PRC
L’indirizzo HLI-PRC (Host Library Interface-Panel, Row, Column) è utilizzato dagli 
host che dispongono di una connessione HLI alla libreria SL3000, compresi ACSLS e 
HSC. L’indirizzo HLI-PRC identifica in maniera univoca tutte le risorse della libreria 
che sono accessibili all’host e sono assegnate al software dell’host.

L’indirizzo HLI-PRC è un valore a otto cifre con cui si specifica la libreria, il pannello, 
la riga e la colonna in cui è posizionata la risorsa. Il formato è ll:pp:rr:cc, dove:

■ l = numero binario; questo valore è sempre 00. 

■ c = numero colonna. La numerazione si basa sul Base Module, come segue:

■ I pannelli del Base Module sono sempre compresi tra 12 e 13. 

■ I moduli a sinistra del Base Module sono numerati in ordine decrescente partendo 
da 11. I moduli a destra sono numerati in ordine crescente partendo da 14. 

■ Alle pareti posteriori vengono assegnati numeri pari mentre alle pareti frontali 
numeri dispari. 

■ Se presenti, i pannelli DEM sono sempre 10 e 11.

■ Se non esistono DEM e un CEM si trova a sinistra del Base Module, i pannelli 10 
e 11 vengono saltati e al CEM vengono assegnate i pannelli 8 e 9. In questo modo 
è possibile aggiungere un DEM a sinistra del Base Module in un secondo 
momento senza dover rinumerare i moduli. 

■ rr = numero della riga all’interno del pannello. La numerazione è consecutiva, 
dall’alto al basso. I valori validi sono da 0 a 51. La riga 0 si trova in alto. 

■ rr = numero della colonna all’interno del pannello. La numerazione è consecutiva, 
da sinistra a destra, partendo dal fronte del modulo. Ogni pannello possiede un 
massimo di sei colonne. I valori vali per le colonne sono quindi compresi tra 0 e 5. 

Numerazione HLI CAP

I numeri delle CAP della libreria sono assegnati dal modulo, da sinistra a destra: 

■ CAP Base Module = 6

■ CAP DEM = 5

■ CAP in CEM a sinistra del Base Module = da 1 a 4

■ CAP in CEM a destra del Base Module = 7–10

■ CAP AEM a sinistra del Base Module = 0

■ CAP AEM a destra del Base Module = 11

Le CAP contengono un’unica colonna di celle con 26 righe. Le celle sono numerate da 
0 a 25. 



Partizionamento e CAP

418605201 • Revisione: A Capitolo 6 Partizionamento della libraria 179

L’AEM contiene una CAP per il caricamento di massa con 234 celle distribuite su sei 
colonne. La numerazione delle colonne inizia dalla parete posteriore e prosegue da 
sinistra a destra (colonne da 0 a 2); continua poi sulla parete frontale e prosegue da 
sinistra a destra (colonne da 3 a 5). 

Celle di storage e unità 
Tutte le celle di storage, le unità nastro e le cartucce allocate a una partizione sono di 
proprietà esclusiva dell’host assegnato e pertanto non sono accessibili da altri host. Ad 
esempio, se viene allocato un gruppo di unità nastro a una partizione, soltanto l’host 
assegnato a questa partizione può accedere a tali unità. 

 Non è invece assolutamente possibile accedere alle celle di storage e alle unità non 
allocate ad alcuna partizione. Ad esempio, si può pensare di lasciare un’area di celle 
senza allocazione, riservata per un partizionamento futuro. 

Nelle schermate e nei report di SL Console, le celle di storage e le unità possono essere 
visualizzate con uno dei seguenti stati:

■ Allocata: assegnata a una partizione corrente. 

■ Non allocata (non assegnata): non assegnata ad alcuna partizione; è possibile 
assegnarla a una partizione corrente. 

■ Non disponibile: assegnata a un’altra partizione. 

■ Non accessibile: non disponibile per operazioni host. Le celle sono ad esempio 
riservate per cartucce diagnostiche, sono fisicamente bloccate o non attive. 

Nota – I TallBotsono risorse condivise e non possono essere allocate a una sola 
partizione. 

Per visualizzare le assegnazioni della partizione per gestire celle di storage e unità, 
consultare “Partitions—Reports—Cartridge Cell and Media Summary” a pagina 258. 

Partizionamento e CAP

Nota – SL3000 non supporta CAP comuni, CAP divise o l’allocazione di celle CAP 
singole a una partizione. Queste funzionalità sono disponibili solo per SL500. 

Quando si configurano le CAP è necessario prevedere attentamente il loro utilizzo. Una 
partizione può infatti utilizzare solo le CAP allocate a sé in modo esplicito. Non esiste il 
concetto di CAP “comune” in SL3000. 

Quando una CAP viene allocata a una partizione, vengono automaticamente allocate 
anche tutte le celle della CAP. Non è possibile allocare o disallocare singole celle di una 
CAP. Non esiste il concetto di CAP “divisa” in SL3000. 
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Allocazioni delle CAP
Per impostazione predefinita, le CAP di una libreria partizionata non sono allocate. 
È possibile allocare le CAP alla partizione tramite la schermata Partitions—Design 
(Step 3b). Le allocazioni delle CAP possono assumere una delle seguenti forme:

■ Dedicata: la CAP è allocata a una partizione con uso esclusivo.

■ Condivisa: la CAP è allocata e può essere utilizzata da più di una partizione 
specificata. Consultare “CAP condivise” per informazioni. 

Una volta allocata, diventa una CAP FC-SCSI CAP o HLI CAP, a seconda del tipo di 
interfaccia host della prima partizione a cui è allocata. Se ad esempio una CAP 
precedentemente non allocata viene allocata a una partizione con interfaccioa FC-SCSI, 
la CAP diventerà una CAP FC-SCSI. Le allocazioni successive delle CAP potranno 
essere indirizzate soltanto su partizioni FC-SCSI. Per modificare la CAP da FC-SCSI in 
HLI, prima di tutto disallocare la CAP dalle partizioni FC-SCSI, quindi riallocarla a una 
partizione HLI.

Nota – Le allocazioni CAP non sono obbligatorie, è possibile avere delle partizioni 
senza CAP allocate. 

Nota – Dato che le applicazioni host FC-SCSI non usano generalmente prenotazioni di 
CAP, si consiglia di dedicare almeno una CAP a ogni partizione FC-SCSI quando 
possibile. In questo modo ogni partizione può operare indipendentemente dalle altre, 
evitando problemi di contesa di risorse che possono subentrare invece in caso di CAP 
condivise. 

CAP condivise
Una libreria può avere un numero superiore di partizioni rispetto alle CAP. È pertanto 
necessario condividere le CAP tra le partizioni. Possono condividere una CAP soltanto 
le partizioni con lo stesso tipo di interfaccia host. Ad esempio, alcune partizioni 
FC-SCSI possono condividere un gruppo di una o più CAP, altre partizioni HLI 
possono condividere un gruppo diverso di CAP. Le partizioni HLI e FC-SCSI non 
possono tuttavia condividere entrambe le stesse CAP. 

Per semplicità, si consiglia di conservare raggruppamenti delle CAP condivise per tutte 
le partizioni a cui sono allocate. Ad esempio, se le CAP A e B vengono allocate a una 
partizione ma anche un’altra partizione necessita di accedere ad A o B, allocare 
entrambe le CAP alla seconda partizione e non soltanto una delle due CAP. 

Nota – È molto importante gestire con attenzione l’utilizzo della CAP condivisa negli 
host FC-SCSI affinché si evitino problemi di contesa. Consultare “Operazioni CAP” a 
pagina 181 per informazioni. 
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Modalità di inserimento automatico delle CAP 
La modalità di inserimento automatico delle CAP consente all’operatore di una libreria 
di aprire una CAP e di avviare l’operazione di inserimento senza che sia necessaria una 
richiesta esplicita o una prenotazione esplicita da parte dell’applicazione host. La 
modalità di inserimento automatico è disponibile per le CAP dedicate a una partizione. 
Le CAP nella modalità di inserimento automatico sono sbloccate. 

Tale modalità è gestita dalle applicazioni host. Consultare la documentazione del 
software di gestione nastri appropriata per informazioni. 

Operazioni CAP 
Per operazioni di inserimento ed espulsione, una CAP può essere utilizzata da una sola 
partizione per volta. Una partizione può rivendicare la proprità di una CAP in uno dei 
seguenti modi:

■ La CAP è dedicata a una partizione. In questo caso la partizione ha sempre la 
proprietà esclusiva sulla CAP.

■ Un’applicazione host prenota la CAP prima che abbia luogo un'operazione di 
inserimento o espulsione. Succede solitamente solo con le applicazioni host HLI. 
Consultare “Prenotazioni di CAP” a pagina 182 per informazioni. 

■ L’utente associa la partizione alla CAP in modo esplicito. Succede solo per le CAP 
FC-SCSI condivise. Consultare “Associazioni di CAP FC-SCSI condivise” a 
pagina 184 per informazioni. 

■ Una partizione posiziona una cartuccia nella CAP: Se non si verifica nessuna delle 
condizioni indicate sopra, la prima partizione che posiziona una cartuccia nella CAP 
durante un’operazione di esportazione diventa proprietaria della CAP finché 
l’esportazione termina e la CAP viene chiusa e svuotata.

Quando una partizione è proprietaria di una CAP, tale CAP è riservata esclusivamente 
a quella partizione e non è disponibile per tutte le altre. 

Stati delle CAP
Per aprire una CAP e inserire o rimuovere le cartucce, è necessario che la CAP sia 
sbloccata. Quando una CAP è sbloccata, la luce del pulsante CAP è accesa. 

Dopo aver chiuso una CAP, la TallBot esegue un controllo per determinare la presenza 
di cartucce. Durante il controllo la CAP è bloccata e la luce del pulsante CAP è spenta. 
Dopo aver completato il controllo, la CAP torna al suo stato predefinito. 
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La seguente tabella descrive gli stati predefiniti di tipi diversi di CAP all’interno di una 
libreria partizionata. 

Prenotazioni di CAP
Entrambi gli host FC-SCSI e HLI possono prenotare le CAP. La possibilità di prenotare 
una CAP concede a una partizione un diritto di proprietà esclusivo su una CAP 
condivisa durante l’operazione di inserimento o espulsione. Al termine dell’operazione, 
l’applicazione host deve rilasciare la prenotazione così che la CAP torni disponibile alle 
altre partizioni che la condividono. Nessun’altra partizione potrà accedere alla CAP 
finché l’operazione non sarà terminata e la prenotazione rilasciata. 

Perché una partizione possa prenotare una CAP, è necessario che la CAP non sia 
prenotata (valido solo per le CAP condivise), sia vuota e chiusa. 

Prenotazioni di CAP HLI
Le applicazioni host HLI si servono di un sistema rigoroso per gestire le prenotazioni 
delle CAP tra gli host client. Quindi, prenotare sempre una CAP prima di sbloccarla o 
spostare una cartuccia su di essa. Se un’applicazione host HLI tenta di prenotare una 
CAP già prenotata da un’altra partizione, il controller della libreria invia un messaggio 
all’host richiedente specificando l’ID della partizione e l’ID della prenotazione. 

Rilasciare le prenotazioni delle CAP

In operazioni normali, la prenotazione di una CAP per un host ACLS o HSC viene 
rilasciata in uno dei seguenti modi:

Tipo di CAP
Stato 
predefinito

Condizione 
luce pulsante 
CAP predefinita Commento

HLI—dedicata o 
condivisa 

Bloccata Spenta La prenotazione dell’host 
sblocca la CAP e la luce 
si accende. Consultare 
“Prenotazioni di CAP” a 
pagina 182 per informazioni. 

HLI—modalità di 
inserimento 
automatico

Sbloccata Accesa

FC-SCSI—dedicata Sbloccata Accesa

FC-SCSI—condivisa Bloccata Spenta L’associazione tra CAP 
e partizione sblocca la 
CAP e la luce si accende. 
Consultare “Associazioni di 
CAP FC-SCSI condivise” a 
pagina 184 per informazioni.
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■ Operazioni di inserimento: dopo che tutte le cartucce sono state inserite nella 
libreria, l’host termina il comando di inserimento in modo esplicito. Il controller 
della libreria rilascia la CAP dopo aver verificato che è chiusa e vuota. 

■ Operazioni di espulsione: dopo che le tutte cartucce sono state espulse, l’host 
termina automaticamente l’operazione di espulsione. Il controller della libreria 
rilascia la CAP dopo aver verificato che è chiusa e vuota. 

Se per un qualsiasi motivo, la prenotazione della CAP non viene rilasciata come 
descritto sopra, la CAP non sarà disponibile a tutte le altre partizioni e le cartucce 
appartenenti alla prima partizione potrebbero rimanere nella CAP. In questo caso, si 
consiglia di terminare l’operazione di inserimento o espulsione dall’host che detiene la 
prenotazione. In questo modo si assicura il rilascio normale della prenotazione della 
CAP. 

Nota – Consultare la documentazione ACSLS o HSC per informazioni su come 
terminare le operazioni di inserimento ed espulsione. 

Ignorare le prenotazioni delle CAP

Può succedere in taluni casi che non sia possibile accedere all’host in possesso di una 
prenotazione e non è pertanto possibile eseguire il normale rilascio della CAP. La causa 
potrebbe trovarsi nella terminazione dell’host oppure nella mancanza di autorizzazioni 
di sicurezza o accesso fisico per poter eseguire i comandi nell’host. In questo caso, 
è possibile ignorare la prenotazione delle CAP manualmente, ossia rimuovere la 
prenotazione. Per informazioni sulla procedura, consultare la sezione “Ignorare la 
prenotazione di una CAP” a pagina 80. 

Nota – Prestare estrema attenzione nell’utilizzo della SL Console quando si ignora la 
prenotazione di una CAP. Se non si completa la procedura, la CAP potrebbe rimanere 
non disponibile a tutte le partizioni e/o le cartucce assegnate a una partizione 
potrebbero essere inserite in un’altra partizione.

Nota – È possibile utilizzare la SL Console per ignorare una prenotazione CAP solo in 
una libreria partizionata. Se una libreria non è partizionata, le prenotazioni delle CAP 
devono essere rilasciate sempre tramite ACSLS o HSC. 

Prenotazioni CAP -SCSI
La maggior parte delle applicazioni host FC-SCSI non usano le prenotazione delle CAP. 
Le applicazioni host FC-SCSI diventano generalmente proprietari esclusivi di una CAP 
e pertanto non gestiscono la condivisione delle CAP. Per evitare la contesa di una CAP 
condivisa tra partizioni, è possibile associare manualmente una partizione a una CAP. 
Consultare “Associazioni di CAP FC-SCSI condivise” per informazioni. 
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Associazioni di CAP FC-SCSI condivise
Se una partizione FC-SCSI condivide delle CAP con altre partizioni, si consiglia di 
associare manualmente la partizione alle relative CAP prima di avviare l’operazione di 
inserimento ed espulsione. Per informazioni sulla procedura, consultare “Associare una 
partizione FC-SCSI alle CAP condivise” a pagina 215.

Un'associazione tra partizione e CAP conferisce alla partizione il diritto di proprietà 
esclusivo sulle proprie CAP condivise, come succedere con la prenotazione di una CAP. 
In questo modo si assicura che le cartucce siano inserite sempre nella partizione 
corrente e si impedisce che altre partizioni rilevino la proprietà di una CAP condivisa 
già in uso. 

Durante l’associazione di una CAP a una partizione, si applicano le seguenti regole:
■ È possibile associare a una CAP soltanto una sola partizione per volta. 

■ Se si seleziona una partizione, tutte le sue CAP allocate le vengono associate in una 
sola volta. Non è possibile selezionare singolarmente le CAP da associare alla 
partizione. 

■ È possibile selezionare più di una partizione per volta soltanto se le partizioni 
selezionate non condividono CAP tra di loro. 

■ Le associazioni tra CAP e partizioni rimangono attive finché non vengono rimosse in 
modo esplicito. Le associazioni non vengono rimosse automaticamente al 
completamento delle operazioni di inserimento o espulsione. 

■ Le associazioni tra CAP e partizioni vengono rimosse durante il reboot della libreria, 
i cicli di alimentazione, la chiusura o l’apertura della porta della libreria o 
l’inizializzazione delle CAP.

■ Le associazioni tra CAP e partizioni vengono rimosse se la CAP viene allocata a 
un’altra partizione tramite la schermata Design (Step 3b). 

■ Se l’associazione tra una CAP e una partizione viene rimossa mentre la CAP è aperta 
o contiene delle cartucce, la proprietà della CAP sarà modificata nel richiedente 
default e la CAP non sarà disponibile per tutte le partizioni. È necessario svuotare 
e chiudere la CAP prima di poterla associare a una qualsiasi partizione. 

Cartucce isolate in librerie partizionate
Nota – Per informazioni sulle cartucce isolate nelle librerie non partizionate, consultare 
“Cartucceisolatein librerie non partizionate” a pagina 138. 

Nelle librerie partizionate, si considera isolata una cartuccia posizionata all’interno di 
una cella o di un’unità non allocata, ossia una cella o un'unità non allocata ad alcuna 
partizione definita. 

Attenzione – Se un host rileva una cartuccia isolata, potrebbe considerarla provvisoria 
e potrebbe quindi sovrascrivere i dati. È quindi molto importante posizionare 
correttamente le cartucce isolate. 

Sono vari i motivi alla base di una cartuccia isolata. Di seguito sono elencate le possibili 
cause:

■ Sono stati modificati i limiti della partizione.

■ È stata eliminata una partizione. 
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■ La cartuccia è stata spostata manualmente in una cella non allocata o non accessibile. 

Se la SL Console individua una cartuccia isolata, viene visualizzato un messaggio di 
avvertenza. Optare quindi per una delle seguenti soluzioni per correggere e posizionare 
la cartuccia isolata:

■ Generare un report sulle cartucce isolate. 

■ Eseguire un controllo della libreria. 

■ Eseguire uno spostamento correttivo su una cartuccia.

Per istruzioni dettagliate sul controllo e sulla correzione di cartucce isolate, seguire le 
procedure seguenti:
■ “Verificare le configurazioni della partizione” a pagina 194

■ “Correggere le cartucce isolate” a pagina 198

■ “Confermare le modifiche alla configurazione della partizione” a pagina 198

Processo di partizionamento

Nota – Il partizionamento della libreria è una funzionalità concessa in licenza. È 
necessario installarla tramite l’utility in licenza della libreria SL3000. Consultare il 
capitolo Capitolo 4, “Licenza” per informazioni. 

Processo di configurazionedella partizione
Quando si configurano le partizioni di una libreria per la prima volta, si consiglia di 
utilizzare le schermate in questa sequenza: 

1. Instructions (Step 1): vengono verificate le istruzioni riepilogative sul processo di 
configurazione della partizione. 

2. Summary (Step 2): vengono visualizzate le informazioni sulla configurazione della 
partizione e sulla connessione tra partizione e host. Accedere eventualmente ad altre 
schermate per eseguire i seguenti task:

■ Aggiungere una partizione

■ Modificare una partizione

■ Eliminare una partizione

Nota – I seguenti task sono disponibili solo per le connessioni tra partizione e host 
FC-SCSI. 

■ Aggiungere una connessione

■ Modificare una connessione

■ Eliminare una connessione

3. Module Map (Step 3a): viene selezionato il modulo della libreria per il quale si 
intende definire i limiti precisi della partizione. 
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4. Design (Step 3b): vengono visualizzate ed eventualmente modificate le informazioni 
sui limiti precisi della partizione. Accedere eventualmente ad altre schermate per 
eseguire i seguenti task:
■ Verificare le configurazioni della partizione

■ Aggiornare la visualizzazione con i dati correnti letti dal database del controller 
della libreria.

5. Commit (Step 4): vengono confermate tutte le modifiche apportate al database del 
controller della libreria nelle schermate Summary(2) e Design (3b) e in tutti i popup 
correlati. Accedere eventualmente ad altre schermate per eseguire il seguente task: 

■ Aggiornare la visualizzazione con i dati correnti letti dal database del controller 
della libreria.

È possibile utilizzare la schermata Reports per visualizzare in qualsiasi momento, 
nonché salvare o stampare se necessario, le informazioni sulla configurazione della 
partizioni lette dal database del controller della libreria. 

Area di lavoro delle partizioni nella SL Console
Le schermate per la partizione Summary (Step 2) e Design (Step 3b), insieme a tutti i 
popup correlati, offrono un’area di lavoro dinamica in cui organizzare le partizioni 
della libreria. Tutte le informazioni relative alla configurazione delle partizioni vengono 
automaticamente salvate nell’area di lavoro della partizione nella memoria della 
SL Console e conservate per la durata della sessione della SL Console. In questo modo 
è possibile passare da una vista ad una altra nonché da una schermata all’altra delle 
partizioni tutte le volte necessarie senza perdere le modifiche apportate alla 
configurazione.

Le informazioni nell’area di lavoro della partizione della SL Console vengono 
confermate nel database del controller della libreria soltanto tramite la schermata 
Commit (Step 4). Queste informazioni andranno perse qualora si verifichi una delle 
seguenti situazioni prima di aver confermato gli aggiornamenti: 
■ Ci si disconnette attivamente dalla sessione della SL Console.
■ La sessione della SL Console scade o la connessione alla libreria è interrotta. 

■ Si aggiorna l’area di lavoro della SL Console attivamente dal database del controller 
della libreria corrente, tramite il pulsante Refresh nelle schermate Summary (Step 2) 
e Design (Step 3b). 

Attenzione – Per questi motivi, si consiglia di non mettere la libreria a disposizione di 
altri utenti finché non si confermano le modifiche apportate all’aria di lavoro della 
partizione.  
 
Non esiste una convalida in tempo reale dei limiti della partizione rispetto al database 
del controller della libreria. Quindi, se la libreria viene resa disponibile e altri utenti 
muovono le cartucce o apportano modifiche alla configurazione della libreria, si 
potrebbe assistere a conflitti di configurazione. Per informazioni, consultare la sezione 
“Sincronizzare la visualizzazione con il database del controller” a pagina 35.  
 
In fase di conferma delle modifiche alle configurazioni della partizione, la libreria 
interrompe temporaneamente tutte le connessioni agli host HSC o ACSLS. Le 
connessioni agli host saranno poi automaticamente ripristinate. Verrà tuttavia 
visualizzata una serie di messaggi di errore e potrebbe essere impossibile concludere i 
task in corso per la gestione delle cartucce.
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Riepilogo del task di partizionamento
I task di partizionamento sono suddivisi nelle seguenti categorie:

■ “Task di configurazionedella partizione” a pagina 187

■ “Task di gestione delle partizioni” a pagina 201

■ “Task per report sulle partizioni” a pagina 211

■ “Task per operazioni sulle CAP” a pagina 215

Task di configurazionedella partizione

Task Pagina

Verificare le istruzioni di partizionamento 188

Creare una partizione 189

Configurare una connessione tra partizione e host (solo partizioni 
FC-SCSI) 

190

Progettare una partizione 191

Verificare le configurazioni della partizione 194

Correggere le cartucce isolate 198

Confermare le modifiche alla configurazione della partizione 198
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▼ Verificare le istruzioni di partizionamento
Utilizzare questa procedura per verificare il processo di partizionamento. 

1. Selezionare Tools > Partitions.

Se si seleziona questa procedura per la prima volta durante una sessione di login alla 
SL Console, si apre automaticamente la schermata Instructions (Step 1). 

2. Verificare le istruzione della schermata precedente prima di procedere con gli altri 
task di partizionamento. 
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▼ Creare una partizione 
Utilizzare questa procedura per creare la partizione di una nuova libreria e assegnare la 
capacità di storage. È possibile creare fino a otto partizioni, con ID compresti tra 1 e 8. 

1. Selezionare Tools > Partitions e fare clic sulla scheda Summary (Step 2). 

Si apre la schermata Summary (Step 2).

2. Fare clic su Add Partition. 

Si apre il popup Add Partition. 

3. Selezionare l’ID della partizione da aggiungere, quindi inserire il nome, la capacità e 
il tipo di interfaccia. 

Nota – Non è necessario che gli ID partizione siano consecutivi. Ad esempio, è 
possibile creare la partizione 2 e la partizione 4 senza dover necessariamente creare la 1 
e la 3.

4. Fare clic su OK. 

Le modifiche alla configurazione della partizione vengono salvate nell’area di lavoro 
della partizione della SL Console per la durata della sessione di login. 

Per aggiornare il database del controller della libreria con tutte le modifiche apportate 
in questa sessione di login alla SL Console, consultare “Verificare le configurazioni della 
partizione” a pagina 194 e “Confermare le modifiche alla configurazione della 
partizione” a pagina 198. 



Task di configurazionedella partizione

190 Manuale dell’utente di SL3000 • Aprile 2008 Revisione: A • 418605201

▼ Configurare una connessione tra partizione e host

Nota – Questa procedura riguarda solo le connessioni tra partizione e host FC-SCSI. Le 
connessioni tra partizione e host HLI sono configurate tramite il software di gestione 
della libreria dell’host (HSC o ACSLS) e non tramite la SL Console. Per informazioni, 
consultare la documentazione su HSC e ACSLS. 

Utilizzare questa procedura per configurare la connessione tra un host e una partizione 
selezionata. Perché la partizione sia accessibile all’host, eseguire la seguente procedura.

Ogni partizione può avere fino a nove connessioni host, ognuna con LUN univoco. 
Ogni host può essere connesso a più di una partizione. 

1. Selezionare Tools > Partitions e fare clic sulla scheda Summary (Step 2).

Si apre la schermata Summary (Step 2).

2. Selezionare la partizione a cui si vuole aggiungere una connessione host.

Nota – Se si seleziona una partizione HLI, tutti i pulsanti nella sezione Details della 
schermata non sono attivi. 
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3. Fare clic su Add Connection. 

Si apre il popup Add Connection. 

4. Inserire un valore in Initiator (WWPN) e LUN. 

Nota – Tutti gli iniziatori connessi alla libreria devono avere una partizione della 
libreria assegnata a LUN 0. Al momento della verifica o della conferma della modifiche 
di configurazione, la SL Console informerà l’utente qualora un iniziatore non 
soddisfacesse questo requisito. 

5. Fare clic su OK. 

▼ Progettare una partizione 
Utilizzare questa procedura per aggiungere o rimuovere le risorse di una libreria (celle 
di storage, unità nastro e CAP) da una partizione. 

Nota – Le risorse di una libreria possono essere allocate a una sola partizione per volta. 
Se si desidera aggiungere delle risorse a una partizione ma tali risorse sono già allocate 
a un’altra partizione, è necessario prima di tutto rimuovere le risorse dalla partizione 
assegnata. Solo poi è possibile aggiungerle alla nuova partizione. 

1. Selezionare Tools > Partitions.
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2. Selezionare la scheda Module Map (Step 3a). 

Si apre la schermata Module Map (Step 3a). 

3. Fare clic sul modulo per il quale si vuole progettare una partizione. 
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4. Selezionare la scheda Design (Step 3b).

Si apre la schermata Design (Step 3b), in cui è visualizzata la configurazione corrente 
del modulo selezionato.

5. Nel menu a tendina Partition, selezionare la partizione da configurare. 

Vengono aggiornati tutti i campi della schermata con la configurazione corrente della 
partizione selezionata. 

Nota – Fare clic sui pulsanti Move Left o Move Right per visualizzare un modulo 
direttamente adiacente a quello attualmente visualizzato. 

6. Scegliere il metodo Selected by e fare clic sul pulsante di scelta Add o Remove.

7. Utilizzare la mappa della libreria per selezionare le risorse da aggiungere o 
rimuovere. 
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Nota – Per istruzioni dettagliate sull’utilizzo della mappa della libreria, consultare 
“Partitions—Design (Step 3b)” a pagina 240. 

Le modifiche alla configurazione della partizione vengono salvate nell’area di lavoro 
della partizione della SL Console per la durata della sessione di login. 

Per aggiornare il database del controller della libreria con tutte le modifiche apportate 
in questa sessione di login alla SL Console, consultare “Verificare le configurazioni della 
partizione” a pagina 194 e “Confermare le modifiche alla configurazione della 
partizione” a pagina 198. 

▼ Verificare le configurazioni della partizione 
Utilizzare questa procedura per verificare le modifiche apportate alla configurazione 
della partizione durante la sessione di login alla SL Console. Questa procedura avvisa 
nel caso si verifichino i seguenti errori:

■ Una partizione contiene cartucce isolate. Consultare “Cartucce isolate in librerie 
partizionate” a pagina 184 per informazioni.

■ Le risorse della libreria sono state rimosse da una partizione. 

■ Un host connesso alla libreria non possiede una partizione assegnata a LUN 0. 

■ La domanda per la capacità in licenza della libreria è in eccesso, ossia le allocazioni 
della partizione totale superano le capacità in licenza.

Nota – Questa procedura verifica una sola partizione per volta. Se è necessario 
verificare più di una partizione, ripetere la procedura separatamente per ogni 
partizione. 

1. Selezionare Tools > Partitions.
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2. Selezionare la scheda Module Map (Step 3a). 

Si apre la schermata Module Map (Step 3a). 

3. Fare clic sul modulo per il quale si vuole verificare una partizione. 

Il modulo viene evidenziato sullo schermo. 

4. Selezionare la scheda Design (Step 3b).

Si apre la schermata Design (Step 3b), in cui è visualizzata la configurazione corrente 
del modulo selezionato.

5. Nel menu a tendina Partition, selezionare la partizione da verificare. 

Vengono aggiornati tutti i campi della schermata con la configurazione corrente della 
partizione selezionata. 

6. Nella barra delle opzioni, fare clic su Verify. 

Vengono verificati i limiti della partizione selezionata, comprese le posizioni di tutte le 
cartucce nastro. 



Task di configurazionedella partizione

196 Manuale dell’utente di SL3000 • Aprile 2008 Revisione: A • 418605201

Nota – La verifica riguarda solo la configurazione della partizione corrente all’interno 
dell’area di lavoro della partizione della SL Console. Non vengono invece verificati i 
limiti della partizione corrente rispetto al database del controller della libreria. Non è 
pertanto possibile individuare conflitti nella configurazione dovuti a eventuali 
movimenti di cartucce per mano di altri utenti o modifiche alla configurazione della 
libreria (eseguite tramite l’interfaccia a riga di comando, altre sessioni della SL Console 
o altre applicazioni host) nel momento in cui sono state apportate le modifiche alla 
partizione. 

Si apre il popup Verify Results in cui si specificano eventuali cartucce isolate, capacità 
di storage utilizzata in eccesso o altri errori nella configurazione della partizione 
corrente. 

Nota – Se la capacità della libreria è utilizzata in eccesso (ossia le allocazioni totali 
della partizione superano la capacità concessa in licenza), è necessario rimuovere le 
celle di storage dalle allocazioni della partizione per rientrare nella capacità concessa. 
Solo poi si può procedere con la fase “Confermare le modifiche alla configurazione 
della partizione” a pagina 198. 
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7. Per visualizzare i messaggi di avvertenza dettagliati in cui vengono spiegati i motivi 
per cui le cartucce sono isolate, selezionare Details. 

È possibile utilizzare il pulsante Details per passare da una vista espansa a una chiusa 
dei messaggi di avvertenza. 

8. Nella vista espansa dei messaggi di avvertenza è inoltre possibile eseguire le 
seguenti operazioni:

■ Stampare i dati del messaggio dettagliato facendo clic su Print.

■ Salvare i dati del messaggio dettagliato in un file delimitato da virgole facendo clic 
su Save. 

9. Selezionare OK per chiudere il popup Verify Results e tornare alla schermata Design 
(Step 3b). 

Nota – Si consiglia di seguire la procedura “Correggere le cartucce isolate” a 
pagina 198 prima di confermare le modifiche nel database del controller della libreria. 
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▼ Correggere le cartucce isolate
Se la SL Console individua una cartuccia isolata, viene visualizzato un messaggio di 
avvertenza. Si consiglia di correggere ed eliminare tutte le cartucce isolate prima di 
procedere con “Confermare le modifiche alla configurazione della partizione” a 
pagina 198. 

Per risolvere il problema delle cartucce isolate, eseguire una delle azioni seguenti: 

■ Stampare un report delle cartucce isolate 

■ Eseguire un controllo della libreria 

■ Eseguire uno spostamento correttivo su una cartuccia isolata 

▼ Confermare le modifiche alla configurazione della 
partizione 

Attenzione – Questa procedura aggiorna il database del controller della libreria con 
tutte le modifiche apportate alla configurazione della partizione durante la sessione 
della SL Console. Se questa procedura viene erroneamente utilizzata prima di aver 
abbandonato la sessione corrente della SL Console, tutte le modifiche andranno perse.

Attenzione – Per questi motivi, si consiglia di non mettere la libreria a disposizione di 
altri utenti finché non si confermano le modifiche apportate all’aria di lavoro della 
partizione.  
 
Non esiste una convalida in tempo reale dei limiti della partizione rispetto al database 
del controller della libreria. Quindi, se la libreria viene resa disponibile e altri utenti 
muovono le cartucce o apportano modifiche alla configurazione della libreria, si 
potrebbe assistere a conflitti di configurazione. Per informazioni, consultare la sezione 
“Sincronizzare la visualizzazione con il database del controller” a pagina 35.  
 
In fase di conferma delle modifiche alle configurazioni della partizione, la libreria 
interrompe temporaneamente tutte le connessioni agli host HSC o ACSLS. Le 
connessioni agli host saranno poi automaticamente ripristinate. Verrà tuttavia 
visualizzata una serie di messaggi di errore e potrebbe essere impossibile concludere i 
task in corso per la gestione delle cartucce.

Nota – Si consiglia di seguire la procedura Correggere le cartucce isolate prima di 
eseguire quella corrente. 

Nota – Se la capacità della libreria corrente è utilizzata in eccesso (ossia le allocazioni 
totali della partizione superano la capacità concessa in licenza), non è possibile eseguire 
questa procedura. Il pulsante Apply non è attivo. Prima di continuare, rimuovere le 
celle di storage dalle allocazioni della partizione per rientrare nella capacità concessa.
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1. Variare la libreria offline per ACSLS e HSC. 

Per le procedure e i comandi, consultare la documentazione del software di gestione 
nastri.

2. Selezionare Tools > Partitions e fare clic sulla scheda Commit (Step 4).

Si apre la schermata Commit (Step 4).

3. Nella barra delle opzioni, fare clic su Apply. 

Vengono verificati i limiti della partizione selezionata, comprese le posizioni di tutte le 
cartucce nastro. 

Nota – La verifica riguarda solo la configurazione della partizione corrente all’interno 
dell’area di lavoro della partizione della SL Console. Non vengono invece verificati i 
limiti della partizione corrente rispetto al database del controller della libreria. Non è 
pertanto possibile individuare conflitti nella configurazione dovuti a eventuali 
movimenti di cartucce per mano di altri utenti o modifiche alla configurazione della 
libreria (eseguite tramite l’interfaccia a riga di comando, altre sessioni della SL Console 
o altre applicazioni host) nel momento in cui sono state apportate le modifiche alla 
partizione. 

Si apre il popup Confirm Apply in cui si specificano eventuali cartucce isolate o altri 
errori nella configurazione della partizione corrente. 



Task di configurazionedella partizione

200 Manuale dell’utente di SL3000 • Aprile 2008 Revisione: A • 418605201

4. Per visualizzare i messaggi di avvertenza dettagliati in cui vengono spiegati i motivi 
per cui le cartucce sono isolate, selezionare Details. 

È possibile utilizzare il pulsante Details per passare da una vista espansa a una chiusa 
dei messaggi di avvertenza. 

5. Nella vista espansa dei messaggi di avvertenza è inoltre possibile eseguire le 
seguenti operazioni:

■ Stampare i dati del messaggio dettagliato facendo clic su Print.

■ Salvare i dati del messaggio dettagliato in un file delimitato da virgole facendo clic 
su Save. 

6. Procedere come segue:

■ Fare clic su No per annullare l’aggiornamento. Il database del controller della libreria 
non viene aggiornato. Si mantengono tuttavia tutte le modifiche alla partizione 
apportate dalla sessione di login nell'area di lavoro della partizione della SL Console. 

■ Fare clic su Yes per aggiornare il database del controller della libreria.

Si apre il popup Commit Success. 

Fare clic su OK per tornare alla schermata Commit (Step 4). 

7. Perché questi aggiornamenti siano riconosciuti, è necessario configurare tutte le 
applicazioni host della libreria interessate. Per le procedure e i comandi, consultare 
la documentazione del software di gestione nastri. 



Task di gestione delle partizioni

418605201 • Revisione: A Capitolo 6 Partizionamento della libraria 201

Task di gestione delle partizioni

▼ Modificare le informazioni riepilogative sulla 
partizione
Utilizzare questa procedura per modificare il nome e la capacità di storage allocata di 
una partizione esistente. 

Nota – Per modificare il tipo di connessione tra partizione e host (HLI o FC-SCSI), 
consultare “Modificare il tipo di interfaccia di una connessione tra partizione e host” a 
pagina 204. 

Nota – Non è possibile modificare l’ID partizione. Per assegnare un ID partizione, 
eliminare la partizione obsoleta e crearne una nuova con un ID nuovo.

Task Pagina

Modificare le informazioni riepilogative sulla partizione 201

Eliminare una partizione 202

Modificare il tipo di interfaccia di una connessione tra partizione e 
host

204

Modificare dettagli di connessione tra partizione e host FC-SCSI 206

Eliminare una connessione tra partizione e host FC-SCSI 207

Aggiornare l’area di lavoro della partizione della SL Console 209

Riallocare le risorse della libreria 210

Apportare una modifica hardware su una libreria partizionata 210



Task di gestione delle partizioni

202 Manuale dell’utente di SL3000 • Aprile 2008 Revisione: A • 418605201

1. Selezionare Tools > Partitions e fare clic sulla scheda Summary (Step 2).

Si apre la schermata Summary (Step 2).

2. Nella sezione Partition Summary, selezionare la partizione da modificare. 

3. Fare clic su Modify Partition.

Si apre il popup Modify a Partition.

4. Inserire le modifiche da apportare. 

5. Fare clic su OK per confermare le modifiche. 

▼ Eliminare una partizione
Utilizzare questa procedura per eliminare una partizione dalla libreria. Di seguito sono 
elencate le modifiche apportate alla configurazione della partizione della libreria:

■ Tutte le risorse allocate alla partizione sono contrassegnate come disponibili. 

■ Tutte le connessioni host per la partizione sono eliminate. 

■ L’ID partizione è eliminato. 

Attenzione – Se si eliminano le partizioni, si potrebbe assistere a cartucce isolate e 
perdita di dati. Consultare “Cartucce isolate in librerie partizionate” a pagina 184 per 
informazioni. 
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Nota – Se si eliminano tutte le partizioni di una libreria, lo stato della libreria diventa 
non partizionata. Tutte le celle di storage, le unità e le CAP attive sono accessibili a tutti 
gli host.

1. Selezionare Tools > Partitions e fare clic sulla scheda Summary (Step 2).

Si apre la schermata Summary (Step 2).

2. Nella sezione Partition Summary, selezionare la partizione da rimuovere.

3. Fare clic su Delete Partition.

Si apre un popup di conferma.

4. Fare clic su OK per confermare l’eliminazione. 

■ Se le partizioni rimangono nella libreria, procedere con Passo 7. 

■ Se non ne rimangono, si apre il popup Select Library Interface Type. 

5. Selezionare il tipo di interfaccia della libreria che si intende assegnare per tutte le 
connessioni host alla libreria. Le opzioni sono le seguenti:

■ HLI

■ FC-SCSI

6. Fare clic su OK per confermare la modifica. 
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7. Gli aggiornamenti sono i seguenti:

Le modifiche alla configurazione della partizione vengono salvate nell’area di lavoro 
della partizione della SL Console per la durata della sessione di login. 

Per aggiornare il database del controller della libreria con tutte le modifiche apportate 
in questa sessione di login alla SL Console, consultare “Verificare le configurazioni della 
partizione” a pagina 194 e “Confermare le modifiche alla configurazione della 
partizione” a pagina 198. 

Se non rimangono partizioni all’interno della libreria, lo stato della libreria cambierà in 
non partizionata non appena saranno salvati gli aggiornamenti. 

▼ Modificare il tipo di interfaccia di una 
connessione tra partizione e host 
Utilizzare questa procedura per modificare il tipo di connessione tra partizione e host 
di una partizione esistente. Date le seguenti conseguenze, utilizzare tale procedura con 
attenzione:

■ La modifica del tipo di interfaccia può comportare la perdita delle connessioni host 
attive. 

■ La modifica del tipo di interfaccia da FC-SCSI a HLI può comportare la perdita dei 
sulla connessione FC-SCSI. 

■ Le CAP non possono essere condivise tra tipi di partizione. La modifica del tipo di 
interfaccia può pertanto comportare la perdita delle assegnazioni definite per CAP 
condivise. Le assegnazioni di CAP dedicate non sono interessate. 

Nota – Per modificare il nome o la capacità di storage allocata di una partizione 
esistente, consultare “Modificare le informazioni riepilogative sulla partizione” a 
pagina 201. 

1. Selezionare Tools > Partitions e fare clic sulla scheda Summary (Step 2).

Si apre la schermata Summary (Step 2).

2. Nella sezione Partition Summary, selezionare la partizione da modificare. 
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3. Fare clic su Modify Partition.

Si apre il popup Modify a Partition.

4. Nel menu a tendina Interface Type, selezionare il tipo di interfaccia che si desidera 
assegnare. Fare clic su OK.

5. La SL Console controlla la configurazione della partizione corrente nell’area di 
lavoro della SL Console. Se la partizione possiede allocazioni di CAP condivise 
oppure in caso di partizioni FC-SCSI e dettagli sulla connessione tra partizione e 
host, vengono visualizzati dei popup di avvertenza. Di seguito sono presentati i 
possibili popup. 

■ Modifica da HLI a FC-SCSI:

■ Modifica da FC-SCSI a HLI:

6. Fare clic su Yes per confermare la modifica. 

Le modifiche alla configurazione della partizione vengono salvate nell’area di lavoro 
della partizione della SL Console per la durata della sessione di login. 

Per aggiornare il database del controller della libreria con tutte le modifiche apportate 
in questa sessione di login alla SL Console, consultare “Verificare le configurazioni della 
partizione” a pagina 194 e “Confermare le modifiche alla configurazione della 
partizione” a pagina 198. 
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▼ Modificare dettagli di connessione tra partizione e 
host FC-SCSI 

Nota – Questa procedura riguarda solo le connessioni tra partizione e host FC-SCSI. Le 
connessioni tra partizione e host HLI sono configurate tramite il software di gestione 
della libreria (HSC o ACSLS), e non tramite la SL Console. Per informazioni, consultare 
la documentazione su HSC e ACSLS. 

Utilizzare questa procedura per modificare il Wide Port Name dell’host e il numero 
LUN della libreria per una connessione tra partizione e host. 

Nota – Non è possibile modificare il numero della porte di destinazione della libreria 
che deve essere sempre 0. 

1. Selezionare Tools > Partitions e fare clic sulla scheda Summary (Step 2).

Si apre la schermata Summary (Step 2).

2. Nella sezione Summary della schermo, fare clic sulla partizione per la quale si 
intende modificare una connessione. 

3. Nella sezione Connections, selezionare la connessione tra partizione e host da 
modificare. 
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Nota – Se si seleziona una partizione HLI, tutti i pulsanti nella sezione Details della 
schermata non sono attivi. 

4. Fare clic su Modify Connection.

Si apre il popup Modify a Connection.

5. Inserire le modifiche da apportare. 

6. Fare clic su OK per confermare le modifiche. 

Le modifiche alla configurazione della partizione vengono salvate nell’area di lavoro 
della partizione della SL Console per la durata della sessione di login. 

Per aggiornare il database del controller della libreria con tutte le modifiche apportate 
in questa sessione di login alla SL Console, consultare “Verificare le configurazioni della 
partizione” a pagina 194 e “Confermare le modifiche alla configurazione della 
partizione” a pagina 198. 

▼ Eliminare una connessione tra partizione e host 
FC-SCSI

Nota – Questa procedura riguarda solo le connessioni tra partizione e host FC-SCSI. Le 
connessioni tra partizione e host HLI sono configurate tramite il software di gestione 
della libreria (HSC o ACSLS), e non tramite la SL Console. Per informazioni, consultare 
la documentazione su HSC e ACSLS. 

Utilizzare questa procedura per eliminare una connessione tra partizione e host. Al 
termine di questa procedura, l’host non potrà più accedere alla partizione. 
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1. Selezionare Tools > Partitions e fare clic sulla scheda Summary (Step 2).

Si apre la schermata Summary (Step 2).

2. Nella sezione Summary della schermata, fare clic sulla partizione per la quale si 
intende eliminare una connessione. 

Nota – Se si seleziona una partizione HLI, tutti i pulsanti nella sezione Details della 
schermata non sono attivi. 

3.  Nella sezione Connections, selezionare la connessione tra partizione e host da 
eliminare.

4. Fare clic su Delete Connection.

Si apre un popup di conferma.
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5. Fare clic su OK per confermare l’eliminazione. 

Le modifiche alla configurazione della partizione vengono salvate nell’area di lavoro 
della partizione della SL Console per la durata della sessione di login. 

Per aggiornare il database del controller della libreria con tutte le modifiche apportate 
in questa sessione di login alla SL Console, consultare “Verificare le configurazioni della 
partizione” a pagina 194 e “Confermare le modifiche alla configurazione della 
partizione” a pagina 198. 

▼ Aggiornare l’area di lavoro della partizione della 
SL Console
Utilizzare questa procedura per aggiornare l’area di lavoro della partizione della 
SL Console con i dati correnti letti dal database del controller della libreria. I dati 
correnti rispecchiano tutti gli aggiornamenti che altri utenti hanno eseguito nel 
database del controller della libreria durante la sessione di login utilizzando 
l’interfaccia a riga di comando, altre sessioni di SL Console o altre applicazioni host. 

Nota – Al termine della procedura, tutte le modifiche non salvate, apportate alla 
partizione durante questa sessione di login alla SL Console saranno annullate. 

1. Selezionare Tools > Partitions.

2. Selezionare una delle seguenti schede:

■ Summary (Step 2) 

■ Design (Step 3b)

Si apre la schermata selezionata.

3.  Nella barra delle opzioni, fare clic su Refresh. 

Si apre il popup Partition Refresh.

4. Fare clic su Yes per confermare l’aggiornamento. 

Tutte le informazioni sullo schermo relative alla partizione vengono aggiornate con i 
dati letti dal database del controller della libreria. 
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▼ Riallocare le risorse della libreria 
Per riallocare le risorse della libreria (celle di storage, unità nastro, CAP o cartucce) da 
una partizione a un’altra, è necessario utilizzare la schermata Design (Step 3b). Seguire 
la seguente procedura a due fasi: 

1. Rimuovere la risorsa dalla partizione in cui è attualmente allocata.

2. Allocare la risorsa in una partizione diversa. 

Consultare “Progettare una partizione” a pagina 191 per istruzioni dettagliate.

Attenzione – Quando le partizioni vengono riallocate, si può assistere a cartucce 
isolate e perdita di dati. Consultare “Cartucce isolate in librerie partizionate” a 
pagina 184 per informazioni. 

▼ Apportare una modifica hardware su una libreria 
partizionata
Alcune modifiche hardware alla libreria (aggiunta di moduli di espansione, di un 
secondo robot o di celle per le CAP) possono richiedere la rimozione di una parte o 
dell’intero modulo partizionato esistente. Utilizzare la procedura seguente per 
apportare tali modifiche hardware senza perdere le informazioni relative alle sezioni 
della libreria che rimangono invariate. 

Attenzione – Se non si segue scrupolosamente questa procedura, si rischia di perdere 
le informazioni di configurazione della partizione della libreria una volta modificato 
l’hardware. 

1. Disallocare tutte le risorse della libreria (celle di storage, CAP e unità) che, con la 
modifica hardware, saranno rimosse dalle partizioni a cui sono attualmente allocate. 

Consultare “Progettare una partizione” a pagina 191 per istruzioni dettagliate.

2. Spegnere la libreria 

Consultare “Spegnere la libreria” a pagina 329 per istruzioni dettagliate. 

3. Installare la modifica hardware.

4. Accendere la libreria 

Consultare “Accendere la libreria” a pagina 329 per istruzioni dettagliate. 

Tutte le allocazioni della partizioni che riguardano parti della libreria non modificate 
rimangono operative.

5. Allocare le risorse della libreria aggiunte in seguito alla modifica hardware. 

Consultare “Progettare una partizione” a pagina 191 per istruzioni dettagliate.

Attenzione – Quando le partizioni vengono riallocate, si può assistere a cartucce 
isolate e perdita di dati. Consultare “Cartucce isolate in librerie partizionate” a 
pagina 184 per informazioni. 
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Task per report sulle partizioni

▼ Visualizzare un report sulle partizioni
Utilizzare questa procedura per visualizzare uno dei seguenti report sulle partizioni:

■ Cartridge Cell and Media Summary: visualizza un elenco dettagliato di tutte le 
assegnazioni di risorse alla partizione.

■ Host Connections Summary: visualizza informazioni dettagliate sulle connessioni tra 
partizioni e host per tutte le partizioni.

■ Orphaned Cartridge Report: visualizza un elenco dettagliato di tutte le cartucce 
isolate.

■ Partition Details: visualizza informazioni dettagliate su una partizione selezionata.

■ Partition Summary: visualizza informazioni riepilogative su tutte le partizioni.

Nota – Nei report sulla partizione vengono elencati i dati salvati nel database del 
controller della libreria. Se la configurazione della partizione è stata modificata senza 
che siano state confermatele modifiche al controller della libreria dalla schermata 
Commit (Step 4), i dati elencati nei report non coincideranno con quelli visualizzati 
nelle schermate relative alle partizioni Summary (Step 2) e Design (Step 3b). 

1.  Selezionare Tools > Partitions e fare clic sulla scheda Reports.

Si apre la schermata Reports.

Task Pagina

Visualizzare un report sulle partizioni 211

Stampare i dati del report sulle partizioni 213

Salvare i dati del report sulle partizioni 214
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2. Nel menu a tendina, selezionare il report da visualizzare. 

Sullo schermo vengono visualizzati i dati correnti letti dal database del controller della 
libreria. 

3. Se si vuole stampare i dati del report e salvarli in un file, seguire le procedure 
seguenti:

■ “Stampare i dati del report sulle partizioni” a pagina 213

■ “Salvare i dati del report sulle partizioni” a pagina 214 
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▼ Stampare i dati del report sulle partizioni
Utilizzare questa procedura per stampare il report su una partizione. Tale procedura 
può essere eseguita da una qualsiasi schermata del report sulla partizione. 

1. Selezionare Tools > Partitions e fare clic sulla scheda Reports.

Si apre la schermata Reports.

2. Nel menu a tendina, selezionare uno dei report. 

Viene visualizzato il report selezionato. In tutte le schermate dei report, sono 
disponibili i pulsanti Print e Save to File. 

3. Fare clic su Print. 

Si apre il popup Print. 

4. Completare il popup di stampa e fare clic su Print. 

Il report viene stampato sulla stampante selezionata. 
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▼ Salvare i dati del report sulle partizioni
Utilizzare questa procedura per salvare i dati di un report partizione su un file 
delimitato da virgole (formato .csv). Per visualizzare il file si possono utilizzare varie 
applicazioni per fogli di calcolo. Tale procedura può essere eseguita da una qualsiasi 
schermata del report sulla partizione. 

1. Selezionare Tools > Partitions e fare clic sulla scheda Reports.

Si apre la schermata Reports.

2. Nel menu a tendina, selezionare uno dei report. 

Viene visualizzato il report selezionato. In tutte le schermate dei report, sono 
disponibili i pulsanti Print e Save to File. 

3. Fare clic su Save to File.

Si apre il popup Save. 

4. Sfogliare la directory in cui si desidera salvare il file e immettere il nome del file. 

5. Fare clic su Save. 

I dati vengono salvati nel file specificato. 
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Task per operazioni sulle CAP 

▼ Associare una partizione FC-SCSI alle CAP 
condivise
Utilizzare questa procedura per associare una partizione FC-SCSI alle CAP condivise. 
Utilizzare questa procedura prima di inserire o espellere le cartucce da una partizione 
FC-SCSI qualora ENTRAMBE le seguenti condizioni siano vere:

■ La partizione condivide una o più CAP con altre partizioni

■ L’applicazione host FC-SCSI non usa prenotazioni di CAP e comandi che 
impediscono o ammettono determinate operazioni.

Nota – Non si deve utilizzare questa procedura con partizioni HLI poiché le 
applicazioni host HLI impiegano sempre prenotazioni di CAP. Se la si usa per le 
partizioni HLI, la CAP non sarà disponibile a host ACSLS e HSC. 

Nota – Tale procedura non è necessaria per le CAP FC-SCSI dedicate perché una 
partizione detiene sempre la proprietà sulle proprie CAP. 

Con questa procedura si assegna a una partizione il diritto di esclusiva sulle sue CAP 
condivise finché l’associazione non viene rimossa in modo esplicito. Consultare 
“Rimuovere un’associazione tra partizione e CAP” a pagina 218 per informazioni. 

Task Pagina

Associare una partizione FC-SCSI alle CAP condivise 215

Inserire le cartucce in una partizione 217

Espellere le cartucce da una partizione 217

Rimuovere un’associazione tra partizione e CAP 218

Ignorare la prenotazione di una CAP 219
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1. Selezionare Tools > Shared CAP Assignment. 

Si apre la schermata Shared CAP Assignment.

2. Fare clic sulla casella di controllo relativa alle partizioni in cui inserire le cartucce. 
Per informazioni sui campi di questa schermata, consultare “Assegnazione 
di CAP condivise” a pagina 273. 

3. Fare clic su Apply. 

Si apre il popup CAP Confirm. 

4. Fare clic su OK. 

5. Eseguire l’operazione di inserimento ed espulsione. Consultare una delle seguenti 
procedure per ulteriori dettagli:

■ “Inserire le cartucce in una partizione” a pagina 217

■ “Espellere le cartucce da una partizione” a pagina 217
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▼ Inserire le cartucce in una partizione
Utilizzare questa procedura per inserire le cartucce in una o più partizioni. Le 
partizioni possono utilizzare solo le CAP che hanno allocate a sé. 

Nota – Se si inseriscono le cartucce in una partizione FC-SCSI che possiede una o più 
CAP condivise e l’applicazione host non utilizza prenotazioni di CAP nonché comandi 
che impediscono o ammettono determinate operazioni, è necessario associare la 
partizione alle CAP prima di avviare questa procedura. Consultare “Associare una 
partizione FC-SCSI alle CAP condivise” a pagina 215. Un errore nella procedura può 
comportare il blocco della CAP e può impedire l’acquisizione della proprietà sulla CAP. 

1. Avviare l’operazione di inserimento nell’host Per le procedure e i comandi, 
consultare la documentazione del software di gestione nastri. 

2. Premere il pulsante CAP per aprire la CAP. 

La porta della CAP si apre. 

3. Posizionare le cartucce nella CAP.

4. Premere il pulsante CAP per chiudere la CAP.

La CAP si chiude e si blocca automaticamente, e la luce sul pulsante CAP si spegne.

5. La TallBot controlla la CAP e sposta le cartucce dalla CAP agli slot di storage 
all’interno della partizione appropriata. 

La luce del pulsante CAP potrebbe riaccendersi una volta completato il controllo. 
Quando tutte le cartucce sono state spostate dalla CAP, la libreria rileva che la CAP è 
vuota. 

6. La prenotazione della CAP viene rilasciata come segue:

■ Se si avvia la procedura da un host HLI o da un host FC-SCSI che utilizzano 
prenotazioni di CAP, l’host rimuove la prenotazione rendendo disponibile la CAP ad 
altre partizioni. 

■ Se prima di tale procedura è stata eseguita manualmente un’associazione tra CAP e 
partizione, è possibile rimuovere l'associazione se la partizione termina con la CAP. 
Per informazioni, consultare la sezione “Rimuovere un’associazione tra partizione e 
CAP” a pagina 218. 

■ Se la partizione FC-SCSI utilizza una CAP dedicata, la CAP rimane sbloccata e 
riservata alla partizione. 

▼ Espellere le cartucce da una partizione
Utilizzare questa procedura per espellere le cartucce da una libreria partizionata. Le 
partizioni possono utilizzare solo le CAP che hanno allocate a sé. 

Nota – Se si espellono le cartucce da una partizione FC-SCSI che possiede una o più 
CAP condivise e l’applicazione host non utilizza prenotazioni di CAP, è necessario 
associare la partizione alle CAP prima di avviare questa procedura. Consultare 
“Associare una partizione FC-SCSI alle CAP condivise” a pagina 215. Un errore nella 
procedura può comportare il blocco della CAP e può impedire l’acquisizione della 
proprietà sulla CAP. 
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1. Avviare l’operazione di espulsione dall’host. Per le procedure e i comandi, consultare 
la documentazione del software di gestione nastri. 

2. La TallBot posiziona le cartucce in una o più CAP assegnate all’host. 

3. Premere il pulsante CAP per aprire la CAP. 

La porta della CAP si apre. 

4. Rimuovere le cartucce dalla CAP.

5. Premere il pulsante CAP per chiudere la CAP.

La CAP si chiude e si blocca automaticamente, e la luce sul pulsante CAP si spegne.

6.  La TallBot controlla la CAP per verificare che sia vuota.

 La luce del pulsante CAP potrebbe riaccendersi una volta completato il controllo.

7.  La prenotazione della CAP viene rilasciata come segue:

■ Se si avvia la procedura da un host HLI o da un host FC-SCSI che utilizzano 
prenotazioni di CAP, l’host rimuove la prenotazione rendendo disponibile la CAP ad 
altre partizioni. 

■ Se prima di tale procedura è stata eseguita manualmente un’associazione tra CAP e 
partizione, è possibile rimuovere l'associazione se la partizione termina con la CAP. 
Per informazioni, consultare la sezione “Rimuovere un’associazione tra partizione e 
CAP” a pagina 218. 

■ Se la partizione FC-SCSI utilizza una CAP dedicata, la CAP rimane sbloccata e 
riservata alla partizione. 

▼ Rimuovere un’associazione tra partizione e CAP
Utilizzare questa procedura dopo aver completato un’operazione di inserimento o di 
espulsione e qualora la partizione sia stata associata precedentemente alle sue CAP 
condivise. Con questa procedura vengono rimosse le associazioni tra CAP e partizioni 
impostate in precendenza. Le CAP condivise tornano quindi disponibili ad altre 
partizioni. 
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1. Selezionare Tools > Shared CAP Assignment. 

Si apre la schermata Shared CAP Assignment.

2. Deselezionare la casella di controllo delle partizioni con associazioni a CAP. Per 
informazioni sui campi di questa schermata, consultare “Assegnazione 
di CAP condivise” a pagina 273. 

3. Fare clic su Apply. 

Si apre il popup CAP Confirm. 

4. Fare clic su OK. 

▼ Ignorare la prenotazione di una CAP
Utilizzare questa procedura quando una CAP condivisa è prenotata per una partizione 
ma la prenotazione non può essere rilasciata dall’host ACSLS o HSC. 

Nota – Questo argomento si applica solo alle librerie partizionate. Se una libreria non è 
partizionata, le prenotazioni delle CAP devono essere rilasciate sempre tramite ACSLS 
o HSC. Per ulteriori informazioni consultare la documentazione su ACSLS e HSC.
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Nota – Seguire tutti i passi di questa procedura. Se non si completa la procedura, la 
CAP potrebbe rimanere non disponibile a tutte le partizioni e/o le cartucce assegnate a 
una partizione potrebbero essere inserite in un’altra partizione. 

1. Selezionare Tools > Diagnostics.

2. Espandere CAP Folder e fare clic sulla CAP la cui prenotazione deve essere ignorata 
(rimozione della prenotazione). 

3.  Fare clic sulla scheda Unreserve.

Si apre la schermata Unreserve in cui è specificata la partizione con la CAP prenotata.

4. Fare clic su Apply per ignorare la prenotazione.

Si apre il popup Unreserve Confirm in cui è visualizzato il messaggio “This will 
remove the reservation from the designated host...” 

■ Fare clic su OK per proseguire con tale operazione. La libreria rimuove la 
prenotazione della CAP e imposta l’utente della CAP su Default. In questo modo la 
CAP non sarà disponibile a tutte le partizioni.

■ Fare clic su Cancel per annullare l’operazione e tornare alla Passo 3. 

5. Se la CAP è bloccata, sbloccarla nella SL Console. Per informazioni sulla procedura, 
consultare “Sbloccare e aprire una CAP” a pagina 86. 
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6. Premere il pulsante CAP per aprire la CAP. 

■ Se è vuota, procedere con la Passo 8. 

■ Se contiene cartucce rimuoverle tutte. 

7. Assegnare un’etichetta alle cartucce con l’ID partizione visualizzato nella Passo 3. 

8. Premere il pulsante CAP per chiudere la CAP. 

La CAP si chiude e blocca automaticamente, e la luce sul pulsante CAP si spegne.

La libreria controlla la CAP per verificare che sia vuota. Lo stato della CAP viene 
quindi impostato su Unreserved. La CAP diventa disponibile a tutte le partizioni alle 
quali è allocata. 

Nota – Aggiornare la visualizzazione della CAP per controllare il suo nuovo stato. 

9. Contattare il responsabile della gestione delle cartucce rimosse così che possa 
determinare dove posizionarle. Se si devono inserire di nuovo nella libreria, inserirle 
nella partizione corretta. 

Riferimento alle schermate delle 
partizioni
In questa sezione vengono elencate descrizioni dettagliate su tutte le schermate della 
SL Console relative alle partizioni, organizzate per percorso di navigazione. Ad 
esempio, Partitions—Summary (Step 2)—Add Connection indica la schermata a cui si 
accede facendo clic su Tools, quindi Partitions dalla barra dei menu, clic sulla scheda 
Summary (Step 2) e infine clic sul pulsante Add Connection. 

Nota – Soltanto la schermata Partitions—Current Partition Definitions è disponibile nel 
pannello operatore locale. A tutte le schermate restanti si accede solo dalla SL Console 
standalone o dalla SL Console via Web.

Le schermate delle partizioni sono suddivise nelle seguenti categorie:

■ “Schermate di riepilogo sulle partizioni” a pagina 222

■ “Schermate per la progettazione delle partizioni e la conferma” a pagina 238

■ “Schermate dei report sulle partizioni” a pagina 255

■ “Schermate operative per CAP partizioni” a pagina 273

Nota – La partizione Summary (Step 2), le schermate Design (Step 3b) e tutti i popup 
correlati forniscono un’area di lavoro dinamica in cui organizzare le partizioni della 
libreria. Tutte le informazioni relative alla configurazione delle partizioni vengono 
automaticamente salvate nell’area di lavoro della partizione nella memoria della 
SL Console e conservate per la durata della sessione della SL Console. In questo modo 
è possibile passare da una vista ad una altra nonché da una schermata all’altra delle 
partizioni tutte le volte necessarie senza perdere le modifiche apportate alla 
configurazione. 
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Attenzione – Le informazioni nell’area di lavoro della partizione della SL Console 
vengono salvate nel database del controller della libreria soltanto tramite la schermta 
Commit (Step 4). Se la sessione della SL Console termina oppure i dati dell’area di 
lavoro vengono aggiornati prima di averli confermati dalla schermata Commit (Step 4), 
andranno perse tutte le modifiche alla partizione apportate tramite le schermate 
Summary (Step 2) e Design (Step 3b) e tutti i popup correlati. 

Schermate di riepilogo sulle partizioni

Partitions—Instructions (Step 1)

Partitions—Summary (Step 2)

Partitions—Summary (Step 2)—Add Connection

Partitions—Summary (Step 2)—Add Connection

Partitions—Summary (Step 2)—Modify Connection

Partitions—Summary (Step 2)—Add Partition

Partitions—Summary (Step 2)—Delete Partition

Partitions—Summary (Step 2)—Modify Partition
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Partitions—Instructions (Step 1)

Schermata di esempio

Descrizione
Visualizza le istruzioni per utilizzare le schermate delle partizioni.

Nota – Questa schermata si apre automaticamente la prima volta in cui si seleziona 
Tools > Partitions durante una sessione di login alla SL Console. 

Campi della schermata
Nessuno

Pulsanti
? (Help) 

Fare clic per visualizzare la guida in linea relativa alla schermata. 
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Consultare anche
■ Partitions—Summary (Step 2) 

■ Partitions—Design (Step 3b) 

■ Partitions—Commit (Step 4) 

■ Partitions—Reports 

Partitions—Summary (Step 2)

Schermata di esempio
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Descrizione
Visualizza le informazioni riepilogative sulla libreria ed eventualmente su una 
partizione selezionata. 

Include anche i pulsanti che consentono di avviare tutte le seguenti attività:

■ Aggiungere una nuova partizione

■ Eliminare una partizione dalla libreria

■ Modificare le informazioni riepilogative sulla partizione

Nota – I seguenti pulsanti sono disponibili solo per le connessioni tra partizione e host 
FC-SCSI. Le connessioni tra partizione e host HLI sono configurate tramite il software 
di gestione della libreria dell’host (HSC o ACSLS), e non tramite la SL Console. Per 
informazioni, consultare la documentazione su HSC e ACSLS. 

■ Aggiungere una nuova connessione tra partizione e host

■ Eliminare una connessione tra partizione e host

■ Modificare la configurazione di una connessione tra partizione e host

Campi della schermata

Partition Summary

Partition Number

Sola visualizzazione.

ID assegnato alla partizione. Gli ID possono essere compresi tra 1 e 8.

Allocated Storage Cells

Sola visualizzazione.

Numero totale delle celle di storage allocate alla partizione. 

Allocated Drive Bays

Sola visualizzazione.

Numero totale delle unità nastro allocate alla partizione. 

Allocated CAPs 

Sola visualizzazione.

Numero totale delle CAP allocate alla partizione. Rappresenta la CAP intera e non le 
singole celle della CAP. 

Allocated CAP Cells

Sola visualizzazione.

Numero totale delle singole celle della CAP allocate alla partizione. 

% Allocated Licensed Capacity 

Sola visualizzazione.

Percentuale della capacità della libreria concessa in licenza che è stata allocata a 
questa partizione. È data da:

(partizione) Allocated Storage Cells / (libreria totale) Licensed Capacity
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Details for Partition n 

Nota – I campi seguenti visualizzano le informazioni sulla connessione tra partizione e 
host relativa alla partizione selezionata attualmente nella tabella Partition Summary. 

Name

Sola visualizzazione.

Nome assegnato alla partizione selezionata. 

Interface Type 

Sola visualizzazione.

Tipo di interfaccia assegnato alla connessione tra partizione e host selezionata. Le 
opzioni sono le seguenti:

■ HLI

■ FC-SCSI

Nota – I seguenti campi sono disponibili solo per le connessioni tra partizione e host 
FC-SCSI. 

Initiator (WWPN) 

Sola visualizzazione.

 WWPN (World Wide Port Name) del controller (HBA) FC-SCSI. 

Target Port 

Sola visualizzazione.

Numero della porta del controller della libreria SL3000. Il valore è sempre 0. 

LUN

Sola visualizzazione.

Numero dell’unità logica (LUN) della partizione della libreria nell’host. Il valore 
deve essere univoco nell’host. 

TOTAL LIBRARY RESOURCES

Storage Cells 

Sola visualizzazione.

Capacità fisica totale della libreria.

Drive Bays 

Sola visualizzazione.

Numero totale delle unità nastro nella libreria.

CAPs 

Sola visualizzazione.

Numero totale delle CAP nella libreria.
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CAP cells

Sola visualizzazione.

Numero totale delle celle CAP nella libreria.

Licensed Capacity 

Sola visualizzazione.

Capacità totale della libreria concessa in licenza. 

RESOURCES ALLOCATED

Storage Cells 

Sola visualizzazione.

Numero totale delle celle di storage allocate a tutte le partizioni della libreria nella 
schermata Design (Step 3b). 

Drive Bays 

Sola visualizzazione.

Numero totale delle unità nastro allocate a tutte le partizioni della libreria.

CAPs 

Sola visualizzazione.

Numero totale delle CAP allocate a tutte le partizioni della libreria.

CAP cells

Sola visualizzazione.

Numero totale delle celle CAP allocate a tutte le partizioni della libreria.

Licensed Capacity 

Sola visualizzazione.

Capacità totale di storage concessa in licenza e assegnata a tutte le partizioni della 
libreria tramite la schermata Add Partition o Modify Partition. 

RESOURCES UNALLOCATED

Storage Cells 

Sola visualizzazione.

Numero totale di celle di storage nella libreria che non sono allocate ad alcuna 
partizione.

Drive Bays 

Sola visualizzazione.

Numero totale di unità nastro nella libreria che non sono allocate ad alcuna 
partizione.

CAPs 

Sola visualizzazione.

Numero totale di CAP nella libreria che non sono allocate ad alcuna partizione.



Schermate di riepilogo sulle partizioni

228 Manuale dell’utente di SL3000 • Aprile 2008 Revisione: A • 418605201

CAP cells

Sola visualizzazione.

Numero totale di celle della CAP nella libreria che non sono allocate ad alcuna 
partizione.

Licensed Capacity 

Sola visualizzazione.

Capacità totale di storage concessa in licenza non assegnata ad alcuna partizione 
della libreria tramite la schermata Add Partition o Modify Partition. È data da:

(libreria totale) Licensed Capacity – (allocata) Licensed Capacity

Pulsanti
Refresh 

Fare clic per aggiornare l’area di lavoro della partizione della SL Console con i dati 
correnti letti dal database del controller della libreria. Tutte le modifiche non 
confermate, apportate alla partizione durante la sessione di login alla SL Console, 
saranno eliminate. Si apre il popup Partition Refresh in cui si richiede di confermare 
l’aggiornamento. 

? (Help) 

Fare clic per visualizzare la guida in linea relativa alla schermata. 

Add Partition

Fare clic per aggiungere una nuova partizione. Si apre il popup 
Partitions—Summary (Step 2)—Add Partition. 

Delete Partition

Fare clic per eliminare la partizione attualmente selezionata. Si apre il popup 
Partitions—Summary (Step 2)—Delete Partition. 

Modify Partition

Fare clic per modificare le informazioni riepilogative sulla partizione selezionata. Si 
apre il popup Partitions—Summary (Step 2)—Modify Partition. 

Nota – I seguenti pulsanti sono disponibili solo per le connessioni tra partizione e host 
FC-SCSI. 

Add Connection

Fare clic per aggiungere una nuova connessione host alla partizione attualmente 
selezionata. Si apre il popup Partitions—Summary (Step 2)—Add Connection. 

Delete Connection

Fare clic per eliminare la connessione tra partizione e host attualmente selezionata. Si 
apre il popup Partitions—Summary (Step 2)—Add Connection.

Modify Connection

Fare clic per modificare la connessione tra partizione e host attualmente selezionata. 
Si apre il popup Partitions—Summary (Step 2)—Modify Connection.
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Consultare anche
■ Partitions—Summary (Step 2) 

■ Partitions—Summary (Step 2)—Add Partition 

■ Partitions—Summary (Step 2)—Delete Partition 

■ Partitions—Summary (Step 2)—Modify Partition 

■ Partitions—Summary (Step 2)—Add Connection 

■ Partitions—Summary (Step 2)—Add Connection 

■ Partitions—Summary (Step 2)—Modify Connection 

■ Partitions—Module Map (Step 3a) 

■ Partitions—Design (Step 3b) 

■ Partitions—Commit (Step 4) 

■ Partitions—Reports 

Partitions—Summary (Step 2)—Add Connection

Schermata di esempio

Descrizione
Consente di configurare la connessione tra un host e la partizione selezionata. Ogni 
partizione può avere fino a nove connessioni tra partizione e host, ognuna con un LUN 
univoco. 

Nota – Questa procedura è disponibile solo per le connessioni tra partizione e host 
FC-SCSI. Le connessioni tra partizione e host HLI sono configurate tramite il software 
di gestione della libreria dell’host (HSC o ACSLS), e non tramite la SL Console. Per 
informazioni consultare la documentazione su HSC e ACSLS. 

Questa schermata è un popup che si apre quando si seleziona Add Connection nella 
schermata Partitions—Summary (Step 2). 
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Attenzione – Le informazioni nell’area di lavoro della partizione della SL Console 
vengono salvate nel database del controller della libreria soltanto tramite la schermta 
Commit (Step 4). Se la sessione della SL Console termina oppure i dati dell’area di 
lavoro vengono aggiornati prima di averli confermati dalla schermata Commit (Step 4), 
andranno perse tutte le modifiche alla partizione apportate tramite le schermate 
Summary (Step 2) e Design (Step 3b) e tutti i popup correlati. 

Campi della schermata
Connections n 

Sola visualizzazione.

ID partizione della partizione selezionata. 

Initiator (WWPN) 

Necessario.

WWPN (World Wide Port Name) del controller (HBA) FC-SCSI. 

Sedici cifre esadecimali. È possibile inserire le cifre esadecimali sia in maiuscolo sia 
in minuscolo. Vengono tuttavia visualizzate sempre in maiuscolo. 

Target Port

Sola visualizzazione.

Numero della porta del controller della libreria SL3000. Il valore è sempre 0. 

LUN

Necessario.

Numero dell’unità logica (LUN) della partizione della libreria nell’host. Il valore 
deve essere univoco nell’host. È possibile inserire fino a nove LUN univoci per 
partizione. 

Nota – Tutti gli iniziatori connessi alla libreria devono avere una partizione della 
libreria assegnata a LUN 0. Al momento della verifica o della conferma della modifiche 
di configurazione, la SL Console informerà l’utente qualora un iniziatore non 
soddisfacesse questo requisito. 

Pulsanti
OK

Fare clic per aggiornare l’area di lavoro della partizione della SL Console con le 
impostazioni correnti della schermata e tornare alla schermata precedente. 

Nota – Il database del controller della libreria non viene aggiornato facendo clic su 
questo pulsante. 

Cancel

Fare clic per eliminare le impostazioni correnti della schermata e tornare alla 
schermata precedente. 
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Consultare anche
■ Partitions—Summary (Step 2) 

Partitions—Summary (Step 2)—Add Connection

Schermata di esempio

Descrizione
Consente di eliminare la connessione tra partizione e host selezionata. 

Nota – Questa procedura è disponibile solo per le connessioni tra partizione e host 
FC-SCSI. Le connessioni tra partizione e host HLI sono configurate tramite il software 
di gestione della libreria dell’host (HSC o ACSLS), e non tramite la SL Console. Per 
informazioni consultare la documentazione su HSC e ACSLS. 

Questa schermata è un popup che si apre quando si seleziona Delete Connection nella 
schermata Partitions—Summary (Step 2). 

Attenzione – Le informazioni nell’area di lavoro della partizione della SL Console 
vengono salvate nel database del controller della libreria soltanto tramite la schermta 
Commit (Step 4). Se la sessione della SL Console termina oppure i dati dell’area di 
lavoro vengono aggiornati prima di averli confermati dalla schermata Commit (Step 4), 
andranno perse tutte le modifiche alla partizione apportate tramite le schermate 
Summary (Step 2) e Design (Step 3b) e tutti i popup correlati. 

Campi della schermata
Nessuno

Pulsanti
OK

Fare clic per aggiornare l’area di lavoro della partizione della SL Console con le 
impostazioni correnti della schermata e tornare alla schermata precedente. 

Nota – Il database del controller della libreria non viene aggiornato facendo clic su 
questo pulsante. 
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Cancel

Fare clic per eliminare le impostazioni correnti della schermata e tornare alla 
schermata precedente. 

Consultare anche
■ Partitions—Summary (Step 2) 

Partitions—Summary (Step 2)—Modify Connection

Schermata di esempio

Descrizione
Consente di modificare la connessione tra partizione e host selezionata. 

Nota – Questa procedura è disponibile solo per le connessioni tra partizione e host 
FC-SCSI. Le connessioni tra partizione e host HLI sono configurate tramite il software 
di gestione della libreria dell’host (HSC o ACSLS), e non tramite la SL Console. Per 
informazioni consultare la documentazione su HSC e ACSLS. 

Questa schermata è un popup che si apre quando si seleziona Modify Connection nella 
schermata Partitions—Summary (Step 2). 

Attenzione – Le informazioni nell’area di lavoro della partizione della SL Console 
vengono salvate nel database del controller della libreria soltanto tramite la schermta 
Commit (Step 4). Se la sessione della SL Console termina oppure i dati dell’area di 
lavoro vengono aggiornati prima di averli confermati dalla schermata Commit (Step 4), 
andranno perse tutte le modifiche alla partizione apportate tramite le schermate 
Summary (Step 2) e Design (Step 3b) e tutti i popup correlati. 
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Campi della schermata
Connections n 

Sola visualizzazione.

ID partizione della partizione selezionata. 

Initiator (WWPN) 

WWPN (World Wide Port Name) del controller (HBA) FC-SCSI. 

Sedici cifre esadecimali. È possibile inserire le cifre esadecimali sia in maiuscolo sia 
in minuscolo. Vengono tuttavia visualizzate sempre in maiuscolo. 

Sullo schermo viene visualizzato il valore assegnato in precedenza. È possibile 
mantenere questo valore oppure modificarlo. 

Target Port

Sola visualizzazione.

Numero della porta del controller della libreria SL3000. Il valore è sempre 0. 

LUN

Necessario.

Numero dell’unità logica (LUN) della partizione della libreria nell’host. Il valore 
deve essere univoco nell’host. 

Nota – Tutti gli iniziatori connessi alla libreria devono avere una partizione della 
libreria assegnata a LUN 0. Al momento della verifica o della conferma della modifiche 
di configurazione, la SL Console informerà l’utente qualora un iniziatore non 
soddisfacesse questo requisito. 

Pulsanti
OK

Fare clic per aggiornare l’area di lavoro della partizione della SL Console con le 
impostazioni correnti della schermata e tornare alla schermata precedente. 

Nota – Il database del controller della libreria non viene aggiornato facendo clic su 
questo pulsante. 

Cancel

Fare clic per eliminare le impostazioni correnti della schermata e tornare alla 
schermata precedente. 

Consultare anche
■ Partitions—Summary (Step 2) 
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Partitions—Summary (Step 2)—Add Partition 

Schermata di esempio

Descrizione
Consente di aggiungere una nuova partizione. È possibile creare fino a otto partizioni, 
con ID compresi tra 1 e 8.

Questa schermata è un popup che si apre quando si seleziona Add Partition nella 
schermata Partitions—Summary (Step 2). 

Attenzione – Le informazioni nell’area di lavoro della partizione della SL Console 
vengono salvate nel database del controller della libreria soltanto tramite la schermta 
Commit (Step 4). Se la sessione della SL Console termina oppure i dati dell’area di 
lavoro vengono aggiornati prima di averli confermati dalla schermata Commit (Step 4), 
andranno perse tutte le modifiche alla partizione apportate tramite le schermate 
Summary (Step 2) e Design (Step 3b) e tutti i popup correlati. 

Campi della schermata
Select a Partition ID

Necessario.

ID partizione da aggiungere. i valori possibili sono compresi tra 1 e 8. 

Il menu a discesa visualizza tutti gli ID disponibili. Il valore predefinito è l’ID 
immediatamente disponbile in ordine numerico. 

Name

Opzionale.

Nome da assegnare alla partizione. 

Caratteri ASCII da 0 a 60. 

Interface Type 

Necessario.

Tipo di interfaccia da utilizzare per la connessione tra partizione e host. Le opzioni 
sono le seguenti:

■ HLI

■ FC-SCSI
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Pulsanti
OK

Fare clic per aggiornare l’area di lavoro della partizione della SL Console con le 
impostazioni correnti della schermata e tornare alla schermata precedente. 

Nota – Il database del controller della libreria non viene aggiornato facendo clic su 
questo pulsante. 

Cancel

Fare clic per eliminare le impostazioni correnti della schermata e tornare alla 
schermata precedente. 

Consultare anche
■ Partitions—Summary (Step 2) 

Partitions—Summary (Step 2)—Delete Partition

Schermata di esempio

Descrizione
Consente di confermare l’eliminazione della partizione specificata. Tutte le 
informazioni sulla partizione (connessioni tra partizione e host, limiti partizione e ID 
partizione) vengono eliminati dall’area di lavoro della partizione della SL Console. 

Questa schermata è un popup che si apre quando si seleziona Delete Partition nella 
schermata Partitions—Summary (Step 2). 

Attenzione – Le informazioni nell’area di lavoro della partizione della SL Console 
vengono salvate nel database del controller della libreria soltanto tramite la schermta 
Commit (Step 4). Se la sessione della SL Console termina oppure i dati dell’area di 
lavoro vengono aggiornati prima di averli confermati dalla schermata Commit (Step 4), 
andranno perse tutte le modifiche alla partizione apportate tramite le schermate 
Summary (Step 2) e Design (Step 3b) e tutti i popup correlati. 

Campi della schermata
Nessuno
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Pulsanti
OK

Fare clic per aggiornare l’area di lavoro della partizione della SL Console con le 
impostazioni correnti della schermata e tornare alla schermata precedente. 

Nota – Il database del controller della libreria non viene aggiornato facendo clic su 
questo pulsante. 

Cancel

Fare clic per eliminare le impostazioni correnti della schermata e tornare alla 
schermata precedente. 

Consultare anche
■ Partitions—Summary (Step 2) 

Partitions—Summary (Step 2)—Modify Partition

Schermata di esempio

Descrizione
Consente di modificare il nome o il tipo di connessione tra partizione e host assegnato 
alla partizione selezionata. 

Questa schermata è un popup che si apre quando si seleziona Modify Partition nella 
schermata Partitions—Summary (Step 2). 

Attenzione – Le informazioni nell’area di lavoro della partizione della SL Console 
vengono salvate nel database del controller della libreria soltanto tramite la schermta 
Commit (Step 4). Se la sessione della SL Console termina oppure i dati dell’area di 
lavoro vengono aggiornati prima di averli confermati dalla schermata Commit (Step 4), 
andranno perse tutte le modifiche alla partizione apportate tramite le schermate 
Summary (Step 2) e Design (Step 3b) e tutti i popup correlati. 
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Campi della schermata
Modify Partition n 

Sola visualizzazione.

ID della partizione da modificare. 

Name

Nome da assegnare alla partizione. 

Caratteri ASCII da 0 a 60. 

Sullo schermo viene visualizzato il valore assegnato in precedenza. È possibile 
mantenere questo valore oppure modificarlo. 

Interface Type 

Tipo di interfaccia da utilizzare per la connessione tra partizione e host. Le opzioni 
sono le seguenti:

■ HLI

■ FC-SCSI

Sullo schermo viene visualizzato il valore assegnato in precedenza. È possibile 
mantenere questo valore oppure modificarlo. 

Nota – La modifica del tipo di interfaccia può comportare la perdita delle connessioni 
host attive e delle allocazioni di CAP condivise. Consultare “Modificare il tipo di 
interfaccia di una connessione tra partizione e host” a pagina 204 per informazioni. 

Pulsanti
OK

Fare clic per aggiornare l’area di lavoro della partizione della SL Console con le 
impostazioni correnti della schermata e tornare alla schermata precedente. 

Nota – Il database del controller della libreria non viene aggiornato facendo clic su 
questo pulsante. 

Cancel

Fare clic per eliminare le impostazioni correnti della schermata e tornare alla 
schermata precedente. 

Consultare anche
■ Partitions—Summary (Step 2) 
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Schermate per la progettazione delle 
partizioni e la conferma

Partitions—Module Map (Step 3a)

Schermata di esempio

Partitions—Design (Step 3b)

Partitions—Design (Step 3b)—Verify Results

Partitions—Commit (Step 4)

Partitions—Commit (Step 4)—Confirm Apply

Partitions—Current Partition Definitions
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Descrizione
Consente di selezionare il modulo della libreria per il quale si intede definire i limiti 
della partizione. 

Campi della schermata
Select a module from the map below 

Necessario.

Sullo schermo viene visualizzata un'immagine sulla configurazione attuale del 
modulo della libreria. Le informazioni sono lette direttamente dal database del 
controller della libreria. 

Fare clic sul modulo per cui si intende progettare una partizione, quindi fare clic 
sulla scheda Design (Step 3b). 

Pulsanti
? (Help) 

Fare clic per visualizzare la guida in linea relativa alla schermata. 

Consultare anche
■ Partitions—Design (Step 3b) 
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Partitions—Design (Step 3b)

Schermata di esempio

Descrizione
Consente di definire i limiti della partizione selezionando le risorse (celle di storage, 
unità nastro o CAP) da includere nella partizione. È possibile utilizzare uno dei 
seguenti metodi per aggiungere o rimuovere le risorse da una partizione (consultare 
“Library Map” a pagina 244 per ulteriori istruzioni): 

■ Selezionare le singole celle o i gruppi di celle

■ Selezionare un’intera colonna all’interno del modulo della libreria (dall’alto al basso)

■ Selezionare un lato all’interno del modulo della libreria (frontale o posteriore)

■ Selezionare un intero modulo della libreria

Nota – Questa videata è disponibile solo se le partizioni per la libreria sono state 
definite dalla schermata Partitions—Summary (Step 2)—Add Partition. 



Schermate per la progettazione delle partizioni e la conferma

418605201 • Revisione: A Capitolo 6 Partizionamento della libraria 241

Attenzione – Se si eliminano i limiti della partizione, si potrebbe assistere a cartucce 
isolate e perdita di dati. Consultare “Cartucce isolate in librerie partizionate” a 
pagina 184 per informazioni. 

Nota – La partizione Summary (Step 2), le schermate Design (Step 3b) e tutti i popup 
correlati forniscono un’area di lavoro dinamica in cui organizzare le partizioni della 
libreria. Tutte le informazioni relative alla configurazione delle partizioni vengono 
automaticamente salvate nell’area di lavoro della partizione nella memoria della 
SL Console e conservate per la durata della sessione della SL Console. In questo modo 
è possibile passare da una vista ad una altra nonché da una schermata all’altra delle 
partizioni tutte le volte necessarie senza perdere le modifiche apportate alla 
configurazione. 

Attenzione – Le informazioni nell’area di lavoro della partizione della SL Console 
vengono salvate nel database del controller della libreria soltanto tramite la schermta 
Commit (Step 4). Se la sessione della SL Console termina oppure i dati dell’area di 
lavoro vengono aggiornati prima di averli confermati dalla schermata Commit (Step 4), 
andranno perse tutte le modifiche alla partizione apportate tramite le schermate 
Summary (Step 2) e Design (Step 3b) e tutti i popup correlati. 

Campi della schermata
Partition

Necessario.

Partizione in cui aggiungere o da cui rimuovere le risorse (celle di storage, unità 
nastro o CAP). 

Il menu a discesa visualizza tutti gli ID partizione validi per la libreria. Identifica 
inoltre il tipo di interfaccia host (FC-SCSI o HLI). Se non si definiscono ID partizione, 
il menu è vuoto. 

Nota – Quando si seleziona una partizione, la schermata viene automaticamente 
aggiornata e vengono visualizzati i dati relativi a quella partizione letti dall’area di 
lavoro della partizione della SL Console. 

Select by

Necessario.

Indica il metodo da utilizzare per definire i limiti della partizione. Le opzioni sono le 
seguenti:

■ Cell: vengono selezionati un gruppo singolo o gruppi rettangolari di risorse.

■ Column: vengono selezionate tutte le risorse in una colonna. 

■ Side: vengono selezionate tutte le risorse (CAP escluse) in un lato di un modulo 
della libreria. 

■ Module: vengono selezionate tutte le risorse (CAP escluse) in un modulo della 
libreria. 

Nota – È necessario selezionare Add o Remove. 
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Add

Necessario.

Indica che si vogliono assegnare delle risorse alla partizione. Si possono selezionare 
soltanto le risorse non allocate nella mappa della libreria. 

Remove

Necessario.

Indica che si vogliono rimuovere delle risorse dalla partizione. Si possono 
selezionare soltanto le risorse allocate nella mappa della libreria. 

Allocated to Partition n 

Nota – I dati in questi campi vengono aggiornati automaticamente dall’area di lavoro 
della partizione della SL Console dopo aver selezionato una partizione.

Storage Cells 

Sola visualizzazione.

Numero totale delle celle di storage allocate alla partizione selezionata, in base ai 
limiti della partizione attualmente definiti. 

Drive Bays

Sola visualizzazione.

Numero totale delle unità nastro allocate alla partizione selezionata, in base ai limiti 
della partizione attualmente definiti. 

CAP Cells

Sola visualizzazione.

Numero totale delle celle CAP allocate alla partizione selezionata, in base ai limiti 
della partizione attualmente definiti. 

Unallocated in Library 

Nota – I dati in questi campi vengono aggiornati automaticamente dall’area di lavoro 
della partizione della SL Console dopo aver selezionato una partizione.

Storage Cells 

Sola visualizzazione.

Numero totale di celle di storage nella libreria che non sono allocate ad alcuna 
partizione.

Drive Bays

Sola visualizzazione.

Numero totale di unità nastro nella libreria che non sono allocate ad alcuna 
partizione.
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CAP Cells

Sola visualizzazione.

Numero totale di celle della CAP nella libreria che non sono allocate ad alcuna 
partizione.

Licensed Capacity 

Nota – Questo campo viene visualizzato soltanto se la libreria possiede una capacità 
concessa in licenza non allocata. Se le allocazioni superano tale capacità (utilizzo della 
capacità in eccesso), viene visualizzato il campo Oversubscription. 

Sola visualizzazione.

Capacità totale della libreria concessa in licenza non allocata ad alcuna partizione. 
È data da:

Capacità totale della libreria concessa in licenza – Totale delle celle di storage 
allocate 

Oversubscription 

Nota – Questo campo viene visualizzato soltanto se le allocazioni superano la capacità 
concessa in licenza (utilizzo della capacità in eccesso). Se la libreria possiede una 
capacità in licenza non allocata, viene visualizzato il campo Licensed Capacity. 

Sola visualizzazione.

Capacità totale della libreria concessa in licenza superata in seguito alle allocazioni 
della partizioni. È data da:

Totale delle celle di storage allocate – Capacità totale concessa in licenza 

È necessario rimuovere le allocazioni in eccesso prima di poter confermare le 
mofiche dalla schermata Commit (Step 4). 

Legend 
Legenda per la mappa della libreria. Lo stato di ogni risorsa della libreria (cella di 
storage, unità nastro o cella CAP) è indicato come segue: 

■ Not Accessible (bianco e barrato con una x-). La risorsa non è accessibile ad 
alcuna risorsa. Di seguito sono elencate i possibili motivi:

- Le celle di storage sono state configurate per le cartucce diagnostiche 

- Le celle di storage non sono comprese nella capacità concessa in licenza della 
libreria. 

■ Unallocated. La risorsa non è attualmente allocata ad alcuna partizione e pertanto 
è disponibile per la partizione selezionata. 

■ Partition n (in oro) La risorsa è allocata alla partizione selezionata, partition n. 

■ Other Partitions (in rosso). La risorsa è allocata a un’altra partizione e pertanto 
NON è disponibile per la partizione selezionata. 

■ Shared CAP (con sfondo grigio) La CAP è stata assegnata ad almeno una 
partizione Viene visualizzato il tipo di interfaccia host assegnato alla CAP (HLI o 
SCSI).

■ Cartridge (icona di una cartuccia). La risorsa contiene una cartuccia nastro. 

■ Gli slot unità con unità installate sono evidenziate da un bordo spesso. Gli slot 
unità vuoti hanno invece un bordo sottile. 
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Library Map 
Rappresentazione grafica della configurazione corrente della libreria. I dati per la 
visualizzazione iniziale della sessione di login alla SL Console vengono letti dal 
database del controller della libreria. Dopo aver modificato le configurazioni delle 
partizioni, saranno visualizzati i dati rilevati dall’area di lavoro della partizione della 
SL Console. Sono visualizzate le seguenti informazioni:

■ Tipo di modulo attualmente visualizzato (Base Module, modulo DEM, modulo 
PEM) 

■ ID modulo numerico (da 1 a 12)

■ Posizione di tutte le risorse (celle di storage, unità nastro, celle di CAP) all’interno 
della libreria

■ Tipo di connessione tra partizione e host di una CAP condivisa 

Nota – Spostare il cursore su una delle risorse per visualizzare un tooltip con le 
informazioni dettagliate sulla cella o sull’unità, l’assegnazione della partizione e 
l’identità di ogni cartuccia installata. 

Nota – Se non si definiscono ID partizione, la mappa della libreria sarà di sola 
visualizzazione.

Utilizzare la mappa della libreria per modificare i limiti della partizione selezionata. 
A seconda che sia stato selezionato il pulsante di scelta Add o Remove, tutte le 
risorse selezionate vengono aggiunte o rimosse dalla partizione. 

In base al valore selezionato nel campo Select by, è possibile eseguire una delle 
seguenti azioni. 

■ Select by cell: vengono selezionati risorse singole o gruppi di risorse. Non è 
necessario che le risorse di una partizione siano adiacenti. 

- Per selezionare una risorsa singola, fare doppio clic.

- Per selezionare un gruppo rettangolare di risorse, fare clic sulla cella o l’unità 
in un angolo del rettangolo, quindi selezionare la cella o l’unità diagonalmente 
opposta. 

■ Select by column: viene selezionata un’intera colonna del modulo. Non è 
necessario che le colonne di una partizione siano adiacenti. Per selezionare una 
colonna, fare clic su una qualsiasi risorsa della colonna. 

■ Select by side: vene selezionato un intero lato di un modulo, CAP esclusa. Non è 
necessario che i lati di una partizione siano adiacenti. Per selezionare un lato di 
un modulo della libreria, fare clic su una qualsiasi risorsa del lato. 

■ Select by module: viene selezionato un intero modulo, CAP esclusa. Non è 
necessario che i moduli in una partizione siano adiacenti. Per selezionare un 
modulo della libreria, fare clic su una qualsiasi risorsa del modulo. 

Pulsanti
Move Left 

Fare clic per visualizzare il primo modulo della libreria a sinistra di quello 
attualmente visualizzato. Il pulsante non è attivo se non esistono moduli a sinistra. 
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Move Right 

Fare clic per visualizzare il primo modulo della libreria a destra di quello 
attualmente visualizzato. Il pulsante non è attivo se non esistono moduli a destra. 

Verify 

Fare clic per verificare le modifiche apportate alla configurazione della 
partizione durante la sessione di login alla SL Console. Si apre il popup 
Tools > Partitions—Design (Step 3b)—Verify Results ad indicare l’eventuale 
presenza di cartucce isolate o di altri errori nella configurazione della partizione 
corrente.

Nota – Questa procedura verifica una sola partizione per volta. Se è necessario 
verificare più di una partizione, ripetere la procedura separatamente per ogni 
partizione. 

Nota – La verifica riguarda solo la configurazione della partizione corrente all’interno 
dell’area di lavoro della partizione della SL Console. Non vengono invece verificati i 
limiti della partizione corrente rispetto al database del controller della libreria. Non è 
pertanto possibile individuare conflitti nella configurazione dovuti a eventuali 
movimenti di cartucce per mano di altri utenti o modifiche alla configurazione della 
libreria (eseguite tramite l’interfaccia a riga di comando, altre sessioni della SL Console 
o altre applicazioni host) nel momento in cui sono state apportate le modifiche alla 
partizione. 

Refresh 

Fare clic per aggiornare l’area di lavoro della partizione della SL Console con i dati 
correnti letti dal database del controller della libreria. Tutte le modifiche non 
confermate, apportate alla partizione durante la sessione di login alla SL Console, 
saranno eliminate. Si apre il popup Partition Refresh in cui si richiede di confermare 
l’aggiornamento. 

? (Help) 

Fare clic per visualizzare la guida in linea relativa alla schermata. 

Consultare anche
■ Partitions—Summary (Step 2) 

■ Partitions—Module Map (Step 3a)

■ Partitions—Design (Step 3b)—Verify Results 

■ Partitions—Commit (Step 4) 

■ Partitions—Current Partition Definitions 

■ Partitions—Reports 
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Partitions—Design (Step 3b)—Verify Results

Schermata di esempio

Descrizione
Visualizza un elenco degli errori di configurazione nell’area di lavoro corrente della 
partizione della SL Console. 

Questa schermata è un popup che si apre quando si seleziona Verify Results nella 
schermata Partitions—Design (Step 3b). 
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Errori possibili:

■ Una partizione contiene cartucce isolate. Per informazioni, consultare la sezione 
“Cartucce isolate in librerie partizionate”.

■ Le risorse della libreria sono state rimosse da una partizione. 

■ La connessione tra partizione e host non dispone di una partizione assegnata a 
LUN 0 (solo per connessioni FC-SCSI). 

In presenza di uno di questi errori, la schermata visualizza all’inizio dei messaggi di 
avvertenza riepilogativi. È possibile visualizzare i messaggi dettagliati facendo clic sul 
pulsante Details. 

Si consiglia di correggere tutti gli errori prima di confermare i dati nel database del 
controller della libreria. 

Si può eventualmente stampare i dati della schermata oppure salvarli in un file 
delimitato da virgole. 

Nota – La partizione Summary (Step 2), le schermate Design (Step 3b) e tutti i popup 
correlati forniscono un’area di lavoro dinamica in cui organizzare le partizioni della 
libreria. Tutte le informazioni relative alla configurazione delle partizioni vengono 
automaticamente salvate nell’area di lavoro della partizione nella memoria della 
SL Console e conservate per la durata della sessione della SL Console. In questo modo 
è possibile passare da una vista ad una altra nonché da una schermata all’altra delle 
partizioni tutte le volte necessarie senza perdere le modifiche apportate alla 
configurazione. 

Attenzione – Le informazioni nell’area di lavoro della partizione della SL Console 
vengono salvate nel database del controller della libreria soltanto tramite la schermta 
Commit (Step 4). Se la sessione della SL Console termina oppure i dati dell’area di 
lavoro vengono aggiornati prima di averli confermati dalla schermata Commit (Step 4), 
andranno perse tutte le modifiche alla partizione apportate tramite le schermate 
Summary (Step 2) e Design (Step 3b) e tutti i popup correlati. 

Campi della schermata

Nota – I campi di questa schermata sono gli stessi visualizzati nel popup 
Partitions—Commit (Step 4)—Confirm Apply. 

Warnings found

Sola visualizzazione.

Messaggi di errore riepilogativi relativi alla configurazione della partizione. 

The library is oversubscribed. Please unallocate nnn storage cells. 

Sola visualizzazione.

Indica che le allocazioni della partizione totale superano attualmente la capacità 
della libreria concessa in licenza. nnn è il numero delle celle che è necessario 
rimuovere dalle allocazioni. Il pulsante Apply nella schermata Commit (Step 4) 
rimane disattivato fino a quando il totale delle celle allocate rientra nella capacità 
della libreria concessa in licenza. 
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The following hosts will need re-audited

Sola visualizzazione.

World Wide Port Name (WWPN) di un qualsiasi host che necessita di un nuovo 
controllo della partizione della libreria. Può succedere se le risorse della libreria sono 
state eliminate dalla partizione. 

The following hosts do not have Lun 0 set

Sola visualizzazione.

World Wide Port Name (WWPN) di un qualsiasi host che non dispone di partizioni 
della libreria impostate come LUN 0 nell’host. L’errore riguarda solo le connessioni 
tra partizione e host FC-SCSI. 

The following orphaned cartridges were found

Sola visualizzazione.

Informazioni dettagliate relative a tutte le cartucce isolate nella configurazione 
corrente della partizione. Comprende la posizione dilibreria, binario, colonna, lato, 
riga della cartuccia, il numero di serie del volume (VOLID), le cause possibili nonché 
le spiegazioni sul perché la cartuccia è isolata. 

Pulsanti
Print

Fare clic per stampare il report sulla stampante selezionata.

Save

Fare clic per salvare il report come file di testo designato e delimitato da virgole 
(estensione .csv). Sono molti i fogli di calcolo e i programmi database in grado di 
aprire i file delimitati da virgole. 

OK

Fare clic per annullare l’aggiornamento. Il database del controller della libreria non 
viene aggiornato. Si mantengono tuttavia tutte le modifiche alla partizione apportate 
dalla sessione di login nell'area di lavoro della partizione della SL Console. 

Details 

Fare clic per passare da una vista espansa a una chiusa della visualizzazione dei 
messaggi di avvertenza. 

Consultare anche
■ Partitions—Design (Step 3b) 

■ Partitions—Commit (Step 4)—Confirm Apply 
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Partitions—Commit (Step 4)

Schermata di esempio

Descrizione
Consente di confermare tutti i dati dell’area di lavoro della partizione corrente della 
SL Console nel database del controller della libreria. Saranno confermati i dati seguenti 
di tutte le partizioni: 

■ Informazioni riepilogative sulla partizione

■ Informazioni sulla configurazione della connessione tra partizione e host 

■ Dettagli sui limiti della partizione 
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Attenzione – Per questi motivi, si consiglia di non mettere la libreria a disposizione di 
altri utenti finché non si confermano le modifiche apportate all’aria di lavoro della 
partizione.  
 
Non esiste una convalida in tempo reale dei limiti della partizione rispetto al database 
del controller della libreria. Quindi, se la libreria viene resa disponibile e altri utenti 
muovono le cartucce o apportano modifiche alla configurazione della libreria, si 
potrebbe assistere a conflitti di configurazione. Per informazioni, consultare la sezione 
“Sincronizzare la visualizzazione con il database del controller” a pagina 35.  
 
In fase di conferma delle modifiche alle configurazioni della partizione, la libreria 
interrompe temporaneamente tutte le connessioni agli host HSC o ACSLS. Le 
connessioni agli host saranno poi automaticamente ripristinate. Verrà tuttavia 
visualizzata una serie di messaggi di errore e potrebbe essere impossibile concludere i 
task in corso per la gestione delle cartucce.

Attenzione – Le informazioni nell’area di lavoro della partizione della SL Console 
vengono salvate nel database del controller della libreria soltanto tramite la schermta 
Commit (Step 4). Se la sessione della SL Console termina oppure i dati dell’area di 
lavoro vengono aggiornati prima di averli confermati dalla schermata Commit (Step 4), 
andranno perse tutte le modifiche alla partizione apportate tramite le schermate 
Summary (Step 2) e Design (Step 3b) e tutti i popup correlati. 

Attenzione – Si consiglia di seguire la procedura Correggere le cartucce isolate prima 
di utilizzare questa schermata. 

Attenzione – In questa schermata, il database del controller della libreria viene 
aggiornato con tutte le modifiche apportate alla configurazione della partizione durante 
la sessione della SL Console. Se questa schermata viene erroneamente utilizzata prima 
di aver abbandonato la sessione corrente della SL Console, tutte le modifiche andranno 
perse.

Campi della schermata
Nessuno

Pulsanti
Apply

Fare clic per aggiornare il database del controller della libreria utilizzando le 
impostazioni correnti dell'area di lavoro della partizione di SL Console. Si apre il 
popup Tools > Partitions—Commit (Step 4)—Confirm Apply a indicare l'eventuale 
presenza di cartucce isolate o di altri errori nella configurazione corrente della 
partizione. 
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Nota – Il pulsante non è attivo se le allocazioni totali della partizione superano al 
momento la capacità della libreria concessa in licenza. Per attivarlo, è necessario 
rimuovere le celle di storage dalle allocazioni della partizione. In questo modo il totale 
delle celle allocate rientrerà nella capacità della libreria concessa in licenza.

Nota – Il pulsante è disattivato se non sono state apportate modifiche all’area di lavoro 
della partizione di SL Console dall’ultima conferma. 

? (Help) 

Fare clic per visualizzare la guida in linea relativa alla schermata. 

Consultare anche
■ Partitions—Summary (Step 2) 

■ Partitions—Design (Step 3b) 

■ Partitions—Design (Step 3b)—Verify Results 

■ Partitions—Commit (Step 4)—Confirm Apply 

■ Partitions—Reports 

Partitions—Commit (Step 4)—Confirm Apply

Schermata di esempio
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Descrizione
Visualizza un elenco degli errori di configurazione nell’area di lavoro corrente della 
partizione della SL Console. Questa schermata è un popup che si apre quando si 
seleziona Apply nella schermata Partitions—Commit (Step 4). 

Dopo aver visualizzato i messaggi di errore, è possibile confermare tutti i dati dell’area 
di lavoro della partizione di SL Console nel database del controller della libreria, 
facendo clic sul pulsante Yes. 

Errori possibili:

■ Una partizione contiene cartucce isolate. Per informazioni, consultare la sezione 
“Cartucce isolate in librerie partizionate”.

■ Le risorse della libreria sono state rimosse da una partizione. 

■ La connessione tra partizione e host non dispone di una partizione assegnata a 
LUN 0 (solo per connessioni FC-SCSI). 

In presenza di uno di questi errori, la schermata visualizza all’inizio dei messaggi di 
avvertenza riepilogativi. È possibile visualizzare i messaggi dettagliati facendo clic sul 
pulsante Details. 

Si consiglia di correggere tutti gli errori prima di confermare i dati nel database del 
controller della libreria. 

Si può eventualmente stampare i dati della schermata oppure salvarli in un file 
delimitato da virgole. 

Attenzione – Le informazioni nell’area di lavoro della partizione della SL Console 
vengono salvate nel database del controller della libreria soltanto tramite la schermta 
Commit (Step 4). Se la sessione della SL Console termina oppure i dati dell’area di 
lavoro vengono aggiornati prima di averli confermati dalla schermata Commit (Step 4), 
andranno perse tutte le modifiche alla partizione apportate tramite le schermate 
Summary (Step 2) e Design (Step 3b) e tutti i popup correlati. 

Campi della schermata

Nota – I campi di questa schermata sono gli stessi visualizzati nel popup 
Partitions—Design (Step 3b)—Verify Results. 

Warnings found

Sola visualizzazione.

Messaggi di errore riepilogativi relativi alla configurazione della partizione. 

The library is oversubscribed. Please unallocate nnn storage cells. 

Sola visualizzazione.

Indica che le allocazioni della partizione totale superano attualmente la capacità 
della libreria concessa in licenza. nnn è il numero delle celle che è necessario 
rimuovere dalle allocazioni. Il pulsante Apply nella schermata Commit (Step 4) 
rimane disattivato fino a quando il totale delle celle allocate rientra nella capacità 
della libreria concessa in licenza. 
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The following hosts will need re-audited

Sola visualizzazione.

World Wide Port Name (WWPN) di un qualsiasi host che necessita di un nuovo 
controllo della partizione della libreria. Può succedere se le risorse della libreria sono 
state eliminate dalla partizione. 

The following hosts do not have Lun 0 set

Sola visualizzazione.

World Wide Port Name (WWPN) di un qualsiasi host che non dispone di partizioni 
della libreria impostate come LUN 0 nell’host. L’errore riguarda solo le connessioni 
tra partizione e host FC-SCSI. 

The following orphaned cartridges were found

Sola visualizzazione.

Informazioni dettagliate relative a tutte le cartucce isolate nella configurazione 
corrente della partizione. Comprende la posizione dilibreria, binario, colonna, lato, 
riga della cartuccia, il numero di serie del volume (VOLID), le cause possibili nonché 
le spiegazioni sul perché la cartuccia è isolata. 

Pulsanti
Print

Fare clic per stampare il report sulla stampante selezionata.

Save 

Fare clic per salvare il report come file di testo designato e delimitato da virgole 
(estensione .csv). Sono molti i fogli di calcolo e i programmi database in grado di 
aprire i file delimitati da virgole. 

Yes

Fare clic per confermare l’aggiornamento del database del controller della libreria 
con le impostazioni dell’area di lavoro della SL Console. 

No

Fare clic per annullare l’aggiornamento. Il database del controller della libreria non 
viene aggiornato. Si mantengono tuttavia tutte le modifiche alla partizione apportate 
dalla sessione di login nell'area di lavoro della partizione della SL Console. 

Details 

Fare clic per passare da una vista espansa a una chiusa della visualizzazione dei 
messaggi di avvertenza. 

Consultare anche
■ Partitions—Commit (Step 4) 

■ Partitions—Design (Step 3b)—Verify Results 
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Partitions—Current Partition Definitions

Schermata di esempio

Descrizione
Visualizza i limiti e le allocazioni della partizione correnti. È l’unica schermata sulle 
partizioni disponibile nel pannello operatore locale.

Nota – La schermata è di sola visualizzazione. 

Campi della schermata
Per descrizioni dettagliate sui campi della schermata, consultare “Partitions—Design 
(Step 3b)” a pagina 240. 
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Pulsanti
Refresh 

Fare clic per aggiornare la visualizzazione con i dati correnti del database del 
controller della libreria. 

? (Help) 

Fare clic per visualizzare la guida in linea relativa alla schermata. 

Consultare anche
■ Partitions—Design (Step 3b) 

Schermate dei report sulle partizioni

Partitions—Reports

Partitions—Reports—Cartridge Cell and Media Summary

Partitions—Reports—Host Connections Summary

Partitions—Reports—Orphaned Cartridge Report

Partitions—Reports—Partition Details

Partitions—Reports—Partition Summary
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Partitions—Reports

Schermata di esempio

Descrizione
Consente di selezionare uno dei seguenti report sulle partizioni della libreria:

■ Cartridge Cell and Media Summary

■ Host Connections Summary

■ Orphaned Cartridge Report

■ Partition Details

■ Partition Summary

Nota – Nei report sulla partizione vengono elencati i dati salvati nel database del 
controller della libreria. Se la configurazione della partizione è stata modificata senza 
che siano state confermatele modifiche al controller della libreria dalla schermata 
Commit (Step 4), i dati elencati nei report non coincideranno con quelli visualizzati 
nelle schermate relative alle partizioni Summary (Step 2) e Design (Step 3b). 
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Campi della schermata
Please select a report to display

Necessario.

Fare clic sul report che si desidera visualizzare. Il menu a discesa elenca tutti i report 
disponibili sulle partizioni della libreria. 

Pulsanti
Refresh 

Fare clic per aggiornare l’area di lavoro della partizione della SL Console con i dati 
correnti letti dal database del controller della libreria. Tutte le modifiche non 
confermate, apportate alla partizione durante la sessione di login alla SL Console, 
saranno eliminate. Si apre il popup Partition Refresh in cui si richiede di confermare 
l’aggiornamento. 

? (Help) 

Fare clic per visualizzare la guida in linea relativa alla schermata. 

Consultare anche
■ Partitions—Summary (Step 2) 

■ Partitions—Design (Step 3b) 

■ Partitions—Commit (Step 4) 

■ Partitions—Reports—Cartridge Cell and Media Summary 

■ Partitions—Reports—Host Connections Summary 

■ Partitions—Reports—Orphaned Cartridge Report 

■ Partitions—Reports—Partition Details 

■ Partitions—Reports—Partition Summary 
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Partitions—Reports—Cartridge Cell and Media 
Summary

Schermata di esempio

Descrizione
Visualizza informazioni dettagliate su tutte le risorse della libreria (celle di storage, 
unità nastro e celle CAP) nonché informazioni su tutte le cartucce di storage.

Nota – Nei report sulla partizione vengono elencati i dati salvati nel database del 
controller della libreria. Se la configurazione della partizione è stata modificata senza 
che siano state confermatele modifiche al controller della libreria dalla schermata 
Commit (Step 4), i dati elencati nei report non coincideranno con quelli visualizzati 
nelle schermate relative alle partizioni Summary (Step 2) e Design (Step 3b). 

Il layout e la visualizzazione di questa schermata possono essere modificati. Consultare 
“Modificare il layout della schermata” a pagina 36 per informazioni. 

Si può eventualmente stampare i dati della schermata oppure salvarli in un file 
delimitato da virgole.



Schermate dei report sulle partizioni

418605201 • Revisione: A Capitolo 6 Partizionamento della libraria 259

Campi della schermata
Library 

Sola visualizzazione.

Numero della libreria in cui è posizionata la risorsa della libreria. È sempre 1. 

Rail

Sola visualizzazione.

Numero del binario in cui è posizionata la risorsa della libreria. È sempre 1. 

Column

Sola visualizzazione.

Numero della colonna in cui è posizionata la risorsa della libreria. Lo si calcola 
partendo dal lato sinistro del Base Module. +1 è verso destra; -1 è verso sinistra.

Side

Sola visualizzazione.

Lato del modulo in cui è posizionata la risorsa della libreria. 1 è la parete posteriore; 
2 è la parete frontale.

Row

Sola visualizzazione.

Numero della riga in cui è posizionata la risorsa della libreria. La numerazione delle 
righe è consecutiva, dall’alto al basso. La riga 1 è in alto.

Partition ID

Sola visualizzazione.

ID della partizione a cui è allocata la risorsa della libreria, se applicabile. 

Partition Name

Sola visualizzazione.

Nome della partizione a cui è allocata la risorsa della libreria, se applicabile. Se non 
esistono partizioni definite per la libreria, viene visualizzato “Non-Partitioned 
Library”. 

Element Type

Sola visualizzazione.

Tipo di risorsa della libreria. Le opzioni sono le seguenti:

■ CAP
■ CELL
■ DRIVE

Vol Ser

Sola visualizzazione.

Numero di serie del volume (VOLID) della cartuccia posizionata nella risorsa della 
libreria, se applicabile. 
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Cell Status

Sola visualizzazione.

Stato capacità della risorsa della libreria. Si applica soltanto alle celle di storage. Le 
opzioni sono le seguenti:

■ Active: la cella è attiva e può essere utilizzata in base alla capacità assegnata. Può 
essere impiegata per immagazzinare le cartucce. 

■ Inactive: la cella non è attiva. Non può essere utilizzata per immagazzinare le 
cartucce. 

Pulsanti
Print

Fare clic per stampare il report sulla stampante selezionata.

Save to File

Fare clic per salvare il report come file di testo designato e delimitato da virgole 
(estensione .csv). Sono molti i fogli di calcolo e i programmi database in grado di 
aprire i file delimitati da virgole. 

Refresh 

Fare clic per aggiornare l’area di lavoro della partizione della SL Console con i dati 
correnti letti dal database del controller della libreria. Tutte le modifiche non 
confermate, apportate alla partizione durante la sessione di login alla SL Console, 
saranno eliminate. Si apre il popup Partition Refresh in cui si richiede di confermare 
l’aggiornamento. 

? (Help) 

Fare clic per visualizzare la guida in linea relativa alla schermata. 

Consultare anche
■ Partitions—Reports—Host Connections Summary 

■ Partitions—Reports—Orphaned Cartridge Report 

■ Partitions—Reports—Partition Details 

■ Partitions—Reports—Partition Summary 
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Partitions—Reports—Host Connections Summary

Schermata di esempio

Descrizione
Visualizza informazioni dettagliate su tutte le connessioni tra partizione e host della 
libreria. 

Nota – Nei report sulla partizione vengono elencati i dati salvati nel database del 
controller della libreria. Se la configurazione della partizione è stata modificata senza 
che siano state confermatele modifiche al controller della libreria dalla schermata 
Commit (Step 4), i dati elencati nei report non coincideranno con quelli visualizzati 
nelle schermate relative alle partizioni Summary (Step 2) e Design (Step 3b). 

Il layout e la visualizzazione di questa schermata possono essere modificati. Consultare 
“Modificare il layout della schermata” a pagina 36 per informazioni. 

Si può eventualmente stampare i dati della schermata oppure salvarli in un file 
delimitato da virgole.
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Campi della schermata

Partitions

Nota – I campi delle schermate di questa sessione sono visualizzati anche nel report 
Partitions—Reports—Partition Summary.

Partition ID

Sola visualizzazione.

ID della partizione (da 1 a 8). 

Partition Name

Sola visualizzazione.

Nome della partizione. 

Connection Type 

Sola visualizzazione.

Tipo di interfaccia utilizzato dalla connessione tra partizione e host. Le opzioni sono 
le seguenti:

■ HLI 

■ FC-SCSI 

Storage Cells 

Sola visualizzazione.

Numero totale delle celle di storage allocate alla partizione.

Media in Storage Cells

Sola visualizzazione.

Numero totale delle cartucce nastro all’interno delle celle di storage della partizione. 

% Storage Cells w/ Media

Sola visualizzazione.

Percentuale delle celle di storage che contengono cartucce nastro. È data da Media in 
Storage Cells / Storage Cells. 

Drive Bays 

Sola visualizzazione.

Numero totale degli alloggiamenti dell’unità allocati alla partizione. 

CAP Cells 

Sola visualizzazione.

Numero totale delle celle CAP allocate alla partizione. 

Total Media 

Sola visualizzazione.

Numero totale delle cartucce nastro all'interno della partizione, tra cui cartucce in 
celle di storage, CAP e unità assegnate alla partizione. 
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Active Cells

Sola visualizzazione.

Capacità totale della cella di storage assegnata alla partizione nella schermata Add 
Partition. 

Host Connections

Initiator (WWPN) 

Sola visualizzazione.

WWPN (World Wide Port Name) di un controller (HBA) FC-SCSI con una 
connessione alla partizione. 

Library Controller Port

Sola visualizzazione.

Numero della porta del controller della libreria SL3000nell’host. Il valore è sempre 0.

LUN

Sola visualizzazione.

Numero dell’unità logica (LUN) della partizione della libreria nell’host.

Partition ID

Sola visualizzazione.

ID della partizione con la quale l’host ha una connessione. 

Pulsanti
Print

Fare clic per stampare il report sulla stampante selezionata.

Save

Fare clic per salvare il report come file di testo designato e delimitato da virgole 
(estensione .csv). Sono molti i fogli di calcolo e i programmi database in grado di 
aprire i file delimitati da virgole. 

Refresh 

Fare clic per aggiornare l’area di lavoro della partizione della SL Console con i dati 
correnti letti dal database del controller della libreria. Tutte le modifiche non 
confermate, apportate alla partizione durante la sessione di login alla SL Console, 
saranno eliminate. Si apre il popup Partition Refresh in cui si richiede di confermare 
l’aggiornamento. 

? (Help) 

Fare clic per visualizzare la guida in linea relativa alla schermata. 

Consultare anche
■ Partitions—Reports—Cartridge Cell and Media Summary 

■ Partitions—Reports—Orphaned Cartridge Report 

■ Partitions—Reports—Partition Details 

■ Partitions—Reports—Partition Summary 
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Partitions—Reports—Orphaned Cartridge Report 

Schermata di esempio

Descrizione
Visualizza le posizioni e i numeri di serie del volume (VOLID) di tutte le cartucce 
isolate della libreria. Identifica inoltre il motivo per cui la cartuccia è isolata. 

Nota – Nei report sulla partizione vengono elencati i dati salvati nel database del 
controller della libreria. Se la configurazione della partizione è stata modificata senza 
che siano state confermatele modifiche al controller della libreria dalla schermata 
Commit (Step 4), i dati elencati nei report non coincideranno con quelli visualizzati 
nelle schermate relative alle partizioni Summary (Step 2) e Design (Step 3b). 

Il layout e la visualizzazione di questa schermata possono essere modificati. Consultare 
“Modificare il layout della schermata” a pagina 36 per informazioni. 

Si può eventualmente stampare i dati della schermata oppure salvarli in un file 
delimitato da virgole.
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Campi della schermata
Library 

Sola visualizzazione.

Numero della libreria in cui è posizionata la cartuccia isolata. È sempre 1. 

Rail 

Sola visualizzazione.

Numero del binario in cui è posizionata la cartuccia isolata. È sempre 1. 

Column

Sola visualizzazione.

Numero della colonna in cui è posizionata la cartuccia isolata. Lo si calcola partendo 
dal lato sinistro del Base Module. +1 è verso destra; -1 è verso sinistra.

Side

Sola visualizzazione.

Lato del modulo in cui è posizionata la cartuccia isolata. 1 è la parete posteriore; 2 è 
la parete frontale.

Row

Sola visualizzazione.

Numero della riga in cui è posizionata la cartuccia isolata. La numerazione delle 
righe è consecutiva, dall’alto al basso. La riga 1 è in alto.

Vol Ser 

Sola visualizzazione.

Numero di serie del volume (VOLID) della cartuccia isolata. 

Explanation

Sola visualizzazione.

Spiegazione sul motivo per cui la cartuccia è isolata. 

Poiché questo report viene generato dal database del controller della libreria, l’unica 
opzione è la seguente:

■ Unreachable from any host 

Pulsanti
Print

Fare clic per stampare il report sulla stampante selezionata.

Save

Fare clic per salvare il report come file di testo designato e delimitato da virgole 
(estensione .csv). Sono molti i fogli di calcolo e i programmi database in grado di 
aprire i file delimitati da virgole. 
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Refresh 

Fare clic per aggiornare l’area di lavoro della partizione della SL Console con i dati 
correnti letti dal database del controller della libreria. Tutte le modifiche non 
confermate, apportate alla partizione durante la sessione di login alla SL Console, 
saranno eliminate. Si apre il popup Partition Refresh in cui si richiede di confermare 
l’aggiornamento. 

? (Help) 

Fare clic per visualizzare la guida in linea relativa alla schermata. 

Consultare anche
■ Partitions—Reports—Cartridge Cell and Media Summary 

■ Partitions—Reports—Host Connections Summary 

■ Partitions—Reports—Partition Details 

■ Partitions—Reports—Partition Summary 
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Partitions—Reports—Partition Details

Schermata di esempio

Descrizione
Visualizza informazioni dettagliate su una partizione selezionata. 

Nota – Nei report sulla partizione vengono elencati i dati salvati nel database del 
controller della libreria. Se la configurazione della partizione è stata modificata senza 
che siano state confermatele modifiche al controller della libreria dalla schermata 
Commit (Step 4), i dati elencati nei report non coincideranno con quelli visualizzati 
nelle schermate relative alle partizioni Summary (Step 2) e Design (Step 3b). 
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Il layout e la visualizzazione di questa schermata possono essere modificati. Consultare 
“Modificare il layout della schermata” a pagina 36 per informazioni. 

Si può eventualmente stampare i dati della schermata oppure salvarli in un file 
delimitato da virgole.

Campi della schermata
Partition Name

Sola visualizzazione.

Nome della partizione. 

Partition ID

Sola visualizzazione.

ID della partizione (da 1 a 8) 

Connection Type

Sola visualizzazione.

Tipo di interfaccia utilizzato dalla connessione tra partizione e host. Le opzioni sono 
le seguenti:

■ HLI

■ FC-SCSI

Assigned Cells 

Sola visualizzazione.

Numero totale delle celle di storage allocate alla partizione.

Available Cells 

Sola visualizzazione.

Numero totale di celle di storage nella libreria disponibili per essere allocate alla 
partizione.

Occupied Cells 

Sola visualizzazione.

Numero totale di celle di storage nella partizione che contengono cartucce nastro.

Active (Capacity Licensed) Cells 

Sola visualizzazione.

Capacità totale della cella di storage assegnata alla partizione nella schermata Add 
Partition. 

Assigned Drive Bays 

Sola visualizzazione.

Numero totale degli alloggiamenti dell’unità allocati alla partizione.

Available Drive Bays 

Sola visualizzazione.

Numero totale di alloggiamenti dell’unità nella libreria disponibili per essere allocati 
alla partizione.
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Occupied Drives 

Sola visualizzazione.

Numero totale delle unità nastro installate nella partizione che contengono cartucce 
nastro.

Assigned CAP cells 

Sola visualizzazione.

Numero totale delle celle di CAP allocate alla partizione utilizzando CAP dedicate o 
condivise. 

Available CAP cells

Sola visualizzazione.

Numero totale delle celle di CAP nella libreria disponibili per essere allocate alla 
partizione. Il numero comprende tutte le celle di CAP come segue:

■ CAP non allocate ad alcuna partizione. 

■ CAP non allocate attualmente a questa partizione, ma allocate ad altre partizioni 
che hanno lo stesso tipo di interfaccia host di questa partizione. 

Il numero non comprende invece tutte le celle di CAP come segue: 

■ CAP attualmente allocate a tale partizione.

■ CAP allocate a partizioni che hanno un tipo di interfaccia host diverso. 

Occupied CAP cells

Sola visualizzazione.

Numero totale di celle di storage nella partizione che contengono cartucce nastro.

% Cell Capacity (Assigned Cells/Total Cells) 

Sola visualizzazione.

Percentuale di celle di storage nella libreria allocate a questa partizione. È data da:

Numero delle celle allocate alla partizione / Capacità fisica totale della libreria

Pulsanti
Print

Fare clic per stampare il report sulla stampante selezionata.

Save

Fare clic per salvare il report come file di testo designato e delimitato da virgole 
(estensione .csv). Sono molti i fogli di calcolo e i programmi database in grado di 
aprire i file delimitati da virgole. 

Refresh 

Fare clic per aggiornare l’area di lavoro della partizione della SL Console con i dati 
correnti letti dal database del controller della libreria. Tutte le modifiche non 
confermate, apportate alla partizione durante la sessione di login alla SL Console, 
saranno eliminate. Si apre il popup Partition Refresh in cui si richiede di confermare 
l’aggiornamento. 

? (Help) 

Fare clic per visualizzare la guida in linea relativa alla schermata. 
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Consultare anche
■ Partitions—Reports—Cartridge Cell and Media Summary 

■ Partitions—Reports—Host Connections Summary 

■ Partitions—Reports—Orphaned Cartridge Report 

■ Partitions—Reports—Partition Summary 

Partitions—Reports—Partition Summary

Schermata di esempio
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Descrizione
Visualizza le informazioni riepilogative su tutte le partizioni della libreria. 

Nota – Nei report sulla partizione vengono elencati i dati salvati nel database del 
controller della libreria. Se la configurazione della partizione è stata modificata senza 
che siano state confermatele modifiche al controller della libreria dalla schermata 
Commit (Step 4), i dati elencati nei report non coincideranno con quelli visualizzati 
nelle schermate relative alle partizioni Summary (Step 2) e Design (Step 3b). 

Il layout e la visualizzazione di questa schermata possono essere modificati. Consultare 
“Modificare il layout della schermata” a pagina 36 per informazioni. 

Si può eventualmente stampare i dati della schermata oppure salvarli in un file 
delimitato da virgole.

Campi della schermata

Nota – I campi di queste schermate sono visualizzati anche nel report 
Partitions—Reports—Host Connections Summary.

Partition ID

Sola visualizzazione.

ID della partizione (da 1 a 8). 

Partition Name

Sola visualizzazione.

Nome della partizione. 

Connection Type 

Sola visualizzazione.

Tipo di interfaccia utilizzato dalla connessione tra partizione e host. Le opzioni sono 
le seguenti:

■ HLI 

■ FC-SCSI 

Storage Cells 

Sola visualizzazione.

Numero totale delle celle di storage allocate alla partizione.

Media in Storage Cells

Sola visualizzazione.

Numero totale delle cartucce nastro all’interno delle celle di storage della partizione. 

% Storage Cells w/ Media

Sola visualizzazione.

Percentuale delle celle di storage che contengono cartucce nastro. È data da Media in 
Storage Cells / Storage Cells. 
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Drive Bays 

Sola visualizzazione.

Numero totale degli alloggiamenti dell’unità allocati alla partizione. 

CAP Cells 

Sola visualizzazione.

Numero totale delle celle CAP allocate alla partizione. 

Total Media 

Sola visualizzazione.

Numero totale delle cartucce nastro all'interno della partizione, tra cui cartucce in 
celle di storage, CAP e unità assegnate alla partizione. 

Active Cells

Sola visualizzazione.

Capacità totale della cella di storage assegnata alla partizione nella schermata Add 
Partition. 

Pulsanti
Print

Fare clic per stampare il report sulla stampante selezionata.

Save

Fare clic per salvare il report come file di testo designato e delimitato da virgole 
(estensione .csv). Sono molti i fogli di calcolo e i programmi database in grado di 
aprire i file delimitati da virgole. 

Refresh 

Fare clic per aggiornare l’area di lavoro della partizione della SL Console con i dati 
correnti letti dal database del controller della libreria. Tutte le modifiche non 
confermate, apportate alla partizione durante la sessione di login alla SL Console, 
saranno eliminate. Si apre il popup Partition Refresh in cui si richiede di confermare 
l’aggiornamento. 

? (Help) 

Fare clic per visualizzare la guida in linea relativa alla schermata. 

Consultare anche
■ Partitions—Reports—Cartridge Cell and Media Summary 

■ Partitions—Reports—Host Connections Summary 

■ Partitions—Reports—Orphaned Cartridge Report 

■ Partitions—Reports—Partition Details 
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Schermate operative per CAP partizioni

Assegnazione di CAP condivise

Schermata di esempio

Assegnazione di CAP condivise

Diagnostics > CAP—Unreserve
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Descrizione
Consente di associare una CAP a una partizione prima di utilizzare una CAP FC-SCSI 
condivisa per inserire o espellere le cartucce da una partizione. Le associazioni tra 
partizione e CAP consentono di prenotare la CAP perché sia utilizzata dalla partizione 
selezionata in modalità esclusiva per tutta la durata delle operazioni in inserimento ed 
espulsione. 

Nota – Questa schermata non è disponibile se la libreria non contiene CAP FC-SCSI 
condivise. 

Seguire le seguenti regole quando si utilizza questa schermata:

■ Utilizzare la schermata soltanto per CAP FC-SCSI condivise. 

■ Non è necessario utilizzare questa schermata per CAP dedicate poiché una 
partizione dispone sempre del diritto di proprietà sulle proprie CAP dedicate. 

■ Non è necessario utilizzare questa schermata con partizioni HLI poiché le 
applicazioni host HLI impiegano sempre prenotazioni di CAP. 

■ È possibile associare a una CAP soltanto una sola partizione per volta. 

■ Se si seleziona una partizione, tutte le sue CAP allocate le vengono associate in una 
sola volta. Non è possibile selezionare singolarmente le CAP da associare alla 
partizione. 

■ È possibile selezionare più di una partizione per volta soltanto se le partizioni 
selezionate non condividono CAP tra di loro. 

■ Le associazioni tra CAP e partizioni rimangono attive finché non vengono rimosse in 
modo esplicito. Le associazioni non vengono rimosse automaticamente al 
completamento delle operazioni di inserimento o espulsione. 

■ Le associazioni tra CAP e partizioni vengono rimosse durante il reboot della libreria, 
i cicli di alimentazione, la chiusura o l’apertura della porta della libreria o 
l’inizializzazione delle CAP.

■ Le associazioni tra CAP e partizioni vengono rimosse se la CAP viene allocata a 
un’altra partizione tramite la schermata Design (Step 3b). 

■ Se l’associazione tra una CAP e una partizione viene rimossa mentre la CAP è aperta 
o contiene delle cartucce, la proprietà della CAP sarà modificata nel richiedente 
default e la CAP non sarà disponibile per tutte le partizioni. È necessario svuotare 
e chiudere la CAP prima di poterla associare a una qualsiasi partizione. 

Consultare “Inserire le cartucce in una partizione” a pagina 217 e “Espellere le cartucce 
da una partizione” a pagina 217 per informazioni sull’utilizzo di questa schermata e del 
pulsante CAP Open. 
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Campi della schermata
Select

Selezionare una o più partizioni per cui si intende inserire o espellere le cartucce 
come segue: 

■ Contrassegnare la casella di controllo per selezionare la partizione. La schermata 
viene aggiornata come segue:

- Tutte le CAP allocate a quella partizione sono contrassegnate dal numero della 
partizione presente sulla mappa del modulo.

- Tutte le altre partizioni che condividono CAP con altre partizioni non sono 
attive. 

■ Eliminare la marcatura dalla casella di controllo per deselezionare la partizione. 

Le partizioni non attive non possono essere selezionate. Una partizione può non 
essere attiva per uno dei seguenti motivi: 

■ Nessuna CAP è stata allocata alla partizione.

■ La partizione ha un tipo di connessione host HLI. 

■ La CAP è attualmente utilizzata da un’altra partizione che condivide la CAP.

■ La CAP è attualmente utilizzata dall’utente predefinito (operatore della 
libreria). 

Partition Name

Sola visualizzazione.

Nome assegnato alla partizione. 

Partition ID

Sola visualizzazione.

ID assegnato alla partizione. Gli ID possono essere compresi tra 1 e 8.

Connection Type

Sola visualizzazione.

Tipo di interfaccia assegnato alla connessione tra partizione e host. Le opzioni sono 
le seguenti:

■ HLI

■ FC-SCSI

Library module map 

Sola visualizzazione.

Sullo schermo viene visualizzata un'immagine sulla configurazione attuale del 
modulo della libreria. Le informazioni sono lette direttamente dal database del 
controller della libreria. 

Le allocazioni delle CAP di ogni partizioni sono indicate come segue: 

■ Una X nella colonna del modulo della libreria indica che la CAP di quel modulo è 
allocata alla partizione di quella riga.

■ Nessuna X nella colonna del modulo della libreria indica che la CAP di quel 
modulo non è allocata alla partizione di quella riga. 
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Pulsanti
Apply

Fare clic per aggiornare il database del controller della libreria con le impostazioni di 
questa schermata. Si apre il popup CAP Confirm in cui si richiede di confermare 
l’aggiornamento. 

Refresh 

Fare clic per aggiornare l’area di lavoro della partizione della SL Console con i dati 
correnti letti dal database del controller della libreria. Tutte le modifiche non 
confermate, apportate alla partizione durante la sessione di login alla SL Console, 
saranno eliminate. Si apre il popup Partition Refresh in cui si richiede di confermare 
l’aggiornamento. 

? (Help) 

Fare clic per visualizzare la guida in linea relativa alla schermata. 

Consultare anche
■ Partitions—Design (Step 3b) 

Diagnostics > CAP—Unreserve

Schermata di esempio
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Descrizione
Consente di ignorare una prenotazione CAP avviata da un host. In questo caso, il 
controller della libreria rimuove la prenotazione della CAP e imposta l’utente della 
CAP su “Default”. In questo modo la CAP non sarà disponibile a tutte le partizioni. 

Una volta ignorata la presentazione, sarà necessario aprire la CAP e rimuovere tutte le 
cartucce. Dopo aver chiuso la CAP, il controller della libreria chiuderà e controllerà la 
CAP per verificare che sia vuota. Lo stato della CAP sarà quindi impostato su 
“Unreserved”. La CAP diventa disponibile a tutte le partizioni.

Nota – Nel caso delle CAP FC-SCSI, ignorare una prenotazione CAP significa 
interrompere tutte le associazioni tra CAP e partizione, anche se la CAP è dedicata alla 
partizione FC-SCSI. È necessario riassociare la partizione alla CAP in modo esplicito 
prima che la partizione possa utilizzare la CAP.

Per dettagli sulla procedura, consultare “Ignorare la prenotazione di una CAP” a 
pagina 219. 

Campi della schermata
CAP CAP_id is status. 

Sola visualizzazione.

Stato della CAP selezionata. Opzioni possibili:

■ reserved by host_name: è stata avviata un’operazione CAP dall’host 
specificato. Si può utilizzare questa schermata per rimuovere la prenotazione 
della CAP.

■ reserved by default: è stata avviata un’operazione CAP nella SL Console. 
Non è possibile utilizzare questa schermata per rimuovere la prenotazione della 
CAP. 

■ not reserved: la CAP non è prenotata; non è necessario rimuovere la 
prenotazione della CAP. 

Module containing selected CAP is displayed below

Sola visualizzazione.

Sullo schermo viene visualizzata un'immagine sulla configurazione attuale del 
modulo della libreria. Le informazioni sono lette direttamente dal database del 
controller della libreria. 

La CAP selezionata è contrassegnata da una freccia. 

Pulsanti
Apply

Fare clic per ignorare la prenotazione della CAP dell’host. Si apre il popup CAP 
Confirm in cui si richiede di confermare l’aggiornamento. 

Nota – Questo pulsante è attivo solo se lo stato della CAP è reserved by host_name”. 
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? (Help) 

Fare clic per visualizzare la guida in linea relativa alla schermata. 

Consultare anche
■ Assegnazione di CAP condivise
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CAPITOLO 7

Diagnostica e utility della SL Console

Eventi libreria 
Il controller della libreria monitora costantemente le attività e registra i log di tutti gli 
eventi. Gli eventi sono archiviati sotto tre titoli:

■ Eventi di comunicazione: sono incluse tutte le comunicazioni host-libreria, libreria-
libreria e libreria-unità. 

■ Evento di errore: a ciascun errore è assegnato un codice di azione di quattro cifre 
(esadecimale). 

■ Eventi di avviso: segnalano un calo delle prestazioni o delle condizioni che può 
indicare futuri errori irreversibili. 

Monitoraggi degli eventi
Gli utenti o il responsabile dell’assistenza tecnica Sun possono utilizzare i monitor della 
SL Console per visualizzare gli eventi della libreria. Le seguenti informazioni possono 
essere utili nel diagnosticare la causa di un evento: 

■ Data/ora: indica quando si è verificato l’evento. 

■ Codici azione: indica il comando avviato, come “caricamento unità”.

■ Codici risultato: indica il risultato dell’azione richiesta. 

■ Diagnostica KSP (Known Service Plan): indica il meccanismo o il componente 
responsabile del task o dell’errore. 

Nota – Non esistono opzioni per eliminare il log dell’evento.
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Verifica automatica della libreria 
L’utility di diagnostica tramite verifica automatica ha lo scopo di aiutare nella diagnosi 
dei problemi più semplici riguardanti il funzionamento della libreria e può essere 
eseguita ogni volta che è necessario. 

Nota – Le routine di verifica automatica della libreria sono non-distruttive. 

La verifica automatica della libreria comporta il seguente processo:

1. Controllo del percorso di comunicazione tra il controller, le unità e la TallBot della 
libreria. 

2. Esecuzione di operazioni di acquisizione e assegnazione per controllare lo stato della 
TallBot e della CAP, comprese operazioni di acquisizione e assegnazione da uno slot 
prenotato a uno qualsiasi dei seguenti slot vuoti:

■ Slot di storage 

■ Slot della CAP

■ Slot corner

3. Esecuzione di un controllo della libreria. 

4. Installazione e disinstallazione delle cartucce diagnostiche per tutte le unità 
installate nella libreria.

Nota – La verifica automatica non parte se negli slot prenotati non viene trovata una 
cartuccia diagnostica.

Nota – Se negli slot del sistema viene trovata una cartuccia diagnostica, la verifica 
automatica viene ripetuta per ogni tipo di unità. Qualora per un certo tipo di unità non 
venisse trovata una cartuccia diagnostica, l’operazione di installazione/disinstallazione 
non verrà effettuata su quella unità.

Aggiornamenti del Firmware della 
libreria
Il firmware della libreria è situato nel controller. Il firmware iniziale viene installato 
durante la fabbricazione. Quando viene rilasciato un nuovo firmware, è necessario 
utilizzare l’utility di caricamento del codice per aggiornare il firmware all’interno della 
libreria e i supporti correlati (CAP e TallBot). 

Nota – Il firmware della libreria non contiene aggiornamenti del codice delle unità. 
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Da dove scaricare il firmware
Il pacchetto del firmware della libreria SL3000 è un file .jar (Java Archive). disponibile 
per il download ai seguenti indirizzi Sun Microsystems, Inc.:

Nota – È necessario disporre di un ID e una password validi per effettuare il login al 
sito di download che si desidera utilizzare. Per assistenza, contattare il Sun 
responsabile dell’assistenza tecnica. 

Processo di installazione del firmware
Il processo di caricamento del codice del firmware nel controller della libreria è il 
seguente: 

1. Individuare il pacchetto di aggiornamento del firmware (file .jar ) sul relativo sito 
di download Sun. Consultare la sezione “Da dove scaricare il firmware” a pagina 281 
sopra. 

2. Scaricare il codice in una cartella sul proprio PC locale. 

3. Scaricare il pacchetto del firmware dal PC al controller della libreria. Tramite questo 
processo il pacchetto viene decompresso al termine del download e reso disponibile 
per l’attivazione. Consultare la sezione “Scaricare un codice nel controller della 
libreria” a pagina 291. 

4. Attivare il codice di download nel controller della libreria. Consultare la sezione 
“Attivare un codice” a pagina 292. 

5. Riavviare la libreria per rendere funzionante il codice. Consultare la sezione 
“Riavviare la libreria” a pagina 290. 

Controlli 
Un controllo è il processo di lettura e catalogazione delle cartucce all’interno della 
libreria o di verifica della posizione delle cartucce. Il controller della libreria gestisce un 
database delle cartucce contenente le seguenti informazioni per tutte le cartucce della 
libreria:

■ Numeri di serie del volume (VOLID o VOLSER) 

■ Posizione corrente (nel formato indirizzo interno della libreria)

■ Stato verificato (vero o falso)

Utente Nome posizione URL

Sun Customers Sun Download Center http://www.sun.com/download/
index.jsp

Sun Partners and 
OEMs

Sun Partner Exchange https://spe.sun.com/spx/control/
Login 
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La libreria controlla la posizione di tutte le cartucce nelle aree di storage e prenotate 
nelle seguenti situazioni:

■ Dopo l’apertura e la chiusura di una o di entrambe le porte di accesso. 

■ Quando la SL Console effettua una richiesta di controllo. 

■ Quando un host invia la richiesta di controllo della libreria. 

La SL Console può essere utilizzata per eseguire i seguenti tipi di controlli:

■ Controllo fisico 

■ Verifica del controllo

Attenzione – Se il record delle cartucce di un host non combacia con le informazioni 
contenute nel database delle cartucce del controller possono verificarsi problemi a 
livello di sistema. 

Controllo fisico
In un controllo fisico, la TallBot verifica il VOLID delle cartucce installate e il controller 
della libreria aggiorna il database delle cartucce. Al termine del controllo, lo stato della 
posizione delle cartucce passa da verificato (“verified”) a vero (“True”). La durata del 
controllo dipende dalle dimensioni della libreria.

La libreria esegue un controllo fisico nelle seguenti situazioni. 

■ Automaticamente quando la porta di accesso di una libreria è stata aperta e chiusa. 
Si tratta sempre di un controllo completo dell’intera libreria. 

■ Quando avviato manualmente dalla SL Console. Esistono due tipi di controlli fisici 
avviati manualmente:

■ Controllo di tutta la libreria: la TallBot analizza tutte le celle (storage, CAP e 
unità), cataloga i VOLID e le posizioni e aggiorna il database delle cartucce del 
controller. Il controllo è un processo che avviene in background e non interrompe 
le attività della libreria online. Per informazioni, consultare la sezione 
“Controllare l’intera libreria” a pagina 295. 

■ Controllo di un intervallo specifico: la TallBot esamina solo un intervallo specifico 
di slot (storage, CAP e unità) e aggiorna il database delle cartucce del controller. 
Le informazioni del controllo vengono mostrate nella SL Console durante 
l’esecuzione del controllo stesso. Per informazioni, consultare la sezione 
“Controllare un intervallo di celle” a pagina 297.

Verifica del controllo
La verifica di un controllo convalida lo stato della posizione di una specifica cartuccia o 
di un intervallo di posizioni (incluse CAP e unità) nel database delle cartucce. Se alla 
verifica lo stato dell’indirizzo di una cartuccia risulta essere falso (“false”), viene 
avviato un controllo fisico di quella posizione e il database delle cartucce viene 
aggiornato. Lo stato di avanzamento del controllo viene mostrato nella sezione Audit 
Console della SL Console. Per informazioni, consultare la sezione “Effettuare la verifica 
di un controllo” a pagina 299. 
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Spostamenti diagnostici del robot
Gli spostamenti diagnostici vengono utilizzati per monitorare o diagnosticare un 
problema all’interno di una TallBot. Lo spostamento può essere effettuato con o senza 
cartucce. 

Al completamento di uno spostamento diagnostico, le cartucce non vengono 
riorganizzate nelle celle storage, ma tornano nelle loro posizioni originali al termine 
dell’operazione. Tuttavia, se l’operazione non va a buon fine, può capitare che le 
cartucce restino nelle nuove posizioni. 

Uno spostamento diagnostico è composto da questi elementi:

■ Intervallo indirizzi target

■ Intervallo indirizzi pool

■ Spostamento dell’ordine di accesso

■ Selezione robot

Intervallo indirizzi target 
L’intervallo degli indirizzi target definisce i parametri di posizione in una libreria entro 
i quali viene eseguito lo spostamento diagnostico. Esistono due tipi di ordini di accesso 
per un indirizzo target:

■ “Ordine di accesso sequenziale” a pagina 284 

■ “Ordine di accesso casuale” a pagina 284 

Di seguito sono indicati tipi di indirizzi target validi:

■ Celle di storage: considera tutte le posizioni storage come intervallo target 

■ CAP: considera tutti gli slot della CAP come intervallo target/pool.

■ Celle unità e storage: considera tutte le celle dell’unità e di storage come intervallo 
target/pool.

■ Celle di sistema: considera le posizioni (slot prenotati) contenenti la cartucce di 
pulizia o diagnostica come intervallo target/pool. 

■ Tutte: considera le celle di storage, della CAP e delle unità come intervallo 
target/pool.

Nota – Selezionando l’opzione storage, CAP, unità, sistema o tutte, le posizioni 
associate vengono prenotate come intervallo target. Tuttavia, solo la posizione in uso 
dalla TallBot per un’operazione di acquisizione/assegnazione non è accessibile da parte 
dell’host.
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Intervallo indirizzi pool
Le posizioni dell’intervallo degli indirizzi pool sono utilizzate per eseguire sulle 
cartucce fornite spostamenti diagnostici verso e dall’intervallo di indirizzi target. Un 
indirizzo pool viene utilizzato anche per eseguire un’operazione se l’indirizzo target 
non contiene una cartuccia. Non è presente un ordine di accesso specifico all’interno 
dell’intervallo degli indirizzi target. L’intervallo degli indirizzi pool non include le 
posizioni delle unità.

Nota – Gli intervalli degli indirizzi pool non contengono le posizioni delle unità.

Spostamento dell’ordine di accesso

Ordine di accesso sequenziale
In uno spostamento diagnostico con ordine di accesso sequenziale, la TallBot effettua 
un’operazione di acquisizione a partire dalla prima posizione nell’intervallo degli 
indirizzi target e quindi continua ad esaminare le posizioni in ordine sequenziale 
all’interno dell’intervallo fino al completamento del numero di spostamenti richiesti. 

Nota – Se si sceglie di non spostare le cartucce, le operazioni di acquisizione/ 
assegnazione non vengono eseguite. La TallBot si posiziona negli indirizzi target e pool.

Ordine di accesso casuale
In uno spostamento diagnostico con ordine di accesso casuale, la TallBot prende una 
posizione a caso nell’intervallo degli indirizzi target per acquisire una cartuccia. La 
TallBot può anche esaminare più volte la stessa posizione nell’intervallo degli indirizzi 
target per acquisire una cartuccia. La routine di accesso casuale termina al 
completamento del numero di spostamenti richiesti. 

Se si sceglie di non spostare le cartucce, le operazioni di acquisizione/assegnazione non 
vengono eseguite. La TallBot si posiziona negli indirizzi target e pool. 

Selezione robot
La TallBot utilizzata per lo spostamento diagnostico viene selezionata in base 
all’intervallo minimo e massimo degli indirizzi target e pool impostato dall’utente. 
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Funzioni di controllo dello spostamento diagnostico
Per gestire gli spostamenti aperti è possibile utilizzare le seguenti opzioni:

Nota – Se sono aperti diversi spostamenti diagnostici, a ciascuno spostamento è 
assegnata una schermata di monitoraggio.

Task di diagnostica e utility 
I task di diagnostica e utility sono suddivisi nelle seguenti categorie:

■ “Task di monitoraggio degli eventi” a pagina 286

■ “Task di utility della libreria” a pagina 289

■ “Task di controllo” a pagina 295

■ “Task di utility della CAP” a pagina 301

■ “Task di utility dell’unità” a pagina 305

■ “TallBot Task di utility” a pagina 308

Per Opzione di menu Note

Avviare File > Start Sequence

Mettere in pausa File > Pause Sequence Interrompe tutti gli spostamenti 
diagnostici, ma mantiene la posizione 
corrente nell’ordine di accesso.

Interrompere File > Stop Sequence Interrompe il funzionamento di uno 
strumento in uso o in pausa.

Riprendere File > Start Sequence Riprende il funzionamento di uno 
strumento in pausa a partire 
dall’ultima posizione nota 
nell’intervallo degli indirizzi target.

Cancella i messaggi 
visualizzati nella finestra di 
monitoraggio

File > Clear Output Window Cancella i messaggi precedenti e 
continua a inviare sullo schermo nuovi 
messaggi.

Effettuare lo spooling Spool File > Start Spooling Dirige gli output di spostamento verso 
un file.

Interrompe lo spooling 
dell’output di uno strumento 
in un file.

Spool File > Stop Spooling Smette di dirigere l’output di 
spostamento verso il file di spooling.
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Task di monitoraggio degli eventi

▼ Visualizzare il monitoraggio di un evento
Le informazioni di monitoraggio degli eventi vengono aggiornate in modo dinamico a 
seconda dell’occorrenza degli eventi selezionati. Le informazioni inviate nel corso di 
un’operazione di invio e-mail, stampa, salvataggio o spooling riflette i dati (e il 
formato) mostrati nella schermata alla richiesta dell’operazione stessa. 

Nota – I monitoraggi degli eventi sono utili per eseguire l’analisi della causa di un 
errore. Se la libreria è incorsa in errori riproducibili, è possibile avviare il monitoraggio 
degli eventi ed effettuare lo spooling di tutti gli eventi in un file per acquisire i dati. 
Quindi, è possibile inviare il file al Sun responsabile dell’assistenza tecnica per farlo 
esaminare. 

Nota – Per monitorare più eventi, consultare la sezione “Visualizzare più monitoraggi” 
a pagina 287.

1. Selezionare Tools > Monitors.

2. Aprire la cartella Permanent Monitors. 

Vengono mostrati i monitoraggi della libreria alla quale si ha accesso. 

3. Fare clic sul monitoraggio dell’evento che si desidera utilizzare e fare clic su Open 
dalla barra delle opzioni. 

Il sistema mostra i dati raccolti per quell’evento.

4. Utilizzare le seguenti opzioni per gestire le informazioni mostrate nelle schermata 
per l’evento selezionato:

Task Pagina

Visualizzare il monitoraggio di un evento 286

Visualizzare più monitoraggi 287

Creare un elenco dei codici di stato dei dispositivi 287

Creare un elenco dei codici risultato 289

Per Selezionare

Mettere in pausa la visualizzazione continua dei dati relativi 
all’evento selezionato

Monitor > Pause

Riprendere la visualizzazione degli eventi Monitor > Resume

Interrompere definitivamente la visualizzazione continua dei 
dati relativi all’evento selezionato

Monitor > Stop

Cancellare la visualizzazione del monitoraggio dell’evento Monitor > Clear
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5. Per chiudere un monitoraggio, fare clic sulla X nell’angolo in alto a destra della 
finestra. 

6. Per effettuare lo spooling dei dati di un evento in un file, seguire questa procedura:

a. Selezionare Spool File > Start Spooling.

b. Nel popup Save, fare clic su Save in Folder e quindi digitare il nome di un file.

c. Fare clic su Save.

d. Per interrompere lo spooling, selezionare Spool File > Stop Spooling.

▼ Visualizzare più monitoraggi
Per aprire e gestire più monitoraggi di eventi, utilizzare le seguenti opzioni dalla barra 
delle opzioni:

▼ Creare un elenco dei codici di stato dei dispositivi
Utilizzare la seguente procedura per creare un elenco con i codici di stato dei 
dispositivi e le loro descrizioni. 

1. Selezionare Tools > Diagnostics. 

2. Fare clic sulla cartella Library Folder nell’albero dei dispositivi.

Si apre la schermata Library.

3. Fare clic sulla scheda Search.

Si apre la schermata Library Search. 

4. Nel menu a tendina Search Type, fare clic su Device Status. 

Per Selezionare

Disporre i monitoraggi aperti sullo schermo. Window > Arrange

Disporre orizzontalmente le finestre dei monitoraggi degli 
eventi

Window > Tile 
Horizontal

Disporre verticalmente le finestre dei monitoraggi degli eventi Window > Tile 
Vertical

Disporre i monitoraggi degli eventi uno sopra l’altro Window > Cascade
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5. Completare il campo Device Status come segue:

■ Per cercare il codice di stato di un particolare dispositivo, è necessario digitare il 
codice completo; non sono ammessi caratteri speciali o codici parziali. 

■ Per elencare tutti i codici di stato dei dispositivi, selezionare la casella di controllo 
List All. 

6. Fare clic su Search nella barra delle opzioni. 

La schermata mostra l’elenco dei codici di stato dei dispositivi e le relative descrizioni. 
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▼ Creare un elenco dei codici risultato
Utilizzare la seguente procedura per creare un elenco con i codici risultato e le loro 
descrizioni. 

1. Selezionare Tools > Diagnostics. 

2. Fare clic sulla cartella Library Folder nell’albero dei dispositivi.

Si apre la schermata Library.

3. Fare clic sulla scheda Search.

Si apre la schermata Library Search. 

4. Nel menu a tendina Search Type, fare clic su Result Code. 

5. Completare il campo Result Code come segue:

■ Per cercare un codice è necessario digitarlo per esteso; non sono ammessi caratteri 
speciali o codici parziali. 

■ Per elencare tutti i codici, selezionare la casella di controllo List All. 

Task di utility della libreria

Task Pagina

Eseguire la verifica automatica della libreria 290

Riavviare la libreria 290

Scaricare un codice nel controller della libreria 291

Attivare un codice 292

Trasferire il file MIB della libreria 293
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▼ Eseguire la verifica automatica della libreria 

Nota – È necessario che nella libreria siano presenti le cartucce diagnostiche adatte alle 
unità della libreria stessa. 

1. Selezionare Tools > Diagnostics. 

2. Fare clic sulla cartella Library Folder nell’albero dei dispositivi.

Si apre la schermata Library.

3. Fare clic sulla scheda SelfTest.

Nota – La schermata di verifica automatica mostra un campo Mode con due opzioni: 
distruttivo e non distruttivo. Allo stato attuale, è valida solo l’opzione non distruttivo. 

4. Fare clic sulla scheda Run nella barra delle opzioni.

Durante la verifica automatica la finestra della SL Console mostra lo stato dei processi 
diagnostici in corso.

▼ Riavviare la libreria
Utilizzare questa procedura per riavviare la libreria. Questo processo prevede il 
ricaricamento del firmware dalla memoria flash e il riavvio del controller della libreria.

1. Selezionare Tools > Diagnostics. 

2. Fare clic sulla cartella Library Folder nell’albero dei dispositivi.

Si apre la schermata Library.
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3. Fare clic su Reboot nella barra delle opzioni.

Si apre il popup Reboot Confirm. 

4. Fare clic su OK. 

5. Fare clic su OK per continuare. 

Il controller riavvia la libreria e si apre il popup Reboot Success. 

6. Fare clic su OK per chiudere il popup. 

7. Mettere la libreria online. Per informazioni, consultare la sezione “Mettere la libreria 
in modalità online” a pagina 328. 

▼ Scaricare un codice nel controller della libreria
1. Selezionare Tools > Diagnostics. 

2. Fare clic sulla cartella Library Folder nell’albero dei dispositivi.

Si apre la schermata Library.

3. Fare clic sulla scheda Load Code. 

4. Fare clic sul pulsante Browse per individuare e selezionare il nome della cartella e 
del file contenente il pacchetto del firmware (file .jar ) sul PC, quindi fare clic su 
Open.

5. Fare clic sul pulsante Load nella barra delle opzioni.

6. Fare clic su OK per confermare il download. 

Nota – Il processo di download può richiedere fino a cinque minuti. La SL Console 
indica lo stato del trasferimento del file dal PC al controller della libreria.

Nota – Al termine del download, il sistema decomprime il pacchetto. 

7. Una volta eseguita la decompressione, è possibile attivare subito il codice o farlo in 
un momento successivo. Per istruzioni dettagliate, consultare la sezione “Attivare un 
codice” a pagina 292.
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▼ Attivare un codice
Attivando il codice presente nel controller della libreria lo si rende operativo. 

1. Selezionare Tools > Diagnostics. 

2. Fare clic sulla cartella Library Folder nell’albero dei dispositivi.

Si apre la schermata Library.

3. Fare clic sulla scheda Activate Code.

4. Fare clic su Target nel menu a tendina.

Nota – Target si riferisce al pacchetto firmware (file .jar ) contenente il codice libreria 
di SL3000.

5. Fare clic sul codice per attivarlo dalla sezione Available Versions. 

Nota – La versione con prefisso * è il codice attualmente attivo. Non è possibile 
selezionare di nuovo questo codice per attivarlo.

6. Fare clic sul pulsante Activate nella barra delle opzioni.

Nota – Per completare il processo di attivazione del codice potrebbero essere necessari 
fino a dieci minuti.

Attenzione – POTENZIALE DANNEGGIAMENTO INTERNO DEL FILE. Non 
riavviare alcun dispositivo né eseguire alcuna operazione all’interno della libreria 
durante l’attivazione del codice.

7. Fare clic su OK per continuare.

Nota – La schermata Activate Console mostra lo stato del processo di attivazione del 
codice. Il codice attivato compare nell’elenco delle versioni disponibili ed è 
contrassegnato da un asterisco (*). Nell’elenco sono riportate anche la versione non 
decompressa e le versioni attivate in precedenza del codice (senza “*”). 

8. Il sistema chiede di riavviare la libreria. Fare clic su OK per riavviare la libreria.

9. Fare clic su OK per terminare la sessione della SL Console.
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10.Nella schermata del login, fare clic su Exit per chiudere l’applicazione. 

11.Attendere che la libreria abbia completato l’inizializzazione prima di connettersi di 
nuovo alla SL Console.

Nota – La SL Console legge tutti i dati di configurazione della libreria dal controller 
della libreria. Per questo motivo, è necessario fare molta attenzione quando si accede 
alla SL Console prima che l’inizializzazione della libreria sia stata completata. 
Potrebbero essere visualizzati dei messaggi di avvertenza a indicare che i dati di 
configurazione non sono ancora disponibili; in tal caso sarà necessario uscire e accedere 
nuovamente alla console in seguito. Inoltre, se il controllo viene effettuato nel corso del 
processo di inizializzazione, fino a che non è completato, tutti i dati di configurazione 
visualizzati potrebbero non essere del tutto aggiornati o accurati. 

▼ Trasferire il file MIB della libreria 
Utilizzare questa procedura per copiare il file SNMP MIB (Management Information 
Base) pubblico in una posizione specifica sul PC o la postazione di lavoro locale. Il file 
viene salvato come file di testo. È possibile inviare il file via e-mail al responsabile 
dell’assistenza tecnica Sun per ricevere assistenza nella diagnosi dei problemi 
riguardanti la libreria. 

1. Selezionare Tools > Diagnostics. 

2. Fare clic sulla cartella Library Folder nell’albero dei dispositivi.

Si apre la schermata Library.
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3. Fare clic sulla scheda TransferFile. 

Si apre la schermata di trasferimento del file MIB. 

4. Fare clic su Transfer. 

Si apre il popup Save. 
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5. Sfogliare la directory in cui si desidera salvare il file ed immettere il nome del file 
nel campo File Name. Assicurarsi di assegnargli il suffisso .txt. 

6. Fare clic su Save. 

I dati vengono salvati nel file specificato e si apre il popup Transferred Successful. 

7. Fare clic su OK per chiudere il popup. 

Task di controllo

▼ Controllare l’intera libreria
Durante questo controllo la TallBot esamina tutti gli slot delle cartucce, cataloga i 
VOLID e le posizioni e aggiorna il database del controller della libreria. 

Nota – Benché si tratti di un processo in background che non comporta l’interruzione 
delle operazioni della libreria, richiede la condivisione delle risorse della TallBot. Per 
questa ragione si consiglia di non eseguire il controllo in periodi di intensa attività. 

Nota – Una volta avviato non è possibile interrompere il controllo. 

1. Selezionare Tools > Diagnostics. 

2. Fare clic sulla cartella Library Folder nell’albero dei dispositivi.

Si apre la schermata Library.

Task Pagina

Controllare l’intera libreria 295

Controllare un intervallo di celle 297

Effettuare la verifica di un controllo 299
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3. Fare clic sulla scheda Audit.

Si apre la schermata Library Audit. 

4. Nel campo Entire Library, fare clic su Yes. Quindi fare clic sul pulsante Audit nella 
barra delle opzioni.

Si apre un popup di conferma. 

5. Fare clic su OK per eseguire il controllo in background o Cancel per annullarlo.

Nota – Una volta fatto clic su OK, il controllo non potrà essere interrotto e continuerà 
fino al completamento del processo. 

6. Dopo qualche ora è possibile visualizzare il report di riepilogo in cui sono riportate 
le ultime posizioni e i VOLID delle cartucce. Per informazioni, consultare la sezione 
“Visualizzare il report di una libreria” a pagina 78.
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▼ Controllare un intervallo di celle
Durante il controllo la TallBot esamina solo un intervallo specifico di slot delle cartucce 
(incluse le CAP e le unità) e aggiorna il database del controller della libreria.

1. Selezionare Tools > Diagnostics. 

2. Fare clic sulla cartella Library Folder nell’albero dei dispositivi.

Si apre la schermata Library.

3. Fare clic sulla scheda Audit.

Si apre la schermata Library Audit. 

4. Nel campo Entire Library, fare clic su No. Nel campo Physical Audit, fare clic su Yes. 
Nel campo Verified Audit, fare clic su No.
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5. Nei campi Start Address e End Address, selezionare i tipi di dispositivi da 
controllare e le posizioni degli indirizzi iniziali e finali interni alla libreria. 
Consultare la sezione “Indirizzo interno della libreria” a pagina 334 per una 
spiegazione dettagliata di questo formato indirizzo. 

6. Fare clic sul pulsante Audit nella barra delle opzioni.

Si apre un popup di conferma. 

7. Fare clic su OK per eseguire il controllo in background o Cancel per annullarlo.

Nota – Una volta fatto clic su OK, il controllo non potrà essere interrotto e continuerà 
fino al completamento del processo. 

8. La sezione Audit Console mostra lo stato di avanzamento del controllo. 
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Nota – È anche possibile visualizzare il report di riepilogo delle cartucce in cui sono 
riportate le ultime posizioni e i VOLID delle cartucce. Per informazioni, consultare la 
sezione “Visualizzare il report di una libreria” a pagina 78.

▼ Effettuare la verifica di un controllo 
La verifica di un controllo convalida lo stato della posizione di una specifica cartuccia o 
di un intervallo di posizioni (incluse CAP e unità) nel database del controller. Se alla 
verifica lo status dell’indirizzo di una cartuccia risulta essere falso (false), viene avviato 
un controllo fisico di quella posizione e il database del controller viene aggiornato. 

1. Selezionare Tools > Diagnostics. 

2. Fare clic sulla cartella Library Folder nell’albero dei dispositivi.

Si apre la schermata Library.
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3. Fare clic sulla scheda Audit.

Si apre la schermata Library Audit. 

4. Nel campo Entire Library, fare clic su No. Nel campo Verified Audit, fare clic su No. 
Nel campo Verified Audit, fare clic su Yes. 

5. Nei campi Start Address e End Address, selezionare i tipi di dispositivi da 
controllare e le posizioni degli indirizzi iniziali e finali interni alla libreria. 
Consultare la sezione “Indirizzo interno della libreria” a pagina 334 per una 
spiegazione dettagliata di questo formato indirizzo. 

6. Fare clic sul pulsante Audit nella barra delle opzioni.
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La sezione Audit Console mostra lo stato di avanzamento del controllo. 

Task di utility della CAP

▼ Eseguire la verifica automatica di una CAP 

Nota – Attualmente la verifica automatica della CAP esegue le stesse routine della 
verifica automatica della libreria. In futuro saranno disponibili veritiche automatiche 
delle CAP specifiche.

Task Pagina

Eseguire la verifica automatica di una CAP 301

Mettere una CAP offline 302

Mettere una CAP online 304
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1. Selezionare Tools > Diagnostics.

2. Espandere la cartella CAP e fare clic sulla CAP da testare. 

3. Fare clic sulla scheda SelfTest.

4. Nel menu a tendina Mode, fare clic su Non-Disruptive. 

5. Fare clic sul pulsante Run nella barra delle opzioni.

Durante la verifica automatica vengono visualizzati dei messaggi di stato. Al termine 
della verifica compare un messaggio che segnala il completamento del processo 
diagnostico. 

▼ Mettere una CAP offline
Seguire questa procedura per mettere una CAP offline con la SL Console. 

Nota – Utilizzare questa procedura solo se non è in uso il software di gestione nastri 
ACSLS o HSC, oppure se i server non sono in grado di comunicare con la libreria. 
ACSLS e HSC non ricevono la notifica quando lo stato della libreria o dei suoi 
componenti viene modificato dalla SL Console; ciò può provocare un 
malfunzionamento della libreria. Per istruzioni su come modificare lo stato della 
libreria e dei suoi componenti attraverso ACSLS o HSC, consultare la documentazione 
del software di gestione dei nastri. 

1. Selezionare Tools > System Detail. 

2. Espandere la cartella CAP Folder e fare clic sulla CAP da modificare. 
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3. Fare clic sulla scheda Status.

La schermata mostra lo stato corrente della CAP. 

4. Nel campo Transition Request, selezionare Take Offline. Fare clic su Apply. 

Tutti i processi in sospeso riguardanti la CAP vengono completati e lo stato della CAP 
viene modificato come segue:

■ Health State: Warn

■ Device State: Not accessible (HLI host connections); Not ready (SCSI host 
connections) 

■ Access State: Offline
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▼ Mettere una CAP online
Seguire questa procedura per mettere una CAP online con la SL Console. 

Nota – Utilizzare questa procedura solo se non è in uso il software di gestione nastri 
ACSLS o HSC, oppure se i server non sono in grado di comunicare con la libreria. 
ACSLS e HSC non ricevono la notifica quando lo stato della libreria o dei suoi 
componenti viene modificato dalla SL Console; ciò può provocare un 
malfunzionamento della libreria. Per istruzioni su come modificare lo stato della 
libreria e dei suoi componenti attraverso ACSLS o HSC, consultare la documentazione 
del software di gestione dei nastri. 

Nota – I dispositivi della libreria che si trovano in stato di errore offline possono 
funzionare online solo dopo aver corretto l’errore. 

1. Selezionare Tools > System Detail. 

2. Espandere la cartella CAP Folder e fare clic sulla CAP da modificare. 

3. Fare clic sulla scheda Status.

La schermata mostra lo stato corrente della CAP. 
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4. Nel campo Transition Request, fare clic su Bring online. Fare clic su Apply. 

Lo stato della CAP viene aggiornato come segue:

■ Health State: ok

■ Device State: Ready

■ Access State: Online

Task di utility dell’unità

▼ Eseguire una verifica automatica dell’unità 
1. Selezionare Tools > Diagnostics.

2. Espandere la cartella Drive Folder e fare clic sull’unità da testare. 

3. Fare clic sulla scheda SelfTest.

4. Nel menu a tendina Mode, fare clic su Non-Disruptive. 

5. Fare clic sul pulsante Run nella barra delle opzioni.

Durante la verifica automatica vengono visualizzati dei messaggi di stato. Al termine 
della verifica compare un messaggio che segnala il completamento del processo 
diagnostico. 

▼ Mettere un’unità offline
Seguire questa procedura per mettere un’unità offline con la SL Console. 

Nota – Utilizzare questa procedura solo se non è in uso il software di gestione nastri 
ACSLS o HSC, oppure se i server non sono in grado di comunicare con la libreria. 
ACSLS e HSC non ricevono la notifica quando lo stato della libreria o dei suoi 
componenti viene modificato dalla SL Console; ciò può provocare un 
malfunzionamento della libreria. Per istruzioni su come modificare lo stato della 
libreria e dei suoi componenti attraverso ACSLS o HSC, consultare la documentazione 
del software di gestione dei nastri. 

1. Selezionare Tools > System Detail. 

2. Espandere la cartella Drive Folder e fare clic sull’unità da modificare. 
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3. Fare clic sulla scheda Status.

La schermata mostra lo stato corrente dell’unità. 

4. Nel campo Transition Request, selezionare Take Offline. Fare clic su Apply. 

Tutti i processi in sospeso riguardanti l’unità vengono completati e lo stato dell’unità 
viene modificato come segue:

■ Health State: Warn

■ Device State: Not accessible (HLI host connections); Not ready (SCSI host 
connections) 

■ Access State: Offline
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▼ Mettere un’unità online
Seguire questa procedura per mettere un’unità online con la SL Console. 

Nota – Utilizzare questa procedura solo se non è in uso il software di gestione nastri 
ACSLS o HSC, oppure se i server non sono in grado di comunicare con la libreria. 
ACSLS e HSC non ricevono la notifica quando lo stato della libreria o dei suoi 
componenti viene modificato dalla SL Console; ciò può provocare un 
malfunzionamento della libreria. Per istruzioni su come modificare lo stato della 
libreria e dei suoi componenti attraverso ACSLS o HSC, consultare la documentazione 
del software di gestione dei nastri. 

Nota – I dispositivi della libreria che si trovano in stato di errore offline possono 
funzionare online solo dopo aver corretto l’errore. 

1. Selezionare Tools > System Detail. 

2. Espandere la cartella Drive Folder e fare clic sull’unità da modificare. 

3. Fare clic sulla scheda Status.

La schermata mostra lo stato corrente dell’unità. 
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4. Nel campo Transition Request, selezionare Bring online. Fare clic su Apply. 

Lo stato dell’unità viene aggiornato come segue:

■ Health State: ok

■ Device State: Ready

■ Access State: Online

TallBot Task di utility

▼ Eseguire la verifica automatica di una TallBot 

Nota – Per eseguire la verifica automatica di una TallBot, è necessario che nella libreria 
siano disponibili delle cartucce diagnostiche. 

1. Selezionare Tools > Diagnostics.

2. Espandere la cartella Robot Folder e fare clic sul robot da testare. 

3. Fare clic sulla scheda SelfTest.

4. Nel menu a tendina Mode, fare clic su Non-Disruptive. 

5. Fare clic sul pulsante Run nella barra delle opzioni.

Durante la verifica automatica vengono visualizzati dei messaggi di stato. Al termine 
della verifica compare un messaggio che segnala il completamento del processo 
diagnostico. 
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▼ Mettere una TallBot offline
Seguire questa procedura per mettere una TallBot offline con la SL Console. 

Nota – Utilizzare questa procedura solo se non è in uso il software di gestione nastri 
ACSLS o HSC, oppure se i server non sono in grado di comunicare con la libreria. 
ACSLS e HSC non ricevono la notifica quando lo stato della libreria o dei suoi 
componenti viene modificato dalla SL Console; ciò può provocare un 
malfunzionamento della libreria. Per istruzioni su come modificare lo stato della 
libreria e dei suoi componenti attraverso ACSLS o HSC, consultare la documentazione 
del software di gestione dei nastri. 

1. Selezionare Tools > System Detail. 

2. Espandere la cartella Robot Folder e fare clic sulla TallBot da testare. 

3. Fare clic sulla scheda Status.

La schermata mostra lo stato corrente della TallBot. 
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4. Nel campo Transition Request, selezionare Take Offline. Fare clic su Apply. 

Tutti i processi in sospeso riguardanti la TallBot vengono completato e lo stato della 
TallBot viene modificato come segue:

■ Health State: Warn

■ Device State: Not accessible (HLI host connections); Not ready (SCSI host 
connections) 

■ Access State: Offline

5. La TallBot viene spostata alla fine del binario e non può essere utilizzata dalla 
libreria. Se la libreria sta utilizzando la funzionalità di TallBot ridondante, 
la seconda TallBot raccoglierà tutte le richieste. 

▼ Mettere una TallBot online
Seguire questa procedura per mettere una TallBot online con la SL Console. 

Nota – Utilizzare questa procedura solo se non è in uso il software di gestione nastri 
ACSLS o HSC, oppure se i server non sono in grado di comunicare con la libreria. 
ACSLS e HSC non ricevono la notifica quando lo stato della libreria o dei suoi 
componenti viene modificato dalla SL Console; ciò può provocare un 
malfunzionamento della libreria. Per istruzioni su come modificare lo stato della 
libreria e dei suoi componenti attraverso ACSLS o HSC, consultare la documentazione 
del software di gestione dei nastri. 

Nota – I dispositivi della libreria che si trovano in stato di errore offline possono 
funzionare online solo dopo aver corretto l’errore. 

1. Selezionare Tools > System Detail. 

2. Espandere la cartella Robot Folder e fare clic sulla TallBot da testare. 
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3. Fare clic sulla scheda Status.

La schermata mostra lo stato corrente della TallBot. 

4. Nel campo Transition Request, fare clic su Bring Online. Fare clic su Apply. 

Lo stato della Tallbot viene aggiornato come segue:

■ Health State: ok

■ Device State: Ready

■ Access State: Online

▼ Definire uno spostamento diagnostico 
È possibile impostare ed eseguire diversi spostamenti diagnostici simultaneamente, 
purché gli intervalli degli indirizzi target e pool non si sovrappongano. 

Nota – Questa procedura richiede la condivisione delle risorse della TallBot; per questa 
ragione si consiglia di non effettuarla in periodi di intensa attività. 

1. Selezionare Tools > Diagnostics. 
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2. Fare clic sulla cartella Library Folder nell’albero dei dispositivi.

Si apre la schermata Library.

3. Fare clic sulla scheda DiagMove e poi sulla scheda Manage. 

Si apre la schermata Diagnostic Move Manage.
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4. Nella sezione Defined Sequence, fare clic su Add.

Si apre la schermata dell’indirizzo target Sequence. 

5. Nel campo Selection Mode, selezionare il tipo di celle di cui si desidera eseguire la 
diagnosi. 

6. Nei campi Minimum Address e Maximum Address, selezionare la colonna (Column), 
il lato (Side) e la riga (Row) degli indirizzi target minimo e massimo. 

7. Fare clic su Next.

Si apre la schermata dell’indirizzo sorgente Sequence. 
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a. Selezionare l’indirizzo target adatto e fare clic su Next. Consultare la sezione 
“Intervallo indirizzi target” a pagina 283. 

8. Per definire i parametri dell’intervallo degli indirizzi pool:

a. Selezionare l’indirizzo pool adatto.

b. Fare clic su Next per proseguire o su Previous per modificare l’intervallo degli 
indirizzi target.

Si apre la schermata Sequence Name. 

9. Definire i seguenti parametri:

■ Nome dello spostamento diagnostico

■ Numero di spostamenti (indicare un numero tra 1 e 5000)

■ Ordine di accesso (sequenziale o casuale)

■ Tipo di spostamento (Robot and Cartridge oppure Robot Only) 
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10.Fare clic su Previous per tornare alla schermata precedente e modificare l’intervallo 
degli indirizzi target o pool oppure su Finish per completare la configurazione.

Compare la schermata Diagnostic Move Manage. La sequenza diagnostica appena 
definita è riportata nella sezione Defined Sequences. 

▼ Avviare uno spostamento diagnostico
1. Selezionare Tools > Diagnostics. 

2. Fare clic sulla cartella Library Folder nell’albero dei dispositivi.

Si apre la schermata Library.
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3. Fare clic sulla scheda DiagMove e poi sulla scheda Manage. 

Si apre la schermata Diagnostic Move Manage.

4. Nella sezione Defined Sequences fare clic su uno spostamento diagnostico e quindi 
fare clic su Open. 
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5. Compare una finestra con le opzioni con le seguenti funzioni:

▼ Gestire gli spostamenti diagnostici
Lo spostamento diagnostico consente di creare e gestire operazioni di 
acquisizione/assegnazione. 

1. Selezionare Tools > Diagnostics. 

2. Fare clic sulla cartella Library Folder nell’albero dei dispositivi.

Si apre la schermata Library.

Per Opzione di menu Note

Avviare File > Start Sequence

Mettere in pausa File > Pause Sequence Interrompe tutti gli spostamenti 
diagnostici, ma mantiene la posizione 
corrente nell’ordine di accesso.

Interrompere File > Stop Sequence Interrompe uno spostamento in 
esecuzione o in pausa.

Riprendere File > Start Sequence Riprende uno spostamento in pausa a 
partire dall’ultima posizione nota 
nell’intervallo degli indirizzi target.

Cancella i messaggi 
visualizzati nella finestra 
di monitoraggio

File > Clear Output 
Window

Cancella i messaggi precedenti e continua 
a inviare sullo schermo nuovi messaggi.

Effettuare lo spooling Spool File > Start Spooling Dirige gli output di spostamento verso 
un file.

Interrompe lo spooling 
degli output di 
spostamento verso un file

Spool File > Stop Spooling Smette di dirigere l’output di spostamento 
verso il file di spooling.
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3. Fare clic sulla scheda DiagMove e poi sulla scheda Manage. 

Si apre la schermata Diagnostic Move Manage.

4. Dalla sezione Defined Sequences, selezionare una delle seguenti opzioni:

Per Opzione da selezionare Note

Definire uno spostamento 
diagnostico 

Add

Avviare uno spostamento 
diagnostico

Open È possibile avviare più spostamenti 
diagnostici contemporaneamente purché gli 
intervalli degli indirizzi target e pool 
assegnati agli spostamenti non si 
sovrappongano.

Eliminare uno spostamento 
diagnostico

Remove Non aprire la routine degli spostamenti 
diagnostici.

Modificare le opzioni di 
uno spostamento 
diagnostico

Modify La routine degli spostamenti diagnostici non 
deve essere aperta, o, se è aperta, deve 
essere impostata sullo stato “Stopped”.

Copiare uno spostamento 
diagnostico esistente

Copy Consente di copiare la definizione di uno 
spostamento diagnostico, effettua modifiche 
se necessario e assegna un nomer diverso.
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5. Per salvare la definizione di uno strumento in un file: 

a. Fare clic su Save nella barra delle opzioni. 

b. Nel popup Save, fare clic su Save in Folder e quindi digitare il nome di un file. 

c. Selezionare il formato file adeguato (HTML, Text o XML) e fare clic su Save.

Nota – Se il file esiste già, sovrascriverlo.

Nota – Dopo aver salvato in un file le definizioni degli spostamenti, è possibile 
rimuoverle dalla SL Console e ripristinarle successivamente in un’altra libreria.

6. Per ripristinare uno spostamento diagnostico salvato in precedenza e rimosso:

a. Fare clic su Restore nella barra delle opzioni.

b. Fare clic sulla cartella e sul nome del file relativo allo spostamento. 

c. Fare clic su Open. 

7. Per gestire gli spostamenti diagnostici attualmente aperti, consultare la sezione 
“Funzioni di controllo dello spostamento diagnostico” a pagina 285.

▼ Monitorare e controllare gli spostamenti 
diagnostici
È possibile aprire e monitorare uno o più spostamenti. 

1. Selezionare Tools > Diagnostics. 

2. Fare clic sulla cartella Library Folder nell’albero dei dispositivi.

Si apre la schermata Library.



TallBot Task di utility

320 Manuale dell’utente di SL3000 • Aprile 2008 Revisione: A • 418605201

3. Fare clic sulla scheda DiagMove e poi sulla scheda Manage. 

Si apre la schermata Diagnostic Move Manage.

4. Nella sezione Defined Sequences fare clic su uno spostamento e quindi fare clic 
su Open. 

Nota – È possibile avere aperti più spostamenti diagnostici contemporaneamente 
purché gli intervalli degli indirizzi di destinazione e pool assegnati agli spostamenti 
non si sovrappongano.

5. Per aprire più spostamenti dall’elenco, seguire i seguenti passi. 

Nota – Per ogni spostamento selezionato viene visualizzata una finestra di 
monitoraggio.
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6. Per ciascuna finestra selezionare File > Start, per avviare lo spostamento. 

La finestra di monitoraggio di ciascuno spostamento aperto riporta i seguenti indicatori 
di stato:

▼ Verificare lo stato di uno spostamento aperto
1. Selezionare Tools > Diagnostics. 

2. Fare clic sulla cartella Library Folder nell’albero dei dispositivi.

Si apre la schermata Library.

Indicatori di stato Descrizione Valori validi

State Stato corrente dello spostamento Running, pausing, paused, 
stopping, stopped

Health Salute attuale dello spostamento OK, warning, error

Spostamenti completati Numero di spostamenti completati tra 
quelli richiesti 

Spooling Status Indica se è stato effettuato o no lo spooling 
dell’output di spostamento

True, False
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3. Fare clic sulla scheda DiagMove e poi sulla scheda Manage. 

Si apre la schermata Diagnostic Move Manage.

4. Selezionare lo spostamento dall’elenco nella sezione Defined Sequences. 

La sezione Status della schermata mostra lo stato, gli spostamenti completati e il 
numero di sequenze attualmente in esecuzione.

La sezione Selected Monitor Console mostra lo stato degli spostamenti diagnostici per 
lo spostamento selezionato dall’elenco.
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CAPITOLO 8

Operazioni manuali

Quando si trova in modalità operativa manuale, la libreria non consente l’accesso da 
parte dell’host. Questo può dipendere dal fatto che nella libreria si è verificato un errore 
irreversibile o che un componente della libreria deve essere riparato o installato. 
Quando la libreria si trova in questa modalità per installare e disinstallare le cartucce è 
necessario l’intervento da parte dell’utente. 

Sicurezza della libreria
Leggere attentamente le precauzioni di sicurezza riportate in questa sezione prima di 
entrare nella libreria. È necessario seguire accuratamente le procedure di sicurezza ogni 
volta che si entra nella libreria. 

Precauzioni generali di sicurezza

Avvertenza – rischio di lesioni personali. Per evitare che la porta di accesso si 
chiuda accidentalmente mentre ci si trova all’interno della libreria, una volta 
sbloccata la porta si consiglia di bloccarla tenendola aperta e di portare la chiave 
con sé. 

Prima di entrare nella libreria, assicurarsi di: 

■ Conoscere la posizione del meccanismo di sblocco di emergenza della porta. 
Consultare la sezione “Dispositivi di blocco della porta di SL3000” a pagina 324.

■ Lasciare aperta la porta di accesso quando si lavora all’interno della libreria. Sulla 
struttura di ogni porta è presente un commutatore che all’apertura interrompe 
l’alimentazione CC e le linee di segnale che vanno ai motori della libreria. Consultare 
la sezione “Servomeccanismo di interruzione dell’alimentazione di SL3000” a 
pagina 324.

■ Conoscere la posizione dei meccanismi di rilascio della porta. Consultare la sezione 
“Meccanismi di rilascio della porta” a pagina 325. 

■ Conoscere i limiti spaziali della libreria. Consultare la sezione “Limiti fisici” a 
pagina 325. 
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Dispositivi di blocco della porta di SL3000 
I dispositivi di blocco di sicurezza della porta sono posizionati dietro le porte di accesso 
frontali del Base Module e del modulo DEM. Per aprire una porta è necessaria una 
chiave di accesso. 

I dispositivi di blocco di sicurezza della porta sono costantemente monitorati dal 
controller della libreria. Durante il normale funzionamento, quando una porta di 
accesso viene aperta si avvia la modalità di interruzione d’emergenza dei componenti 
robotici e tutti i motori della libreria vengono immediatamente disabilitati. Ciò 
impedisce ai motori di funzionare mentre la porta della libreria è aperta. Se la libreria 
viene messa in modalità offline, aprendo la porta di accesso la corrente che va ai binari 
e al bus di alimentazione viene interrotta. 

I commutatori sulla porta vengono monitorati anche quando la libreria è spenta. In 
questo caso, una batteria invia la corrente ai circuiti al fine di rilevare l’apertura o la 
chiusura di una porta.

Quando un Base Module e un DEM sono collegati tra loro, aprendo la porta di accesso 
di uno dei due moduli viene automaticamente sospeso il funzionamento dell’intera 
libreria (i due commutatori sulla porta sono collegati in serie).

Servomeccanismo di interruzione 
dell’alimentazione di SL3000
Un’ulteriore funzionalità di sicurezza è il servomeccanismo di interruzione 
dell’alimentazione. Se il controller della libreria rileva che il motore della libreria è 
guasto, interromperà la corrente che lo alimenta tramite un servomeccanismo di 
interruzione dell’alimentazione. In questo modo si evita un’interruzione improvvisa 
della corrente fino a che non viene determinata la causa del problema. 
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Meccanismi di rilascio della porta
Le maniglie presenti sulle porte di accesso del Base Module e del modulo DEM 
presentano un meccanismo di rilascio di colore giallo (vedere la FIGURA 8-1.) Questo 
meccanismo funge da protezione in caso una persona si trovi all’interno della libreria e 
la porta di accesso si chiuda e blocchi accidentalmente. Azionando il meccanismo di 
rilascio, la porta si sblocca e si apre. 

FIGURA 8-1 Meccanismo di rilascio della porta 

Illuminazione interna
L’interno della libreria è sempre illuminato da LED bianchi posizionati sul soffitto. 

Limiti fisici
La libreria non offre molto spazio per muoversi. È necessario tenere sempre presenti i 
limiti spaziali. 

■ Fare attenzione che gli indumenti non si impiglino negli array di plastica che 
ospitano le cartucce (lo spazio è di soli 0,4 m [18 in.]).

■ Fare attenzione a non urtare gli array con testa o il corpo. 

■ Per accedere alle cartucce, può essere necessario spostare una TallBot; in tal caso, fare 
attenzione a non danneggiare i componenti elettronici della TallBot. 

■ Se si sta inserendo o estraendo manualmente una cartuccia, fare attenzione a non 
toccare i componenti di caricamento meccanici ed elettronici dell’unità.
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Task delle operazioni manuali

▼ Mettere la libreria in modalità offline 
Seguire questa procedura per mettere la libreria in modalità offline tramite la 
SL Console. 

Nota – Utilizzare questa procedura solo se non è in uso il software di gestione nastri 
ACSLS o HSC, oppure se i server non sono in grado di comunicare con la libreria. 
ACSLS e HSC non ricevono la notifica quando lo stato della libreria o dei suoi 
componenti viene modificato dalla SL Console; ciò può provocare un 
malfunzionamento della libreria. Per istruzioni su come modificare lo stato della 
libreria e dei suoi componenti attraverso ACSLS o HSC, consultare la documentazione 
del software di gestione dei nastri. 

Può essere necessario utilizzare questa procedura nei seguenti casi:

■ Prima di spegnere la libreria.

■ Prima di aprire la porta di accesso della libreria.

■ Quando la libreria non è operativa e richiede un intervento di manutenzione. 

1. Mettere tutte le unità della libreria in modalità offline. 

Per informazioni, consultare la sezione “Mettere un’unità offline” a pagina 305. 

2. Selezionare Tools > System Detail.

3. Fare clic sulla cartella Library Folder nell’albero dei dispositivi.

Task Pagina

Mettere la libreria in modalità offline 326

Mettere la libreria in modalità online 326

Spegnere la libreria 326

Accendere la libreria 326

Aprire la porta di accesso della libreria 326

Chiudere e bloccare la porta di accesso della libreria 331



Task delle operazioni manuali

418605201 • Revisione: A Capitolo 8 Operazioni manuali 327

4. Fare clic sulla scheda Status, e poi sulla scheda General.

Viene visualizzato lo stato corrente della libreria. 

5. Nel campo Transition Request, selezionare Take offline. Fare clic su Apply.

Tutti i processi in sospeso vengono completati e lo stato della libreria viene modificato 
come segue:

■ Health State: Warn

■ Device State: Not accessible (HLI host connections); Not ready (SCSI host 
connections) 

■ Access State: Offline 
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▼ Mettere la libreria in modalità online
Seguire questa procedura per mettere la libreria in modalità offline tramite la 
SL Console. 

Nota – Utilizzare questa procedura solo se non è in uso il software di gestione nastri 
ACSLS o HSC, oppure se i server non sono in grado di comunicare con la libreria. 
ACSLS e HSC non ricevono la notifica quando lo stato della libreria o dei suoi 
componenti viene modificato dalla SL Console; ciò può provocare un 
malfunzionamento della libreria. Per istruzioni su come modificare lo stato della 
libreria e dei suoi componenti attraverso ACSLS o HSC, consultare la documentazione 
del software di gestione dei nastri. 

1. Selezionare Tools > System Detail.

2. Fare clic sulla cartella Library Folder nell’albero dei dispositivi.

3. Fare clic sulla scheda Status, e poi sulla scheda General.

La schermata mostra lo stato corrente della libreria. 

4. Nel campo Transition Request, selezionare Bring online. 
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5. Fare clic su Apply. 

Lo stato della libreria viene aggiornato, in questo modo:

■ Health State: ok

■ Device State: Ready

■ Access State: Online

6. Se consentito, mettere la libreria in modalità online negli host ACSLS e HSC. Per le 
procedure dettagliate, consultare la documentazione relativa agli host ACSLS e HSC. 

▼ Spegnere la libreria
Utilizzare questa procedura per spegnere la libreria. 

1. Mettere tutte le unità della libreria in modalità offline. 

Per informazioni, consultare la sezione “Mettere un’unità offline” a pagina 305. 

2. Mettere la libreria in modalità offline. 

Per informazioni, consultare la sezione “Mettere la libreria in modalità offline” a 
pagina 326. 

3. Aprire le porte posteriori del Base Module e del DEM (se presente). 

4. Spegnere i commutatori di alimentazione. 

5. Se necessario, spegnere gli interruttori di circuito sulle unità di distribuzione 
dell’alimentazione. 

▼ Accendere la libreria
Utilizzare questa procedura per accendere la libreria. Se le porte di accesso sono state 
aperte e chiuse verrà eseguito il controllo completo della libreria. 

1. Aprire le porte posteriori del Base Module e del DEM (se presente). 

2. Se necessario, accendere gli interruttori di circuito sulle unità di distribuzione 
dell’alimentazione. 

3. Accendere i commutatori di alimentazione. 

4. La libreria inizia il processo di inizializzazione, in questo modo:

Nota – La SL Console legge tutti i dati di configurazione della libreria dal controller 
della libreria. Per questo motivo, è necessario fare molta attenzione quando si accede 
alla SL Console prima che l’inizializzazione della libreria sia stata completata. 
Potrebbero essere visualizzati dei messaggi di avvertenza a indicare che i dati di 
configurazione non sono ancora disponibili; in tal caso sarà necessario uscire e accedere 
nuovamente alla console in seguito. Inoltre, se il controllo viene effettuato nel corso del 
processo di inizializzazione, fino a che non è completato, tutti i dati di configurazione 
visualizzati potrebbero non essere del tutto aggiornati o accurati. 
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1. Il codice del controller della libreria è attivato.

2. Il controller della libreria individua elettronicamente i componenti della libreria:

a. Determina la configurazione dell’alimentazione CA (N+1 o 2N). 

b. Verifica la funzione del controller dell’unità nastro. 

c. Controlla le funzioni opzionali (per esempio, un pannello operatore locale). 

d. Stabilisce la comunicazione e la configurazione del controller della TallBot. 

e. Esamina tutte le unità nastro e ne determina la posizione. 

f. Ricerca tutte le CAP:

- Se la porta di una CAP è completamente aperta, verrà lasciata tale. 

- Se non è possibile determinare lo stato della porta di una CAP, viene 
aggiornato come chiuso e bloccato.

3. La TallBot esegue il processo di individuazione fisica:

a. La TallBot analizza tutta la libreria per determinarne le dimensioni. 

b. La TallBot esamina il blocco di identificazione del modulo per ciascun modulo. 

c. La libreria effettua la configurazione automatica sulla base di queste informazioni. 

4. Se una delle porte di accesso è stata aperta e chiusa, verrà avviato il controllo della 
libreria, in questo modo: 

a. La TallBot identifica ogni colonna di array (dall’alto verso il basso). 

b. La TallBot esamina ogni colonna, registrando i VOLID di tutte le cartucce. 

c. La posizione di ciascun VOLID viene registrata nel database del controller della 
libreria. 

d. Le celle di storage senza cartucce sono indicate come vuote.

e. Se viene trovata una cartuccia in una CAP, la CAP viene chiusa e bloccata. 

Nota – Il controllo non aggiorna i database delle cartucce host. Per informazioni 
sull’aggiornamento dei database host, consultare la documentazione relativa al 
software di gestione dei nastri. 

5. xLa libreria entra nello stato Ready.

5. Mettere la libreria in modalità online.

Per istruzioni dettagliate, consultare la sezione “Mettere la libreria in modalità online” 
a pagina 328. 
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▼ Aprire la porta di accesso della libreria 
Utilizzare questa procedura per aprire le porte principali della libreria. 

Avvertenza – rischio di lesioni personali. Per evitare che la porta di accesso si 
chiuda accidentalmente mentre ci si trova all’interno della libreria, una volta 
sbloccata la porta si consiglia di bloccarla tenendola aperta e di portare la chiave 
con sé. 

1. Mettere tutte le unità della libreria in modalità offline. 

Per informazioni, consultare la sezione “Mettere un’unità offline” a pagina 305. 

2. Mettere la libreria in modalità offline. 

Per informazioni, consultare la sezione “Mettere la libreria in modalità offline” 
a pagina 326. 

3. Inserire la chiave nella serratura e girarla per sbloccare la porta. 

4. Sollevare la maniglia per aprire la porta.

5. Girare la chiave per bloccare la porta aperta. In questo modo la porta non potrà 
essere chiusa mentre qualcuno è all’interno della libreria. 

6. Rimuovere la chiave dalla serratura e tenerla con sé. 

▼ Chiudere e bloccare la porta di accesso della 
libreria 
Utilizzare questa procedura per chiudere e bloccare le porte principali della libreria. 

1. Verificare di non aver dimenticato niente all’interno della libreria.

2. Se la porta di accesso aperta era stata bloccata, inserire la chiave nella serratura e 
girarla per sbloccare la porta. 

3. Spingere la porta e assicurarsi che si sia chiusa saldamente. 

4. Girare la chiave per bloccare la porta chiusa.

5. Rimuovere la chiave dalla serratura e riporla in un luogo sicuro. 

6. Se la libreria è spenta, accenderla. 

Per informazioni, consultare la sezione “Accendere la libreria” a pagina 329. 

Nota – Poiché le porte di accesso sono state aperte, verrà eseguito un controllo 
completo della libreria. 
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APPENDICE A

Indirizzi delle risorse della libreria 

Questa appendice descrive i seguenti schemi di indirizzamento della libreria. 

■ Indirizzo interno della libreria: utilizzato dal controller della libreria.

■ Posizioni HLI-PRC: utilizzati da host con connessioni TCP/IP alla libreria.

■ Posizioni dell’elemento FC-SCSI: utilizzati da host con connessioni FC-SCSI alla 
libreria. 

■ Numeri dell’hardware dell’unità: slot per array fisico in cui è installata un’unità. 

■ World Wide Name dinamici dell’unità: generati automaticamente dal controller della 
libreria per le unità installate. 

Questi schemi sono utilizzati per posizionare tutte le risorse della libreria, tra cui:

■ Celle di storage delle cartucce

■ Slot delle unità nastro

■ Unità installate 

■ Celle di sistema/prenotate

■ Celle della CAP 

Tecnologia CenterLine 
Il design modulare della libreria SL3000 sfrutta la tecnologia CenterLine per favorire il 
bilanciamento del workload e migliorare le prestazioni del sistema. Il lato sinistro del 
Base Module, l’unico modulo necessario, funge da asse (CenterLine). È possibile 
aggiungere altri moduli sul lato destro o sinistro del Base Module. Le colonne a destra 
della CenterLine hanno numerazione positiva (+), mentre quelle a sinistra negativa (–). 
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Indirizzo interno della libreria

Celle di storage
Lo schema di indirizzamento interno della libreria SL3000 è composto da cinque 
elementi: 

1. Numero libreria: sempre 1. 

2. Numero binario: sempre 1.

FIGURA A-1 Indirizzamento della CenterLine e delle colonne 

Center Line

 Colonne con numerazione negativa (–)  Colonne con numerazione positiva (+) 

 Unità -4,    -3,    -2,     -1 1,     2,     3,     4 

Cartucce -12, -11, -10, -9, -8, -7 -6, -5, -4, -3, -2, -1 1,  2,  3,  4,  5,  6 7,  8,  9,  10, 11, 12
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3. Numero colonna: posizione orizzontale. È riportato sull’estremità sinistra (tenendo 
di fronte la parete di fondo) del Base Module. Le colonne hanno numerazione 
positiva (+), in ordine crescente, da sinistra verso destra, in tutti i moduli connessi al 
lato destro del Base Module. 

Se un modulo è collocato a sinistra del Base Module, invece, le posizioni delle 
colonne hanno numerazione negativa (–), in ordine crescente, da destra verso 
sinistra, in tutti i moduli connessi al lato sinistro del Base Module.

4. Lato: parete di fondo = 1, parete frontale = 2.

5. Riga: posizione verticale, indicata nell’ultima cella in alto della colonna. Le celle di 
storage delle cartucce sono numerate da 1 a 52. 

Nella prima riga in alto, le unità sono numerate in questo modo: Colonne 1—4, Riga 1. 
Nella seconda riga, sono numerate in questo modo: Colonne 1—4, Riga 2, e così via. 
Tuttavia, come indicato nella TABELLA A-1 a pagina 335, le unità hanno quattro colonne, 
mentre gli array delle cartucce ne hanno sei. 

Esempio di indirizzo interno della libreria—Base Module
Come esempio sull’utilizzo dello scherma di indirizzamento interno della libreria, 
consultare la TABELLA A-1 a pagina 335; l’indirizzo dell’unità 13 sarebbe 1, 1, +4, 1, 4, 
come indicato di seguito: 

1. Numero libreria = 1 

2. Numero binario = 1

3. Numero colonna = +4

4. Lato = 1

5. Riga = 4

TABELLA A-1 Base Module—Posizioni nella parete posteriore (vista frontale della libreria)  

Riga          +1          +2          +3          +4

   +1       Unità 4       Unità 3       Unità 2       Unità 1

   +2       Unità 8       Unità 7       Unità 6       Unità 5

   +3       Unità 12       Unità 11       Unità 10       Unità 9
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Come secondo esempio, la posizione delle due celle drop-off su questa parete sono:

1. Numero libreria = 1

2. Numero binario = 1

3. Numero colonna = +2

4. Lato = 1

5. Righe = 49 e 50

...che si traduce in 1, 1, +2, 1, 49 e 1, 1, +2, 1, 50.

Esempio di indirizzo interno della libreria—DEM
Per la numerazione dell’unità 27 consultare la TABELLA A-2 a pagina 337. Come 
esempio sull’utilizzo dello schema di indirizzamento interno della libreria, la posizione 
dell’unità sarebbe... 

1. Numero libreria = 1

2. Numero binario = 1

3. Numero colonna = -3

4. Lato = 1

5. Riga = 1

...che si traduce in 1, 1, -3, 1, 1.

   +4       Unità 16       Unità 15       Unità 14       Unità 13

         +1          +2          +3          +4          +5          +6

+24 Celle di 
storage 

Celle di 
storage 

Celle di 
storage 

Celle di 
storage 

Celle di 
storage 

Celle di 
storage 

  ~

+35

+36 Celle di 
storage 

Celle di 
storage 

Celle di 
storage 

Celle di 
storage 

Celle di 
storage 

Celle di 
storage 

  ~

+48

+49 
  ~

Nessun 
array

In alto 2 = 
subordinato

4 celle  
Diagnostica
/Pulizia

ID 4 celle 4 celle 
Diagnostica/ 
Pulizia

4 celle 
Diagnostica/ 
Pulizia

+52 In basso = 
swap

Nota: vista frontale della libreria.

TABELLA A-1 Base Module—Posizioni nella parete posteriore (vista frontale della libreria) (segue)

Riga          +1          +2          +3          +4
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Come secondo esempio, la posizione dell’array di quattro celle che può contenere 
cartucce diagnostiche su questa parete è...

1. Numero libreria = 1

2. Numero binario = 1

3. Numero colonna = -4

4. Lato = 1

5. Righe = da 49 a 52

...che si traduce in 1, 1, -4, 1, da 49 a 1, 1, -4, 1, 52.

TABELLA A-2 Drive Expansion Module—Posizioni sulla parete posteriore (vista frontale della libreria) 

         -4          -3          -2          -1 Riga

    Unità 28     Unità 27     Unità 26       Unità 25    1

    Unità 32     Unità 31     Unità 30       Unità 29    2

         -6          -5          -4          -3          -2          -1

Celle di 
storage

Celle di 
storage

Celle di 
storage

Celle di 
storage

Celle di 
storage

Celle di 
storage

   13

   ~

   23

Celle di 
storage

Celle di 
storage

Celle di 
storage

Celle di 
storage

Celle di 
storage

Celle di 
storage

   24

   ~

   35

Celle di 
storage 

Celle di 
storage 

Celle di 
storage 

Celle di 
storage 

Celle di 
storage 

Celle di 
storage 

   36

   ~

   48

Nessun 
array

In alto 2 = 
subordinato

4 celle  
Diagnostica
/Pulizia

ID 4 celle 4 celle 
Diagnostica
/Pulizia

4 celle 
Diagnostica
/Pulizia

   49 
   ~

In basso = 
swap

   52

Nota: vista frontale della libreria.
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Celle di sistema/prenotate 
All’interno del Base Module due celle sono riservate solo alle posizioni di drop-off e 
una cella è prenotata come cella swap. Le restanti celle del sistema possono essere 
utilizzate per le cartucce diagnostiche o di pulizia; per un elenco andare alla 
TABELLA A-3 a pagina 338.

All’interno del Base Module vi sono un totale di 12 celle di diagnostica e pulizia; nel 
modulo DEM sono presenti complessivamente 12 o 15 celle di diagnostica o pulizia. Per 
un elenco fare riferimento alla TABELLA A-3 a pagina 338.

In un CEM o un PEM non sono presenti celle prenotate.

Celle della CAP 
Le posizioni delle celle all’interno delle CAP seguono uno schema di notazione simile a 
quello delle altre posizioni all’interno della libreria: 

1. Numero libreria: (sempre 1)

2. Numero binario: (sempre 1)

3. Numero colonna: posizione orizzontale. È riportato sull’estremità sinistra (avendo di 
fronte l’interno della libreria) del Base Module. Le colonne hanno numerazione 
positiva (+), in ordine crescente, da sinistra verso destra, in tutti i moduli connessi al 
lato destro del Base Module. 

Se un modulo è collocato a sinistra del Base Module, invece, le posizioni delle 
colonne hanno numerazione negativa (–), in ordine crescente, da destra verso 
sinistra, in tutti i moduli connessi al lato sinistro del Base Module.

4. Lato: (sempre 2 [parte frontale]).

5. Riga: posizione verticale, indicata nell’ultima cella in alto della colonna. Le celle 
sono numerate da 1 a 13 nel caricatore superiore e da 14 a 26 in quello inferiore. 
Le maniglie del caricatore sono posizionate sopra ciascun caricatore della CAP. 

Nota – La maniglia del caricatore non è considerata una cella.

TABELLA A-3 Celle prenotate 

Posizioni celle Tipo di modulo Utilizzo Posizione

1, 1, 2, 1, 49—50 Base Module Celle subordinate (prenotate) Parete posteriore del Base Module 

1, 1, -4, 1, 49—50 DEM Cartucce di pulizia/diagnostica Parete posteriore del DEM 

1, 1, 2, 1, 51 Base Module Cella swap (prenotata) Parete posteriore del Base Module 

1, 1, -5, 1, 51 DEM Cartucce di pulizia/diagnostica Parete posteriore del DEM 

1, 1, 5, 1, 49—52 
1, 1, 6, 1, 49—52

Base Module Cartucce di pulizia/diagnostica Parete posteriore del Base Module 

1, 1, -1, 1, 49—52 
1, 1, -2, 1, 49—52

DEM Cartucce di pulizia/diagnostica Parete posteriore del DEM 

Nota: non posizionare cartucce dati in una cella prenotata. Tali celle non sono visualizzate dal 
database dell’utente (questo significa che la TallBot online non andrà mai in queste celle).



Posizioni HLI-PRC

418605201 • Revisione: A Appendice A Indirizzi delle risorse della libreria 339

Esempio di indirizzo interno della libreria—Celle della CAP
La quarta cella della CAP nella parte inferiore del Base Module sarebbe... 

1. Numero libreria = 1

2. Numero binario = 1

3. Numero colonna = +5

4. Lato = 2

5. Riga = 4

...che si traduce in 1, 1, +5, 2, 4.

La sesta cella della CAP nella parte inferiore di un DEM sarebbe...

1. Numero libreria = 1

2. Numero binario = 1

3. Numero colonna = -2

4. Lato = 2

5. Riga = 6

...che si traduce in 1, 1, -2, 2, 6.

Posizioni HLI-PRC

Celle di storage 
La posizione (indirizzo) dell’interfaccia della libreria host-pannello, riga, colonna (HLI-
PRC) è composta da un numero di otto -cifre separate da virgole (LL, PP, RR, CC) che 
rappresentano il numero LSM, Pannello, Riga, Colonna. Questo schema di 
indirizzamento è utilizzato dai client HLI, inclusi ACSLS e HSC, per indicare le celle di 
storage delle cartucce alle quali possono accedere. 

Nota – L’indirizzo interno della libreria SL3000 identifica la posizione fisica della 
cartuccia all’interno della libreria e l’HLI-PRC si riferisce all’indirizzo assegnato dal 
software host.

La posizione della cella appare nel seguente formato: 

      L       L       P       P       R       R       C       C
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dove, 

LL: numero LSM (sempre 00)  
PP: Pannello (relativo al Base Module: numeri discendenti a sinistra e ascendenti a 
destra; numeri pari = pareti posteriori, numeri dispari = pareti frontali)

■ Base Module = pannelli 12 e 13

■ DEM aggiunto a sinistra = pannelli 10 e 11

Nota – Eccezione: se un CEM viene aggiunto a sinistra di un Base Module anziché di 
un DEM, la numerazione del pannello di quel modulo sarà 8 e 9 (consultare la sezione 
“Posizione della cella di storage HLI-PRC—Esempio 3” a pagina 341). In questo modo è 
possibile installare un DEM in un momento successivo senza dover rinumerare i 
moduli.

■ modulo aggiunto a destra = pannelli 14 e 15

Nota – RR: Riga nel pannello (un numero da 0 a 51)  
Nota bene: le righe dell’indirizzo interno della libreria partono da 1 mentre le righe 
HLI-PRC da 0.

CC: Colonna nella riga (numerazione da sinistra a destra, a partire dalla parte frontale 
del modulo)

Nota – CC: Colonne nel pannello (un numero da 0 a 5). 
Nota bene: le colonne dell’indirizzo interno della libreria partono da 1 mentre le righe 
HLI-PRC da 0.

Posizioni della cella di storage HLI-PRC—Esempio 1
Per un esempio su come è formulato questo schema di numerazione, fare riferimento 
alla TABELLA A-4. 

Nell’esempio 1, la libreria è composta da due moduli. La posizione della cella di una 
cartuccia posta sulla parete posteriore del Base Module alla colonna 5 e riga 24, si 
tradurrebbe in: 

LL = 00, PP = 12, RR = 24, CC = 05; oppure 00, 12, 24, 05 

TABELLA A-4 Posizioni delle celle nell’interfaccia libreria host—Esempio 1

               Drive Expansion Module                         Base Module

Parete posteriore = Pannello 10 Parete posteriore = Pannello 12

Numeri colonne cartucce Numeri colonne cartucce

0 1 2 3 4 5 0 1 2 3 4 5

0 1 2 3 4 5 0 1 2 3 4 5

Numeri colonne cartucce Numeri colonne cartucce

Parete anteriore = Pannello 11 Parete anteriore = Pannello 13

Nota: vista frontale della libreria.
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Posizione della cella di storage HLI-PRC—Esempio 2
Aggiungendo un modulo a sinistra della libreria descritta nell’Esempio 1 si ottiene uno 
schema con numerazione discendente. Fare riferimento alla TABELLA A-5 per vedere 
come funziona. 

In questo esempio, è stato aggiunto un modulo CEM a sinistra di un DEM. I suoi 
pannelli hanno numerazione 8 e 9. Aggiungendo un altro modulo a sinistra della 
libreria, i pannelli di questo modulo sarebbero 6 e 7. 

Viceversa, aggiungendo un modulo a destra del Base Module, i numeri dei pannelli del 
nuovo modulo sarebbero 14 e 15, e così via. 

Posizione della cella di storage HLI-PRC—Esempio 3
Come eccezione alla numerazione continua dei pannelli, viene mostrato un terzo 
esempio nella TABELLA A-6. In questa libreria, sono stati aggiunti due CEM a sinistra 
del Base Module. Si noti che, senza un DEM, la numerazione dei pannelli a sinistra del 
Base Module è 8 e 9, e non 10 e 11.

Ciò indica:

■ che vi è un’eccezione allo schema di numerazione consecutiva dei pannelli

■ che se successivamente viene installato un DEM, la numerazione dei pannelli dei 
moduli esistenti non cambia

TABELLA A-5 Posizioni delle celle nell’interfaccia libreria host—Esempio 2

  Cartridge Expansion Module       Drive Expansion Module                 Base Module

Parete posteriore = Pannello 8 Parete posteriore = Pannello 10 Parete posteriore = Pannello 12

Numeri colonne cartucce Numeri colonne cartucce Numeri colonne cartucce

0 1 2 3 4 5 0 1 2 3 4 5 0 1 2 3 4 5

0 1 2 3 4 5 0 1 2 3 4 5 0 1 2 3 4 5

Numeri colonne cartucce Numeri colonne cartucce Numeri colonne cartucce

Parete anteriore = Pannello 9 Parete anteriore = Pannello 11 Parete anteriore = Pannello 13

Nota: vista frontale della libreria.
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Nota – Questo schema di numerazione agevola notevolmente gli utenti che, 
aggiungendo un nuovo modulo, non dovranno modificare le configurazioni dei 
pannelli esistenti.

Benché il software di gestione del nastro host segua lo stesso schema di numerazione a 
cinque cifre dell’indirizzo della libreria SL3000, vi sono significative differenze rispetto 
all’assegnazione delle celle, al comportamento della CAP e ad altri aspetti di 
funzionamento descritti di seguito.

Per identificare la posizione HLI-PRC di una cartuccia, consultare la sezione 
“Posizionare una cartuccia in base al VOLID” a pagina 92. Questa procedura mostra le 
informazioni relative alla cartuccia nei formati dell’indirizzo interno della libreria e 
dell’indirizzo HLI-PRC. 

Slot delle unità
Per quando riguarda le unità, la notazione delle posizioni HLI-PRC è diversa rispetto a 
quella delle celle di storage delle cartucce. La TABELLA A-7 mostra come funziona lo 
schema di numerazione; la libreria è vista posteriormente. 

TABELLA A-6 Posizioni delle celle nell’interfaccia libreria host—Esempio 3

Cartridge Expansion Module Cartridge Expansion Module                 Base Module

Parete posteriore = Pannello 6 Parete posteriore = Pannello 8 Parete posteriore = Pannello 12

Numeri colonne cartucce Numeri colonne cartucce Numeri colonne cartucce

0 1 2 3 4 5 0 1 2 3 4 5 0 1 2 3 4 5

0 1 2 3 4 5 0 1 2 3 4 5 0 1 2 3 4 5

Numeri colonne cartucce Numeri colonne cartucce Numeri colonne cartucce

Parete anteriore = Pannello 7 Parete anteriore = Pannello 9 Parete anteriore = Pannello 13

Nota: vista frontale della libreria.
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■ I numeri standard corrispondono alla numerazione fisica delle unità.

■ I numeri in apice (in grassetto) corrispondono alle posizioni HLI-PRC (riga).

■ La numerazione HLI-PRC è sequenziale da desta a sinistra, da 0 a 3, per la prima 
riga (in alto) del primo modulo.

■ Lo schema di numerazione sequenziale HLI-PRC ricomincia, da destra a sinistra, 
da 0 a 3, nel modulo successivo.

■ Il numero della colonna è sempre 0.

Posizioni dell’unità HLI-PRC—Esempio 1
Un’unità è identificata da un numero a essa assegnato anziché che tramite le posizioni 
delle righe e delle colonne. Il numero dell’unità viene assegnato alla posizione occupata 
dalla riga di una cella, mentre la posizione occupata dalla colonna di una cella è sempre 
00. Per esempio, il numero 20 assegnato all’unità equivale alla seguente posizione HLI-
PRC:

Libreria = 00

Pannello = 12

Unità = 16

Colonna = 00

Posizioni dell’unità HLI-PRC—Esempio 2
Come secondo esempio, passando da una posizione HLI-PRC a una hardware, l’unità 
nastro 00, 10, 25, 00 è equivalente all’hardware dell’unità nastro numero 51.

TABELLA A-7 Posizioni dell’unità nastro nell’interfaccia della libreria host  

                             Base Module                     Drive Expansion Module

                     Pannello posteriore =12                     Pannello posteriore =10

        13         22         31         40         253         262         271         280

        57         66         75         84         297         306         315         324

        911         1010         119         128         3311         3410         359         368

        1315         1414         1513         1612         3715         3814         3913         4012

        1719         1818         1917         2016         4119         4218         4317         4416

        2123         2222         2321         2420         4523         4622         4721         4820

        4927         5026         5125         5224

        5331         5430         5529         5628

Note: vista posteriore della libreria. 
      I numeri in apice (in grassetto) rappresentano le posizioni HLI-PRC (che si traducono nel 
numero della riga).
      La notazione numerica standard rappresenta il numero dell’unità. 
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Celle della CAP 
Le posizioni HLI-PRC della CAP hanno una notazione differente rispetto a quella 
utilizzata per le celle di storage delle cartucce. Le CAP utilizzano numeri CAP al posto 
di numeri pannello e le celle CAP sono sempre posizionate nella colonna 00, righe dalla 
00 alla 25. Di seguito è riportata la struttura nel dettaglio: 

Libreria = sempre 00

CAP = 01–10 

Riga = 00–25

Colonna = sempre 00

Per individuare la posizione HLI-PRC di una cartuccia, consultare la sezione 
“Posizionare una cartuccia in base al VOLID” a pagina 92. Questa procedura mostra le 
informazioni relative alla cartuccia sia nel formato dell’indirizzo interno della libreria 
che in quello dell’indirizzo HLI-PRC. 

Posizioni dell’elemento FC-SCSI
Poiché la libreria SL3000 presenta anche un’interfaccia controllo Fibre Channel 
(libreria), è necessario conoscere la numerazione della cartuccia/CAP/unità secondo gli 
elementi FC-SCSI. 

La TABELLA A-8 a pagina 345 rappresenta le posizioni dell’elemento FC-SCSI nelle 
pareti posteriori di una libreria che ha: 

■ Quattro moduli

■ 166 celle di storage per cartucce concesse in licenza 
■ 36 unità nastro 

La TABELLA A-9 a pagina 345 rappresenta gli elementi FC-SCSI nelle pareti anteriori 
della stessa libreria.

Nota – Entrambe le tabelle riportate di seguito indicano gli elementi FC-SCSI di una 
libreria non partizionata nativa.

La TABELLA A-8 e la TABELLA A-9 sono solo degli esempi che servono a mostrare che 
la numerazione dell’elemento FC-SCSI è: 

■ Per gli elementi di storage: dall’alto verso il basso, da sinistra a destra, a partire dalla 
parete posteriore (vista frontale, numero 2000) e continuando con lo stesso schema 
sulle pareti anteriori (vista frontale della libreria). 

■ Per gli elementi CAP (elementi di importazione/esportazione): dal basso verso l’alto, 
da sinistra a destra, a partire dall’elemento numero 10 nella CAP più a sinistra del 
modulo.

■ Le unità nastro (elementi per il trasferimento dei dati): da sinistra a destra, dall’alto 
in basso, a cominciare dalla CenterLine del Base Module (elemento 1000) e 
continuando nel DEM. 
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Nella sequenza non sarà incluso uno slot unità vacante. 

La TABELLA A-9 indica la posizione degli elementi FC-SCSI delle pareti anteriori della 
stessa libreria. 

TABELLA A-8 Posizioni degli elementi FC-SCSI—Pareti posteriori (vista frontale)  

Cartridge 
Expansion 
Module

      Drive Expansion Module  
               (Center Line) 

                Base Module  
                (Center Line)  Cartridge 

Expansion 
Module

2000 2010 1022 1023 1024 1025 1000 1001 1002 1003 2060 2070

2001 2011 1026 Vuoto 1027 1028 1004 1005 1006 1007 2061 2071

2002 2012 1029 1030 Vuoto 1031 1008 1009 1010 1011 2062 2072

2003 2013 1032 1033 1034 1035 1012 1013 1014 1015 2063 2073

2004 2014 2020 2026 2032 2038 1016 Vuoto 1017 1018 2064 2074

2005 2015 2021 2027 2033 2039 1019 1020 1021 Vuoto 2065 2075

2006 2016 2022 2028 2034 2040 2044 2048 2052 2056 2066 2076

2007 2017 2023 2029 2035 2041 2045 2049 2053 2057 2067 2077

2008 2018 2024 2030 2036 2042 2046 2050 2054 2058 2068 2078

2009 2019 2025 2031 2037 2043 2047 2051 2055 2059 2069 2079

Note: per le unità nastro la numerazione parte dalla CenterLine (parete sinistra del Base Module).
          Gli slot delle unità nastro vuoti non vengono considerati.

TABELLA A-9 Posizioni degli elementi FC-SCSI—Pareti anteriori (vista frontale) 

Cartridge 
Expansion 
Module

        Drive Expansion Module  
                 (Center Line) 

               Base Module  
               (Center Line) Cartridge 

Expansion 
Module

2080 2090 2100 2107   (CAP) 10 2123 2130   (CAP) 36 2146 2156

2081 2091 2101 2108              2124 2131               2147 2157

2082 2092 2102 2109               2125 2132               2148 2158

2083 2093 2103 2110             ~ 2126 2133             ~ 2149 2159

2084 2094 2104 2111               2127 2134               2150 2160

2085 2095  
Maniglia 
porta 
 

2112                
Maniglia 
porta 
 

2135               2151 2161

2086 2096 2113               35 2136              51 2152 2162

2087 2097 2114 2117 2120 2137 2140 2143 2153 2163

2088 2098 2105 2115 2118 2121 2128 2138 2141 2144 2154 2164

2089 2099 2106 2116 2119 2122 2129 2139 2142 2155 2155 2165

Note: vista frontale della libreria. 
           Le posizioni delle celle di storage delle cartucce sono in ordine crescente e saltano le posizioni 
delle maniglie delle porte.
           Le celle CAP sono uniche e sequenziali, da sinistra a destra, con vista frontale della libreria.
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Numeri dell’hardware dell’unità
Il numero dell’hardware di un’unità è strettamente interno alla libreria ed è definito dai 
cavi elettrici che collegano lo slot dell’unità. I numeri sono stampati su decalcomanie 
all’interno delle porte posteriori dei moduli della libreria.

La TABELLA A-10 mostra questo schema di numerazione per il Base Module, visto 
posteriormente. La TABELLA A-11 a pagina 346 illustra la numerazione del DEM.

TABELLA A-10 Numerazione dell’unità nastro del Base Module—Hardware 

Numero array Vassoi dell’unità

1 Unità 1 Unità 2 Unità 3 Unità 4

Unità 5 Unità 6 Unità 7 Unità 8

Numero array Vassoi dell’unità

2 Unità 9 Unità 10 Unità 11 Unità 12

Unità 13 Unità 14 Unità 15 Unità 16

Numero array Vassoi dell’unità

3 Unità 17 Unità 18 Unità 19 Unità 20

Unità 21 Unità 22 Unità 23 Unità 24

Nota – I numeri riportati sono stati presi dalla parte posteriore del Base Module.

TABELLA A-11 Numerazione dell’unità nastro del Drive Expansion Module—Hardware  

Numero array Vassoi dell’unità

1 Unità 25 Unità 26 Unità 27 Unità 28

Unità 29 Unità 30 Unità 31 Unità 32

Numero array Vassoi dell’unità

2 Unità 33 Unità 34 Unità 35 Unità 36

Unità 37 Unità 38 Unità 39 Unità 40

Numero array Vassoi dell’unità

3 Unità 41 Unità 42 Unità 43 Unità 44

Unità 45 Unità 46 Unità 47 Unità 48

Numero array                                                    Vassoi unità

4 Unità 49 Unità 50 Unità 51 Unità 52

Unità 53 Unità 54 Unità 55 Unità 56

Nota – I numeri riportati sono stati presi dalla parte posteriore del DEM.
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World Wide Name dinamici dell’unità
I World Wide Name (WWN) dinamici dell’unità, o indirizzi Fibre Channel, vengono 
generati automaticamente dal controller della libreria durante l’inizializzazione della 
stessa. Essi vengono assegnati agli slot delle unità della libreria e non ai dispositivi. 
Se viene sostituita un’unità, alla nuova unità viene assegnato lo stesso nome di quella 
sostituita, in questo modo non è necessario riconfigurare il sistema. A ciascuno slot 
sono assegnati tre World Wide Name: nodo, porta A e porta B.

Nota – La funzionalità del World Wide Name dinamico viene generalmente abilitata al 
momento dell’installazione. È necessario che sia libreria che tutte le unità nastro siano 
dotate di un firmware che supporta tale funzionalità Quando la funzionalità è abilitata, 
tutte le unità devono avere un livello di firmware adeguato. Se il livello di firmware di 
un’unità non è sufficiente, resta in attesa di essere configurata e non può essere 
utilizzata dall’host.
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APPENDICE B

Schemi delle pareti  

Questa appendice fornisce tabelle e schemi dettagliati sui seguenti elementi:

■ “Pareti del Base Module” a pagina 350

■ “Pareti del Drive Expansion Module” a pagina 351

■ “Pareti del Cartridge Expansion Module” a pagina 352

■ “Pareti del Parking Expansion Module” a pagina 353

■ “Blocco di configurazione” a pagina 354

■ “Numerazione dellerighe” a pagina 355

■ “Celle di sistema/prenotate” a pagina 356
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Nota – È impossibile accedere alle celle di colore grigio chiaro se su quel lato non è 
installato un modulo adiacente. 

FIGURA B-1 Pareti del Base Module

Base Module 
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 ■ 140 celle per cartucce 
dati

■ Con CAP da 26 celle 
■ Con pannello 

operatore o finestra
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■ Con finestra array 

delle cartucce 
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■ 8 slot delle unità 
nastro 

■ 180 cartucce dati 

■ 16 slot delle unità 
nastro 

■ 125 cartucce dati 

■ 24 slot delle unità 
nastro 

■ 65 cartucce dati 
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Nota – È impossibile accedere alle celle di colore grigio chiaro se su quel lato non è 
installato un modulo adiacente. 

FIGURA B-2 Pareti del Drive Expansion Module 
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■ Con finestra array 
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■ 8 slot delle unità 
nastro 

■ 180 cartucce dati 

■ 16 slot delle unità 
nastro 

■ 125 cartucce dati 

■ 24 slot delle unità 
nastro 

■ 65 cartucce dati 

■ 32 slot delle unità 
nastro 

■ 0 cartucce dati 
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Nota – È impossibile accedere alle celle di colore grigio chiaro se su quel lato non è 
installato un modulo adiacente. 

FIGURA B-3 Pareti del Cartridge Expansion Module 

Cartridge Expansion Module di sinistra 

Parete anteriore 
■ 260 celle delle 

cartucce 

Parete anteriore 
■ 182 celle delle 

cartucce
■ Con CAP da 26 celle 

Parete posteriore 
■ 256 celle delle 

cartucce

Cartridge Expansion Module di destra 

Parete posteriore 
■ 308 celle delle 

cartucce 

Parete anteriore 
■ 234 celle delle 

cartucce 
■ Con CAP da 26 celle 

Parete anteriore 
■ 312 celle delle 

cartucce 
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Nota – Sei colonne di array, tre sulla parete posteriore e tre sulla parete frontale, sul 
lato sia sinistro che destro; non sono accessibili e non consentono un’unità robotica 
difettosa. 

FIGURA B-4 Pareti del Parking Expansion Module 

Parking Expansion Module di sinistra 

Parete anteriore 
■ 156 celle delle 

cartucce 

Parete posteriore 
■ 152 celle delle 

cartucce 

Parking Expansion Module di destra 

Parete posteriore 
■ 156 celle delle 

cartucce 

Parete anteriore 
■ 156 celle delle 

cartucce 
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Blocco di configurazione
Ogni modulo nella libreria SL3000 ha un blocco di configurazione nella parte inferiore 
della parete posteriore nella colonna 4, righe 49, 50, 51 e 52. Questo blocco identifica: 

■ Il tipo di modulo 

■ La configurazione della parete posteriore 

■ La configurazione della parete frontale 

■ Le opzioni per quel modulo

Durante l’inizializzazione della libreria, l’unità robotica ispeziona il blocco di 
configurazione per stabilire la configurazione del modulo.

FIGURA B-5 Blocco di configurazione 

Tipi di moduli: 

■ Base Module 
■ DEM 
■ CEM 

■ PEM
■ AEM 

La configurazione della parete posteriore: 

Target 

Configurazione della parete frontale: 

Opzioni: 

■ Pannello operatore 
locale 

■ Finestra 
■ Array delle cartucce

I   I\I   I
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Numerazione dellerighe 
FIGURA B-6 Numerazione delle righe 

Esempio 1  
Base Module 

Esempio 2  
CEM 

Le righe indicano la posizione verticale di una 
cartuccia o di un’unità nastro.

Le righe hanno sempre una numerazione positiva. 

Le righe delle celle di storage sono numerate 
dall’alto (1) verso il basso (52). 
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Celle di sistema/prenotate 
Sia il Base Module che il Drive Expansion Module presentano slot speciali nella parte 
inferiore della parete posteriore. Questi slot assolvono a funzioni speciali per la libreria 
e le unità nastro. 

La FIGURA B-7 mostra un esempio di questi slot: 

1. Slot swap (2) nella colonna 2, righe 49 e 50.

2. Slot di diagnostica (1) nella colonna 2, riga 51. 

3. Slot di diagnostica (4) nella colonna 3, righe 49, 50, 51 e 52. 

4. Blocco di configurazione nella colonna 4, righe 49, 50, 51 e 52.

5. Cartucce di pulizia (4) nella colonna 5, righe 49, 50, 51 e 52. 

6. Cartucce di pulizia (4) nella colonna 6, righe 49, 50, 51 e 52. 

FIGURA B-7 Slot prenotati 

Swap
Diagnostica

Diagnostica Blocco di 
configurazione

Pulizia Pulizia

Target
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APPENDICE C

Gestione delle cartucce 

Questa appendice fornisce informazioni sull’etichettatura e la gestione delle cartucce 
utilizzate nelle librerie Sun StorageTek. 

Etichette cartucce valide 
Le cartucce della libreria devono essere etichettate con un’etichetta esterna valida. 
La libreria supporta diverse etichette codice a barre Code 39 standard: 

Per le cartucce T9840 e T10000, utilizzare etichette fornite da Trioptic (progettazione di 
Data Products/Colorflex) o Tricode (American Eagle/Writeline). Entrambe le versioni 
richiedono un carattere ID supporto separato.

Nota – Le cartucce non etichettate non sono supportate. Consultare la sezione 
“Cartucce non etichettate” a pagina 359.

Sun Unità nastro e cartucce StorageTek 
Le etichette delle unità nastro di Sun StorageTek T9840 (modelli C e D) e T10000 sono 
elencate nella TABELLA C-1. Queste unità nastro offrono anche supporto per la 
crifratura. 

TABELLA C-1 Sun StorageTek Codici cartucce 

ID supporto Tipo di cartuccia

VOLSER + R Cartuccia dati T9840

VOLSER + R (sfondo verde) Cartuccia dati VolSafe T9840C

VOLSER + R (sfondo viola) Cartuccia dati VolSafe T9840D

CLN (spazio vuoto) VOLSER + U Cartuccia di pulizia T9840

CLN (spazio vuoto) VOLSER + Y Cartuccia di pulizia T9840D (Nota: l’unità 
nastro T9840D ha una sola cartuccia di 
pulizia.)

DG (spazio vuoto) VOLSER + R Cartuccia diagnostica T9840 
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Unità nastro e cartucce LTO

Nota – La tecnologia LTO è stata sviluppata da IBM, Hewlett-Packard e Seagate 
(Certance). La tecnologia LTO è un “formato aperto”, il che significa che gli utenti 
hanno a disposizione molteplici fonti di approvvigionamento di prodotti e supporti. 

La etichette per cartucce LTO presentano otto caratteri. Gli ultimi due sono l’ID del 
supporto (L3, L4, LT o LU). CLN o DG sono i primi caratteri sulle etichette di pulizia o 
diagnostica. Le unità nastro LTO-4 offrono anche supporto per la cifratura. 

VOLSER + T1 Cartuccia dati T10000

DG spazio vuoto) VOLSER + T1 Cartuccia diagnostica T10000

CLN (spazio vuoto) VOLSER + CT Cartuccia di pulizia T10000

VOLSER + TS Cartuccia dati T10000 (sport)

DG (spazio vuoto) VOLSER + TS Cartuccia diagnostica T10000 (sport)

CLN (spazio vuoto) VOLSER + CT Cartuccia di pulizia T10000 (sport)

TABELLA C-2 Codici cartucce LTO  

ID supporto Tipo di cartuccia

L3 Cartuccia dati Generazione 3

L4 Cartuccia dati Generazione 4

LT WORM (Write once read many times), da 400GB
Questa funzionalità impedisce all’utente di modificare o cancellare le 
informazioni sul nastro. Per ulteriori informazioni, visitare il sito Web del 
proprio distributore e cercare WORM. 

LU WORM (Write once read many times), da 800GB

CLN (spazio 
vuoto) + CU

Cartuccia di pulizia universale
Sun consiglia di usare l’etichetta universale CLN + CU invece di un’etichetta 
specifica del produttore (CLN + C1 per Hewlett-Packard o CLN + C2 per IBM).

DG (spazio vuoto) 
+ VOLSER

Cartuccia diagnostica (applicare un’etichetta DG a una cartuccia dati vuota da 
utilizzare per i test diagnostici della libreria) 

Nota – Per assicurare compatibilità con le versioni precedenti, le cartucce dati 
Generazione 2 (L2) sono supportate esclusivamente per operazioni di sola lettura. 

TABELLA C-1 Sun StorageTek Codici cartucce (segue)

ID supporto Tipo di cartuccia
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Corretto inserimento della cartuccia
La cartuccia deve essere inserita nella cella di storage, nella cella della CAP o nell’unità 
con il codice a barre in basso, e con il VOLID leggibile da destra a sinistra. L’hub della 
cartuccia deve essere sempre rivolto verso il basso. 

Cartucce non leggibili
Le cartucce possono essere classificate come non leggibili per le seguenti ragioni:

■ Cartucce non etichettate

■ Cartucce-capovolte

HSC e ACSLS espellono automaticamente cartucce non leggibili dalla libreria. Gli host 
FC-SCSI potrebbero non essere in grado di farlo; la cartuccia non leggibile può essere 
spostata automaticamente in una CAP durante l’inizializzazione della libreria. 

Nota – Se numerose cartucce vengono identificate come non leggibili, potrebbe esserci 
una fotocamera o un lettoreTallBot difettoso. Ciò potrebbe far sì che un elevato numero 
di cartucce venga espulso dalla libreria. 

Cartucce non etichettate
Le cartucce senza etichette esterne non sono completamente supportate dalla libreria 
SL3000. Le cartucce non etichettate non possono essere montate sulle unità, ma possono 
essere spostate tra CAP e celle di storage. 

■ Se una cartuccia non etichettata viene posizionata in una CAP, la TallBot la lascerà in 
tale posizione. La disposizione della cartuccia dipende dal software dell’host. 

■ Se una cartella non etichettata viene posizionata in una cella di storage della libreria, 
nel corso del controllo verrà segnalato che la cartuccia è illeggibile e non valida. 
A seconda del software dell’host, la cartuccia può non essere riconosciuta da 
quest’ultimo o espulsa attraverso la CAP. 

Cartucce-capovolte
Non tentare mai di inserire le cartucce capovolte, soprattutto quelle per Sun StorageTek. 
Il modo in cui la libreria gestisce la situazione dipende dal tipo di cartuccia.
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Sun StorageTek Cartucce

Attenzione – Le cartucce perSun StorageTekcapovolte non entrano nelle celle di 
storage della libreria e possono danneggiarsi o danneggiare la TallBot.

■ Se una cartuccia per Sun StorageTek viene infilata capovolta nel caricatore di una 
CAP, la CAP non si chiude. 

■ Se una cartuccia per Sun StorageTek viene infilata capovolta in una cella di storage 
della libreria, la cartuccia uscirà dalla cella di storage e danneggerà la TallBot. 

Cartucce LTO 
■ Se una cartuccia LTO viene posizionata capovolta nel caricatore di una CAP, 

la TallBot lascerà la cartuccia in tale posizione. La disposizione della cartuccia 
dipende dal software dell’host. 

■ Se una cartuccia LTO viene posizionata capovolta in una cella di storage della 
libreria, nel corso del controllo verrà segnalato che la cartuccia è illeggibile e non 
valida. A seconda del software dell’host, la cartuccia può non essere riconosciuta da 
quest’ultimo o espulsa attraverso la CAP. 



418605201 • Revisione: A 361

APPENDICE D

Server della SL Console via Web 

La SL Console via Web è una funzionalità standard della libreria SL3000 ed è compresa 
nel CD fornito con ogni libreria. Consente di installare la SL Console su un Web server 
centralizzato. I singoli client possono quindi utilizzare un browser supportato per 
scaricare e accedere alla SL Console via Web. 

La SL Console via Web è distribuita come file Java Web Archive (.war). 

Considerazioni su sicurezza 
Il cliente è responsabile dell’implementazione di tutti i sistemi di sicurezza appropriati, 
compresi firewall, accesso utente.

Requisiti del server
È possibile implementare la SL Console via Web su un qualsiasi Web server compatibile 
con la piattaforma J2EE (Java 2 Platform, Enterprise Edition). Si consiglia di utilizzare 
Java System Web Server. 

Nota – Tutte le procedure descritte in questo documento presumono si stia utilizzando 
Java System Web Server. 
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Installazione e gestione del server
L’installazione e la gestione del server della SL Console via Web implicano le seguenti 
procedure:

■ “Scaricare Java System Web Server” a pagina 362

■ “Installare Java System Web Server” a pagina 365

■ “Accedere alla console di amministrazione di Java System Web Server” a pagina 369

■ “Installare e implementare la SL Console via Web” a pagina 372

■ “Avviare la SL Console via Web” a pagina 377

■ “Aggiornare la SL Console via Web” a pagina 379

▼ Scaricare Java System Web Server
Utilizzare questa procedura per scaricare Java System Web Server qualora non sia già 
installato sul proprio server. 

Nota – Per questa procedura è necessario disporre di un nome utente e di una 
password Sun Online Account. 

1. Aprire un browser; nella barra degli indirizzi inserire l’URL della pagina dei server 
Sun:

http://www.sun.com/download/index.jsp?cat=Web%20%26%20Proxy%20Servers&tab=3&subcat=Web%20Servers 

2. Nella pagina dei server, selezionare il collegamento al server che corrisponde alla 
piattaforma del proprio server. 
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3. Nella schermata Sun Java System Web Server, che varierà a seconda della selezione 
nel passo precedente, scorrere per verificare l’elenco delle piattaforme supportate, 
quindi fare clic su Download. 

4. Nella schermata Sun Download Center Login, inserire il nome utente e la password, 
quindi fare clic su Login.

Nota – Se non si dispone ancora di un account, selezionare Register Now e seguire le 
istruzioni per crearne uno. 
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5. Nella schermata Sun Download Center, selezionare quanto segue:

■ Fare clic sul pulsante di scelta Accept License Agreement.

■ Selezionare il collegamento Sun Java System Web Server che corrisponde alla 
piattaforma del proprio server.
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6. Nel popup, fare clic su Save to Disk, per salvare il file di archivio compresso in una 
directory a scelta, quindi fare clic su OK. 

Nota – L’operazione può richiedere diversi minuti.

7. Utilizzare l’utility di estrazione appropriato (ad esempio, gunzip, pkunzip) per 
estrarre i file di Java System Web Server in una directory a scelta. 

▼ Installare Java System Web Server 
Utilizzare questa procedura per installare Java System Web Server qualora non sia già 
installato sul proprio server. 

1. Nella directory in cui sono stati estratti i file di Sun Java System Web Server, fare 
doppio clic o eseguire il file di configurazione dalla riga di comando (setup o 
setup.exe, a seconda della propria piattaforma. 

Se l’installazione avviene su una piattaforma Solaris, potrebbe essere necessario 
richiamare le autorizzazioni root o sudo a seconda della directory in cui si sta 
installando. In questo caso, seguire i seguenti passi:

a. cd extraction_directory

dove extraction_directory è la directory in cui sono stati estratti i file compressi di Java 
Web Server. 

b. xhost + 

c. sudo ./setup 
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2. Nella schermata Welcome fare clic su Next. 

3. Nella schermata Software License Agreement, selezionare il pulsante di scelta Yes, 
quindi fare clic su Next. 
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4. Nella schermata Select Installation Directory, specificare la directory in cui si vuole 
installare il server, quindi fare clic su Next.

5. Nella schermata Type of Installation, selezionare Express, quindi fare clic su Next.
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6. Nella schermata Administration Server Settings, specificare la password di 
protezione per l’utente admin, quindi fare clic su Next. 

7. Nella schermata Ready to Install, verificare le informazioni sull’installazione, quindi 
fare clic su Install Now. 

Inizia l’installazione e sullo schermo compare una barra di avanzamento. 
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8. Nella schermata Installation Complete, verificare le informazioni e annotare l’URL 
dell’Administration Console specificato nel punto #2 alla voce “Next Steps. Sarà 
richiesto nella prossima procedura. 

9. Fare clic su Finish per uscire dal programma di configurazione. 

▼ Accedere alla console di amministrazione di Java 
System Web Server

1. Avviare Sun Java System Web Server, se non è ancora operativo: 

■ Su Windows, fare clic su Start > All Programs > Sun Microsystems > Web Server 
7.0 > Start Administration Server. 

■ Su Solaris, aprire una finestra del terminale e digitare quanto segue:

sudo /opt/webserver7/admin-server/bin/startserv 

Nota – Attendere alcuni minuti prima di avviare il server. 

2. Aprire un browser e, nel campo della barra degli indirizzi, inserire l’URL annotato al 
termine della procedura precedente (“Installare Java System Web Server”). La console 
di amministrazione sarà avviata. 
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3. Nel popup, accettare il certificato del server, quindi fare clic su OK. 

4. Nel browser in cui è stato aperto l'URL della console di amministrazione, inserire 
admin in User Name e Password, quindi fare clic su Log in. 
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5. Si apre la schermata Common Tasks. 
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▼ Installare e implementare la SL Console via Web 

Nota – Prima di eseguire questa attività, è necessario disporre del CD di installazione 
della SL Console via Web. 

1. Inserire il CD di installazione della SL Console via Web nell’unità del CD del server. 

2. Accedere alla console di amministrazione di Sun Java System Web Server. 
Consultare “Accedere alla console di amministrazione di Java System Web Server” a 
pagina 369 per informazioni. 

3. Nella schermata Common Tasks, selezionare Add Web Application.

4. Nella schermata Add Web Application, procedere come segue:

■ Web Application Location: fare clic sul pulsante Browse per trovare il percorso del 
file opel.war sul CD di installazione. 

■ URI: tipo /opel

■ Lasciare tutti gli altri campi con i valori predefiniti. 

■ Fare clic su OK. 
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5. Nella schermata Web Applications, fare clic su Save.
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6. Nella schermata Web Applications aggiornata, selezionare il collegamento 
Deployment Pending in alto a destra. 

7. Nella schermata Configuration Deployment, fare clic su Deploy. 
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8. Nella schermata Results, fare clic su Close. 

9. Nella schermata Web Applications viene visualizzato un messaggio a indicare che 
l’applicazione è stata aggiunta correttamente. 

È possibile selezionare il pulsante Home in altro a destra per tornare alla schermata 
Common Tasks. 
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▼ Avviare la SL Console via Web 
1. Accedere alla console di amministrazione di Sun Java System Web Server. 

Consultare “Accedere alla console di amministrazione di Java System Web Server” a 
pagina 369 per informazioni. 

2. Nella schermata Common Tasks, selezionare Start/Stop Instances. 
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3. Nella schermata Configuration Instances, selezionare la casella di controllo a fianco 
dell’istanza locale del server della SL Console via Web, quindi fare clic su Start. 

Le istanze dell’applicazione della SL Console via Web vengono avviate e sullo schermo 
compare una barra di avanzamento. 

4. Nella schermata Results, fare clic su Close. 
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▼ Aggiornare la SL Console via Web 
La SL Console via Web può essere aggiornata mentre è in esecuzione. Gli aggiornamenti 
vengono propagati automaticamente sui client quando recuperano l’applicazioni della 
SL Console via Web dal server. 

Nota – Prima di eseguire questa attività, è necessario disporre del CD di 
aggiornamento della SL Console via Web. 

1. Inserire il CD di aggiornamento della SL Console via Web nell’unità del CD del 
server. 

2. Accedere alla console di amministrazione di Sun Java System Web Server. 
Consultare “Accedere alla console di amministrazione di Java System Web Server” a 
pagina 369 per informazioni. 

3. Nella schermata Common Tasks, selezionare Edit Virtual Server.
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4. Nella schermata General Properties, selezionare la scheda Web Applications.

5. Nella schermata Web Applications, selezionare la casella di controllo accanto all’URI 
/opel, quindi fare clic su Update.
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6. Nella schermata Update Web Application, procedere come segue:

■ Web Application Location: fare clic sul pulsante Browse per trovare il percorso del 
file opel.war sul CD di aggiornamento. 

■ Lasciare tutti gli altri campi con i valori predefiniti. 

■ Fare clic su OK. 

Inizia l’aggiornamento del server e sullo schermo compare una barra di avanzamento. 
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7. Nella schermata Web Applications, selezionare il collegamento Deployment Pending 
in alto a destra. 

8. Nella schermata Configuration Deployment, fare clic su Deploy. 

Inizia l’implementazione e sullo schermo compare una barra di avanzamento. 
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9. Nella schermata Results, fare clic su Close per tornare alla schermata Web 
Applications. 
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Problemi comuni e soluzioni
In questa sezione vengono descritte le soluzioni ad alcuni problemi comuni che si 
verificano durante l’installazione e la manutenzione di Java System Web Server. 

Windows 2000 Sun Java System Web Server Errori 
di installazione

Errore MSVCP60.dll in Windows 
Se l’installazione avviene su una piattaforma Windows 2000 che non comprende 
Microsoft Visual C v6 runtime DLL, MSVCP60.dll, verranno visualizzati errori simili a 
quelli riportati di seguito:
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Il log di installazione del Web server riporta errori di questo genere:

▼ Correzione dell’errore MSVCP60.dll in Windows 
Utilizzare questa procedura per correggere l’errore MSVCP60.dll in Windows. 

1. Cercare la stringa seguente su Web:

msvcp60.dll download 

2. Scaricare il file DLL nella directory /winnt/system32. 

3. Eliminare la directory in cui è stato installato Java System Web Server 
nell’installazione non corretta.

4. Ripetere l'installazione di Java System Web Server dall’inizio.

L’installazione dovrebbe essere completata senza che si ripresenti l'errore. 
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▼ Solaris 9 & 10 Sun Java System Web Server Errori 
di installazione

Errore in Java Home
Se non è possibile avviare l’installazione del server, se gli errori indicano che l’avvio di 
HotSpot non è riuscito e se è impossibile individuare la JVM, è necessario modificare la 
configurazione di Sun Java System Web Server. 

▼ Correzione dell’errore Java Home su Solaris 
Utilizzare questa procedura per correggere l’errore Java Home. 

1. Accedere alla console di amministrazione di Sun Java System Web Server. 
Consultare “Accedere alla console di amministrazione di Java System Web Server” 
a pagina 369 per informazioni. 

2. Selezionare Home > Common Tasks. 

3. In Configuration Tasks, selezionare Edit Java Settings. 
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4. Nel campo Java Home, inserire la directory in cui è istallato JDK/JRE. Ad esempio:

/usr/java 

Nota – Potrebbe essere necessario modificare le autorizzazioni sulla directory del 
livello principale in cui è installato Sun Java System Web Server. Perché un utente non 
root possa avviare un’istanza del server, è necessario che possa scrivere nella directory 
del server. Ad esempio, se il server è stato installato nella directory a livello principale 
/opt/webserver7, l’utente che avvia l’istanza deve poter scrivere in questa directory 
nonché nella directory https server_name di livello inferiore. Per ulteriori informazioni, 
consultare il sito Sun Java System Web Server. 
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